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Getting Started Quickly

To Get Started
Quickly

If you are not familiar with the ABI PRISM® 377 DNA Sequencer, follow the guidelines 
listed under “What to Do If You Are a New User” on page 1-3.

If you are familiar with the instrument and its operation, proceed as follows.

� Before using the instrument, read the safety information located on page 1-4, and 
in the ABI PRISM® 377 Site Preparation and Safety Guide (P/N 903393).

� If you are preparing your own gels, proceed to:

– Appendix A, “Gel Recipes,” for recommendations and instructions on 
preparing gel solutions

– Chapter 2, “Pouring Gels,” for instructions on how to pour the gel

� If you have a gel, proceed to Chapter 3, “Instrument Operation,” for step-by-step 
instructions on instrument set up and operation.

Note Chapters 2 and 3, and Appendix A are bound separately for your convenience. They 
can be removed from the binder and used separately as quick reference guides for preparing 
gels and using the instrument.
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What to Do If You Are a New User

Safety Information Before using the instrument, read the safety information located on page 1-4, and in 
the ABI PRISM 377 Site Preparation and Safety Guide (P/N 903393).

The Macintosh
Computer

This manual is written with the assumption that you know how to operate a 
Macintosh® computer. If you are not familiar with this computer, refer to the Macintosh 
documentation shipped with this system for specific operating information.

What to Read We recommend reading:

� “ABI PRISM 377 DNA Sequencer—System Components” on page 1-11

– Provides an overview of system hardware and software

� “Theory of Operation” on page 1-13

– Describes electrophoresis and how data is collected

� “Using the Instrument” on page 1-14

– Provides an overview of the steps involved in using the instrument

– Introduces terminology specific to system operation

� Chapter 2, “Pouring Gels” and Appendix A, “Gel Recipes” if you are preparing 
your own gels. Includes:

– Detailed instructions for two methods of pouring gels

– Recommendations and instructions for preparing a variety of gels that can be 
used on this instrument

– Storage recommendations for reagents and stock solutions

– Factors that affect gel quality and read lengths for sequencing

– Supplier information

� Chapter 3, “Using the Instrument”

– Provides detailed instructions for setting up and operating the instrument for 
both GeneScan® analysis software and sequencing analysis software 
applications

Note Chapters 2 and 3, and Appendix A are bound separately for your convenience. They 
can be removed from the binder and used separately as quick reference guides for pouring gels 
and using the instrument.
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Safety Information

Site Preparation and
Safety Guide

The ABI PRISM 377 Site Preparation and Safety Guide (P/N 903393) was sent to you 
prior to instrument installation. This guide includes important safety information that 
should be read by all users before they operate the instrument. Topics covered in the 
guide include:

� An explanation of the safety labels affixed to the instrument

� Laser safety, including hazards and safe-operation requirements

� Chemical safety, including a waste profile and Material Data Safety Sheets for the 
chemicals commonly used with the instrument 

We strongly recommend this guide be kept readily available for reference at all times.

Safety Warnings in
this Manual

Safety warnings appear throughout this manual at relevant locations. These warnings 
address chemical, high voltage, and laser safety. They appear in the format shown 
below.

! WARNING ! ELECTRICAL SHOCK HAZARD. The ABI Prism 377 contains a high 
voltage power supply. Although the instrument has been designed with safety features in 
the door to disconnect the power supply when the door is open, please follow 
procedures as prescribed. As with any electrophoresis apparatus, be careful during 
instrument operation and when handling electrodes and liquids.

! WARNING ! LASER HAZARD. Exposure to direct or reflected laser light at 40 mW 
for 0.1 seconds can burn the retina and leave permanent blind spots. Never look directly 
into the laser beam or allow a reflection of the beam to enter your eyes. 

Ergonomic Hazard ! WARNING ! Ergonomic Hazard. Performing loading activities may increase risk of 
developing the following cumulative trauma disorders (repetitive motion or repetitive 
strain injuries) which include but are not limited to: tendinitis, tenosynovitis, 
epicondylitis, strains, and/or sprains. To reduce the risk of experiencing these types of 
disorders, the following recommendations have been developed to decrease awkward 
posture; repetitive motion; excessive force; static muscle loading; and soft tissue 
contact.

� Use an automated multi-channel pipette loader

� Locate the instrument on a variable or predetermined-height worktable or 
lab bench

� Use a stable stool or stepladder

� Install adequate artificial lighting in the appropriate area to facilitate loading

� Ensure adequate front access to instrument while performing loading 
activities
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Special Text Usage

User Attention
Words

The text of this manual includes four user attention words designed to draw your 
attention to safety issues or issues relative to proper instrument operation. Each 
represents a certain level of attention or action, as described below.

Note Calls attention to information.

IMPORTANT Indicates information that is necessary for proper instrument operation or for 
effective chemistry.

CAUTION Indicates that damage to the instrument could result if you do not comply 
with this information.

! WARNING ! Indicates that physical injury to the user or other persons could result 
if these precautions are not implemented.

User Bulletins

What are
User Bulletins

User Bulletins are the mechanism we use to inform our customers of technical 
information, products improvements, and new products that are related to the 
operation of the ABI PRISM 377 DNA Sequencer and related laboratory techniques. 
Examples of topics covered in user bulletins include:

� New versions of ABI PRISM® 377 Data Collection Software

� Improved and new accessories for the instrument

� New gel formulations and protocols

User bulletins related to the use of this instrument will be mailed to you. We 
recommend storing the bulletins in this manual. A tab labeled “User Bulletins” has 
been included for this purpose.
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Technical Support

Contacting Technical
Support

You can contact Applied Biosystems for technical support by telephone or fax, by 
e-mail, or through the Internet. You can order Applied Biosystems user documents, 
MSDSs, certificates of analysis, and other related documents 24 hours a day. In 
addition, you can download documents in PDF format from the Applied Biosystems 
Web site (please see the section “To Obtain Documents on Demand” following the 
telephone information below).

To Contact Technical
Support by E-Mail

Contact technical support by e-mail for help in the following product areas:

Hours for Telephone
Technical Support

In the United States and Canada, technical support is available at the following times:

To Contact Technical
Support by

Telephone or Fax

In North America

To contact Applied Biosystems Technical Support, use the telephone or fax numbers 
given below. (To open a service call for other support needs, or in case of an 
emergency, dial 1-800-831-6844 and press 1.)

Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems and PCR pcrlab@appliedbiosystems.com

Protein Sequencing, 
Peptide and DNA Synthesis

corelab@appliedbiosystems.com

Biochromatography, PerSeptive DNA, PNA 
and Peptide Synthesis systems, CytoFluor®, 
FMAT™, Voyager™, and Mariner™ Mass 
Spectrometers

tsupport@appliedbiosystems.com

Applied Biosystems/MDS Sciex api3-support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com

Product Hours

Chemiluminescence 8:30 a.m. to 5:30 p.m. Eastern Time

Framingham support 8:00 a.m. to 6:00 p.m. Eastern Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time

Product or
Product Area

Telephone
Dial...

Fax
Dial...

ABI PRISM® 3700 DNA Analyzer 1-800-831-6844,
then press 8

1-650-638-5981

DNA Synthesis 1-800-831-6844,
then press 21

1-650-638-5981

Fluorescent DNA Sequencing 1-800-831-6844,
then press 22

1-650-638-5981

Fluorescent Fragment Analysis (includes 
GeneScan® applications)

1-800-831-6844,
then press 23

1-650-638-5981

Integrated Thermal Cyclers (ABI PRISM® 

877 and Catalyst 800 instruments)
1-800-831-6844,
then press 24

1-650-638-5981
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ABI PRISM® 3100 Genetic Analyzer 1-800-831-6844,
then press 26

1-650-638-5981

BioInformatics (includes BioLIMS™, 
BioMerge™, and SQL GT™ 
applications)

1-800-831-6844,
then press 25

1-505-982-7690

Peptide Synthesis (433 and 43X 
Systems)

1-800-831-6844,
then press 31

1-650-638-5981

Protein Sequencing (Procise Protein 
Sequencing Systems)

1-800-831-6844,
then press 32

1-650-638-5981

PCR and Sequence Detection 1-800-762-4001,
then press 1 for PCR,
2 for the 7700 or 5700,
6 for the 6700
or dial 1-800-831-6844, 
then press 5

1-240-453-4613

Voyager MALDI-TOF Biospectrometry 
and Mariner ESI-TOF Mass 
Spectrometry Workstations

1-800-899-5858,
then press 13

1-508-383-7855

Biochromatography (BioCAD 
Workstations and Poros Perfusion 
Chromatography Products)

1-800-899-5858,
then press 14

1-508-383-7855

Expedite Nucleic acid Synthesis 
Systems

1-800-899-5858,
then press 15

1-508-383-7855

Peptide Synthesis (Pioneer and 9050 
Plus Peptide Synthesizers)

1-800-899-5858,
then press 15

1-508-383-7855

PNA Custom and Synthesis 1-800-899-5858,
then press 15

1-508-383-7855

FMAT 8100 HTS System and 
Cytofluor 4000 Fluorescence Plate 
Reader

1-800-899-5858,
then press 16

1-508-383-7855

Chemiluminescence (Tropix) 1-800-542-2369 (U.S. 
only),
or 1-781-271-0045

1-781-275-8581

Applied Biosystems/MDS Sciex 1-800-952-4716 1-650-638-6223

Product or
Product Area

Telephone
Dial...

Fax
Dial...
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Outside North America

Region
Telephone
Dial...

Fax
Dial...

Africa and the Middle East

Africa (English Speaking) and West Asia 
(Fairlands, South Africa)

27 11 478 0411 27 11 478 0349

South Africa (Johannesburg) 27 11 478 0411 27 11 478 0349

Middle Eastern Countries and North 
Africa (Monza, Italia)

39 (0)39 8389 481 39 (0)39 8389 493

Eastern Asia, China, Oceania

Australia (Scoresby, Victoria) 61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 758 8268 60 3 754 9043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 22358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 11

Belgium 32 (0)2 712 5555 32 (0)2 712 5516

Czech Republic and Slovakia (Praha) 420 2 61 222 164 420 2 61 222 168

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0) 6150 101 0 49 (0) 6150 101 101

Hungary (Budapest) 36 (0)1 270 8398 36 (0)1 270 8288

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Poland, Lithuania, Latvia, and Estonia 
(Warszawa)

48 (22) 866 40 10 48 (22) 866 40 20

Portugal (Lisboa) 351 (0)22 605 33 14 351 (0)22 605 33 15

Russia (Moskva) 7 095 935 8888 7 095 564 8787

South East Europe (Zagreb, Croatia) 385 1 34 91 927 385 1 34 91 840

Spain (Tres Cantos) 34 (0)91 806 1210 34 (0)91 806 1206

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands (Nieuwerkerk a/d 
IJssel)

31 (0)180 331400 31 (0)180 331409

United Kingdom (Warrington, Cheshire) 44 (0)1925 825650 44 (0)1925 282502

All other countries not listed
(Warrington, UK)

44 (0)1925 282481 44 (0)1925 282509
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To Reach Technical
Support Through

the Internet

We strongly encourage you to visit our Web site for answers to frequently asked 
questions and for more information about our products. You can also order technical 
documents or an index of available documents and have them faxed or e-mailed to 
you through our site. The Applied Biosystems Web site address is

http://www.appliedbiosystems.com/techsupp

To Obtain
Documents on

Demand

Free, 24-hour access to Applied Biosystems technical documents, including MSDSs, 
is available by fax or e-mail or by download from our Web site.

Japan

Japan (Hacchobori, Chuo-Ku, Tokyo) 81 3 5566 6230 81 3 5566 6507

Latin America

Del.A. Obregon, Mexico 305-670-4350 305-670-4349

Region
Telephone
Dial...

Fax
Dial...

To submit technical questions from North America or Europe:

Step Action

1 Access the Applied Biosystems Technical Support Web site.

2 Under the Troubleshooting heading, click Support Request Forms, then select the 
relevant support region for the product area of interest.

3 Enter the requested information and your question in the displayed form, then click 
Ask Us RIGHT NOW (blue button with yellow text).

4 Enter the required information in the next form (if you have not already done so), 
then click Ask Us RIGHT NOW.

You will receive an e-mail reply to your question from one of our technical experts 
within 24 to 48 hours.

To order 
documents... Then...

by index number a. Access the Applied Biosystems Technical Support Web site at 
http://www.appliedbiosystems.com/techsupp

b. Click the Index link for the document type you want, then find the 
document you want and record the index number.

c. Use the index number when requesting documents following the 
procedures below.

by phone for fax 
delivery

a. From the U.S. or Canada, call 1-800-487-6809, or
from outside the U.S. and Canada, call 1-858-712-0317.

b. Follow the voice instructions to order the documents you want.

Note There is a limit of five documents per request.
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through the 
Internet for fax 
or e-mail 
delivery

a. Access the Applied Biosystems Technical Support Web site at 
http://www.appliedbiosystems.com/techsupp

b. Under Resource Libraries, click the type of document you want.

c. Enter or select the requested information in the displayed form, then 
click Search.

d. In the displayed search results, select a check box for the method of 
delivery for each document that matches your criteria, then click 
Deliver Selected Documents Now (or click the PDF icon for the 
document to download it immediately).

e. Fill in the information form (if you have not previously done so), then 
click Deliver Selected Documents Now to submit your order.

Note There is a limit of five documents per request for fax delivery but 
no limit on the number of documents you can order for e-mail delivery.

To order 
documents... Then...
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ABI PRISM 377 DNA Sequencer—System Components

Hardware The ABI PRISM 377 DNA Sequencer consists of two main components: 

� The ABI PRISM 377 DNA Sequencer (the instrument) 

� A Macintosh computer

A printer is available as optional equipment. The components are connected by an 
asynchronous RS-232C serial data line.

Software The ABI PRISM 377 DNA Sequencing System is shipped with the following software:

� ABI PRISM Data Collection Software

� Data analysis software—one or both of the following:

– ABI PRISM® GeneScan® Analysis Software

– ABI PRISM® DNA Sequencing Analysis Software

The type of data analysis software shipped with the instrument is determined 
when the system is ordered.

� Symantec AntiVirus for Macintosh (SAM™)

� The Norton Utilities™

The software is installed onto the computer during system installation.

IMPORTANT Complete and return any registration cards included with the software to 
ensure you receive notification of future updates.

Models Available Four models of the ABI PRISM 377 DNA Sequencer are available. The hardware for 
each model is identical. The data collection software and firmware are different.

ABI PRISM 377 DNA Sequencer

The standard ABI PRISM 377 instrument is designed to accommodate three sizes of 
gel plates—12 and 36 cm for GeneScan applications, and 36 and 48 cm for 
sequencing applications. Combs available are 18, 24, 32, 36, and 48-well shark’s 
tooth, and 24, 32, and 36-well square tooth. Data is collected from 194 channels 
during each scan.

ABI PRISM 377-18 DNA Sequencer

The ABI PRISM 377-18 DNA Sequencer is the lowest cost, lowest-throughput version 
of the instrument. It can run up to 18 lanes on a single gel.

ABI PRISM 377 DNA Sequencer with XL Upgrade

The ABI PRISM 377 DNA Sequencer with XL Upgrade increases the number of 
samples that can be analyzed simultaneously. Increased throughput is made possible 
by modifying the instrument to collect data from 388 channels instead of 194 during 
each scan.
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The XL Upgrade can accommodate the following combs: 48- and 64-well shark’ s 
tooth combs for sequencing applications; 48-, 50-, 64-, and 66-well for GeneScan 
applications. You can still use 36-well or other lower lane density combs if desired. 
Refer to the ABI PRISM® 377 DNA Sequencer XL Upgrade User’s Manual 
(P/N 904412) for more information.

ABI PRISM 377 DNA Sequencer with 96-Lane Upgrade

The ABI PRISM 377 DNA Sequencer with 96-lane Upgrade increases the number of 
samples that can be run on each gel. Increased throughput is made possible by 
re-engineering the instrument to collect data from 480 channels instead of 388 for the 
ABI PRISM 377 DNA Sequencer with XL Upgrade or 194 for the ABI PRISM 377 DNA 
Sequencer. In addition, the scan region has been increased from 6 inches to 
7.25 inches.

The 96-lane upgrade includes a 100-well shark’s tooth comb, and a new front glass 
plate. The new front glass plate has a bevel where samples are loaded. The bevel 
increases the thickness of the gel from 0.2 mm to 0.4 mm in this region. Lower lane 
density combs can still be used, but only with the original front glass plates provided 
with the standard ABI PRISM 377 instrument.

Refer to the ABI PRISM® 377 DNA Sequencer 96-Lane Upgrade User’s Manual 
(P/N 4305423) for more information.
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Theory of Operation

How the Instrument
Works

The ABI PRISM 377 DNA Sequencer is an automated instrument designed for 
analyzing fluorescently-labeled DNA fragments by gel electrophoresis. Gel 
electrophoresis is the movement of charged molecules through a gel solution (such as 
polyacrylamide) in an electrical field. It is used to separate DNA fragments by size.

The instrument functions the same way for both sequencing and GeneScan 
applications. The main differences between these applications is in the preparatory 
chemistries used, and the type of analysis performed on the resulting data.

To use the instrument, DNA fragments labeled with up to four different fluorescent 
dyes are combined and loaded into one lane on a vertical slab gel made of 
polymerized acrylamide or acrylamide derivatives. You can load up to 96 lanes on one 
gel depending on the model instrument you have. The instrument is designed to 
accommodate different size gel plates so that the distance the sample migrates before 
detection can be varied. This feature permits run times and sample resolution to be 
optimized according to the type of analysis, either base calling (DNA sequencing), 
molecular sizing in base pairs, or molecular quantitation.

Once the samples are loaded, voltage is applied, causing the fragments to 
electrophorese through the gel and separate according to size. At the lower portion of 
the gel above the lower buffer chamber, the fragments pass through an area called the 
“read region” (see page 1-15), where a laser beam continuously scans across the gel.

The laser excites the fluorescent dyes attached to the fragments, and they emit light at 
a specific wavelength for each dye. The light is collected in 194, 388, or 480 channels 
(the 377, 377XL, or 377-96 respectively) during each scan. It is then separated 
according to wavelength by a spectrograph onto a cooled, charge coupled device 
(CCD) camera, so all four types of fluorescent emissions can be detected with one 
pass of the laser.

The data collection software collects the light intensities from the CCD at particular 
wavelength bands (software-selectable virtual filters) and stores them on the 
Macintosh as digital signals for processing. The collected data before it is analyzed is 
often referred to as raw data. The file in which the raw data is stored is referred to as a 
gel file. The raw data of the gel is a matrix of information from the number of channels 
across the gel (194, 388, or 480) in four colors, multiplied by the number of scans 
collected. The gel file contains an image of the data for display and the raw scan data. 
Gel files range in size from 20 MB to 40MB.

At the end of data collection, the analysis software (ABI PRISM DNA Sequencing 
Analysis or ABI PRISM GeneScan Analysis software) is used to manually or 
automatically process, analyze, and translate the collected data into either base 
sequence, fragment sizing information, or relative concentrations.
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Using the Instrument

Overview The process of setting up the instrument, loading samples onto the gel, and 
electrophoresing the samples is commonly referred to as performing a run. An 
overview of the steps involved in performing a typical run are listed in the table below. 
Step-by-step instructions are listed in Chapter 3, “Instrument Operation.”

The term run is also used when referring to a run module (described below and in 
Chapter 9), and to step 5 of the process listed above. A description of the plate check, 
prerun, and run are provided on pages 1-15 through 1-17. Configuring the software is 
described below.

The Data Collection
Software

ABI PRISM Data Collection Software is the interface between the instrument and the 
computer. It performs the following functions:

� Controls the instrument by sending it commands that are contained in files called 
modules.

� Collects raw data from the instrument and stores it in a gel file (Figure 1-1 on 
page 1-17; described on page 1-13)

� Transfers data automatically to either the sequencing or GeneScan analysis 
software for automatic data analysis at the end of a run (software must be 
configured for this to occur)

Modules contain the various settings (electrophoresis voltage, gel temperature, etc.) 
required for instrument operation. Two sets of modules are included:

� Standard modules—provide gel temperature control from 10°C above ambient to 
a maximum of 60°C

� Chiller modules—used when an external cold water bath is attached to the 
instrument, and temperatures below 10°C above ambient are required

There are three types of standard and chiller modules: plate check, prerun, and run. 
Prerun and run modules are specific for either sequencing or GeneScan applications.

Configuring the software for a run means setting up a sample sheet and a run sheet. 
There are two types of sample and run sheets: one for sequencing and one for 
GeneScan applications. A sample sheet is a file that contains information used for 
sample identification, sample tracking, and data analysis.

A run sheet is a file that contains the sample identification, tracking, and data analysis 
information from the sample sheet; the gel comb configuration and other pertinent 
information used to direct instrument operation during a run (i.e. a plate check, prerun, 
and run module), and to analyze data automatically after the run. The data collection 
software is described in detail in Chapter 9, “Data Collection Software.”

Step Action

1 Set up the instrument.

2 Perform a plate check. 

3 Configure the data collection software.

4 Perform a prerun and load the samples.

5 Start the run.
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The Plate Check The purpose of the plate check is to ensure that the glass plates and gel are clean and 
free of fluorescent contaminants before the samples are loaded. During a plate check, 
the read region of the plates is scanned without electrophoresis. The read region is 
the area of the glass scanned by the laser. It is approximately 2.5 to 4.5 cm from the 
bottom of the glass. It is 6 inches wide for standard and XL instruments, 7 inches wide 
for 96-lane instruments, and 3 inches wide for the ABI PRISM 377-18 instrument.

The number of channels in the read region are:

� 194 for the standard ABI PRISM 377 and 377-18 instruments (numbered 0 to 193)

� 388 for ABI PRISM 377 XL instruments (numbered 0 to 387)

� 480 for ABI PRISM 377 96-lane instrument (numbered 0 to 479)

The type of comb used determines the number of channels a lane will include. For 
example, one lane of a 36-well comb is equivalent to approximately 5 channels.

To perform a plate check, you open a new run sheet, select a plate check module, and 
click the Plate Check button on the run sheet. A Scan window opens automatically, 
and you observe the window for approximately 2 minutes.

Relatively flat scan lines as shown in the figure above indicate the plates are clean 
and there are no contaminants in the read region of the gel. If peaks appear, either the 
plates are dirty or the gel is contaminated. The plates can be cleaned and the plate 
check repeated. If peaks still appear, the gel is probably contaminated. 

4.5 cm 
2.5 cm

Top of glass plates

Read region
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If the gel is contaminated, you can:

� Load a new gel.

� Determine which lanes are safe to load with samples, and which lanes should be 
left empty. This is referred to as skipping lanes.

� Terminate the plate check, fill the buffer chambers, start the prerun, and allow the 
gel to electrophorese for a few minutes while watching the Scan window. 
Sometimes contaminants will migrate out of the read region.

Instructions for performing a plate check and determining which lanes to skip are 
listed in Chapter 3, “Instrument Operation.” The scan window and the run sheet are 
described in more detail in Chapter 3, “Instrument Operation,” and in Chapter 9, “Data 
Collection Software.”

The PreRun A prerun is typically performed after the plate check, and prior to starting the run. The 
purpose of the prerun is to:

� Equilibrate the gel temperature before samples are loaded

� Allow the operator to ensure the system is working properly

During a prerun the pump, heating system, and scanner are activated. Prerunning the 
gel is particularly important when performing a high speed (2400 scans/hour) run. The 
gel must be at run temperature (the temperature at which the samples will be 
electrophoresed) when the samples are loaded to ensure appropriate denaturation 
conditions exist. Prerunning also removes mobile ions from the gel, and prevents 
extrusion (gel oozing from between the plates) from occurring when the run begins 
and a higher voltage is applied.

To perform a prerun, the gel and all other necessary parts must be installed inside the 
instrument, and a prerun module must be selected on the run sheet. You start the 
prerun by clicking the PreRun button on the run sheet.

During the prerun, you open the Status window (shown below) to monitor instrument 
conditions including the gel temperature. Run temperature is typically reached after 
15–25 minutes, even though the default duration of the prerun module may be longer.

Total duration of 
the module

Indicates the amount of time left 
for the specified module to run
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Once the gel reaches run temperature, the prerun is typically paused—not 
cancelled—and the samples are loaded. When paused, the pump and heater remain 
on, and the gel temperature designated by the module is maintained. Once the 
samples are loaded, the prerun is cancelled and the run is started.

Instructions for performing a prerun are listed in Chapter 3, “Instrument Operation.” 
The status window and the run sheet are described in more detail in Chapter 3, 
“Instrument Operation,” and in Chapter 9, “Data Collection Software.”

The Run The run is typically performed after the plate check and prerun. During the run, 
samples are electrophoresed and data is collected. 

To perform a run, the run sheet must be completed (i.e. the run module, sample sheet, 
number of lanes, well-to-read distance, etc. must be specified.) You start the run by 
cancelling the prerun, and then clicking the Run button on the run sheet.

Once the Run button is clicked, electrophoresis and data collection begin. The raw 
data is stored in a gel file along with sample information from the run sheet (imported 
from the sample sheet).

Figure 1-1 Gel file

Four different windows are available for viewing the data being collected and 
instrument status in real-time. The Scan and Gel windows are for viewing data. The 
Status window displays the current status of the instrument. The Electrophoresis 
History window displays the actual values for the electrophoresis power supply and 
gel temperature throughout the course of a run.

When the run is finished, data is analyzed either automatically or manually. Automatic 
data analysis must be specified on the run sheet prior to starting the run.

For more detailed information and instructions, see Chapter 3, “Instrument Operation,” 
and Chapter 9, “Data Collection Software.”
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Data Analysis

Overview Once the run is finished, the collected data is transferred automatically (if specified on 
the run sheet) or manually to either the ABI PRISM DNA Sequencing Analysis 
Software or the ABI PRISM GeneScan Analysis Software for analysis. 
Electropherograms can be printed on a color printer. You can display the raw and 
analyzed data on the computer screen, or edit and print it at any time. Both types of 
analysis software are briefly described below.

ABI PRISM

GeneScan Analysis
Software

GeneScan Analysis Software automatically analyzes data collected from each 
sample. This software allows you to:

� Create custom analysis parameters, or use the default analysis settings. 

� Size and quantitate PCR and other DNA fragments.

� Automatically identify all DNA bands, compare the mobility of each band to that of 
an internal lane standard, and size the bands based on the sizing curve of the 
internal lane standards.

� Interactively confirm and fine-tune data analysis.

� Display the results of an experiment as an electropherogram, reconstructed gel 
image, tabular data, or a combination of electropherograms and tabular data.

� Adjust the dye intensity of each sample individually or collectively.

� Customize colors to more easily view large quantities of data.

� Organize analyzed data in a variety of ways to fit the needs of your individual 
projects. For example, every project file can contain sample data from one or 
more runs.

Refer to the ABI PRISM GeneScan® Analysis Software User’s Manual for more 
detailed information.
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ABI PRISM DNA
Sequencing Analysis

Software

Sequencing Analysis Software analyzes the raw data collected from each sample. 
This software:

� Tracks gel files

� Extracts sample information from gel files 

� Performs multicomponent analysis

� Applies mobility corrections

� Normalizes base spacing

� Baselines data

� Determines analysis starting points

� Calls bases

� Includes the following two utilities:

– GelDoc—removes tracking data from a gel file, repairs file resources, and 
removes and restores the image from a gel file

– DataUtility—makes or copies matrices for instrument files

You can reanalyze and edit the sequence data. Also, data files are in formats that you 
can use with commercially available or user-generated programs on the Macintosh or 
on other compatible computers.

Refer to the ABI PRISM DNA Sequencing Analysis Software User’s Manual for specific 
information about the Sequencing Analysis software.
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Additional ABI PRISM Software

Genotyper
Fragment Analysis

Software

Genotyper® software analyzes the data generated by GeneScan Analysis Software. It 
enables you to analyze and interpret nucleic acid fragment size and quantitation data 
by converting it to user-defined results specific to your genotyping studies. For 
example, Genotyper can convert GeneScan fragment data to called alleles.

Genotyper results can be transferred to databases for storage, spreadsheets for 
statistical analysis, or linkage analysis software.

GenoPedigree GenoPedigree™ software is an interactive pedigree diagram editor that reads and 
writes its own documents containing pedigree, layout, and style information. 
GenoPedigree can also generate files for linkage analysis.

GenBase GenBase™ software is a database application that stores data for genotypes, 
pedigrees, markers, traits (diseases), and other relevant information. You can import 
data from or export data to GenBase from Genotyper and GenoPedigree.

Primer Express Primer Express™ software allows you to design, analyze, and order oligonucleotides. 
The process is simple: import or drag sequences into the application, then select 
primers using the Automatic Find mode, default settings, or custom parameters 
settings. The software performs the appropriate calculations, and automatically 
updates all relevant views.

You can select target amplicon sequences, automatically translate DNA sequences to 
amino acids, exclude DNA sequences from an amplicon, label exon-intron junctions, 
and annotate important sequence sites.

The software has specific, ready-to-use templates for many PCR and sequencing 
applications: 

� TaqMan® probe and primer design

� Standard, nested, allele-specific, multiplex, and RT PCR

� Sequencing

� Cycle sequencing

� Batch processing of multiple DNA documents

� Primer test

Two choices are available for viewing DNA sequences: text or map format. The Map 
page shows a graphical representation of the sequence and allows viewing of all 
primers found in relation to template DNA. All sequence annotations are shown, 
including restriction endonuclease sites, exon-intron junction sites, and amino acid 
translations.

Primer information (primer pairs when applicable) is displayed in a primer table page. 
The table displays all relevant information according to your preference. You decide 
how the information display is sorted.

Primer Express software is fully compatible with our AutoAssembler and Sequence 
Navigator software.
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The GeneAssist
Sequence Analysis

System

GeneAssist® is a multi-user system used to edit, assemble, and analyze DNA and 
protein sequence data. The GeneAssist programs are designed to run on the 
Macintosh platform either independently or interactively with a UNIX server. They 
provide a robust set of tools for sequence analysis, and allow you to access and store 
data in a common file format.

GeneAssist has three Macintosh programs:

� Factura™ cleans up sequence data for analysis and alignment. It identifies 
specified vector and ambiguity ranges, restriction sites, and a specified 
confidence range. It also identifies multiple base positions with codes described 
by the International Union of Biochemists (IUB codes), based on a user-defined 
threshold. The program processes sequences in batches, speeding the process 
considerably.

� AutoAssembler™ allows you to quickly and efficiently assemble small pieces of 
DNA into larger segments of DNA, using ABI Prism 377 data as well as other 
types of data. It provides powerful tools for editing the sequences, including the 
ability to display constantly-spaced electropherograms that are synchronized with 
the assembled sequences. You can build a consensus from the assembled 
sequences and export it for use with other programs.

� GeneAssist Analysis allows you to analyze data from ABI Prism 377 sequence 
files, files processed in AutoAssembler, text files, or a database. You can use this 
program to rapidly search biological databases for specific sequences or motifs, 
and to interactively work with the resulting sequence lists. In addition to sequence 
lists the program can create dot plots, alignments, and restriction maps of 
sequence data.

AutoAssembler
Sequence Assembly

Software

AutoAssembler™ simplifies sequence assembly by automating each step of the 
process from vector deactivation, sequence “cleanup”, and assembly, to easy 
resolution of sequence ambiguities. It is designed for use on small to medium size 
sequencing projects.

AutoAssembler automatically examines all possible relationships between sequences 
in both orientations. Dynamic programming is used to determine the optimum 
sequence order, resulting in a precise consensus sequence.

Multiple projects are efficiently managed and easily updated. Convenient sequence 
and project reports monitor sequence quality and project progress. In addition, data 
integrity is always maintained because AutoAssembler allows you to go back and 
review all stages of your project at any time. No data is ever lost, and original 
sequence information is always preserved. Deactivated vector and ambiguity 
sequence regions, as well as edited base calls, can be viewed or reactivated as 
original primary base sequences. Moreover, unlike other software programs, this 
information is preserved within the original sequencer data files, making data 
management easier and more reliable.

Results can be graphically viewed and quickly interchanged as project layouts; bar 
and sequence alignments; and aligned, multiple, four-color electropherograms, 
allowing you to analyze your data from several different perspectives. The statistics 
view helps you quickly identify ambiguous sequence regions. Electropherograms, 
features tables, sequence annotations, and edited and primary sequence data are 
accessible and easily edited directly from within any part of the program and for any 
sequence.
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AutoAssembler can be upgraded to client-server based INHERIT® AutoAssembler for 
large scale sequencing projects. With INHERIT, any number of Macintosh clients are 
networked with a SUN Microsystems® server and FDF® Data Search System to 
provide shared-use efficiency and faster performance. The user-interface for INHERIT 
AutoAssembler and AutoAssembler are identical.

Sequence Navigator Sequence Navigator® is a two-part software package designed for automated DNA 
and protein sequence comparisons. It accurately aligns sequences to a standard or a 
population, and identifies sequence variants. To accomplish this, Sequence Navigator 
integrates with data collected on the ABI PRISM 377 DNA Sequencer, as well as text 
files from other sources.

Sequence Navigator comes standard with two powerful software modules: Factura 
and Sequence Navigator. Factura automatically identifies critical patterns as it sorts 
through and deactivates needless data. Factura’s automated batch processing for 
feature identification saves you time by recognizing features such as the vector, 
primer, and heterozygote/IUB base positions.

Once sequence files have been processed in Factura and a batch work sheet created, 
the work sheet is imported to Sequence Navigator. With Sequence Navigator you can 
perform basic sequence editing, use pair-wise alignments to assemble contigs, select 
multiple alignment to identify sequence variants, and display the electropherograms 
collected by the ABI PRISM 377 DNA Sequencer.

ABI PRISM BioLIMS
Software System

ABI PRISM BioLIMS® software was designed by Applied Biosystems in collaboration 
with Molecular Informatics, a key player in the development of the Genome Sequence 
Database—the world’s most widely used relational database for genetic sequence 
information. It is the first commercially available system for automated genetic 
information management and an excellent foundation on which to build your current 
and future bioinformatics capabilities.

Using BioLIMS software, you can automate DNA sequencing from data acquisition to 
assembled contig. Data flows automatically from your ABI PRISM 377 DNA Sequencer 
into the ABI PRISM BioLIMS relational database, and on to downstream analysis 
packages.

To simplify project tracking and automation, all sequences are stored by project name. 
Using UNIX and AppleScript® to control the process, sequence information flows 
seamlessly from your instruments to the database and into the analysis packages.

ABI PRISM GeneScan Analysis Software (BioLIMS version 2.0 and up only), 
ABI PRISM Sequencing Analysis Software, Factura, and AutoAssembler programs all 
read and write to the database. Just specify the sequences you want to analyze and 
the applications you want to use. 

The ABI PRISM BioLIMS software system simplifies data retrieval, analysis, and 
reporting. It maintains data integrity by eliminating multiple copies of the same data, 
and it helps improve reporting efficiency by allowing you to quickly organize and locate 
critical information.

However you choose to configure and implement this software system, the integrity of 
your data is ensured. One copy of the original sequence data is preserved at all times, 
so the original data is never lost or written-over, not matter how often the data is 
analyzed and edited. For further protection, data backup and archiving utilities are 
built-in.
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The ABI PRISM BioLIMS system streamlines data retrieval and reporting by allowing 
you to locate specific sets of information. Database queries can be performed using 
various data file attributes, including project name, sequence name, instrument, date, 
and operator. Your query results can be saved and printed for documentation and 
reference.

The power of this centralized database gives local and remote users immediate 
access to their data. Whether you’re in a different lab or working in your home, you can 
use ABI PRISM BioLIMS query tools to quickly retrieve the information you need.
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Chapter Contents

In this Chapter The following topics are discussed in this chapter:

Related Information in Appendix A—Gel Recipes

Topics in
Appendix A

The following related topics and information are located in Appendix A, “Gel Recipes”:

Topics See page

Selecting a Gel Formulation 2-2

Importance of Using High Quality Gels 2-3

About the Gel Pouring Methods in This Chapter 2-4

Before Using New Glass Plates 2-5

Cleaning Glass Plates, Spacers, and Combs 2-6

Method 1—Part 1—Mounting Glass Plates into the Gel Cassette 2-10

Method 1—Part 2—Attaching the Gel Injection Device 2-14

Method 1—Part 3—Pouring the Gel Using Mounted Plates 2-18

Method 2—Pouring the Gel Using Unmounted Plates 2-20

Topics

Gel recipes and recommendations for ABI PRISM® DNA Sequencing and GeneScan® 

analysis software applications

How to store reagents and stock solutions

Factors that affect sequencing read lengths

Factors that affect gel quality including:

� Purity of reagents 

� Rate of polymerization

� Air bubbles

� Age of the gel
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Selecting a Gel Formulation

Gel Recipes and
Protocols

Protocols for preparing the following gel solutions are located in Appendix A, 
“Gel Recipes.”

� 19:1 polyacrylamide (any percent) 

� 29:1 polyacrylamide (4.25% and 4.5%)

� Long Ranger® (4.75% and 5.0%)

� PAGE-PLUS (4.8% and 5.25%)

� Mutation detection (MDE) gel for single-strand conformation polymorphism 
(SSCP)

For Sequencing
Runs

A variety of gels can be used for sequencing runs on the ABI PRISM® 377 DNA 
Sequencer. Because conditions vary from lab-to-lab, one gel formulation may work 
better than another. We recommend testing each formulation, and selecting the one 
that performs best.

19:1 polyacrylamide gels are frequently used for sequencing applications. The gel 
formulations that typically provide the longest read lengths are as follows:

For GeneScan Runs Gels used for GeneScan runs on this instrument are:

� 5.0% Long Ranger

� 4.25% 19:1 polyacrylamide

� Mutation detection (MDE) gel for single-strand conformation polymorphism 
(SSCP)

Plate Size and Run Speed  Gel Formulations
Expected Read 
Length in Bases

� 36-cm well-to-read 
(WTR) plates

� 1200 scans/hr

� 4.5% 29:1 polyacrylamide

� 5.0% Long Ranger (concentrate 
or Singel™ gel forms)

� 4.8% PAGE-PLUS

650–800

� 36-cm WTR plates

� 2400 scans/hr

� 4.5% 29:1 polyacrylamide 550–700

� 48-cm WTR plates

� 1200 scans/hr

� 4.25% 29:1 polyacrylamide

� 4.75% Long Ranger 
(concentrate or Singel™ gel 
forms)

� 5.25% PAGE-PLUS

750–900
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Importance of Using High Quality Gels

Why a High Quality
Gel is Important

One of the most critical variables that determines the success or failure of both 
sequencing and GeneScan runs is the gel. The use of consistently prepared, high 
quality gels helps ensure the best experimental results, and minimizes the time spent 
troubleshooting gel-related problems. Poor quality gels often cause problems that are 
mistaken for instrument problems.

For sequencing runs, the quality of the gel directly effects the number of bases that 
can be called.

For GeneScan runs, the quality of the gel effects the mobility of DNA fragments from 
run-to-run, reproducibility of sizing, signal strength, and resolution.

Factors that affect gel quality include:

� Purity and freshness of reagents

� Rate of polymerization

� Presence of air bubbles

� Age of the gel

A discussion of these factors is located in Appendix A, “Gel Recipes.”
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About the Gel Pouring Methods in This Chapter

Methods Presented
in This Chapter

Many methods and devices are available for pouring gels. The two methods presented 
in this chapter are:

� Method 1—Using Mounted Plates and the Gel Injection Device

� Method 2—Using Unmounted Plates

Method 1 Using Mounted Plates and the Gel Injection Device

In this method, the glass plates are mounted in the gel cassette. The gel injection 
device is attached to the plates, and the gel solution is injected between the plates 
using a syringe. Instructions for this method are present in three parts:

� “Method 1—Part 1—Mounting Glass Plates into the Gel Cassette” on page 2-10

� “Method 1—Part 2—Attaching the Gel Injection Device” on page 2-14

� “Method 1—Part 3—Pouring the Gel Using Mounted Plates” on page 2-18

The advantages of using this method are:

� The gel cassette:

– Eliminates the need for binder clips

– Ensures the proper amount of pressure is applied to the plates at the correct 
locations along the edges of the plates

� Gel preparation is more consistent

Method 2 Using Unmounted Plates

In this method, the glass plates are clamped together with binder clips, and the gel 
solution is manually injected between the plates. Instructions for this method are listed 
under “Method 2—Pouring the Gel Using Unmounted Plates” on page 2-20.

Summary of the
Gel Preparation

Procedure

A summary of the steps involved in preparing a gel are as follows:

Step Action

1 Clean the glass plates, spacers, and comb.

2 Mount the plates and spacers in the gel cassette and attach the gel injection device 
(method 1 only).

or

Assemble the plates and spacers using binder clips (method 2 only).

3 Prepare the gel solution.

4 Add the polymerizing reagents to the gel solution.

5 Pour the gel.

6 Insert the comb.

7 Wrap bottom of plates with plastic wrap.

8 Allow the gel to polymerize.
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Before Using New Glass Plates

The Gasket Mark The first time the front glass plate and the gasket of the upper buffer chamber make 
contact, an invisible, permanent, hydrophobic area is created on the surface of the 
glass. This hydrophobic area is referred to as the gasket mark. If subsequent gels are 
poured using the same plates with the gasket mark on the inside, the gel solution will 
not flow readily across this area of the plate. Therefore, always keep the same side of 
each plate facing out.

Gasket marks can be removed by cleaning the plates with an alcoholic KOH wash. 
See “Removing the Gasket Mark” on page 2-9.

Identifying the Front
and Back of a Plate

The sides of glass plates can be identified several different ways. Applied Biosystems 
glass plates are scored with the part number and well-to-read distance. You can orient 
plates so these identifiers always face out. In addition you can:

� Number the front and back plates as a set, and always use the same two plates 
together. The benefit of this method is that gel-related problems can more easily 
be tracked back to a particular set of plates. Use an engraving pen to mark the 
glass near the top of the outside of each plate. 

� Make a small scratch with an engraving pen, or place a small piece of waterproof 
tape near the top of the outside of each plate.

IMPORTANT Do not use a ballpoint pen or other liquid marker to identify plates. Mark 
plates near the top as shown below to ensure that the identifier is not near the read region 
(defined in Chapter 3) or seal area of the upper buffer chamber.

Refer to Chapter 3, “Instrument Operation,” for more information on the read region 
and upper buffer chamber.

Front plate Rear plate

Locate the identifier at
the top of each plate

Always face the side
with the identifier away
from the gel
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Cleaning Glass Plates, Spacers, and Combs

Why Clean Plates
are Important

Clean plates, spacers, and combs are critical for successful gel preparation and a 
successful run. Plates that are cleaned thoroughly and consistently will also help 
avoid the temporary loss of signal that can occur sporadically on this instrument. 

Our research indicates this loss of signal is due to contaminant molecules 
(surfactants, fatty acids, long chain polymers) attached to the surface of the plates. It 
manifests itself as a band of little or no signal across the entire width of the gel image. 
It usually occurs between 140 to 200 base pairs, and typically lasts the equivalent of 
20 to 40 base pairs. Following this band, signal strength usually returns to normal.

Glass plates can be cleaned manually or in a dishwasher. The use of a laboratory 
dishwasher with a hot (195°F/90°C) deionized water rinse cycle has been found to 
effectively remove suspect contaminants, thereby eliminating any temporary loss of 
signal.

Gasket marks can be removed by cleaning the plates with an alcoholic KOH wash. 
See “The Gasket Mark” on page 2-5, and “Removing the Gasket Mark” on page 2-9.

Using a Dishwasher We strongly recommend cleaning glass plates in a laboratory dishwasher with a hot 
(195°F/90°C) deionized water rinse cycle. Using a dishwasher helps ensure plates are 
cleaned effectively and consistently every time, and will also eliminate the sporadic, 
temporary loss of signal that can occur on this instrument (described above.) 
Deionized water is required for the rinse cycle only. Dishwasher recommendations are 
listed on page 2-8.

When using a dishwasher, we recommend you:

� Connect the dishwasher to a high-grade, deionized water source.

� Clean plates as soon as possible once the gel is removed.

� Rinse residual gel from plates before loading in the dishwasher.

� Initially use the longest deionized water rinse option on the dishwasher, followed 
by a drying cycle. After some experimentation, you may be able to reduce the 
rinse time.

� Do not use a detergent.

� Avoid excessive handling of dry plates with ungloved hands.

Cleaning by Hand Detergents

� Alconox—most major laboratory suppliers

� Multiterge—VWR Scientific Products, P/N 34171-010

! WARNING ! CHEMICAL HAZARD. Acrylamide and bisacrylamide are poisons, 
neurotoxins, irritants, carcinogens, and possible teratogens. Acrylamide and 
bisacrylamide sublime (the solids release toxic vapor) and are harmful if swallowed, 
inhaled, or absorbed through the skin. Effects are cumulative. When handling, always 
wear protective equipment (lab coat, safety glasses, and chemical-resistant gloves) and 
use in a well-ventilated area. On a routine basis, thoroughly clean surfaces subject to 
contamination.
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Procedure

If a dishwasher is not available, follow this procedure to manually clean glass plates.

Step Action

1 Put on a pair of gloves. If necessary, wash gloves to remove talc powder.

IMPORTANT Always wear gloves when handling glass plates to avoid skin 
contact with the gel, and to avoid contaminating clean glass plates.

2 If the plates … Then …

contain a gel a. Gently pry the plates apart starting at the bottom of 
the plates. Do not pry plates apart at the ears. Be 
careful not to chip the plates.

b. Remove the comb and spacers.

c. Remove the gel using one of these methods:

– Lay a large Kimwipe on the gel and roll it up.

– Wash the gel off the plate with water.

d. Properly dispose of the gel immediately.

do not contain a gel proceed to step 4.

3 Wash the glass plates with a very small amount of detergent (approximately 
0.10 gram) such as Alconox or Multiterge that is non-fluorescent and will not leave a 
residue.

IMPORTANT Do not soak plates in detergent. Use only a very small amount of 
detergent. Detergent residue can cause red or other fluorescent fronts to appear on 
the gel image.

4 Thoroughly rinse the plates with hot water.

5 Rinse the plates again with hot deionized water.

IMPORTANT This step is critical for the complete removal of contaminants 
such as surfactants, fatty acids, and long chain polymers. These contaminants can 
cause the temporary loss of signal during instrument operation. Because the 
optimum water temperature is 195°F/90°C, we recommend cleaning plates in a 
dishwasher to avoid injury.

6 Stand the plates up and allow them to air dry. Lean plates so the side that will 
contact the gel is angled downward. This will help keep dust and other airborne 
particles from settling on the inside surface of the plate.

Note If there is not enough time to let the plates air dry, you can dry them gently 
with lint-free towels such as Kimwipes. Do not use compressed air to blow plates 
dry. Never use an organic solvent to speed up the drying process. Compressed air 
propellants and organic solvents may leave fluorescent residues.

Ears
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Dishwasher
Recommendations

The following dishwashers and plate rack are recommended for cleaning glass plates.

Cleaning Spacers
and Combs

! WARNING ! CHEMICAL HAZARD. Acrylamide and bisacrylamide are poisons, 
neurotoxins, irritants, carcinogens, and possible teratogens. Acrylamide and 
bisacrylamide sublime (the solids release toxic vapor) and are harmful if swallowed, 
inhaled, or absorbed through the skin. Effects are cumulative. When handling, always 
wear protective equipment (lab coat, safety glasses, and chemical-resistant gloves) and 
use in a well-ventilated area. On a routine basis, thoroughly clean surfaces subject to 
contamination.

Two methods can be used to clean spacers and combs.

Method 1

Clean the spacers and combs with hot water. Then rinse them with hot deionized 
water, and allow them to air dry.

Method 2

If the spacers and combs are very dirty, clean them with a very small amount of 
Alconox. Then rinse them with hot water, followed by a hot deionized water rinse. 
Allow them to air dry.

IMPORTANT Do not soak combs in detergent or even water for a long period of time such 
as overnight. Soaking will break down the glue, and the comb will eventually come apart.

Item P/N Supplier(s)

Lancer 1600 Dishwasher with 
facility for drying

Lancer 1600 UP Lancer USA Inc.
705 West Highway 434
Longwood, Florida 32750
Telephone: 407-332-1855

Lancer UK Ltd
1 Pembroke Ave
Waterbeach, Cambridge
CB5 9QR
Telephone: 44-01223-861665
Fax: 44-01223-861990

Sequencing plate rack with a 
50 plate capacity for Lancer 
1600 dishwasher

SPR 16

Labconco Undercounter 
SteamScrubber 
Washer/Dryer

15-352-801 Fisher Scientific 
U.S. Headquarters
585 Alpha Drive
Pittsburgh, Pennsylvania 15238

Customer Service: 1-800-766-7000
Fax: 1-800-926-1166
Internet: http://www.fishersci.com
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Removing the
Gasket Mark

An alcoholic KOH wash can be used to remove buffer chamber gasket marks from the 
plates.

Preparation of all solutions should be carried out in a hood using safety glasses, gloves, 
and other appropriate protective clothing.

Step Action

1 Add 30–35 g of potassium hydroxide (KOH) or sodium hydroxide (NaOH) pellets to 
a plastic bottle.

! WARNING ! Potassium hydroxide is hygroscopic and caustic. It can 
cause severe burns and blindness if it comes in contact with the skin or eyes. 
Always work in a fume hood. Obtain a copy of the  from the manufacturer. 
Wear appropriate protective eyewear, clothing, and gloves.

2 Add 200 mL of absolute ethanol to the bottle.

! WARNING ! CHEMICAL HAZARD. Ethanol is a flammable chemical and 
is irritating to the skin, eyes, respiratory system. It can cause nerve and liver 
damage, CNS depression, nausea, vomiting, and headache. Always work in a 
fume hood. Obtain a copy of the MSDS from the manufacturer. Wear 
appropriate protective eyewear, clothing, and gloves.

3 Mix the solution well. It will take at least 15 minutes for most of the pellets to 
dissolve.

Note This recipe is for a saturated solution, so some pellets will remain. Store 
the solution with the bottle capped tightly. During storage, the color of the solution 
will turn dark red-brown. The solution can still be used, and is good for 1 year.

4 Place some uncolored absorbent towels or other covering in the hood to catch 
spills.

5 Place the gel plates on the towels with the inside surfaces facing up.

Note The plates should be nearly level so that the cleaning solution does not 
run off onto the bench. Only the inside (gel side) surface of the plates need be 
cleaned, though the outside surfaces can be cleaned similarly.

6 Pour approximately 15 mL of the cleaning solution onto the area of the plate where 
the gasket mark is.

7 Allow the solution to remain on the plates for 10 minutes.

CAUTION Longer times can harm the plates.

8 Repeat steps 2 and 3.

9 Rinse thoroughly with deionized water.

10 Clean plates as usual.
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Method 1—Part 1—Mounting Glass Plates into the Gel Cassette

Using Unmounted
Plates

Gels can be prepared using mounted or unmounted plates. The following procedure is 
for using mounted plates. Refer to “Method 2—Pouring the Gel Using Unmounted 
Plates” on page 2-20 if you wish to prepare the gel using unmounted plates.

Carrying a Cassette
with Plates

When carrying plates mounted in the gel cassette, always hold the cassette by the 
sides with both hands. Do not carry the cassette with plates by holding the top bar 
only. The weight of the plates may cause the bar to break, resulting in broken glass 
plates.

Materials Required � Comb, sharks- or square-tooth

� Gel cassette

� Glass plates, front and rear, one set

� Kimwipes

� Spacers, two 0.2-mm

� Water, distilled and deionized

Before Mounting
the Plates

Before mounting the glass plates into the gel cassette, verify that:

� A clean, level working area such as a bench top is available for mounting the 
plates and pouring the gel.

� The plates, spacers, and comb are clean and dry (cleaning procedure on 
page 2-6).

� The spacers are the same length as the glass plates. If the spacers are too long, 
the gel injection device may leak. Trim them to the proper size if necessary.

If the plates have never been used before, read “Before Using New Glass Plates” on 
page 2-5.

Do not hold cassette here 
to carry glass plates

Hold cassette by the 
sides with both hands 
to carry glass plates
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Procedure

To mount glass plates in the gel cassette: 

Step Action

1 Place the cassette on a level, clean surface.

2 Raise the laser beam safety bar, and turn all the clamps to the open position.

3 Check the inside surface of both plates for water droplets, dust, lint, or anything else 
that might fluoresce or scatter light. Clean the plates with a damp Kimwipe if 
necessary.

4 Place the rear plate in the cassette with the notched end oriented toward the bottom 
of the cassette.

IMPORTANT To avoid difficulty pouring the gel, always load the front and 
rear plates with the same side of the glass facing out. Refer to “Before Using 
New Glass Plates” on page 2-5 for more information.

5 Place the spacers on the rear plate as shown below (notched side facing the middle 
of the plate). Two to three droplets of water can be applied to the edge of the glass 
where the spacers will rest to keep them from moving.

IMPORTANT Align the outside edge of each spacer with the outside edge of 
the plate. Spacers must cover the notched areas of the plate.

Clamp in closed 
position

Clamp in open 
position

Laser beam safety 
bar raised 

Bottom of cassette
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6 Place the front plate on top of the rear plate and spacers so that the:

� Gasket mark faces up (hydrophobic area, described on page 2-5)

� Bottom of the plates are flush

� Large notch in top of plate is oriented toward the top of the cassette (see 
illustration in next step)

IMPORTANT To avoid difficulty pouring the gel, always load the front and rear 
plates with the same side of the glass facing out. Refer to “Before Using New Glass 
Plates” on page 2-5 for more information.

7 Keeping both plates together, push the plates to the bottom of the cassette until the 
notches of the rear plates are seated firmly against the metal plate stops in the 
cassette. Push the plates from the top to ensure firm contact.

8 Run the tip of your finger along the bottom of the plates to make sure they are flush.

IMPORTANT The bottom edges of the plates must be flush with each other. If 
the plates are even slightly misaligned, the gel injection device will leak.

To mount glass plates in the gel cassette: (continued)

Step Action

Bottom of plates must be flush

Metal plate stops

Bottoms of plates 
correctly aligned

Misalignment like this causes 
the gel injection device to leak
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9 Press on the center of the front plate with the fingertips of one hand to hold the 
plates in position. At the same time, lock the plates in place by turning all the 
cassette clamps to the closed position except the clamps that secure the top and 
bottom of the plates (shown below).

10 Run the tip of your finger along the bottom of the plates again to make sure they are 
still flush. If the plates shifted, unlock the clamps and adjust the plates.

Repeat this procedure until the plates are locked in position against the plate stops, 
and the bottoms of the plates are flush.

To mount glass plates in the gel cassette: (continued)

Step Action

These clamps are 
left open for 36-cm 

glass plates
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Method 1—Part 2—Attaching the Gel Injection Device

Materials Required The materials required for this procedure are as follows:

� Gel injection device—three pieces as illustrated below

– Gel injection fixture, clear

– Two braces that hold the comb in place (one clear and one black)

� Level, raised support (for example, two empty pipet tip boxes)

� Absorbent paper

Gel injection fixture

Clear brace

Black brace
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Attaching the Gel
Injection Device

If you are pouring gels using unmounted plates, proceed to “Method 2—Pouring the 
Gel Using Unmounted Plates” on page 2-20.

To attach the gel injection device: 

Step Action

1 Place the gel cassette with plates on a level, raised support. The support(s) should 
be under the cassette—not under the glass plates.

2 Attach the black brace as follows:

a. Hold the brace with the tabs pointing up. Move the tabs up through the gap 
between the side rails and top bar of the cassette as shown below, so the tabs 
rest on the rails.

b. Slide the brace along the rails and under the glass.

c. Firmly push the brace under the plates until the tabs press against the rear 
plate.

Tabs on black brace

Black brace in place 
with tabs firmly seated 
against rear plate

Side rail
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3 Attach the clear brace as follows:

a. Slide the pegs of the brace up against the cassette clamps at the top of the 
plates.

b. Fit the ears of the brace over the ears of the front glass plate.

IMPORTANT The brace must cover the ears of the front plate to prevent 
leakage and hold the comb in place.

4 Insert the flat edge of the comb between the plates as far as it will go.

5 Lock the clear brace in position by turning the appropriate two clamps.

6 Test the tightness of the comb between the plates by carefully pulling on the tips of 
the teeth. If either side or both sides of the comb can be pulled out from between 
the plates, tighten the screws on the underside of the black brace.

Note Testing the fit of the comb between the plates at this point in the procedure 
is more efficient than waiting until you are ready to pour the gel. You may not have 
enough time to make the appropriate adjustments if you perform this test after the 
polymerizing reagents are added to the gel solution.

7 IMPORTANT Keep the braces locked in place throughout the remainder of this 
procedure.

Check the luer fitting in the gel injection fixture. Finger-tighten the fitting if it is loose.

8 If the fixture is still wet from previous use, briefly blow air through the luer fitting to 
expel any trapped moisture. An empty syringe or compressed air can be used.

To attach the gel injection device: (continued)

Step Action

Ear

Peg of clear brace 
positioned against 
clamp before 
clamp is closed
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9 Attach the gel injection fixture as follows:

a. Hold the fixture underneath the plates at a 45° angle. 

b. Rotate the fixture up and onto the plates as shown below.

c. Close the cassette clamps to lock the fixture in place.

d. Simultaneously lock down both clamps on the fixture.

e. Verify that the tension springs lock the fixture firmly against the notches on the 
outside of the gel cassette (see exploded view below)

Verify that the edges of the plates are flush against the rubber gasket inside the 
fixture.

10 Place absorbent paper on the table at each end of the plates to catch any gel 
solution that spills during injection.

IMPORTANT Do not raise the cassette by placing objects such as blocks or 
pipet tip boxes under the plates. This can cause the gel to be thinner in middle.

To attach the gel injection device: (continued)

Step Action

Lock both clamps down 
simultaneously

No gap here 
indicates fixture is 
properly locked in 

Luer fitting
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Method 1—Part 3—Pouring the Gel Using Mounted Plates

Preparing the Gel
Solution

Prepare the gel solution now. See “Selecting a Gel Formulation” on page 2-2 for 
guidelines. Gel recipes are listed in Appendix A, “Gel Recipes.”

IMPORTANT The polymerizing reagents—ammonium persulfate and TEMED—are the 
catalysts that initiate polymerization. Once these reagents are added to the gel solution, you 
must work quickly to pour the gel. Polymerization can occur within 15 minutes.

Using Mounted
Plates and the Gel

Injection Device

At this point in the gel preparation procedure, the glass plates, spacers, and comb 
should be mounted in the gel cassette. The gel injection device should be attached to 
the plates. The entire assembly should be resting on a level, raised support.

! WARNING ! CHEMICAL HAZARD. Long Ranger gel solution contains acrylamide. 
Acrylamide is a neurotoxin. Avoid skin contact with Long Ranger gel solution because 
acrylamide can be absorbed through the skin. Always work in a fume hood. Obtain a 
copy of the MSDS from the manufacturer. Wear appropriate protective eyewear, clothing, 
and gloves.

! WARNING ! CHEMICAL HAZARD. Acrylamide and bisacrylamide are poisons, 
neurotoxins, irritants, carcinogens, and possible teratogens. Acrylamide and 
bisacrylamide sublime (the solids release toxic vapor) and are harmful if swallowed, 
inhaled, or absorbed through the skin. Effects are cumulative. When handling, always 
wear protective equipment (lab coat, safety glasses, and chemical-resistant gloves) and 
use in a well-ventilated area. On a routine basis, thoroughly clean surfaces subject to 
contamination.

To inject the gel solution: 

Step Action

1 Remove the clear brace and comb.

2 Draw at least 35 mL of gel solution into a 60-cc syringe, filling it slowly to avoid 
introducing air bubbles.

IMPORTANT Draw enough solution into the syringe to inject the entire gel 
without having to stop and draw more solution.

3 Check the tip of the syringe. The gel solution should be at the tip, and no air bubbles 
should be present. Adjust the solution and remove air bubbles if necessary.

4 Screw the tip of the syringe into the luer fitting. 

IMPORTANT Do not overtighten. Overtightening will strip the threads.
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5 Slowly and steadily inject the solution between the plates. At the same time, 
constantly tap the top plate directly in front of the gel path to eliminate air bubble 
formation. Injection takes approximately 60 seconds. Stop when the solution fills the 
space between the plates. Allow a small amount to pool in the well of the black 
brace.

CAUTION Tapping the plate with a tool such as a rubber mallet or reflex 
hammer can break the plates.

Note If you need to refill the syringe, be careful not to introduce air through the 
fitting. Keep excess solution in a beaker to verify polymerization.

6 Unscrew the syringe. Do not remove the luer fitting.

7 If using a … Then …

shark’s-tooth comb a. insert the straight edge of the comb to form one 
large well.

b. Verify no air bubbles are trapped where the gel 
and comb meet.

square-tooth comb a. insert the teeth of the comb.

b. Verify no air bubbles are trapped where the gel 
and comb meet.

8 Reinstall the clear brace and lock it in place.

9 Remove the gel injection fixture.

10 Close the bottom cassette clamps to secure the bottom of the plates.

11 Flush the gel injection fixture immediately with water to clean it. Clean the syringe in 
a similar manner if it is to be reused.

Note Allow the luer fitting to dry completely before using it again.

12 Cover the bottom of the plates with plastic wrap or damp paper towel to prevent the 
bottom of the gel from drying out.

13 Allow the gel to polymerize the amount of time recommended by the gel solution 
protocol.

To inject the gel solution: (continued)

Step Action
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Method 2—Pouring the Gel Using Unmounted Plates

Materials Required � Binder clips

– Eight medium size

– Three large size

� Comb

� Kimwipes

� Plastic wrap

� Raised, level platform (e.g. two empty pipet tip boxes)

� Glass plates, front and rear, one set

� Spacers, two 0.2 mm

� Syringe, 60-cc

Preparing the Gel
Solution

Prepare the gel solution now. See “Selecting a Gel Formulation” on page 2-2 for 
guidelines. Gel recipes are listed in Appendix A, “Gel Recipes.”

IMPORTANT The polymerizing reagents—ammonium persulfate and TEMED—are the 
catalysts that initiate polymerization. Once these reagents are added to the gel solution, you 
must work quickly to pour the gel. Polymerization can occur within 15 minutes. If desired, you 
can prepare the solution up to the point of adding the polymerizing reagents, then 1) prepare 
the work area and glass plates, 2) add the polymerizing reagents to the gel solution, and 
3) pour the gel.

Preparing the
Work Area and

Glass Plates To prepare the work area and glass plates: 

Step Action

1 Prepare a raised platform that is stable and level. For example, two empty pipet tip 
boxes work well.

2 Check the inside surface of both plates for water droplets, dust, lint, or anything else 
that might fluoresce or scatter light. Clean the plates with a damp Kimwipe if 
necessary.

3 Place the rear plate on the platform.

4 Place absorbent paper towels under the plate to catch spills or overflow.

5 Check the spacers and comb. If necessary, wipe them off with a damp Kimwipe.
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6 Place the spacers on the rear plate as shown below (notched side facing the middle 
of the plate). Two to three droplets of water can be applied to the edge of the glass 
where the spacers will rest to keep them from moving.

IMPORTANT Align the outside edge of each spacer with the outside edge of 
the plate. Spacers must cover the notched areas of the plate.

7 Place the front plate on top of the rear plate with the gasket mark facing up 
(hydrophobic area, described on page 2-5). Align the bottom of the plates so they 
are flush.

8 Attach four medium binder clips along the length of each side of the plates. Evenly 
space the clips, and clamp them so pressure is applied to the middle of the 
spacers. 

IMPORTANT To avoid uneven gel thickness, do not position binder clips any 
further onto the plates than the middle of the spacers.

9 Slightly raise the end of the glass plates with the large notch in the front plate. This 
will help the solution flow more easily to the bottom of the plates.

To prepare the work area and glass plates: (continued)

Step Action

Front
plate

Rear plate with spacers

Pressure from binder clip 
applied to middle of spacer
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Injecting the
Gel Solution

! WARNING ! CHEMICAL HAZARD. Long Ranger gel solution contains acrylamide. 
Acrylamide is a neurotoxin. Avoid skin contact with Long Ranger gel solution because 
acrylamide can be absorbed through the skin. Always work in a fume hood. Obtain a 
copy of the MSDS from the manufacturer. Wear appropriate protective eyewear, clothing, 
and gloves.

! WARNING ! CHEMICAL HAZARD. Acrylamide and bisacrylamide are poisons, 
neurotoxins, irritants, carcinogens, and possible teratogens. Acrylamide and 
bisacrylamide sublime (the solids release toxic vapor) and are harmful if swallowed, 
inhaled, or absorbed through the skin. Effects are cumulative. When handling, always 
wear protective equipment (lab coat, safety glasses, and chemical-resistant gloves) and 
use in a well-ventilated area. On a routine basis, thoroughly clean surfaces subject to 
contamination.

To inject the gel solution: 

Step Action

1 Draw at least 35 mL of gel solution into a 60-cc syringe, filling it slowly to avoid 
introducing air bubbles.

IMPORTANT Draw enough solution into the syringe the first time to inject the 
entire gel without having to stop and draw more solution.

2 Check the tip of the syringe. The gel solution should be at the tip, and no air bubbles 
should be present. Adjust the solution and remove air bubbles if necessary.

3 Starting at one end of the large notch in the front plate, slowly and steadily inject gel 
solution between the plates across the entire width of the notch.

4 Simultaneously:

� Continue injecting the gel solution while moving the syringe back and forth 
along the width of the notch

� Constantly tap the top plate directly in front of the gel path to eliminate air 
bubble formation

Injection takes approximately 60 seconds. Stop when the solution completely fills 
the space between the plates.

Note If you need to refill the syringe, be careful not to introduce any air bubbles. 
Keep excess solution in the beaker to verify polymerization.
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5 If using a … Then …

shark’s-tooth comb insert the straight edge of a shark’s- 
tooth comb to form one large well.

square-tooth comb insert the teeth of a square-tooth comb 
to form the wells.

6 Verify no air bubbles are trapped where the gel and comb meet.

7 Attach three large binder clips to the top of the plates directly over the comb. Evenly 
space the clips. If using a shark’s-tooth comb, be careful not to damage any teeth 
while clamping the plates.

IMPORTANT Do not attach binder clips to the bottom of the gel. This can result 
in an uneven gel thickness.

IMPORTANT To prevent well leakage, the 96-lane plates and casting combs 
require 10–12 pounds clamping pressure.

8 Cover the bottom of the plates with plastic wrap or damp paper towel to keep the 
bottom of the gel from drying out. 

9 Allow the gel to polymerize the amount of time recommended by the gel solution 
protocol.

To inject the gel solution: (continued)

Step Action

Do not put clips on bottom of gel
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Summary of Procedures for Performing a Run

To Perform a Run To perform a run (electrophorese samples on the instrument) you will:

Materials Required but not Supplied

Available from
Applied Biosystems

� 25 mM EDTA with 50 mg/mL blue dextran, pH 8.0 (P/N 402055)

� Matrix standard samples (may not be required; refer to your protocol and 
Chapter 6, “Making Matrix Files for GeneScan,” or Chapter 7, “Making Instrument 
Files for Sequencing,” as appropriate for more information)

� Sequencing standard (for sequencing runs only; may not be required; refer to your 
protocol for the recommended sequencing standard)

� Size standard (required for GeneScan® analysis software runs only; refer to your 
protocol for the recommended size standard)

� Thermal cycler (we recommend the GeneAmp® PCR System 9700 or 9600)

� Thermal cycler accessories, MicroAmp® tray/retainer sets, reaction tubes, and 
caps

Available from
Major Laboratory

Suppliers

� Formamide, deionized (see Appendix A for deionization procedure)

� Gel, freshly prepared (recipes in Appendix A)

� Gloves, disposable, powder-free

� Kimwipes®

� Microcentrifuge or centrifuge adapted for spinning microtiter plates

� Pipet and tips, small volume, calibrated

– Gilson Pipetman (Rainin Instruments, P/N P10 or P20)

– Flat pipet tips (Rainin Instruments, P/N GT-1514)

Note Pipet tips listed above fit both the P10 and P20. However, they eject off the P10 only.

� Syringe, 60-cc, with a 16- to 18-G needle

� Tris Borate EDTA (TBE) stock solution, 10X, pH 8.3

� Water, sterile, deionized

1. Prepare the buffer and loading solutions before you start or as needed.

2. Clean the outside of the gel plates and mount them in the gel cassette.

3. Install the lower buffer chamber and gel cassette.

4. Perform a plate check.

5. Install the upper buffer chamber, and fill both chambers with buffer solution.

6. Install the front heat-transfer plate.

7. Set up the software by completing a sample sheet and a run sheet.

8. Perform a prerun and load the samples.

9. Start the run.
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Preparing the 1X Tris Borate EDTA (TBE) Buffer Solution

Materials Required � Graduated cylinder, large

� 10X Tris Borate EDTA (TBE) stock solution, pH 8.3 at ambient temperature 
(Procedure for preparing 10X TBE in Appendix A.)

� Water, deionized

IMPORTANT If the pH of the 10X TBE stock solution is not 8.3 (± 0.2), discard and use 
fresh solution. Do not attempt to adjust the pH.

Preparing the
1X TBE Buffer

Solution

! WARNING ! Tris-borate-EDTA (TBE) buffer can be harmful if inhaled, ingested, or 
absorbed through the skin. It is irritating to the eyes, skin, and mucous membranes. 
Always work in a fume hood. Obtain a copy of the MSDS from the manufacturer. Wear 
appropriate protective eyewear, clothing, and gloves. 

Prepare this solution before you start or as needed based on the procedures in this 
chapter. To prepare the 1X TBE buffer solution:

Preparing the Formamide/Blue Dextran Loading Solution

Materials Required � Formamide, deionized, pH > 7.0 (Deionization procedure in Appendix A.)

� 25 mM EDTA (pH 8.0) with blue dextran (50 mg/mL)

Storage
Recommendations

We recommend storing the materials required separately.

� Formamide—store at –20°C

– Freeze/thaw formamide stored in Eppendorf tubes a maximum of 5–10 times 
before discarding

� EDTA with blue dextran—store at room temperature

Preparing the
Loading Solution

! WARNING ! CHEMICAL HAZARD. Formamide is a known teratogen. It can cause 
birth defects. Wash thoroughly after handling formamide. Wear appropriate protective 
eyewear, clothing, and gloves. Obtain a copy of the MSDS from the manufacturer.

Prepare this solution before you start or as needed based on the procedures in this 
chapter. Prepare loading solution fresh daily by mixing the following ingredients in a 
5:1 ratio (formamide : EDTA with blue dextran). The amount you will need to prepare 
will vary depending on the number of lanes used.

Step Action

1 Pour 120 mL of 10X TBE stock solution into the graduated cylinder.

2 Dilute with deionized water to a total volume of 1200 mL, and mix well.
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Cleaning the Gel Plates Before Loading the Gel

How to Carry the
Cassette with Plates

IMPORTANT When carrying a cassette with plates, always hold the cassette by the sides 
with both hands. Do not carry the cassette by the top bar. The weight of the plates may cause 
the bar to break, resulting in broken glass plates.

Cleaning the Plates
Before Using the Gel

Follow this procedure to clean the outside surface of the glass plates before loading 
the gel on the instrument.

IMPORTANT Wear gloves throughout this procedure for your protection, and to avoid 
transferring fluorescent contaminants from your hands to the glass plates.

Do not hold cassette here 
to carry glass plates

Hold cassette by the 
sides with both hands 
to carry glass plates

To clean the glass plates: 

Step Action

1

cont.

If the plates are … Then …

very dirty a. remove the plates from the cassette to clean 
them (if applicable).

CAUTION Always remove the plates from 
the cassette before rinsing in a sink with tap 
water. Arcing can occur inside the instrument 
if the cassette and plates are installed with 
even a small amount of moisture on them. 
Arcing is a luminous, low voltage, high current 
electrical discharge that can severely damage 
the instrument.

b. Put the plates in a sink and rinse them with 
cool tap water, making sure the read region 
(see page 3-47) is thoroughly cleaned.

c. Dry the plates with Kimwipes.
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1
cont.

not very dirty a. you can leave them in the cassette to clean 
them (if applicable).

b. Using deionized water and Kimwipes 
thoroughly clean the read region 
(see page 3-47).

c. Dry the plates with Kimwipes.

IMPORTANT Be sure to clean the outside of the back plate. Gel solution can 
sometimes leak out the back while pouring the gel, and polymerizes as drops on 
the glass. If not removed, the back plate will not make full contact with the rear 
heat-transfer plate, and instrument sensitivity will be greatly reduced. Over time, gel 
solution can also damage the rear heat-transfer plate.

2 For square-tooth combs only: Place the overlay strip on the clean class. Align the 
well outlines on the overlay strip with the teeth of the comb.

3 Carefully remove the comb from between the plates, and clean it with deionized 
water and Kimwipes. Allow the comb to air dry.

4 Clean the comb area with deionized water and Kimwipes. Remove residual 
acrylamide from the well region.

Very carefully use the teeth of the comb to remove residual acrylamide in the well 
region formed between the plates.

5 Visually examine the plates for dust, lint, water spots, and fingerprints. Clean again 
if necessary.

6 If the plates are … Then …

mounted in the gel cassette, 
and you are using a 
square-tooth comb

proceed to “Installing the Gel Cassette and Lower 
Buffer Chamber” on page 3-8.

mounted in the gel cassette, 
and you are using a 
shark’s-tooth comb

proceed to step 5 on page 3-6.

not in the gel cassette proceed to “Loading the Gel Into the Cassette” on 
page 3-6.

To clean the glass plates: (continued)

Step Action

Well region

Comb area
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Loading the Gel Into the Cassette

Procedure IMPORTANT When carrying a cassette with plates, always hold the cassette by the sides 
with both hands. Do not carry the cassette by the top bar. The weight of the plates may cause 
the bar to break, resulting in broken glass plates. See the illustration on page 3-4.

To load the gel into the cassette: 

Step Action

1 Place the cassette on a clean, level surface.

2 Orient the plates in the cassette as shown below so the front plate is on top. Then 
push the plates to the bottom of the cassette until the notches in the rear plate are 
seated firmly against the metal plate stops in the cassette. Push the plates from the 
top to ensure firm contact.

3 Press on the center of the front plate with the fingertips of one hand to hold plates in 
place. At the same time, lock the plates into position by turning all the cassette 
clamps to the closed position except for the bottom pair of clamps.

4 Lower the laser beam safety bar, and turn the bottom cassette clamps to lock the 
bar into position.

5 If using a … Then …

shark’s-tooth comb a.  make sure the comb is clean and dry.

b. Proceed to the next step.

square-tooth comb proceed to “Installing the Gel Cassette and Lower 
Buffer Chamber” on page 3-8.

6 If this is … Then …

not a 96-lane upgrade 
instrument

proceed to the next step.

a 96-lane upgrade 
instrument

using a syringe, add 1X TBE buffer to the loading area. 
Adding TBE makes comb insertion and removal much 
easier.

Plate stops

Laser beam safety bar lowered and 
locked in place by these two clamps
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7 Insert the teeth of the shark’s-tooth comb between the plates as follows:

a. Hold the comb at both ends.

b. Slowly and carefully insert the teeth of the comb between the plates without 
bending any of the teeth or introducing air bubbles.

c. Continue sliding the comb between the plates until the tips of all the teeth 
penetrate the gel approximately 1–2 mm.

If the top of the gel is not completely flat in the sample loading region, you may 
have to insert some of the teeth further than 1–2 mm so that all the teeth 
penetrate the gel surface.

IMPORTANT If any of the teeth penetrate the gel too much, do not pull them 
out. Leave them in the gel. Removing teeth that have penetrated the gel causes 
samples to leak into adjacent wells.

8 Proceed to “Installing the Gel Cassette and Lower Buffer Chamber” on page 3-8.

To load the gel into the cassette: (continued)

Step Action
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Installing the Gel Cassette and Lower Buffer Chamber

The Electrophoresis
Chamber

The following illustration shows the various components of the electrophoresis 
chamber when it is empty.

Figure 3-1 Electrophoresis chamber

Water flow 
quick-
disconnect 
valves

High voltage connection 
for upper buffer chamber

Positioning pins

Rear 
heat-transfer 

plate

Power switch and status 
lights

Front heat-transfer plate 
ground connection

Clamps

High voltage connection 
for lower buffer chamber
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Installation
Procedure

! WARNING ! ELECTRICAL SHOCK HAZARD. Severe electrical shock can result if 
you defeat the safety interlocks located in the door of the instrument. Close the panel 
door before operating the instrument.

To install the gel cassette and lower buffer chamber: 

Step Action

1 Open the right front panel of the ABI PRISM® 377 instrument.

2 Inspect the front and rear heat-transfer plates, and the two positioning pins inside 
the electrophoresis chamber (Figure 3-1 on page 3-8) for residue. If dirty, clean with 
a Kimwipe.

CAUTION TBE crystals and dried acrylamide can accumulate on the 
positioning pins and heat-transfer plates. The presence of these residues can 
result in arcing. Arcing is a luminous, low voltage, high current electrical 
discharge that can severely damage the instrument.

Note TBE crystals and dried acrylamide can also cause misalignment of plates, 
resulting in a colored haze over the gel image.

3 Place the lower buffer chamber on the bottom shelf of the electrophoresis chamber, 
and connect the electrode cable to the lower high voltage connection.

4 Fit the cassette up against the rear heat-transfer plate between the four clamps in 
the chamber as shown below. Turn the clamps to lock the cassette in place.

IMPORTANT Do not touch the read region of the plates (see page 3-47).

Clamps locking 
cassette in place

Electrode cable from 
lower buffer chamber

Lower buffer 
chamber
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5 Carefully check cassette installation. The positioning pins in the chamber 
(Figure 3-1 on page 3-8) must be touching the spacers through the two holes on 
the back of the cassette. The pins should be visible through the glass. 

Repeat the installation if necessary.

IMPORTANT Proper installation is critical to ensure good results. The rear 
heat-transfer plate is spring loaded, and is designed to apply even pressure to the 
glass plates. If the cassette is not properly installed against the positioning pins, 
instrument sensitivity will be greatly reduced, and experimental results will be poor.

6 Close the front panel of the instrument, and proceed to “Performing a Plate Check” 
on page 3-11.

To install the gel cassette and lower buffer chamber: (continued)

Step Action
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Performing a Plate Check

Plate Check
Procedure

See “Using the Instrument” in Chapter 1 for a description of the plate check and its 
purpose.

! WARNING ! ELECTRICAL SHOCK HAZARD. Severe electrical shock can result if 
you defeat the safety interlocks located in the door of the instrument. Close the panel 
door before operating the instrument.

To check the plates: 

Step Action

1 Open the Special menu and choose Restart to restart the computer.

We recommend restarting the computer once a day or before each run to reduce 
memory fragmentation, and to quit any applications that might be running in the 
background.

2 If not launched automatically, launch the ABI PRISM® Data Collection Software 
(data collection software) by double-clicking the icon.

3 Open a new run sheet (also referred to as the “run window”) as follows:

a. Open the File menu and select New.

b. Select Sequence Run or GeneScan Run as appropriate.

c. Open the Plate Check Module pop-up menu, and select a plate check module.

4 Click Plate Check on the run sheet. The Log and Scan windows are displayed. The 
plates are scanned without electrophoresis.

5 Observe the Scan window. After approximately 45 seconds, four lines are 
displayed. The typical pattern from top to bottom is red, black, blue, and green. The 
blue and green lines can be transposed, or displayed on top of each other. This is 
acceptable.

6 Watch the scan lines for approximately 30 seconds.

7 If … Then …

the scan lines are relatively flat 
(Figure 3-2 on page 3-12)

the plates are clean. 

a. Click Cancel and terminate the Plate 
Check.

b. Leave the run window open.

c. Proceed to “Installing the Upper Buffer 
Chamber” on page 3-15.

peaks appear in the scan window 
(Figure 3-2 on page 3-12)

the plates are dirty. Proceed to “Reclean 
the Plates” on page 3-13.

the green line is higher than the red 
and black lines

the plates or gel are contaminated with a 
large amount of fluorescent material. 
Proceed to “Reclean the Plates” on 
page 3-13.
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Figure 3-2 Scan windows during the plate check showing clean and dirty plates. The typical 
order of colors for the scan lines from top to bottom is red, black, blue, and green

Clean plates Dirty plates
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Reclean the Plates Peaks in the scan lines during a Plate Check indicate contaminants on the glass in the 
read region, or contaminating fluorescence in the gel. Clean the plates again as 
described below, and repeat the plate check.

To clean the plates and repeat the plate check:

Step Action

1 Click Pause to pause the plate check.

2 Open the right front panel of the instrument, and remove the gel cassette.

! WARNING ! LASER HAZARD. Exposure to direct or reflected laser light 
at 40 mW for 0.1 seconds can burn the retina and leave permanent blind 
spots. Never look directly into the laser beam or allow a reflection of the beam 
to enter your eyes. 

3 Carefully clean both sides of the glass with deionized water and Kimwipes, 
particularly the read region.

4 Remount the cassette in the electrophoresis chamber.

5 Close the front panel of the instrument.

6 Click Resume to check the plates again.

7 If … Then …

the plates are clean a. Click Cancel and terminate the plate check.

b. Leave the run window open.

c. Proceed to “Installing the Upper Buffer Chamber” 
on page 3-15.

peaks are still present the gel is probably contaminated. Choose one of the 
following:

� Determine which lanes are contaminated, and 
leave those lanes empty when loading samples. 
See “Skipping Lanes” on page 3-14 to determine 
which lanes are contaminated.

� Cancel the plate check, fill the buffer chambers, 
install the front heat-transfer plate, and start the 
prerun. Prerun the gel approximately three 
minutes and watch the Scan window. 
Contaminants may migrate out of the read region 
and peaks will disappear. All lanes can then be 
used. (See pages 3-15, 3-16, 3-18, and 3-35.)

� Click Cancel, terminate the plate check, and install 
a new gel.
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Skipping Lanes

Determining Which
Lanes to Skip

The Scan window displays data as channel numbers. Follow this procedure to 
determine the lane number(s) that correspond to the channel number(s) containing 
fluorescent contaminants. Skip these lanes when loading samples.

Step Action

1 While the Scan window is open and the plate check is running, hold a spare, clean 
comb up against the scan window. The comb must be of the exact configuration as 
the one used to prepare the gel.

2 Resize the Scan window to the exact size of the numbered lanes only on the 
comb.

3 The lanes in which the peaks appear are the lanes to skip when loading samples. In 
the example shown above, sample would not be loaded in lanes 26, 27, and 28. If 
the peaks are close to the edge of a lane, we recommend skipping an extra lane.

4 Click Cancel and terminate the plate check.

5 If a sample sheet … Then …

has not been completed proceed to “Installing the Upper Buffer Chamber” on 
page 3-15.

has already been 
completed

reopen the sample sheet and make the necessary 
changes to reflect the empty lanes.

6 If the sample sheet has already been imported to the run sheet:

a. Open the sample sheet pop-up menu and select <none>.

b. Open the sample sheet pop-up menu and reselect the sample sheet. 
(See “Select the Sample Sheet” on page 3-29.)

7 Proceed to “Installing the Upper Buffer Chamber” on page 3-15.

Click here and 
drag to resize 
the window
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Installing the Upper Buffer Chamber

Procedure To install the upper buffer chamber:

Step Action

1 Open the front panel of the instrument.

2 Open the two top clamps holding the gel in the cassette.

3 Rest the two tabs on the back of the chamber on the ears at the top of the front 
glass plate.

4 Close the clamps to lock the chamber in place.

5 Connect the electrophoresis cable to the upper high voltage connection. (See 
Figure 3-1 on page 3-8.)

6 Proceed to “Filling the Buffer Chambers” on page 3-16.

Ears of front 
glass plate
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Filling the Buffer Chambers

To Fill the Buffer
Chambers

IMPORTANT The concentration of the buffer in both chambers must match the 
concentration of the buffer in the gel. Otherwise, samples will run slower or faster than 
expected, or you may get a “No EP Current Detected” error message. The gel recipes listed in 
Appendix A use 1X Tris Borate EDTA buffer (TBE).

! WARNING ! Tris-borate-EDTA (TBE) buffer can be harmful if inhaled, ingested, or 
absorbed through the skin. It is irritating to the eyes, skin, and mucous membranes. 
Obtain a copy of the MSDS from the manufacturer. Wear appropriate protective eyewear, 
clothing, and gloves. 

To fill the buffer chambers:

Step Action

1 If not already prepared, prepare the 1X Tris Borate EDTA (TBE) buffer solution by 
following the instructions listed on page 3-3.

2 Slowly and carefully fill the upper buffer chamber with approximately 600 mL of 
1X TBE buffer. Do not allow buffer to splash onto the plates. Fill levels for the two 
styles of upper buffer chambers for this instrument are shown below. Filling the 
buffer chamber to the recommended level helps reduce the amount of buffer that 
evaporates during a run.

3 Wait approximately 30 seconds, and then check for leaks as follows:

a. Look for fluid dripping down the front of the plates. This indicates the buffer 
chamber gasket may be worn and should be replaced. 

b. Look for fluid inside the lower buffer chamber. This indicates that buffer is 
leaking over the ears of the plates and down the sides of the cassette.

Fill to top of the two level marks 
located on each side of the front 
of the buffer chamber

Fill so buffer just touches the bottom 
of tab the lid rests on (tab is located 
on the rear of the buffer chamber)

Transparent 
buffer chamber

White buffer 
chamber
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4 If leakage occurs, try one or more of the following:

� Check the buffer level. If the chamber is overfilled, remove the excess buffer.

� Plug the suspected areas with melted agarose. If buffer is leaking over the ears 
of the plates, apply a bead or ribbon of agarose to seal this area.

� Carefully empty the buffer chamber and clean the gasket. Also clean the front 
of the glass plate where the gasket makes contact.

If leakage continues, replace the gasket. Follow the procedure “Replacing the 
Upper Buffer Chamber Gasket” in Chapter 8. 

IMPORTANT If the buffer level drops below the notch in the front plate (in the 
upper buffer chamber) or below the bottom of both plates (in the lower buffer 
chamber), electrical contact is lost and the instrument shuts down automatically to 
prevent arcing (a luminous, low voltage, high current electrical discharge that can 
severely damage the instrument.)

5 Carefully fill the lower buffer chamber with 1X TBE buffer to the top edge of the 
overflow dam. Do not overfill.

Note Be careful not to splash buffer up onto the back of the rear plate. Buffer on 
the plate will dry during the run, resulting in a green haze on the gel image.

6 Proceed to “Installing the Front Heat-Transfer Plate” on page 3-18.

To fill the buffer chambers:

Step Action

Instrument shuts down automatically if 
buffer level drops below the notch at the 
top of the front plate, or below the 
bottom of the plates during a run
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Installing the Front Heat-Transfer Plate

Install the Front
Heat-Transfer Plate

To install the front heat-transfer plate:

Step Action

1 If this is a … Then …

48-cm run use of the front heat-transfer plate is 
optional, and is not necessary for good 
data. Proceed to step 2 and install the 
plate, or proceed to “Setting Up the 
Software for a Run” on page 3-19.

36-cm run Proceed to step 2.

2 Open the six gel cassette clamps between the upper buffer chamber and the laser 
beam safety bar.

3 Make sure the laser beam safety bar is down and locked into position.

4 Carefully position the front heat-transfer plate up against the glass plates so it rests 
on the laser beam safety stop.

CAUTION The front heat-transfer plate is heavy, and can be damaged if 
dropped or bumped against a hard surface. Exposed metal on a damaged 
plate will cause arcing. Arcing is a luminous, low voltage, high current 
electrical discharge that can severely damage the instrument. Handle the 
plate with care.

5 Close the cassette clamps to lock the plate in position.

6 Attach the grounding strap to the heat plate ground connection.

7 Connect the water supply tubes to the quick-disconnect fittings.

8 Proceed to “Setting Up the Software for a Run” on page 3-19.

Quick-disconnect 
fittings for water 
supply tubes

Grounding strap Front heat-transfer plate
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Setting Up the Software for a Run

Overview This chapter does not include a detailed description of the data collection software. 
See Chapter 9, “Data Collection Software,” for more information.

Before starting a run, you must set up a sample sheet and a run sheet specific to your 
application (sequencing or GeneScan). The location of instructions for preparing 
sample and run sheets are listed in the following table.

Preparing a Sequencing Sample Sheet

IMPORTANT Do not mix sequence and GeneScan analysis samples on the same sample 
sheet or in the same run.

Save Time by
Setting Sample

Sheet Preferences

If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up sample sheets by setting sequencing sample sheet 
default preferences. Setting sample sheet preferences means changing the default 
value of certain fields on the sample sheet template to the values used most often. 
The following fields on sequencing sample sheets can be set as preferences:

� DyeSet/Primer

� Instrument File

Once these preferences have been set, the preferred values appear automatically on 
each new sequence sample sheet. Preferences can be changed as often as 
necessary either by setting new preference values, or by opening the pop-up menus 
and manually selecting new values. Instructions for setting sequencing sample sheet 
default preferences are located in Chapter 5, “Setting Preferences.”

Project Names
and BioLIMS

BioLIMS® and Setting Preferences

The Project Name field on the sample sheet is used to identify data transferred to 
BioLIMS. If this field is left empty, the data transferred to BioLIMS is identified by the 
gel file name only. Project names are defined prior to setting up sample sheets by 
opening the Windows menu, and selecting Project Info under Preferences. For more 
information and instructions, see Chapter 5, “Setting Preferences.”

Application Type of Sheet Location of Instructions

Sequencing Sample sheet page 3-19

Run sheet page 3-28

GeneScan Sample Sheet page 3-24

Run sheet page 3-28
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Open a New
Sample Sheet and

Enter Sample Names

To open a new sequencing sample sheet and enter sample names:

Step Action

1 Open the File menu and select New (leave the run window open).

2 Click the icon named Sequence Sample.

3 Enter sample names in the Sample Name column by clicking in the Sample Name 
field, and typing the sample name. Enter names in the exact order the samples will 
be loaded onto the gel. The numbers to the left of the Sample Name column 
represent the gel lane numbers. Leave fields blank that correspond to empty lanes.

IMPORTANT Each sample must have a unique name. Limit sample names to 
27 characters including the default characters. Do not use colons, slashes, or 
symbols in sample names. 

Note More text can be entered than is visible. Text automatically shifts as the 
information is entered. Use the keyboard arrow keys to scroll through long entries.
To import sample names from tab-delimited text files, follow the instructions listed in 
Chapter 9, “Data Collection Software.”

4 If matrix standard samples are being run, enter a name for each matrix sample. To 
help ensure a robust matrix is produced, we strongly recommend you follow these 
guidelines:

� Leave at least one empty lane between non-matrix standard samples and 
matrix standard samples.

� Leave one empty lane between each matrix standard sample.

Lane number on the gel

Empty lanes between non-matrix
and matrix standard samples, and
between each matrix standard sample
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Select a
DyeSet/Primer File

Different dye set/primer files can be used for the same run as long as the virtual filter 
set is the same for all samples. Dye set/primer file names for dRhodamine Terminators 
are similar to those for BigDye™ Terminators, and can easily be mistaken for one 
another. If the wrong file is selected, base spacing in the data will not be noticeably 
affected. C and T bases will be miscalled. If you are not sure which file to select, refer 
to the chemistry kit protocol, and to “DyeSet/Primer Files” in Chapter 9.

Select an Instrument
File

The instrument file must be the same for all the samples.

To select a dye set/primer file: 

Step Action

1 Open the DyeSet/Primer pop-up menu and select the appropriate file for the first 
sample. You must select a file if you want the data to be analyzed automatically at 
the end of the run.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the 
folder that contains the dye set/primer files. To correct this, you must set the 
Settings Folder Preference to the ABI Folder. See “Setting Folder Location 
Preferences” on page 3-51.

2 If the file is the same for all remaining samples, click in the column heading to select 
the entire column, open the Edit menu, and select Fill Down. Otherwise, select the 
appropriate DyeSet/Primer file for each sample individually.

Click these boxes to 
open pop-up menus

Click in this field to select
the entire column

To select the instrument file:

Step Action

1 Open the Instrument File pop-up menu for the first sample, and select the 
appropriate file. You must select a file if you want the data to be analyzed 
automatically at the end of the run.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the 
folder that contains the instrument files. To correct this, you must set the Settings 
Folder Preference to the ABI Folder. See “Setting Folder Location Preferences” on 
page 3-51.

2 Click in the column heading to select the entire column, open the Edit menu, and 
select Fill Down to enter the same instrument file for the remaining samples.
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Select Project Names
and Enter

Comments

The Project Name field is for BioLIMS users only. Otherwise, the field can be left 
blank. If a project name is not identified, the data transferred to BioLIMS is identified 
by the gel file name only. 

Project names must be defined prior to setting up the sample sheet as Project Info 
Preferences. Refer to “Project Information Preferences” in Chapter 5 for instructions 
and more information.

Figure 3-3 Example of a completed sequencing sample sheet

To select project names and enter comments: 

Step Action

1 Open the Project Name pop-up menu for each sample, and select the appropriate 
project name.

2 If the Project Name is the same for all remaining samples, click in the column 
heading to select the entire column, open the Edit menu, and select Fill Down. 
Otherwise, select the appropriate Project Name for each sample individually.

3 To enter comments, click in the Comments field, and type the information.

Click here to open the
Project Name pop-up menu
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Save and Close the
Sample Sheet

To save and close the sample sheet:

Step Action

1  Do one of the following:

� Open the File menu and select Close.

� Click the box in the upper left-hand corner of the window, and then click Save.

2 A dialog box showing the default sample sheet file name, and the location where 
the sample sheet will be stored is displayed. 

a. Change the file name now if desired.

b. Click Save.

IMPORTANT Although it is an option, we do not recommend changing the 
storage location of the sample sheet. If the location is changed, software will not be 
able to locate the sample sheet when you set up the run sheet.

Note You can also save the sample sheet by opening the File menu and 
selecting Save, Save As, or Save A Copy In.

3 Proceed to “Preparing a Run Sheet” on page 3-28 to finish setting up the software.

Folder where sample sheets
are stored

Sample sheet file name
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Preparing a GeneScan Sample Sheet

IMPORTANT Do not mix GeneScan and sequence analysis samples on the same sample 
sheet or in the same run.

Save Time by
Setting Sample

Sheet Preferences

If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up sample sheets by setting GeneScan sample sheet 
default preferences. Setting sample sheet preferences means changing the default 
value of certain fields on the sample sheet template to the values used most often. 
The following field can be set as a preference:

� Std (size standard dye color)

Once you have set this preference, the preferred value appears automatically on each 
new GeneScan sample sheet. This preference can be changed as often as necessary 
either by setting a new preference value, or by manually selecting a different value on 
the sample sheet. Instructions for setting GeneScan sample sheet default preferences 
are located in Chapter 5, “Setting Preferences.”

Open a New Sample
Sheet and Enter

Sample Names

To open a new GeneScan sample sheet and enter sample names:

Step Action

1 Open the File menu and select New (leave the run window open).

2 Click the icon named GeneScan Sample.

3 Enter sample names in the Sample Name column by clicking in the appropriate 
Sample Name field, and typing the sample name. Enter names in the exact order 
the samples will be loaded onto the gel. The numbers to the left of the Sample 
Name column represent the gel lane numbers. Leave fields blank that correspond 
to empty lanes. See Figure 3-4 on page 3-25.

IMPORTANT Each sample must have a unique name. Limit sample names to 
27 characters including the default characters. Do not use colons, slashes, or 
symbols in sample names. 

Note More text can be entered than is visible. Text automatically shifts as the 
information is entered. Use the keyboard arrow keys to scroll through long entries.
To import sample names from tab-delimited text files, follow the instructions listed 
under “Importing and Exporting Sample Sheet Information” in Chapter 9.

4 If matrix standard samples are being run, enter a name for each matrix sample. To 
help ensure a robust matrix is produced, we strongly recommend you follow these 
guidelines (see Figure 3-4 on page 3-25):

� Leave at least one empty lane between non-matrix standard samples and 
matrix standard samples.

� Leave one empty lane between each matrix standard sample.

IMPORTANT Matrices are dye set, instrument, and run condition dependent. 
As such, matrices must be remade when any of these conditions change. For more 
information, refer to Chapter 6, “Making Matrix Files for GeneScan.”
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Figure 3-4 Sample name column on a GeneScan sample sheet

Select Project Names The Project Name field is for BioLIMS version 2.0 and up users only. Otherwise, the 
field can be left blank. If a project name is not identified, the data transferred to 
BioLIMS is identified by the gel file name only. 

Project names must be defined prior to setting up the sample sheet as Project Info 
Preferences. Refer to “Project Information Preferences” in Chapter 5 for instructions 
and more information.

Lane number on the gel

Sample A loaded in lane 1

Lane 2 left empty

First matrix standard sample

Lane 4 left empty

Second matrix standard sample

loaded in lane 3

loaded in lane 5

To select project names:

Step Action

1 Open the Project Name pop-up menu for each sample, and select the project 
name.

2 If the Project Name is the same for all remaining samples, click in the column 
heading to select the entire column, open the Edit menu, and select Fill Down. 
Otherwise, select the appropriate Project Name for each sample individually.

Click here to open the
Project Name pop-up menu
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Specify the Size
Standard Dye Color

To specify the size standard dye color:

Specify the Dyes Run
in Each Lane

To specify the dye colors run together in each lane:

Enter Sample Info
and Comments

The information in the Sample Info and Comments fields is imported into ABI PRISM 
Genotyper® DNA Fragment Analysis Software, and is used for sample identification 
and sorting. If these fields are left blank, only the words “sample file” will appear when 
sample information is displayed in Genotyper.

To enter Sample Info and Comments:

Step Action

1 For all non-matrix standard samples, designate the color of the size standard by 
clicking in the box to the right of the appropriate letter in the Color column (B = blue; 
G = green; Y = yellow; R = red). When selected, a diamond is displayed in the Std 
column. This must be specified for data to be analyzed automatically.

2 Leave the Std column blank for matrix standard samples. If necessary, remove 
diamonds for matrix standard samples by clicking on the diamond.

Size standard
dye color is red

Step Action

1 Click in the appropriate boxes in the Pres (present) column to select the dye colors 
that will be run in each lane for each sample. Codes for the colors are displayed in 
the Color column (B = blue; G = green; Y = yellow; R = red). Dyes must be specified 
for data to be analyzed automatically.

2 To deselect a color, click in the appropriate box to remove the X.

Click in these boxes to 
indicate the dyes being 
run in each lane

Step Action

1 To enter Sample Info, click in the Sample Info field and type the information.

2 To enter comments, click in the Comments field and type the information.
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Figure 3-5 Example of a completed GeneScan sample sheet

Save and Close the
Sample Sheet

To save and close the sample sheet:

Empty lane between 
matrix samples

Samples loaded 
in lanes 1 and 2

Lane numbers

Empty lane between 
non-matrix and 
matrix samples

Matrix sample 
loaded in lane 4

Matrix sample 
loaded in lane 6

The diamond indicates the 
color of the size standard

Checkboxes indicate the 
dyes run in each lane

Project names must be 
predefined in Preferences Can be set as 

a Preference

Step Action

1 Do one of the following:

a. Open the File menu and select Close.

b. Click the box in the upper left-hand corner of the window, and then click Save.

2 A dialog box showing the default sample sheet file name, and the location where 
the sample sheet will be stored is displayed. 

a. Change the file name now if desired.

b. Click Save.

IMPORTANT Although it is an option, we do not recommend changing the 
storage location of the sample sheet. If the location is changed, software will not be 
able to locate the sample sheet when you set up the run sheet.

3 Proceed to “Preparing a Run Sheet” on page 3-28 to finish setting up the software.

Folder where sample sheets
are stored

Sample sheet file name
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Preparing a Run Sheet

Save Time by
Setting Run

Sheet Preferences

If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up run sheets by setting sequencing or GeneScan run 
sheet default preferences. Setting run sheet preferences means changing the default 
value of certain fields on the run sheet template to the values used most often. The 
following fields can be set as preferences:

� Operator

� Lanes

� Well-to-read distance

� Prerun and run modules

� Auto print

� Analysis parameters (GeneScan run sheets only)

� Gel’s matrix file (GeneScan run sheets only)

� Size standard (GeneScan run sheets only)

Once these preferences are set, the preferred values appear automatically on each 
new run sheet. Preferences can be changed as often as necessary either by setting 
new preference values, or by manually selecting new values on the run sheet. 
Instructions for setting run sheet preferences are located in Chapter 5, “Setting 
Preferences.”

Open a New
Run Sheet

To open a new run sheet:

Step Action

1 If the run window used 
for the plate check is

Then …

2 still open click on that window to make it the active window.

3 not open open a new run sheet as follows:

a. Open the File menu and select New.

b. Click either the Sequence Run or GeneScan Run 
icon as appropriate. A new Run folder is created 
automatically in the Runs folder inside the 
ABI PRISM 377 folder.

Note We recommend using the same run sheet for 
the plate check, prerun, and run. This will limit the 
number of run folders created per run to one.
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Select the Plate
Check, PreRun, and

Run Modules

To select the plate check, prerun, and run modules:

Select the Number
of Lanes

To select the number of lanes:

Select the
Sample Sheet

IMPORTANT Select the number of lanes before selecting the sample sheet. If the default 
number of lanes is less than the number of samples, the sample information on the run sheet 
will be truncated. For example, if you entered 36 samples on the sample sheet, but the default 
number of lanes on the run sheet is 24, only the information for the first 24 samples will be 
imported to the run sheet if the sample sheet is selected before the number of lanes is changed 
to 36.

To select a sample sheet:

Step Action

1 Open the Plate Check Module pop-up menu, and select a plate check module.

IMPORTANT If the pop-up menus list <none> only, software cannot find the 
folder that contains the modules. See “Setting Folder Location Preferences” on 
page 3-51.

2 Open the PreRun Module pop-up menu, and select a prerun module.

3 Open the Run Module pop-up menu, and select a run module.

Step Action

1 Open the Lanes pop-up menu and select the appropriate value.

Note If this is an XL or 96-lane upgrade instrument, the appropriate value for the 
Run Mode field is selected automatically when this parameter is set. The run sheet 
for the standard ABI PRISM 377 instrument does not have a Run Mode field.

For GeneScan applications:

Full Scan–24, 34, 36 lanes
XL Scan–48, 50, 64, 66 lanes
96 Lane Scan–96 lanes

For Sequencing applications:

Full Scan–24, 32, 36 lanes
XL Scan–48, 64 lanes
96 Lane Scan–96 lanes

Step Action

1 Open the sample sheet pop-up menu, and select the sample sheet prepared for this 
run. Once selected, the information on the sample sheet is imported to the run 
sheet.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the 
folder that contains the sample sheets. To correct this, see “Setting Folder Location 
Preferences” on page 3-51.
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Select the
Instrument or Gel’s

Matrix File

For GeneScan runs in particular, matrices are dye set, instrument, and run condition 
dependent. As such, matrices must be remade when any of these conditions change. 
For more information, refer to Chapter 6, “Making Matrix Files for GeneScan,” and the 
ABI PRISM GeneScan® Reference Guide, P/N 4303188.

To select an instrument or gel matrix file:

Select the Run
Mode, Well-to-Read

Distance, and
Operator

To select the run mode, well-to-read distance, and operator:

2 The information imported from the sample sheet cannot be changed on the run 
sheet. If changes are made to the sample sheet after it has been selected on the 
run sheet, you must reimport the sample sheet data.

To make changes to the sample sheet after selecting it on the run sheet:

a. Open the sample sheet by clicking the icon next to the sample sheet pop-up 
menu on the run sheet.

b. Make changes to the sample sheet.

c. Close and save the sample sheet.

d. Open the sample sheet pop-up menu on the run sheet, and select <none>.

e. Open the sample sheet pop-up menu on the run sheet, and reselect the 
sample sheet.

Note You cannot make changes to the sample sheet while a module is running.

Step Action

Click this icon

If this is a … Then …

sequencing run open the Instrument File pop-up menu, and select the appropriate file. If 
one does not yet exist, leave the field set to <none>. A file must be 
selected for automatic data analysis.

GeneScan run open the Gel’s Matrix File pop-up menu, and select the appropriate file. 
If one does not yet exist, leave the field set to <none>. A file must be 
selected for automatic data analysis.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the folder that 
contains the instrument/matrix files. To correct this, you must set the Settings Folder 
Preference to the ABI Folder. See “Setting Folder Location Preferences” on page 3-51.

Step Action

1 If this is … Then …

a standard instrument proceed to the next step.

an XL or 96-lane upgrade instrument verify that the correct mode is displayed 
in the Run Mode field.

2 Open the Well-to-Read distance pop-up menu and select the appropriate value.

3 Click in the Operator field and type your name.
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Enter the Collection
Time

To enter the collection time:

Step Action

1 Enter the duration of the run in the Collect time field. Use the run time 
recommended in your protocol. The following are suggested run times only.

Well-to-Read 
Length in cm

Type of Run
(Scans per 

Hour/Application)

Suggested Collection Time in Hours

19:1 Acrylamide 
Gels

Long Ranger™ 
(LR), PAGE-PLUS 

(PP), 29:1 
Acrylamide Gels

12 1200/GS 1.0 1.0

12 2400/GS 1.0 1.0

36 1200/GS & Seq 7.0 9.0

36 2400/GS
2400/Seq

2.0
3.5

4.0
4.0

48 1200/Seq 10.0 11.0 (29:1 & LR)
12.0 (PP)

GS = GeneScan application; Seq = Sequencing Application

Note The number of scans that can be collected is limited by the software.

2 If … Then …

you do not want the data to be 
analyzed automatically

a. deselect the boxes in the Auto 
Analyze column by clicking in each 
box to remove the X.

b. Proceed to “Starting the Run or 
Closing the Run Sheet” on page 3-34.

this is a sequencing run and you want 
the data to be analyzed automatically

proceed to “Auto Analysis for Sequencing 
Runs” on page 3-32.

this is a GeneScan run and you want 
the data to be analyzed automatically

proceed to “Auto Analysis for GeneScan 
Runs” on page 3-33.
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Auto Analysis for
Sequencing Runs

See “About Automatic Data Analysis” in Chapter 9 for more information.

IMPORTANT Do not automatically analyze matrix standard samples.

To set up the run sheet for automatic data analysis:

Step Action

1 Verify that the data analysis software is selected in Preferences. To do this:

a. Open the Window menu, and select Preferences.

b. Select Sequence Run Defaults …

c. Look at the “Autoanalyze with …” field. 

2 If the analysis software 
is … Then …

selected click OK to return to the run sheet.

not selected a. Open the “Autoanalyze with” pop-up menu, and 
select Other.

b. In the dialog box, locate the ABI PRISM® DNA 
Sequencing Analysis Software and click Open.

c. Close the current run sheet, and create a new 
run sheet. 

Note Changing the preference has no affect on 
run sheets created prior to the change.

3 On the run sheet, verify that the Auto Analyze boxes are selected for each 
non-matrix standard sample. If the boxes are not selected:

a. Open the sample sheet by clicking the icon next to the sample sheet pop-up 
menu on the run sheet.

b. Select a dye set/primer file for each sample you want analyzed automatically. 

c. Close and save the sample sheet.

d. Open the sample sheet pop-up menu, and select <none>.

e. Open the sample sheet pop-up menu, and reselect the sample sheet to update 
the information.

4 If matrix standard samples are being run, deselect Auto Analyze for all matrix 
standard samples.

5 Select Auto Print for analyzed data to be printed automatically.

6 Proceed to “Starting the Run or Closing the Run Sheet” on page 3-34.

Analysis software
not selected

Click this icon
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Auto Analysis for
GeneScan Runs

See “About Automatic Data Analysis” in Chapter 9 for more information.

IMPORTANT Do not analyze matrix standard samples.

To set up the run sheet for automatic data analysis:

Step Action

1 Verify that the data analysis software is selected in Preferences. To do this:

a. Open the Window menu, and select Preferences.

b. Select GeneScan Run Defaults …

c. Look at the “Autoanalyze with …” field. 

2 If the analysis software 
is … Then …

selected click OK to return to the run sheet.

not selected a. Open the “Autoanalyze with” pop-up menu, and 
select Other.

b. In the dialog box, locate the ABI PRISM 
GeneScan® Analysis Software and click Open.

c. Close the current run sheet, and create a new 
run sheet. 

Note Changing the preference has no affect on 
run sheets created prior to the change.

3 Verify that the Auto Analyze boxes are selected for each non-matrix standard 
sample (Figure 3-5 on page 3-27). Selecting Auto Analyze allows you to select 
analysis parameters, a size standard, and the auto print option.

4 If matrix standard samples are being, run, deselect Auto Analyze for all matrix 
standard samples.

5 If not already selected, or if you wish to change the preference settings, set the 
remaining fields as follows:

a. Open the Analysis Parameters pop-up menu, and select an analysis 
parameters file. Analysis parameters must be set up in the analysis software 
program prior to completing the run sheet. Refer to the ABI PRISM GeneScan 
Analysis Software User’s Manual for instructions.

b. Open the Size Standard pop-up menu, and select the appropriate size 
standard file.

c. Select the Auto Print boxes for analyzed data to be printed automatically.

Note If the pop-up menus list <none> only, software cannot find the folders that 
contain the analysis parameters and size standard files. To correct this, see “Setting 
Folder Location Preferences” on page 3-51.

6 Proceed to “Starting the Run or Closing the Run Sheet” on page 3-34.

Analysis software
not selected
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C

Figure 3-6 Auto analyze selected and deselected on a GeneScan run sheet

Starting the Run or
Closing the Run

Sheet

To start the run or close the run sheet:

Auto analyze selected. A set of 
analysis parameters and a size 
standard must be selected.

Auto analyze deselected. This 
automatically deactivates the 
analysis parameters, size 
standard, and auto print fields.

If … Then …

you are ready to proceed 
with instrument operation

a. open the File menu and choose Save. A dialog box 
showing the default run sheet name, and the location 
where the file will be saved is displayed. Change the file 
name and storage location now if desired.

b. Click Save.

c. Proceed to “Performing a PreRun and Loading the 
Samples” on page 3-35.

you wish to close the run 
sheet

a. open the File menu and choose Close.

b. Click Save. A dialog box showing the default run sheet 
name, and the location where the file will be saved is 
displayed (shown in previous step). Change the file 
name and storage location now if desired.

c. Click Save.

Folder where run
sheets are stored

Run sheet file name
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Performing a PreRun and Loading the Samples

Prepare the Loading
Solution

If not already prepared, prepare the loading solution now. Instructions are listed under 
“Preparing the Formamide/Blue Dextran Loading Solution” on page 3-3.

Flush the Wells ! WARNING ! Tris-borate-EDTA (TBE) buffer can be harmful if inhaled, ingested, or 
absorbed through the skin. It is irritating to the eyes, skin, and mucous membranes. 
Obtain a copy of the MSDS from the manufacturer. Wear appropriate protective eyewear, 
clothing, and gloves.

Before starting the prerun, it is important to remove all the bubbles from the wells in 
the gel by flushing the wells with buffer.

Start the PreRun See “Using the Instrument” in Chapter 1 for a description of the prerun and its 
purpose.

IMPORTANT To avoid gel extrusion, the electrophoresis voltage during a prerun should 
never exceed 1 kV. Prerunning the gel is particularly important when performing a high speed 
(2400 scans/hour) run. The gel must be at run temperature when the samples are loaded to 
ensure appropriate denaturation conditions.

To flush the wells:

Step Action

1 Fill the syringe (needle attached) with 1X TBE buffer from the upper buffer chamber.

2 For shark’s-tooth combs only: Starting at one end of the comb, slowly inject the 
buffer across the well area to force out the air bubbles.

3 Repeat this procedure until all air bubbles are gone.

Note Bubbles present during electrophoresis result in an uneven electrical field 
and poor electrical contact. Bubbles will also electrophorese into the gel and alter 
the loading surface.

4 If desired, install the lid onto the upper chamber now. However, sample loading may 
be easier with the lid off.

To prerun the gel: 

Step Action

1 If not already specified in the Run window, open the PreRun pop-up menu and 
select the appropriate PreRun module.

2 Optional–recommended when using a square-tooth comb and if you are a new 
user. Follow these steps to stain the surface of the gel. Staining will help you 
visualize the wells and make sample loading easier.

a. Load approximately 25–50 µL of formamide/blue dextran loading solution into a 
pipet.

b. Starting at one end of the wells, slowly drag and release the formamide/blue 
dextran loading solution across the tops of the wells. 

CHEMICAL HAZARD. Formamide is a known teratogen. It can cause birth 
defects. Wash thoroughly after handling formamide. Wear appropriate 
protective eyewear, clothing, and gloves. Obtain a copy of the MSDS from the 
manufacturer.

3 Close the front panel of the instrument.
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4 Click PreRun. The Scan window is displayed.

5 Open the Window menu and select Status to display the Status window.

� Green arrow indicates actual reading from instrument.

� Gray box indicates value set by the module.

� Electrophoresis voltage, gel temperature, and laser power are setpoints.

� Electrophoresis current and power are limits.

6 Prerun the gel only until run temperature (gel temperature in the Status window) is 
reached (approximately 15–25 minutes). The default duration of the prerun module 
may be longer, so watch the “Time Remaining” in the Status window (shown 
above).

Note Prerunning the gel longer than it takes to reach run temperature can 
cause it to swell up around the comb. If this occurs, the samples may not run 
straight in the gel, and resolution will be adversely affected. The surface of the gel 
where the samples are loaded should be as level as possible.

7 If contaminants are present in the gel, and you have elected to skip contaminated 
lanes when loading samples:

a. Click on the Scan window to activate it.

b. Watch the scan lines during the PreRun. Sometimes contaminants migrate out 
of the gel during the PreRun, and all the lanes can then be used.

8 Once the gel has reached run temperature, click Pause to temporarily halt the 
prerun.

IMPORTANT Pause the prerun—do not cancel it. When paused, the pump and 
heater remain on, thereby maintaining the gel temperature.

To prerun the gel: (continued)

Step Action

Total amount of time 
the module will run

Time remaining for the module being executed
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Denature the
Samples

To denature the samples:

Load the Samples ! WARNING ! Ergonomic Hazard. Performing loading activities may increase risk of 
developing the following cumulative trauma disorders (repetitive motion or repetitive 
strain injuries) which include but are not limited to: tendinitis, tenosynovitis, 
epicondylitis, strains, and/or sprains. To reduce the risk of experiencing these types of 
disorders, the following recommendations have been developed to decrease awkward 
posture; repetitive motion; excessive force; static muscle loading; and soft tissue 
contact.

� Use an automated multi-channel pipette loader

� Locate the instrument on a variable or predetermined-height worktable or 
lab bench

� Use a stable stool or stepladder

� Install adequate artificial lighting in the appropriate area to facilitate loading

� Ensure adequate front access to instrument while performing loading 
activities

Remember to load the samples in the same lanes as specified on the run sheet. The 
information on the run sheet at the start of the run is the information used to identify 
each sample in the Gel file. Changes made to sample and run sheets after starting the 
run are not implemented.

Step Action

1 Finish preparing the samples and bring them up to the final volume as directed in 
the protocol you are using.

2 Load the samples and any other reagents as directed by the protocol into reaction 
tubes.

3 Cap each tube and vortex for 3–5 seconds.

4 Spin down the contents of the tubes, and load them onto a thermal cycler or heat 
block.

5 Denature the samples as directed by the protocol.

6 Remove the samples from the thermal cycler or heat block, and immediately place 
them on ice until ready to load.

To load the samples: 

Step Action

1 If this is … Then …

a 96-lane instrument proceed to “Starting and Monitoring the Run” on 
page 3-40. Sample loading instructions are part of 
this procedure.

not a 96-lane instrument If not already paused, click Pause in the Run window 
to pause the PreRun.

Pausing stops electrophoresis, but maintains the 
temperature of the gel while loading samples.
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2 Carefully flush all of the wells with 1X TBE buffer to remove urea.

! WARNING ! Tris-borate-EDTA (TBE) buffer can be harmful if inhaled, 
ingested, or absorbed through the skin. It is irritating to the eyes, skin, and 
mucous membranes. Obtain a copy of the MSDS from the manufacturer. Wear 
appropriate protective eyewear, clothing, and gloves. 

3 Optional: Load formamide/blue dextran loading solution in the well to the left of the 
first sample lane, and in the well to the right of the last sample lane (the comb 
creates additional wells on either side of the numbered wells). This helps focus the 
bands in the first and last lanes.

! WARNING ! CHEMICAL HAZARD. Formamide is a known teratogen. It 
can cause birth defects. Wash thoroughly after handling formamide. Wear 
appropriate protective eyewear, clothing, and gloves. Obtain a copy of the 
MSDS from the manufacturer.

4 If using a … Then …

square-tooth comb � load one sample per lane into each consecutive 
well. 

� Refer to your protocol for the load volume, or to 
“Suggested Load Volumes” on page 3-39.

� Change the pipet tip for each sample. 

shark’s-tooth comb select Load Method 1 or 2 below.

Load Method 1—
≤≤≤≤ 50% of lanes used

� Load one sample into 
every other well. 

� Refer to your protocol 
for the load volume or 
to “Suggested Load 
Volumes” on 
page 3-39. 

� Change the pipet tip 
for each sample. 

Load Method 2—≥≥≥≥ 50% of lanes used

Refer to your protocol for the load volume, or to 
“Suggested Load Volumes” on page 3-39. Change 
the pipet tip for each sample.

a. Load one sample into each odd-numbered well. 

b. Close the front panel of the instrument.

c. Click Resume and allow the samples to 
electrophoresis into the gel for two minutes.

d. Click Pause.

e. Open the front panel of the instrument.

f. Carefully flush all of the wells with 1X TBE buffer 
to remove any residual formamide from the 
previously loaded wells.

g. Load one sample into each even-numbered 
well.

IMPORTANT Whenever possible, load a sample in lane one (unless 
contaminants are present and you are skipping that lane). It is better to leave empty 
lanes at the right end of the gel. Also, avoid skipping more than one lane between 
samples. The tracker may not work properly if more than one lane is left empty 
between samples.

IMPORTANT For shark’s-tooth comb users—loading samples in every other 
lane is necessary for good tracking. Although the formamide in the loading solution 
helps narrow the lane width, loading samples in adjacent lanes can blur the 
definition between lanes. Loading samples in every other lane creates discrete 
spaces between samples to properly identify the lanes.

5 Close the front panel of the instrument, and proceed to “Starting and Monitoring the 
Run” on page 3-40.

To load the samples: (continued)

Step Action
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Suggested Load
Volumes

Total resuspension volume depends on the application and chemistry. Refer to your 
protocol or the following guides as appropriate:

� ABI PRISM GeneScan® Reference Guide, P/N 4303188

� ABI PRISM DNA Sequencing Chemistry Guide, P/N 4305080

For GeneScan Applications

For Sequencing Applications

Number of Wells Load Volume (µL)

24 and 36 1.5

50 1.0–1.5

66 0.5–1.0

96 0.5—1.0

Number of Wells Load Volume (µL)

18 0.75—2.0

36 0.75—2.0

48 0.5—2.0

64 0.5—1.5

96 0.5—1.0
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Starting and Monitoring the Run

See Chapter 3, “Instrument Operation,” for a description of the run and its purpose.

To Start the Run To start the run:

Step Action

1 Click Cancel on the Run sheet, and then click Terminate to cancel the PreRun.

2 Wait five seconds, and then click Run.

The data collected throughout the run is stored in a Gel file. A dialog box displaying 
the default gel file name and storage location appears. You can change the name 
and storage location of the gel file now if desired. Do not use colons, slashes, or 
symbols in gel file names.

3 Click Save. The Scan window is displayed.

Note If a dialog box appears indicating there is not enough room on the hard 
disk to save the files created by a run, delete files (particularly Gel files) to create 
enough space. First, back up important files onto floppy disks or another storage 
device, then delete files off the hard disk and click Run again.

4 Verify electrophoresis has resumed by viewing the Status window.

5 Verify scanning has resumed by checking the following in the Scan window:

� All four scan lines should be above zero.

� Current scan number should increment.

If either electrophoresis or scanning does not resume, cancel the run and restart it.

6 If this is a 96-lane instrument, load your samples now as follows:

a. Click Pause to pause the run.

b. Open the front panel of the instrument.

c. Carefully flush all of the wells with 1X TBE buffer to remove urea.

! WARNING ! Tris-borate-EDTA (TBE) buffer can be harmful if inhaled, 
ingested, or absorbed through the skin. It is irritating to the eyes, skin, and 
mucous membranes. Obtain a copy of the MSDS from the manufacturer. Wear 
appropriate protective eyewear, clothing, and gloves.

d. Load samples in the odd numbered lanes.

e. Click Resume and allow the samples to electrophorese for one minute.

f. Click Pause.

g. Carefully flush all of the wells with 1X TBE buffer to remove any residual 
formamide from the previously loaded wells.

h. Load the remaining samples.

i. Close the front panel of the instrument.

j. Click Resume to continue the run.

7 To cancel a run in progress and analyze the data collected up to that point, click 
Cancel, and then click Stop & Analyze.

The gel file is closed, sent to the analysis software, and then analyzed. Data 
collection software automatically quits, and the run is terminated.

Note To use the Stop & Analyze feature, the run sheet must be configured for 
automatic data analysis before the run is started. The run cannot be resumed after 
selecting Stop & Analyze.
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The amount of time it takes for peaks to appear varies, and is dependent upon the well-to-read 
distance, type of gel, and run speed. General guidelines are listed below.

Monitoring the Run Four types of windows are available for viewing data and instrument status.

� Data windows are:

– Scan

– Gel

� Instrument windows are:

– Status

– Electrophoresis History

Refer to Chapter 9, “Data Collection Software,” for more information on these 
windows. 

Note To use as little RAM as possible, we recommend leaving a minimum number of 
windows open (for example, only the Status and Scan windows). The Gel window requires the 
largest amount of RAM to display.

Scan Window

The Scan window displays the intensity of the fluorescent emissions being collected 
as samples pass through the read region of the gel and the dyes are excited by the 
laser. The emissions are displayed as peaks. Each dye/virtual filter is represented by a 
different colored line. The display is continuously updated during instrument operation. 
The current scan number is displayed in the upper right hand corner of the window.

Well-to-Read 
Distance (cm)

Run Speed 
(scans/hour)

Approximate Amount of Time 
Before Peaks are Detected

Sequencing GeneScan

12 1200/2400 N/A 10–20 minutes

36 1200 40 minutes 20–25 minutes

36 2400 20 minutes 20–25 minutes

48 1200 1 hour N/A
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Gel Window

Like the Scan window, data in the Gel window also represents the fluorescent 
emissions collected from the samples as they pass through the read region of the gel. 
The first fragments scanned by the laser appear at the top of the window, and move 
down as new data is collected.

Status Window

The Status window displays the current status of the instrument (green boxes). This 
information is updated approximately every three seconds. Open the Status window 
by choosing Status from the Window menu.

The electrophoresis voltage, gel temperature, and laser power are setpoints specified 
by the module currently being executed. Electrophoresis current and electrophoresis 
power are limits. The instrument shuts down automatically if limits are exceeded. 
Setpoints and limits are shown in the grey boxes.
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Electrophoresis History Window

The Electrophoresis History window displays the set and actual values for the 
electrophoresis power supply and gel temperature throughout the course of a run. The 
scale for each panel is adjustable.

The information in the Electrophoresis History window is also stored in the Gel file. To 
display the electrophoresis history window, open the Window menu and choose 
Electrophoresis History.

Click here to adjust scale

Scan numbers
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Viewing the Log File

A Log file is created for each run when the run is started. Log files contain a 
comprehensive record of all error and status messages generated by data collection 
software during a run including:

� Start and stop times of the run

� Instrument and Macintosh® errors

Log files are stored in the Run folder. To view the Log file, open the Windows menu 
and select Log. Refer to Chapter 9, “Data Collection Software,” for more information 
on this window.
3-44 Instrument Operation



Cleaning Up After the Run

Cleaning Procedure To clean up after a run:

Step Action

1 Optional. Turn the instrument off.

2 Open the front panel of the instrument.

3 Disconnect the upper and lower buffer chamber electrode cables.

4 If the front heat-transfer plate was used, disconnect the grounding strap and water 
supply tubes.

5 Remove the front heat-transfer plate by releasing the six cassette clamps that hold 
the plate in place and lifting it away from the instrument.

IMPORTANT Always remove the front heat-transfer plate from the gel cassette 
before removing the cassette from the instrument. The front heat-transfer plate is 
heavy, and removing them together can damage the cassette.

6 Siphon the buffer from the upper and lower buffer chambers into an appropriate 
waste container.

! WARNING ! Tris-borate-EDTA (TBE) buffer can be harmful if inhaled, 
ingested, or absorbed through the skin. It is irritating to the eyes, skin, and 
mucous membranes. Obtain a copy of the MSDS from the manufacturer. Wear 
appropriate protective eyewear, clothing, and gloves. 

7 Open the four clamps that hold the cassette in place, and remove the cassette from 
the instrument.

8 Holding the cassette over a sink, carefully open the cassette clamps holding the 
upper buffer chamber to the cassette, and remove the buffer chamber.

9 Remove the gel plates from the cassette.

10 Clean the cassette with damp Kimwipes and allow it to air dry it.

11 Remove the lower buffer chamber and discard any remaining buffer.

12 Clean up any liquid left in the electrophoresis chamber.

13 Clean the front and rear heat-transfer plates and the positioning pins with damp 
Kimwipes. Place the front heat-transfer plate on a non-scratch surface. Allow all the 
parts to air dry.

14 Rinse the buffer chambers with deionized water, and allow them to air dry.

IMPORTANT To avoid damaging the electrode inside the buffer chambers, 
rinse the buffer chambers only. Do not scrub or clean them with a sponge.

15 Follow the procedures listed in Chapter 2, Gel Preparation, to:

� Remove the gel from between the glass plates.

� Clean the glass plates, spacers, and comb.
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Analyzing the Data

For Sequencing
Runs

Refer to the ABI PRISM® DNA Sequencing Analysis Software User’s Manual for 
instructions on how to analyze data from a sequencing run.

For GeneScan Runs Refer to the ABI PRISM GeneScan® Analysis Software User’s Manual for instructions 
on how to analyze data from a GeneScan run.

Archiving and Printing Data from Runs

Refer to Chapter 9, “Data Collection Software,” for information on archiving and 
printing data.
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The Read Region

What is the Read
Region

The read region is the area of glass scanned by the laser. It is approximately 2.5 to 
4.5 cm from the bottom of the glass, and is:

� 6 inches wide for standard and XL instruments

� 7.25 inches wide for 96-lane instruments

� 3 inches wide for ABI PRISM 377-18 instruments

The number of channels in the read region are:

� 194 for the standard ABI PRISM 377 and 377-18 instruments (numbered 0 to 193)

� 388 for ABI PRISM 377 XL instruments (numbered 0 to 387)

� 480 for ABI PRISM 377 96-lane instrument (numbered 0 to 479)

The type of comb used determines the number of channels per lane. For example, 
one lane of a 36-well comb is equivalent to approximately 5 channels.

4.5 cm 
2.5 cm

Top of glass plates

Read region
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Manually Controlling the ABI PRISM 377 Instrument

Procedure In manual control mode, the instrument settings can be changed in real time. The 
instrument must be idle before you can control it manually, because commands sent 
via standard operation mode (from a run sheet) override commands entered manually.

Functions specified from the Manual Control function pop-up menu are executed 
when the Execute button is clicked. Functions continue running until:

� The function is cancelled

� A new function is selected

To manually operate the instrument:

Step Action

1 Open the Window menu and choose Manual Control.

2 Open the Function pop-up menu (Fxn Name), and select a function.

3 If appropriate, enter a number in the Value field. Guidelines are shown in the Range 
box, and in the following table.

4 Click Execute.

If necessary, click Cancel to terminate a function.

Function pop-up menu

Per the guidelines shown in the Range
field, enter a value between 0 and 60.
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Manual Control
Functions

The following tables describe the functions that can be performed from the Manual 
Control window.

Function Name Description

Electrophoresis On Starts electrophoresis.

Electrophoresis Off Stops electrophoresis.

Electrophoresis Volts Sets electrophoresis volts to a value between 0.00 and 5.00 kV.

Electrophoresis 
Current

Sets electrophoresis current to a value between 0.00 and 60.0 mA.

Electrophoresis 
Power

Sets electrophoresis power to a value between 0 and 300 W.

Laser Standby Sets the laser to minimum power.

Laser Run Turns the laser on.

Laser Power Sets laser power to a value between 0.00 and 40.0 mW (in 10ths of 
mW).

Pump On Turns the temperature control system on, and sets the temperature 
to a value between 20 and 60°C.

Pump Off Turns the temperature control system off.

CCD Pixel Position The charge coupled device (CCD) pixel position value is a reference 
point for alignment of the CCD camera with the laser beam. The 
instrument is shipped with the correct CCD pixel position value in 
memory. When a run is started, data collection software checks for a 
value greater than zero. If not found, the error message shown below 
is displayed.

If this occurs, the value must be reentered. See “CCD Pixel Position 
Value” in Chapter 4, “Troubleshooting.” For convenience, the value 
can be stored in a calibration file. The value can be sent to the 
instrument using the Calibration File Send command. See “Using 
Calibration File Make and Send” in Chapter 4 for more information.

Calibration File Make Used to create a file called ABI 377 Calibration that contains the 
CCD pixel position value and instrument serial number. The file is 
stored in the Preferences folder inside the System folder. See “Using 
Calibration File Make and Send” in Chapter 4 for more information. 

Calibration File Send Used to send the CCD pixel position value and instrument serial 
number to the instrument. The serial number is transferred into all 
Sample files created by the data analysis software, and can be 
viewed in the annotative view of the sample file. This is useful for 
instrument identification, particularly if more than one instrument is 
being operated. See “Using Calibration File Make and Send” in 
Chapter 4 for more information.

CCD Gain Typically does not require adjustment. When running dRhodamine 
terminators on an ABI PRISM 377 with XL Upgrade, we recommend 
increasing the gain to 4. The default setting is 2.
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CCD Offset Used to move baselines and signals up and down the scale in the 
Scan window and in the recorded data. CCD Offset can be useful if 
baselines look unusually high or low. Be aware that baselines 
normally drop over the course of a run. Therefore, the lowest 
baseline should be set high enough so that it does not drop below 
zero by the end of the run. We recommend setting the lowest 
baseline at the beginning of the run between 300 and 500 points.

External Cooler On 
(Relay 4)

Used to manually control power to an external water bath. This 
function gives you control of the internal system pump from the rear 
of the instrument at relay 4. Manual control is not required if the 
recommended external water bath and chiller modules are used.

Refer to Appendix B, “Subambient Temperature Operation,” for 
further information regarding external cold water baths. Refer to 
“Modules” on page 9-42 to see a list of all the modules available 
including chiller modules.

External Cooler Off 
(Relay 4)

External Cooler On and Off can be used to manually control power 
to an external water bath.

Cold Boot 
Instrument

Downloads the firmware image to the instrument. Use this command 
if the computer and instrument are communicating, but the 
instrument is not responding appropriately. This symptom indicates 
the firmware image on the instrument is corrupt. See “Performing a 
Cold Boot” in Chapter  4 for more information.

Function range of values:

Function Range of Values

Electrophoresis Volts* 0.00 to 5.00 kV

Electrophoresis Current* 0.00 to 60.0 mA

Electrophoresis Power* 0 to 300 W

Laser Power 0.00 to 40.0 mW (in 10ths of mW)

Pump On 20 to 60°C

CCD Gain† 1, 2, 4, or 8 CCD Output

CCD Offset 0 to 4096 CCD Output

CCD Pixel Position‡ 1 to 512 pixels

* These parameters can be controlled manually to make them limiting. However, you should be 
thoroughly familiar with the principles of electrophoresis before doing so.

† This parameter amplifies the signal, and should not require adjustment.

‡ Use this only if instrument memory has been reset, and the value has been lost.

Function Name Description
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Setting Folder Location Preferences

Overview The folder locations for the following types of files and folders must be designated to 
perform a run, and to handle the data generated during a run:

� Sample sheets

� Module files

� Run folders

� Firmware image file

� Settings

� GeneScan analysis parameters (for GeneScan users only)

� GeneScan size standards (for GeneScan users only)

Software must know where to put and locate these files to operate the instrument. 
These folders are typically located on the hard disk of the Macintosh attached to the 
instrument. The folder names and locations listed below are the ones specified during 
system installation. The settings can be changed at any time. However, if changes are 
made, the new folder location and/or name must be specified in the Preferences 
Folder Locations dialog box (page 3-52). Refer to Chapter 5, “Setting Preferences,” 
and Chapter 9, “Software,” for more information.

Folder
Location and 
Folder Name* What the Folder Contains

Sample Sheet Folder Macintosh HD: 
ABI Prism 377: 
Sample Sheets

Contains all the sample sheets. When 
setting up a run sheet, the selections 
displayed in the pop-up menu for sample 
sheets are the files stored in this folder.

Module Folder Macintosh HD: 
ABI Prism 377: 
Modules

Contains the Plate Check, PreRun, and Run 
modules. When setting up a run sheet, the 
selections displayed in the Plate Check, 
PreRun, and Run Module pop-up menus are 
the files stored in this folder.

Chiller Modules 
Folder

Macintosh HD: 
ABI Prism 377: 
Chiller Modules

Contains the Plate Check, PreRun, and Run 
modules. When setting up a run sheet, the 
selections displayed in the Plate Check, 
PreRun, and Run Module pop-up menus are 
the files stored in this folder.

Folder Containing 
Run Folders

Macintosh HD: 
ABI Prism 377: 
Runs

Contains the Run folders. A new Run folder 
is created for each run. At the end of 
analysis, each new Run folder will contain a 
gel file, log file, sample files, and a run file.

Firmware File Folder Macintosh HD: 
ABI Prism 377: 
Firmware Image

Contains the firmware image file.

* IMPORTANT Locations and folder names listed are those at the time of system 
installation. We strongly recommend not changing folder names and locations.

‡ = Displayed in Folder Locations dialog box for GeneScan users only.
Instrument Operation 3-51



Setting Folder
Location Preferences

To set the Folder Location preferences:

Settings Folder Macintosh HD: 
System folder: 
ABI Folder

Typically set as the ABI Folder. The choices 
in other Preferences dialog boxes and in 
Run windows use the information contained 
in this folder for their pop-up menus.

IMPORTANT To automatically analyze 
data after a run using the sequencing 
analysis software, the Settings folder must 
be designated as the ABI folder.

GeneScan Analysis 
Parameters‡

Macintosh HD: 
GeneScan Analysis 
x.x: 
GS Parameters 
Folder

Contains the parameters used to analyze 
GeneScan run data, and is located in the 
GeneScan Analysis software folder.

GeneScan Size 
Standard Folder‡

Macintosh HD: 
GeneScan Analysis 
x.x: 
GS Standards 
Folder

Contains the size standard definitions used 
to analyze GeneScan run data, and is 
located in the GeneScan Analysis software 
folder.

Folder
Location and 
Folder Name* What the Folder Contains

* IMPORTANT Locations and folder names listed are those at the time of system 
installation. We strongly recommend not changing folder names and locations.

‡ = Displayed in Folder Locations dialog box for GeneScan users only.

Step Action

1 If the Preferences dialog box … Then …

is not open open the Window menu, select 
Preferences, and then select Folder 
Locations.

is open open the Page pop-up menu and select 
Folder Locations.

2 Click the box that corresponds to the folder location you wish to set.

Click in these boxes to select 
and change a folder location
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3 Using the pop-up menu in the dialog box that is displayed, locate and select the 
folder the appropriate folder.

IMPORTANT To automatically analyze data with ABI PRISM DNA Sequencing 
Analysis Software on the same computer used for data collection, the Settings 
Folder must be designated as the ABI Folder (shown below).

4 Click the Select box underneath the list of folders. Do not click Open.

5 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.

Step Action

Use this pop-up 
menu to locate the 
desired folder

Highlight the new 
folder by clicking 
it once

The text above the menu indicates the folder location 
preference currently being set, and corresponds to the 
“select” button at the bottom of the box.

Click here to select 
the new folder—do 
not click Open
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Chapter Contents

In this Chapter This chapter contains information you can use to troubleshoot and solve many of the 
problems that can occur when using this system. Quick reference tables are listed on 
pages 4-3 through 4-19. The remaining portion of the chapter contains procedures 
referenced in the tables, and provides more information on the data collection 
software and firmware.
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For More Troubleshooting Information

References For more troubleshooting information, refer to these manuals as appropriate for your 
application:

� GeneScan® Reference Guide : ABI™ 373 and ABI PRISM® 377 DNA Sequencers 
(P/N 4303188)

� Automated DNA Sequencing Chemistry Guide: ABI™ 373 and ABI PRISM® 377 
DNA Sequencers, P/N 4305080
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Gel and Gel Image Troubleshooting Guide

Observation Possible Causes Recommended Actions

Misshapen wells

Note If only a few wells are 
misshapen, you can still load the 
gel using only those lanes with flat, 
well-formed wells

Suction when comb removed When removing the comb: 

1. Lay gel flat.
2. Pour 1X TBE over comb.
3. Remove comb slowly.

Wet comb or well-former Ensure that comb is clean and dry before 
inserting into gel.

Note To ease insertion of comb, you 
can “wet” the comb with acrylamide (or the 
appropriate gel polymer).

Air bubbles trapped when comb 
inserted

Ensure that no air is trapped by comb.

Swirls in gel (Schlieren pattern) Excessive TEMED or APS Prepare new solutions following protocol

Temperature too high Polymerize at 20–23°C

Gel polymerized too quickly Do not heat gel solution to dissolve urea

Insufficient reagent mixing Mix reagents gently but thoroughly

Polymerization too slow

(gels should polymerize within 
15–20 minutes)

Excessive dissolved oxygen � Keep vacuum filter strength and time 
constant

� Stir and pour solutions gently

� Filter/pour gels at 20–23°C

� Not enough TEMED or APS

� Degraded TEMED or APS

� Prepare new solutions following the 
protocol using fresh high-quality 
reagents

� Store APS at room temperature in a 
desiccator 

� Store TEMED in tightly sealed container 
at room temperature

Temperature too low during casting Polymerize at 20–23°C

Did not use deionized water Use only distilled or deionized water for 
making all solutions

Gel solution leaks out when 
injecting gel

� Bottom of plates not flush

� Gel pouring fixtures not 
mounted correctly

� Plates not positioned properly in 
the cassette

Review the gel pouring procedures in 
Chapter 2, “Pouring Gels.”

Gel extrudes from between plates
into upper buffer chamber during 
electrophoresis

Buildup of charge on the surface of 
the glass plate. See “Gel 
Extrusion” on page 4-29 for more 
information.

Clean the plates with an alcoholic KOH 
wash (page 4-30) or a 3 M HCl wash 
(page 4-31).

Large migrating region showing no 
fluorescence

Plates not rinsed free of Alconox Rinse plates thoroughly with distilled, 
deionized water.

Lane-wide region(s) of 
fluorescence

Contaminated loading buffer or 
sample

Remake solutions co-loaded with sample.
Troubleshooting 4-3



Severely bowed gel image Clamping bottom of gel plates Do not clamp the bottom of the gel.

Note Use clamps of equal tension 
along the side of the gel. The clamps must 
be placed over the spacers.

Gel extruded between plates into 
upper buffer reservoir. See “Gel 
Extrusion” on page 4-29 for more 
information.

Clean the plates with an alcoholic KOH 
wash (page 4-30) or a 3 M HCl wash 
(page 4-31).

Red or green smearing on gel Gel dried out before running � Before storing a poured gel, wrap the 
gel ends with damp Kimwipes and 
plastic wrap.

� Use gel within 2–6 hours after pouring

Appearance of donut-shaped band 
(with black central hole)

Too much sample loaded Load less sample or remake sample with a 
higher dilution.

Gel-wide region of migrating 
fluorescence (can be of any color)

Contamination of buffer with 
fluorescent species (e.g., 
laboratory pen used to label lanes, 
gel plates, or comb)

Do not mark gel plates or comb.

Lower buffer chamber not clean 
(i.e., contaminated with fluorescent 
species)

Clean and replenish buffer in lower buffer 
chamber.

Tilted or deformed bands Small bubble in lane Cast gel as described in protocol. Make 
sure plates are lint-free before pouring gel.

Gel not clamped properly Use clamps of equal tension along the 
side of the gel. The clamps must be placed 
over the spacers only.

IMPORTANT Do not clamp the bottom 
of the gel.

Dirty plates Clean plates using one of these methods:

� Soak the plates overnight in a 5% 
solution of Multiterge detergent 
(VWR Scientific, P/N 34171-010)

� Use a 3 M HCl wash (page 4-31)

� Use an alcoholic KOH wash 
(page 4-30)

Lanes appear as smears Impure or degraded TEMED or 
APS

Use fresh reagents.

Samples are overloaded Follow loading procedure in your protocol 
or in Chapter 3.

Electrophoresis failure due to 
buffer leak

Make sure that the plates are clamped 
correctly, and that the upper buffer 
chamber gasket makes a proper seal.

Do not spill buffer behind the upper buffer 
chamber. Wicking can occur.

Gel image contains vertical red 
streaks (“red rain”) near end of run 
(top of gel image)

Gel destruction in read region � Wrap bottom of gel to prevent drying.

� Run at a lower temperature or voltage.

Observation Possible Causes Recommended Actions
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Gel image contains green/blue 
streaks throughout run

Fluorescent contaminant in gel Vacuum filter gel solution. Cast gel in 
dust-free environment.

Urea crystals present in gel Use room temperature reagents. Pour at 
20–23°C.

IMPORTANT Do not refrigerate.

Particles on outer surface of plates 
in read region

Wipe read region with damp, lint-free 
Kimwipe.

Blue or green streaks (“curtain”) at 
top of gel image

Buffer leak Make sure that the plates are clamped 
correctly, and that the upper buffer 
chamber gasket makes a proper seal.

Do not spill buffer behind the upper buffer 
chamber. Wicking can occur.

Blue or green curtain obscuring 
entire gel image

Warped gel plate Use gel plates from Applied Biosystems.

Green streak through entire gel 
lane

Protein in template Clean up the template before performing 
sequencing reactions.

Greenish-yellow haze Poor gel plate alignment Remove the gel plates and realign them 
correctly.

Fluorescent contaminant in gel Use fresh reagents.

Do not write on gel plates with marking 
pens.

Residual detergent on plates Rinse plates thoroughly with hot deionized 
water.

Observation Possible Causes Recommended Actions
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Instrument Troubleshooting Guide

Observation Possible Causes Recommended Actions

A dialog box appears indicating there 
is not enough room on the hard disk 
to start a plate check, prerun, or run.

Hard disk is too full. Delete files (particularly gel files) to 
create enough space. If the files are 
important, back them up first. Delete 
files by dragging them to the trash 
and emptying the trash. See 
Chapter 8 for more information.

The following message is displayed: CCD pixel position value erased from 
instrument memory.

Re-enter the CCD pixel position 
value. Follow the procedure “Location 
of the CCD Pixel Position Value” on 
page 4-26.

The buffer level in upper buffer 
chamber is going down, but no 
external leaks are visible.

Buffer is wicking over ears of the 
plates and leaking down spacers

Follow this procedure:

a. Siphon the buffer out of the upper 
buffer chamber.

b. Dry the corners of the notched 
area at the top of the front plate.

c. Apply a small amount of molten 
agarose to the corners of the 
notches. 

d. Refill the upper buffer chamber.

Buffer splashes and crystallizes 
around the read region.

Buffer poured into lower buffer 
chamber too quickly

Fill the chamber to the top edge of the 
overflow dam. Do not overfill.

No communication between 
instrument and computer.

� Instrument memory cleared due to 
a power outage.

� Corrupted firmware on instrument.

� Cable is loose.

Perform a single reset. See “Locating 
the Firmware Image File” on 
page 4-24. 

If this does not solve the problem, 
perform a total reset. See “Performing 
a Total Reset” on page 4-22.

Flat scan lines or no scan lines. � Instrument memory cleared due to 
a power outage.

� Corrupted firmware on instrument.

Perform a single reset. See “Locating 
the Firmware Image File” on 
page 4-24.

Error message:

EP Voltage Deviation Exceeds 
Tolerance

The EP voltage deviated outside the 
tolerance range. Instrument operation 
is paused.

Call service.

Error message:

No EP Current Detected

Concentration of TBE buffer in buffer 
chambers differs from the 
concentration in the gel. All should be 
1X TBE.

TBE buffer concentration must be the 
same in the gel and both buffer 
chambers. Remake the gel and buffer 
chamber solutions so the TBE buffer 
concentration is the same in each.

Ears
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Error message:

Warning: Possible Plate P43/J43 
Thermistor Open/Short Circuit

Warning: Plate Out. Thermistor 
P43/J43 Open/Short Circuit

Warning: Possible Plate P44/J44 
Thermistor Open/Short Circuit

Warning: Plate In. Thermistor 
P44/J44 Open/Short Circuit

Warning: Possible Heater Thermistor 
Open/Short Circuit

� Possible open or short circuit exists 
with the thermistor/cable 
connected to J43 or J44.

� Temperature of the plate in an 
instrument with 100k ohm 
thermistors is 21.9°C or less.

� One of two temperature sensors 
(thermistors) on the rear 
heat-transfer plate may be bad. 

 The instrument will function normally 
with one sensor. Schedule a service 
call to have the thermistors checked. 
Click OK, and continue operating the 
instrument. 

This message may appear when you 
launch data collection software and 
start a plate check, prerun, or run.

Error message:

Flow Detected with Pump Off – 
External Cooling in Use!

� The wrong module is being used 
for a run where an external cooling 
device is attached.

� Internal coolant system valve is 
stuck in the on or open position.

If an external cooling device is in use, 
check the modules selected on the 
run sheet. Use Chiller modules.

If no external cooling system is in use, 
try to start the run as follows, and 
place a service call.

� Click OK in the error message box 
and try to start the run.

� Open the Manual Control window 
and try to turn the pump on 
manually.

Error message:

Err: Coolant Flow Failure!

Pump turned on and off three times to 
see if coolant flow was detected.

Open the Manual Control window and 
try to turn the pump on manually. If 
the problem persists, call service.

Error message:

No Flow Detected! Attempted Pump 
Restart

Coolant pump was turned on, but no 
coolant flow was detected by the flow 
switch.

Check the water reservoir. Refill the 
bottle if necessary. Procedure listed in 
Chapter 8, “System Maintenance.”

Error message:

Scanner Did Not Find Its Home 
Position

Scanner did not find home position 
prior to collecting data for a plate 
check, prerun, or run. 

Press the Reset button on the back of 
the instrument once. Then click 
Resume in the run window.

Error message:

A Valid XL Lane Firmware Image is 
Required!

Non-XL data collection software tried 
to establish communication with an 
ABI PRISM® 377 instrument with XL 
upgrade.

Install and use ABI PRISM® 377 XL 
Upgrade Data Collection Software.

Error message:

A Valid 96 Lane Firmware Image is 
Required!

Non-96 data collection software tried 
to establish communication with an 
ABI PRISM® 377 instrument with the 
96-lane upgrade.

Install and use ABI PRISM® 377 
96-Lane Upgrade Data Collection 
Software.

Error message:

Heat plate temperature exceeds 70°C

even when status window indicates 
less than 70°C.

Clog in coolant system. Flush the coolant system to remove 
the clog, and refill the water reservoir 
with deionized water and 5.0% 
antifreeze. See “Removing Coolant 
System Clogs” on page 4-32.

Observation Possible Causes Recommended Actions
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Error message:

The A2D Converter is Not 
Functioning

Converter not functioning. No data 
being transmitted from instrument to 
computer.

Turn the instrument power switch off 
and then on again. If the message 
appears again, perform a plate check 
to see if a signal is displayed. 

If no signal is displayed, call service.

If a signal is displayed, and the 
reoccurrence of this error is not 
severe, you should be able to run 
samples and collect data. If the 
problems persists, call service.

Flow switch sticks and plugs up. Clog in coolant system. Flush the coolant system to remove 
the clog, and refill the water reservoir 
with deionized water and 5.0% 
antifreeze. See “Removing Coolant 
System Clogs” on page 4-32.

High resistance to flow through heat 
plates.

Clog in coolant system. Flush the coolant system to remove 
the clog, and refill the water reservoir 
with deionized water and 5.0% 
antifreeze. See “Removing Coolant 
System Clogs” on page 4-32.

Quick-disconnect fittings leak. Buildup behind the seals. Flush the coolant system to remove 
the clog, and refill the water reservoir 
with deionized water and 5.0% 
antifreeze. See “Removing Coolant 
System Clogs” on page 4-32.

Pump shuts down during run 
(warning displayed), or

Pump shuts down during run 
(warning displayed) and poor 
resolution due to gel running too cold.

Clog in coolant system. Flush the coolant system to remove 
the clog, and refill the water reservoir 
with deionized water and 5.0% 
antifreeze. See “Removing Coolant 
System Clogs” on page 4-32.

Rear panel LEDs are stuck in one 
pattern, e.g. all on or all off.

� Instrument memory cleared due to 
a power outage.

� Corrupted firmware on instrument.

Perform a total reset or cold boot the 
instrument. See:

� “Performing a Total Reset” on 
page 4-22

� “Performing a Cold Boot” on 
page 4-23.

Computer cannot load a new 
firmware image onto the instrument, 
or

A new firmware image appears to 
have been downloaded, however,

� The instrument still does not 
operate

� The rear panel LEDs remain stuck 
in one pattern.

� Instrument memory cleared due to 
a power outage.

� Corrupted firmware on instrument.

Perform a total reset or cold boot the 
instrument. See:

� “Performing a Total Reset” on 
page 4-22

� “Performing a Cold Boot” on 
page 4-23.

Observation Possible Causes Recommended Actions
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No current/electrophoresis Incorrect TBE buffer formulation Use correct buffer concentrations:

� 10X TBE in the gel (for a final 
concentration of 1X)

� 1X TBE running buffer

Instrument set up incorrectly Verify that:

� The electrode leads are secure 
and plugged in.

� The bottom and top of the gel are 
immersed in running buffer.

Broken instrument parts Inspect the electrophoresis cables, 
electrodes, and platinum wire in both 
buffer chambers.

If anything is visibly broken, replace 
the electrophoresis cable and 
electrode assembly. Procedure in 
Chapter 8, “System Maintenance.”

Corrupted firmware on instrument. Resend firmware by performing a 
total reset. See “Performing a Total 
Reset” on page 4-22.

Front heat-transfer plate sticks to the 
gel plates.

Upper buffer chamber leak. Follow this procedure:

a. Empty and remove the upper 
buffer chamber.

b. Open the plate clamps.

c. Slide the front heat transfer plate 
up along the gel plate until it is 
released.

d. Clean the front heat-transfer 
plate

e. Check the upper buffer chamber 
for leaks and repair or replace as 
appropriate.

IMPORTANT Always remove the 
front heat transfer plate from the gel 
cassette before removing the 
cassette from the instrument. The 
front heat transfer plate is heavy. 
Removing them together can damage 
the cassette.

Observation Possible Causes Recommended Actions
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Data Collection Software Troubleshooting Guide

Observation Possible Causes Recommended Actions

The following dialog box is displayed 
when data collection software is 
launched.

� Folder names have been 
changed.

� Preferences file corrupt.

Reset the Folder Locations Preference. 
Instructions are listed in Chapter  9 on 
page 9-39, and in Chapter 5, “Setting 
Preferences.”

Message indicating there is not 
enough room to store data from run.

Not enough room on the hard 
disk.

Delete files (particularly gel files) from the 
hard disk. Gel files are large and are 
stored in the corresponding Run folder 
created for each run.

Data not analyzed automatically Sample Sheet not completed or 
completed incorrectly

Complete Sample Sheet as described.

GeneScan® Analysis Software 
Run Defaults set incorrectly in 
data collection program (in the 
Preferences under the Window 
menu)

Make sure that the Autoanalyze box is 
checked and that the GeneScan Run 
Default appears with the correct path 
name.

Insufficient free RAM Restart the computer before collecting 
data.

Note You should always restart the 
computer before collecting data.

Conflicting extensions Choose Extensions Manager from the 
Control Panels. Turn off any extensions 
that were not part of the original 
installation and restart computer.

Error messages displayed during data 
collection.

See “About Troubleshooting 
Software” on page 4-20 for 
more information on possible 
causes.

Error messages displayed during data 
collection are also logged in the Log file. 
The Log lists both computer errors and 
instrument firmware errors.

Computer cannot load a new firmware 
image onto the instrument, or

A new firmware image appears to 
have been downloaded, however,

� The instrument still does not 
operate

� The rear panel LEDs remain stuck 
in one pattern.

� Instrument memory cleared 
due to a power outage.

� Corrupted firmware on 
instrument.

Perform a total reset or cold boot the 
instrument. See:

� “Performing a Total Reset” on page 4-22

� “Performing a Cold Boot” on page 4-23.
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Signal Troubleshooting Guide

Observation Possible Causes Recommended Actions

Loss of signal (50–75%) Plates and gel cassette not installed 
properly against positioning pins. 

Repeat the run after reviewing the 
instructions in Chapter 2 for installing 
the plates and gel cassette.

Temporary loss of signal, typically 
between 140 to 200 bp lasting about 
20 to 40 bp

Contaminants on glass plates

See “Temporary Loss of Signal” on 
page 4-29 for more information.

Try the following:

� Wash glass plates in laboratory 
dishwasher with hot deionized water 
rinse cycle (195°F/90°C)

� Soak plates overnight in a 5.0% 
solution Multiterge

See Chapter 2 for more information on 
cleaning glass plates.

Inconsistent signal from lane to lane Some samples not thoroughly mixed 
with formamide/size standard 
mixture

Mix samples into formamide/size 
standard mixture by pipetting up and 
down several times.

Signal too low

(peak heights lower than usual)

Insufficient sample added to some or 
all lanes

� Check your protocol.

� Examine the efficiency of the PCR.

� Check pipette calibration.

Refer to the GeneScan or Sequencing 
guides listed on page 4-2 for more 
information.

Cassette not flush with back heat 
transfer plate and alignment pins

Place cassette flush against back heat 
transfer plate. 

IMPORTANT The spacers must 
touch the alignment pins. You should 
be able to see the alignment pins 
pressing against the spacers.

Difficulty in loading sample because 
wells not flushed

Flush the wells prior to loading the gel.

Bad formamide Use freshly deionized formamide. 
(Procedure in Appendix A.) 

Note Formamide pH should be 
between 7 and 9.

Insufficient [F]dNTPs added to PCR 
reaction

Reamplify using more [F]dNTPs or 
examine the efficiency of the PCR.

Optics/detector misaligned Call service representative.
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Signal too high 

(streaks appearing, or peaks heights 
greater than 4000 RFU)

Too much sample added to some or 
all lanes

Load less sample.

Reamplify using less [F]dNTPs.

Unincorporated [F]dNTPs Purify the PCR product.

Unincorporated dye terminators Follow the protocols for excess dye 
terminator removal carefully. See the 
user bulletin: Precipitation Methods to 
Remove Residual Dye Terminators 
from Sequencing Reactions 
(P/N 4304655). Obtain from our 
website at: 
www.appliedbiosystems.com/techsupp
ort

High/noisy baseline Matrix made incorrectly resulting in 
too much correction (also indicated 
by troughs under peaks)

Remake matrix. Be sure to:

� Remove primer peak (or aberrant 
off-scale peaks) from scan range.

� Pick start and stop points on flat 
parts of the baseline when viewing 
raw data.

� Make matrix using same gel 
formulation, buffer, and run 
conditions as samples.

Contamination of buffer with 
fluorescent species (for example, 
from laboratory pen used to label 
lanes gel plates or comb)

Do not label gel plates or comb.

Lower buffer chamber not clean (i.e., 
contaminated with fluorescent 
species)

Clean and replenish buffer in lower 
buffer chamber.

Signal gets progressively weaker for 
successive gels run over time

Degraded primers Store primers in the dark at –15 to 
–25°C when not in use. Avoid 
unnecessary freeze-thaw cycles.

Keep primers on ice during run setup.

Expired or mishandled reagents Check expiration dates on all reagents.

If not expired, verify that reagents are 
being stored and used according to 
manufacturer’s instructions.

Compare with signal strength of the 
same samples prepared and run using 
fresh reagents.

Observation Possible Causes Recommended Actions
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Faint or no signal from sample DNA 
and from positive control

Insufficient enzyme in reactions. Use the recommended amount of 
enzyme.

Incomplete activation of AmpliTaq 
Gold™ DNA Polymerase

Repeat amplification, making sure to:

� Hold reactions initially at 95°C for 
10–15 minutes.

� Use the recommended buffer.

Note Both buffer pH and buffer 
composition affect enzyme activation.

Note At temperatures >95°C, the 
enzyme is susceptible to irreversible 
denaturation. If you suspect insufficient 
activation, increase the incubation 
time, not the incubation temperature.

Too little sample DNA added to 
reaction.

Note This is especially critical in 
human identification experiments 
because sample quality is often 
poor.

Quantitate DNA and use the amount 
recommended in the protocol.

Note For accurate quantitation of 
human DNA samples, use the 
QuantiBlot® Human DNA Quantitation 
Kit (P/N N808-0114).

Insufficient enzyme in reactions. Use the recommended amount of 
enzyme.

Incomplete activation of AmpliTaq 
Gold™ DNA Polymerase

Repeat amplification, making sure to:

� Hold reactions initially at 95°C for 
10–15 minutes.

� Use the recommended buffer.

Note Both buffer pH and buffer 
composition affect enzyme activation.

Note At temperatures >95°C, the 
enzyme is susceptible to irreversible 
denaturation. If you suspect insufficient 
activation, increase the incubation 
time, not the incubation temperature.

Too little sample DNA added to 
reaction.

Note This is especially critical in 
human identification experiments 
because sample quality is often 
poor.

Quantitate DNA and use the amount 
recommended in the protocol.

Note For accurate quantitation of 
human DNA samples, use the 
QuantiBlot Human DNA Quantitation 
Kit (P/N N808-0114).

(continued)

Incorrect or suboptimal thermal 
cycler parameters

Check protocol for correct thermal 
cycler parameters.

If the correct parameters were used, 
they may need to be optimized for your 
specific application. (For example 
allow a linear increase in extension 
time with increasing cycle number or 
increase time at the denaturation 
plateau.)

Observation Possible Causes Recommended Actions
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Faint or no signal from sample DNA 
and from positive control

(continued from previous page)

PCR Master Mix not well mixed 
before aliquoting

Vortex PCR Master Mix thoroughly.

Primer concentration too low Use the recommended primer 
concentration.

Primers degraded Use new primers.

Note Preincubation at 95°C for 
5–10 minutes should inactivate 
proteases or nucleases.

Note To prevent primer 
degradation during storage, store 
primers at –15 to –25°C, either 
lyophilized or in TE. Avoid excessive 
(more than 3–4) freeze-thaw cycles.

Too little free Mg2+ in reaction Check that you added sufficient total 
Mg2+ given concentration of the dNTPs 
and EDTA.

Note [Free Mg2+] = 
[Total Mg2+] – [Total dNTP] – 2[EDTA]

Incorrect pH Verify buffer pH and buffer 
concentration.

Wrong PCR tube Use:

� GeneAmp® Thin-Walled Reaction 
Tubes for DNA Thermal Cycler 480

� MicroAmp® Reaction Tubes with 
Caps for the GeneAmp PCR 
Systems 9600 and 2400

MicroAmp Base used with 
tray/retainer set and tubes in 
GeneAmp® PCR System 9600 or 
2400

Remove MicroAmp Base from 
tray/retainer set and repeat 
amplification.

Verify GeneAmp PCR System 
protocols and programmed 
parameters

Refer to the thermal cycler user’s 
manual and check instrument 
calibration.

Tubes not seated tightly in the 
thermal cycler during amplification 
(DNA Thermal Cycler 480)

Push reaction tubes firmly into contact 
with block after first cycle. Repeat 
amplification.

GeneAmp PCR System 9600 
heated cover misaligned

Align the heated cover so that white 
stripes align after twisting the top 
portion clockwise.

Poor thermal cycler performance Check instrument calibration.

Observation Possible Causes Recommended Actions
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Good signal from positive control but 
faint or no signal from sample DNA

Sample contains PCR inhibitor (for 
example, heme compounds, EDTA, 
or certain dyes)

Quantitate DNA. Dilute if possible in 
order to add minimum necessary 
volume. Repeat amplification.

Wash the sample in an Amicon 
Centricon-100 column and repeat 
amplification.

Note For fragments smaller than 
130 bp, use the Amicon Centricon-30 
column instead.

Add bovine serum albumin (BSA) to 
the PCR reaction mixture. (Use 
8–16 µg BSA for every 50 µL PCR 
reaction volume.)

Sample DNA is degraded Evaluate the quality and concentration 
of the DNA sample by:

� Using the QuantiBlot Human DNA 
Quantitation Kit (for human DNA)

� Running an agarose yield gel

If DNA is degraded or inaccurately 
quantitated, reamplify with an 
increased amount of DNA.

Insufficient sample DNA added 
because of inaccurate quantitation

Evaluate the quality and concentration 
of the DNA sample by:

� Using the QuantiBlot Human DNA 
Quantitation Kit (for human DNA)

� Running an agarose yield gel

If DNA is degraded or inaccurately 
quantitated, reamplify with an 
increased amount of DNA.

Incorrect pH Verify buffer pH and concentration.

If correct, quantitate sample DNA. Too 
little or too much DNA can alter the pH.

Primer choice not optimal (for 
example, primers may be annealing 
to sites of template secondary 
structure or may have internal 
secondary structure)

Use different primers.

Refer to the GeneScan Reference 
Guide for more information.

Tm of primers is lower than expected Decrease the annealing temperature 
by 2°C increments.

Observation Possible Causes Recommended Actions
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Amplification Troubleshooting Guide

Observation Possible Causes Recommended Actions

Poor yield for multiplex PCR Non-optimal thermal cycling parameters Between the denaturation and annealing 
stages, add a 2 minute down-ramp time 
to thermal cycling profile.

For multiplex PCR, a short down-ramp 
time is not necessarily optimal.

Competition from mispriming and other 
competing side reactions

Use AmpliTaq Gold DNA Polymerase.

Refer to the Refer to the GeneScan 
Reference Guide for more information on 
designing custom primers, multiplexing 
PCR, and Hot Start PCR.

Problems with primer choice, 
concentration, or degradation

Refer to the troubleshooting guide in the 
GeneScan Reference Guide.

Inconsistent yields with control 
DNA

Combined reagents not spun to bottom of 
PCR sample tube

Place all reagents in apex of tube and 
spin briefly after combining.

Combined reagents left at room 
temperature or on ice for extended 
periods of time (encouraging mispriming 
and other primer artifacts)

Put tubes in block immediately after 
combining reagents.

Combined reagents not thoroughly mixed Vortex all primers, reagents, and reaction 
mixes (minus enzyme) thoroughly to 
ensure uniform concentration.

Primers not uniformly suspended before 
adding to reaction mixture. (Primers can 
aggregate and settle to the bottom of the 
tube.)

Pipetting errors. Follow all these precautionary measures:

� Calibrate pipettes

� Attach tips firmly

� Check pipetting technique

� Minimize pipetting small volumes (for 
example, make master mixes)

You may also want to consider using a 
2-µL or other high-precision pipette

Yield gets progressively 
poorer for successive PCR 
amplifications performed over 
time

Expired or mishandled reagents Check expiration dates on all reagents. If 
not expired, verify that reagents are being 
stored and used according to 
manufacturer’s instructions.

Compare with PCR performance using 
fresh reagents.

Poor yield for multiplex PCR Non-optimal thermal cycling parameters Between the denaturation and annealing 
stages, add a 2 minute down-ramp time 
to thermal cycling profile.

For multiplex PCR, a short down-ramp 
time is not necessarily optimal.
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Resolution Troubleshooting Guide

Observation Possible Causes Recommended Actions

Fuzzy or smeared bands 
in electropherogram

Dirty gel plates Clean plates with Alconox cleaner and a 
soft cloth, then rinse thoroughly with 
distilled, deionized water.

Excess urea in wells before loading Flush wells immediately before loading.

Incorrect TBE buffer formulation Remake buffer, carefully following 
protocol.

Worn or damaged spacers causing variable 
gel thickness

Replace damaged spacers.

Poor resolution 
throughout size range

Poor quality or old reagents Remake 10X TBE and gel solution stock 
using fresh reagents from a reliable 
source.

IMPORTANT Urea must be ultrapure.

Formamide degraded to formic acid and 
formate ions (denaturing applications only)

Use freshly deionized formamide. 
(Deionization procedure in Appendix A.)

Note Formamide pH should be 
between 7 and 9.

Small bubble between load and read region Cast gel as described in protocol.

Note Make sure plates are lint-free 
before pouring gel. 

Incomplete strand separation due to 
insufficient heat denaturation

Make sure the samples are heated at 
95 °C for 5 minutes prior to loading in gel. 

Misshapen wells

Note If only a few wells are misshapen, 
you can still load the gel using only those 
lanes with flat, well-formed wells.

To prevent suction when removing the 
comb:

a. Lay gel flat.

b. Pour 1X TBE over comb.

c. Remove comb slowly.

Ensure that no air is trapped by comb 
during insertion.

Wrong TBE buffer formulation Remake buffer, carefully following 
protocol.

Catastrophic loss of 
resolution (bands tilted 
and poorly resolved)

Gel extruding from between plates. See “Gel 
Extrusion” on page 4-29 for more 
information.

Clean the plates with an alcoholic KOH 
wash (page 4-30) or a 3 M HCl wash 
(page 4-31).
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For GeneScan applications only, see also “Optimizing Electrophoresis Conditions for 
GeneScan Applications” on page 4-34.

Poor resolution Poor quality reagents, especially acrylamide Use fresh reagents from a reliable source

Small bubble(s) between load and read 
region

� Clean plates thoroughly

� Cast gel carefully. Remove bubbles by 
tapping plates while pouring. See 
Chapter 2 for more information.

Well shape not flat � Check for air bubbles trapped by comb

� Remove comb carefully

� Only load in flat wells

� Do not push shark’s-tooth combs too far 
into the gel

Old buffer � Make 1X fresh daily

� Do not use 10X TBE which has 
precipitated

Old gel � Use gels within 2–6 hours of casting

IMPORTANT Do not refrigerate.

Gel not allowed to polymerize long enough � Allow gel to polymerize the full length of 
time recommended by the protocol

Gel stored under/in bright light � Do not store gel under or in bright light

Variation in spacers Use spacers and comb sets that are of 
equal thickness.

Temperature of room, gel solution, or glass 
too warm or cool during polymerization

20–23°C is optimal.

Observation Possible Causes Recommended Actions
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Sample Mobility Troubleshooting Guide

Observation Possible Causes Recommended Actions

Inconsistent mobilities from gel to gel Total % polymer wrong � Follow protocol carefully

Wrong concentration of Bis � Follow protocol carefully

Wrong buffer concentration � Follow protocol carefully

� Do not use 10X TBE which has 
precipitated

Poor quality reagents or old urea � Remake the 10X TBE and 
acrylamide stock solution using 
highest grade reagents.

� Use ultra pure urea

Dissolved O2 concentration � Keep vacuum strength/time 
constant

� Stir/pour gel solutions gently

� Filter/pour gels at 20–23°C

Variation in spacers � Use spacers and comb sets of 
equal thickness

Temperature of room, gel solution or 
glass varies

� 20–23°C is optimal

Slow mobility Total polymer concentration too high Check reagents. Prepare new 
solutions using fresh reagents.Bisacrylamide concentration too high

Buffer concentration too low

Old gel Pour a fresh gel and use within 2 to 
6 hours of casting

IMPORTANT Do not refrigerate.

Mobility too quick Total polymer concentration too low Check reagents. Prepare new 
solutions using fresh reagents.

Note Do not use TBE buffer if it 
has precipitate in it.

Bisacrylamide concentration too low

Buffer concentration too high
Troubleshooting 4-19



About Troubleshooting Software

Log File Error
Messages

Macintosh® computer operating errors are recorded in Log files. A Log file is created 
for each run, and is stored in the corresponding Run folder. The log lists error 
messages displayed during data collection including computer and instrument 
firmware errors. 

Software-related errors are usually due to problems with: 

� Memory

For example, the computer might not have enough memory to handle a certain 
function, or the data collection program might not have been allocated enough 
memory when launched.

� File searching

For example, data collection software may not be able to locate a file it needs to 
open or save. Or, a file might be corrupted.

� Hard Disk

Any hard disk problem will result in an error message.

Check these areas if the Log file lists Macintosh errors. Run Norton Utilities™ Disk 
Doctor to check the hard disk, and correct recurring problems.
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About Troubleshooting Firmware

About the Firmware The firmware required to run the instrument is stored in memory on the instrument. A 
copy of the firmware is also included as part of the data collection software, and is 
stored as a file in the ABI PRISM 377 folder.

The firmware is downloaded from the computer to the instrument during system 
installation. This occurs automatically when the instrument is turned on and data 
collection software is launched for the first time. If the instrument is turned off between 
runs, a battery backup keeps the firmware stored in instrument memory.

New versions of data collection software received after system installation can also 
include new firmware. When installed on the computer and launched for the first time, 
the software will ask if the firmware on the instrument should be upgraded.

A power outage can sometimes clear the instrument memory, or the firmware can 
become corrupt. Below is a list of symptoms that can indicate corrupt firmware on the 
instrument, and recommended corrective actions.

Symptoms of
Corrupt Firmware

If any of the following symptoms occur, perform a single reset (see page 4-22): 

� Flat scan lines or no scan lines when they should be present in the Scan window

� No response to commands from the computer

If any of the following symptoms occur, perform a total reset or cold boot as 
appropriate (see pages 4-22 and 4-23):

� No response to commands from the computer even after performing a single reset

� Rear panel LEDs are stuck in one pattern, e.g. all on or all off

� The computer cannot load a new image onto the instrument

� The computer appears to have downloaded a new firmware image onto the 
instrument, however, 

– the instrument still does not run

– the rear panel LEDs remain stuck in one pattern
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Performing a Single Reset

Procedure Using the eraser end of a pencil or similar object, press the red reset button on the 
back of the instrument once. If communication is not restored, perform a total reset as 
described below.

Performing a Total Reset

What is a Total Reset When a total reset is performed, the firmware currently installed on the instrument is 
erased. Data collection software must be restarted so that a new copy of the firmware 
is loaded automatically onto the instrument

Procedure To perform a total reset:

Step Action

1 Using the eraser end of a pencil or similar object, press the red reset button on the 
back of the instrument twice in rapid succession.

2 Quit the data collection software program.

3 Relaunch the data collection software program. The firmware is automatically 
downloaded to the instrument. This will take 60–90 seconds.

Note If the following dialog box is displayed, see “Locating the Firmware Image 
File” on page 4-24.

4 In response to this prompt, quit and then relaunch the data collection software 
program again.
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Performing a Cold Boot

Overview If the computer and instrument are communicating, but the instrument does not 
respond appropriately, the firmware image may be corrupted. Download a new copy of 
the firmware using Cold Boot Instrument.

Procedure To cold boot the instrument:

5 Check the CCD pixel position value as follows:

a. Open the Window menu and select Manual Control.

b. Open the Fxn Name menu and select CCD Pixel Position Value.

The value is displayed in the Value box. If it matches the value on the instrument, it 
is ok. If it does not match, correct the value. See “CCD Pixel Position Value” on 
page 4-25 for more information.

Step Action

Step Action

1 Select Manual Control from the Window menu in the data collection software 
program.

2 Open the Fxn Name pop-up menu.

3 Select Cold Boot Instrument, and click Execute.

The current firmware image is erased from memory, and the status lights on the 
front of the instrument change from green (ready) to flashing yellow.

4 Open the File menu, and select Quit.

5 Launch the data collection software program. The firmware is automatically 
downloaded to the instrument.

Note If the following dialog box is displayed, see “Locating the Firmware Image 
File” on page 4-24.
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Locating the Firmware Image File

Location of the
Firmware File

The firmware required to run the instrument is stored in memory on the instrument. A 
copy of the firmware is also included as part of the data collection software, and is 
stored in the ABI PRISM 377 folder.

The location of the firmware on the computer must be specified as one of several 
Folder Location Preferences. Folder Location Preferences are set during system 
installation. If files or folders are renamed or moved after installation, data collection 
software may not be able to locate the firmware image file when necessary. If this 
occurs, a dialog box asking “Where Is? ABI Prism 377 Firmware” is displayed.

Follow the procedure listed below to locate and download the firmware. Refer to 
Chapter 5, “Setting Preferences,” for more information.

Procedure To locate and download the firmware:

Folder containing Firmware file

Firmware file

Step Action

1 Open the pop-up menu in the dialog box, and locate the folder containing the 
firmware image file. Unless changed after system installation, the filename is 
ABI Prism 377 Firmware. It is located in a folder named Firmware Image inside the 
ABI PRISM 377 folder.

2 Click Open. Software automatically downloads the file to the instrument.

3 Once the file is downloaded, the following alert box is displayed. Click Quit.

4 Double-click the ABI Prism 377 Collection icon to launch the data collection 
software.
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CCD Pixel Position Value

Overview The charge coupled device (CCD) pixel position value is a reference point for the 
alignment of the CCD camera with the laser beam. The instrument is shipped with the 
correct CCD pixel position value stored in its memory. When you start a run, the Data 
Collection software checks for a value greater than zero. If not found, the following 
error message is displayed.

Follow the procedures “Location of the CCD Pixel Position Value” and “Checking and 
Entering the CCD Pixel Position Value” on page 4-26 to locate and reenter the value.

Calibration File
Make and Send

Two functions—Calibration File Make and Calibration File Send—allow you to create a 
file that contains the CCD pixel position value and instrument serial number. This file is 
called ABI 377 Calibrations, and is stored in the Preferences folder inside the System 
folder. The benefits to using these functions are as follows.

� Simply use Calibration File Send to reenter the CCD pixel position value, rather 
than manually locating and reentering the value.

� Once Calibration File Send is executed, the instrument serial number is added to all 
sample files, and is visible when sample files are opened in the annotative view. 
This is useful for tracking and troubleshooting, particularly when more than one 
instrument is in operation.

See “Using Calibration File Make and Send” on page 4-27 for more information.
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Location of the CCD
Pixel Position Value

The correct CCD pixel position value is printed on a white label affixed to the CCD 
camera. The label is visible from the front of the instrument through the opening below 
the rear heat-transfer plate.

Locating the CCD
Pixel Position Value

To locate the CCD pixel position value:

Checking and
Entering the CCD

Pixel Position Value

To enter the CCD pixel position value

Rear heat-transfer 
plate

CCD camera with 
pixel position label 
visible here

Step Action

1 Have a flashlight available.

2 Open the front door of the instrument.

3 Shine the flashlight through the opening below the rear heat-transfer plate, and 
locate the white label on the CCD camera.

4 Record the value from the white label.

5 If you cannot find the label, call Applied Biosystems technical support (telephone 
numbers listed in Chapter 1.)

Step Action

1 Turn power on to the instrument.

2 Select Manual Control from the Window menu in the data collection software. 

3 Open the Fxn Name pop-up menu, and select the CCD Pixel Position function.

The current pixel position value is displayed. If it is the same as the value on the 
white label, do not complete the remaining steps. If the value is different, continue.

4 Select the text box, and type the correct CCD pixel position value.

5 Click Execute.

6 If the CCD Pixel Position error occurs again, call Applied Biosystems technical 
support (telephone numbers listed in Chapter 1.)
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Using Calibration File Make and Send

Function
Description

Two functions—Calibration File Make and Calibration File Send—allow you to create a 
file that contains the CCD pixel position value and instrument serial number. This file is 
called ABI 377 Calibrations, and is stored in the Preferences folder inside the System 
folder. The benefits to using these functions are as follows.

� Simply use Calibration File Send to reenter the CCD pixel position value, rather 
than manually locating and reentering the value as described under “CCD Pixel 
Position Value” on page 4-25.

� Once Calibration File Send is executed, the instrument serial number is added to all 
sample files, and is visible when sample files are opened in the annotative view. 
This is useful for tracking and troubleshooting, particularly when more than one 
instrument is in operation.

Using Calibration
File Make

IMPORTANT The correct CCD pixel position value must be entered in instrument memory 
before using Calibration File Make. See “Location of the CCD Pixel Position Value” and 
“Checking and Entering the CCD Pixel Position Value” on page 4-26.

Creating the ABI 377 Calibrations File

Adding the Serial Number to the ABI 377 Calibrations File

Add the instrument serial number to the ABI 377 Calibrations File. 

To create an ABI 377 Calibrations file: 

Step Action

1 Turn power on to the instrument.

2 Select Manual Control from the Window menu. 

3 Open the Fxn Name pop-up menu.

4 Select Calibration File Make.

5 Click Execute, and select Save from the File menu.

To enter the instrument serial number in the calibrations file: 

Step Action

1 Make a note of the serial number from the back of the instrument.

2 Open the System folder, then the Preferences folder, and then the ABI 377 
Calibration file.

3 Select the series of question marks displayed, and then type the instrument serial 
number in their place.

4 Open the File menu and select Save.

5 Close the ABI 377 Calibrations file.

6 Quit the SimpleText program.
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Using Calibration
File Send

To send the ABI 377 Calibrations file information to the instrument:

Step Action

1 Turn power on to the instrument.

2 Open the Window menu and select Manual Control. 

3 Open the Fxn Name pop-up menu and select Calibration File Send.

4 Click Execute.

The CCD pixel position value and instrument serial number are sent to the 
instrument.
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Temporary Loss of Signal

Description This problem manifests itself as a band of little or no signal across the entire width of 
the gel image. It usually occurs between 150 and 250 bases. Temporary loss of signal 
has been traced to contaminants on the gel plates. These contaminants include 
surfactants, fatty acids, and long chain polymers.

Solution Rinsing glass plates in a dishwasher with hot deionized water (90°C) has been found 
in most cases to remove the contaminants that cause temporary loss of signal.

In a few cases where a dishwasher did not work well, soaking the plates overnight in a 
5% solution of Multiterge detergent (VWR Scientific, P/N 34171-010) eliminated the 
temporary loss of signal.

Gel Extrusion

Description When voltage is applied on the ABI PRISM® 377 DNA Sequencer, the polyacrylamide 
gel sometimes moves from between the glass gel plates toward the cathode (upper 
electrode) and into the upper buffer chamber. Up to about five centimeters of gel in a 
folded sheet can be deposited in the chamber.

This “gel extrusion” usually begins at the start of a run or even during the prerun. It is 
believed to be caused by a buildup of charge on the surface of the glass plate such 
that the gel is not bound to the plate after pouring. As the voltage is applied, the gel 
migrates toward the upper electrode.

The gel image can show a variety of anomalous effects, including catastrophic loss of 
resolution, lane splitting, extreme band tilt, and band distortion.

Solution Almost all known cases of gel extrusion have been resolved by alcoholic KOH washing 
or acid washing. See “Performing an Alcoholic KOH Wash” on page 4-30 and 
“Performing a 3 M HCl Wash” on page 4-31.
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Performing an Alcoholic KOH Wash

Procedure The following procedures are not meant to be used for regular gel plate maintenance, 
but for decontamination. For regular plate cleaning, we recommend using a 
dishwasher with a hot, deionized water rinse.

! WARNING ! Preparation of all solutions should be carried out in a hood using 
safety glasses, gloves, and other appropriate protective clothing.

To perform an alcoholic KOH wash: 

Step Action

1 Add 30–35 g of potassium hydroxide (KOH) or sodium hydroxide (NaOH) pellets to 
a plastic bottle.

! WARNING ! Potassium hydroxide is hygroscopic and caustic. It can 
cause severe burns and blindness if it comes in contact with the skin or eyes. 
Always work in a fume hood. Obtain a copy of the MSDS from the 
manufacturer. Wear appropriate protective eyewear, clothing, and gloves.

2 Add 200 mL of absolute ethanol to the bottle.

! WARNING ! CHEMICAL HAZARD. Ethanol is a flammable chemical and 
is irritating to the skin, eyes, respiratory system. It can cause nerve and liver 
damage, CNS depression, nausea, vomiting, and headache. Always work in a 
fume hood. Obtain a copy of the MSDS from the manufacturer. Wear 
appropriate protective eyewear, clothing, and gloves.

3 Mix the solution well. It will take at least 15 minutes for most of the pellets to 
dissolve.

Note This recipe is for a saturated solution, so some pellets will remain. Store 
the solution with the bottle capped tightly. During storage, the color of the solution 
will turn dark red-brown. The solution can still be used, and is good for 1 year.

4 Place some uncolored absorbent towels or other covering in the hood to catch 
spills.

5 Place the gel plates on the towels with the inside surfaces facing up.

Note The plates should be nearly level so that the cleaning solution does not 
run off onto the bench. Only the inside (gel side) surface of the plates need be 
cleaned, though the outside surfaces can be cleaned similarly.

6 Pour approximately 15 mL of the cleaning solution onto the center of each plate to 
be cleaned. Spread the solution over the surface of plate.

7 Allow the solution to remain on the plates for 5 minutes.

CAUTION Longer times can harm the plates.

8 Rinse the plates thoroughly with distilled, deionized water. Allow plates to dry.

Note Avoid other cleaning procedures or solutions that may reintroduce 
contaminants to the plates.
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Performing a 3 M HCl Wash

Procedure To perform a 3 M HCl wash:

Removing Gasket Marks from Glass Plates

Procedure An alcoholic KOH wash can also be used to remove buffer chamber gasket marks 
from the plates.

Step Action

1 Place some uncolored absorbent towels or other covering in the hood to catch 
spills.

2 Pour 10 mL of concentrated HCl (12 N, 37%) carefully into 30 mL of water and mix 
thoroughly.

! WARNING ! Hydrochloric acid (HCl) is a very corrosive liquid. Always 
work in a fume hood to avoid inhalation. Obtain a copy of the MSDS from the 
manufacturer. Wear appropriate protective eyewear, clothing, and gloves.

3 Place the plates on the towels with the inside surfaces facing up.

Note The plates should be nearly level so that the cleaning solution does not 
run off onto the bench. Only the inside (gel side) surface of the plates need be 
cleaned, though the outside surfaces can be cleaned similarly.

4 Pour approximately 15 mL of the cleaning solution in the center of each plate to be 
cleaned. Spread the solution over the surface of plate.

5 Allow the solution to remain on the plates for 5 minutes.

Note Longer times will not harm the plates but are unnecessary.

6 Rinse the plates thoroughly with distilled, deionized water. Allow plates to dry.

Note Avoid other cleaning procedures or solutions that can reintroduce 
contaminants to the plates.

Step Action

1 Perform steps 1–5 above.

2 Pour approximately 15 mL of the cleaning solution onto the area of the plate where 
the gasket mark is.

3 Allow the solution to remain on the plates for 10 minutes.

CAUTION Longer times can harm the plates.

4 Repeat steps 2 and 3.

5 Rinse thoroughly with deionized water.

6 Clean plates as usual.
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Removing Coolant System Clogs

Clog Indicators If tap water is used in the water reservoir, calcium buildups can occur, particularly in 
regions with hard water. Calcium buildup can cause the following problems:

� Flow switch sticks and plugs up

� High resistance to flow through heat plates

� Quick-disconnect fittings leak due to buildup behind the seals

� Warning displayed that the pump has shut down during a run

� Poor resolution due to a gel running too cold (accompanied by a warning that the 
pump has shut down)

� Error message that the heat plate temperature exceeds 70°C even though the 
status window indicates less than 70°C

Note The error message, “Heat plate temperature exceeds 70°C,” is triggered by either the 
plate sensors or heater sensor. If the flow switch sticks in the flowing position due to calcium 
deposits, the pump shuts down, but the heater continues to operate in an attempt to raise the 
temperature of the front heat-transfer plate. When the temperature of the heater exceeds 70°C, 
the error message is displayed.

Recommendations � Flush the system with a mild acid solution to remove calcium deposits. The cleaning 
solution and procedure are listed below.

� Refill the water reservoir with a solution of deionized water and 5.0% antifreeze. 
Refer to “Refilling the Water Reservoir” in Chapter 8, “System Maintenance,” for 
more information.

Cleaning Solutions Calcium deposits can usually be removed by flushing the system with a mild acid 
solution. Commercially available de-scaling solutions for removing deposits in coffee 
pots or hot water systems are recommended. Follow all precautions on the label when 
working with these solutions. If necessary, use a 3.0% by volume nitric acid solution.

! WARNING ! Do not use nitric acid with a higher concentration. Full strength nitric 
acid is 15.99N and should be diluted for use in this procedure.

! WARNING ! CHEMICAL HAZARD. Nitric acid (fuming) is an extremely corrosive 
oxidant. 3% nitric acid should be prepared by trained personnel only. Do not inhale 
vapor. Work in a well-ventilated area in a fume hood, and wear respiratory protection 
suitable for acid vapor. When diluting nitric acid, ALWAYS ADD ACID TO WATER or to 
aqueous solutions. Obtain a copy of the MSDS from the manufacturer. Wear full 
protective clothing, including eye and face coverings, rubber gloves, and rubber apron.

! WARNING ! HAZARDOUS WASTE/EXPLOSION HAZARD. Nitric acid waste must 
be emptied into the AQUEOUS waste bottle. DO NOT mix nitric acid waste with ORGANIC 
waste products, such as phenol. The mixture is potentially highly explosive. Always work 
in a fume hood. Wear appropriate eyewear, clothing, and gloves when handling TEMED 
solutions. Dispose of the contents of the waste tray and waste bottle in accordance with 
all applicable local, state, and federal health and environmental regulations.

! WARNING ! ELECTRICAL SHOCK HAZARD. The ABI Prism 377 contains a high 
voltage power supply. Although the instrument has been designed with safety features in 
the door to disconnect the power supply when the door is open, please follow 
procedures as prescribed. As with any electrophoresis apparatus, be careful during 
instrument operation and when handling electrodes and liquids.
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Procedure To flush the system with a cleaning solution:

To flush the cleaning solution out of the instrument:

To fill the water bottle:

Step Action

1 Power on the instrument.

2 Open the panel on the right side of the instrument to access the water reservoir.

3 Place paper towels under the bottle.

4 Unscrew the water bottle and properly dispose of the fluid.

5 Fill the bottle with 800 mL of cleaning solution and reattach the bottle to the 
instrument.

6 Open the Collection software, if it is not already open.

7 Turn the pump on.

a. Open the Window menu and select Manual Control.

b. Open the Fxn Name pop-up menu and select Pump On.

c. Enter 51 in the Value box and click Execute.

8 Allow the solution to circulate for 15 to 30 minutes.

9 Turn the pump off.

a. Open the Fxn Name menu and select Pump Off.

b. Click Execute.

Step Action

1 Open the panel on the right side of the instrument to access the water reservoir.

2 Unscrew the water bottle and properly dispose of the cleaning solution.

3 Fill the bottle with 800 mL of deionized water and reattach the bottle to the 
instrument.

4 Turn the pump on.

a. Open the Window menu and select Manual Control.

b. Open the Fxn Name pop-up menu and select Pump On.

c. Enter 51 in the Value box and click Execute.

5 Allow the water to circulate for 1-2 minutes.

6 Turn the pump off.

a. Open the Fxn Name menu and select Pump Off.

b. Click Execute.

7 Repeat steps 1-6 three more times to ensure the cleaning solution has been 
removed.

Step Action

1 Unscrew the water bottle and properly dispose of the solution.

2 To prevent calcium and other mineral deposits from reoccurring, refill the system 
with a solution of deionized water and 5.0% antifreeze. Refer to “Refilling the Water 
Reservoir” in Chapter 8, “System Maintenance,” for more information.
Troubleshooting 4-33



Optimizing Electrophoresis Conditions for GeneScan Applications

Introduction Optimizing electrophoresis conditions (run time, run voltage, and run temperature) for 
GeneScan applications can greatly improve data quality, run-to-run precision, and/or 
throughput. When selecting values for these parameters, consider the following 
factors:

� Range of fragment lengths

� Required degree of resolution

� Type of genetic analysis you will be performing

For example, does the application require native or denaturing conditions? 

The preset electrophoresis parameters in the application modules are set to ensure 
the following:

� Detection of all fragments in the typical size range permitted by the application

For example, microsatellite loci are rarely over 400 base pairs in length.

� Acceptable run times

� Acceptable resolution

Definition of
Resolution

The resolution, Rs, of two peaks in an electropherogram is defined as follows:

where the Pi are the peak positions measured below the peak apex and the Wi are the 
peak widths measured at half peak maximum.

Modifying Run Time Determining Required Run Time

To determine the minimal acceptable run time for a given run voltage, you will need to 
perform a trial run. To ensure that you collect sufficient data to perform analysis, set 
the electrophoresis run time approximately 10% higher than the migration time of the 
largest fragment of interest.

In general, the migration time of the 400-bp fragment in the GeneScan-400HD Internal 
Lane Size Standard is 2 hours on a 36-cm well-to-read 5% Long Ranger gel.

Note The “largest fragment of interest” will most probably be a size-standard peak that is 
needed for sizing the largest sample fragments of interest. The set of size-standard peaks that 
GeneScan uses to generate the sizing curve can vary with the size-calling method. In general, 
be sure to include the two size-standard peaks immediately larger than the largest sample 
fragment of interest. 

Decreasing Run Time

For faster run times, you can increase the electrophoresis voltage, but this can 
decrease the resolution.

Rs

P1 P2–

0.5 W1 W2+( )×
-----------------------------------------=
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Modifying
Electrophoresis

Temperature

Perform native applications and non-denaturing applications, such as SSCP, at lower 
temperatures (27–42°C).

Protocols for most denaturing applications specify a 51°C run temperature.

For More
Information

For information on setting electrophoresis parameters, refer to “Modifying and 
Creating Modules” on page 9-45 in Chapter 9.
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Setting Preferences 5
Chapter Contents

In This Chapter The following topics are discussed in this chapter:

What Are Preferences

About Preferences Preferences are default settings selected by the user in the data collection software. 
Certain preferences, such as the folder locations, must be set to operate the 
instrument, save and retrieve files, and process the data generated by runs. Other 
preferences are designed to save you time and customize the system. For example, 
you can reduce the time spent setting up sample and run sheets by changing certain 
sample and run sheet defaults to reflect the type of run performed most often. Most 
preferences have factory-set default values. All preferences (including the factory-set 
defaults) can be changed at any time.

Topic See page

What Are Preferences 5-1

Where are Preferences Stored 5-2

Viewing and Modifying Preferences 5-3

If the Preferences File Becomes Corrupt 5-4

Folder Location Preferences 5-5

Default File Name Preferences 5-8

Sequencing Sample Sheet Preferences 5-10

Sequencing Run Sheet Preferences 5-11

GeneScan Sample Sheet Preferences 5-12

GeneScan Run Sheet Preferences 5-13

General Settings 5-15

Dye Indicator Preferences 5-17

Project Information Preferences 5-20
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List of Preferences The following is a brief description of each preference.

Where are Preferences Stored

Location Preferences are stored in a file that has one of the following names:

� ABI  377 (for standard ABI PRISM® 377 instruments)

� ABI 377XL (for ABI PRISM 377 instruments with the XL upgrade)

� ABI 377-96 (ABI PRISM 377 instruments with the 96-lane upgrade)

� ABI 377-18 (ABI PRISM 377-18 instruments)

The preferences file is located inside the Preferences folder which is located inside the 
System Folder on the hard disk.

Preference Description
See 
page

Folder Locations Location of the folders on the hard disk in which the 
following are stored: sample sheets, standard and chiller 
modules, Run folders and files, the firmware image, 
general settings, matrix/instrument files, GeneScan® 
software analysis parameters, and GeneScan size 
standard files.

5-5

Default File Names Naming convention used by data collection software to 
automatically name the new files and folders created for 
each run.

5-8

Sequencing Sample 
Sheet Defaults

User-designated parameters on sequencing sample 
sheets.

5-10

GeneScan Sample 
Sheet Defaults

User-designated parameters on GeneScan sample sheets. 5-12

Sequencing Run 
Sheet Defaults

User-designated parameters on sequencing run sheets. 5-11

GeneScan Run 
Sheet Defaults

User-designated parameters on GeneScan run sheets. 5-13

General Settings Instrument name, global serial number, plate check 
module, communication port, and minimum number of 
scans.

5-15

Dye Indicators Colors used to display data on the computer screen and to 
print data.

5-17

Project Information For BioLIMS® software users only. Project information 
required to properly identify data transferred to BioLIMS.

5-20
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Viewing and Modifying Preferences

How To The information in the preferences file cannot be viewed or modified by double- 
clicking on the file icon.

To view and/or modify preferences:

Detailed instructions for modifying each preference are located in this chapter.

Step Action

1 Launch the data collection software.

2 Open the Window menu, and select Preferences to open the preferences menu.

3 Select a preference. A dialog box is displayed in which you can view and modify the 
current settings for that particular preference. The preferences file is modified 
whenever you click OK in a preferences dialog box. 
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If the Preferences File Becomes Corrupt

Indicators Occasionally, the preferences file becomes corrupted. When this occurs, you will 
either be unable to launch the data collection software, or you will experience 
problems with the application.

Note If you launch the data collection software and a dialog box asking you to set folder 
locations preferences is displayed, you need only to reset the folder locations preferences to 
continue. See “Folder Location Preferences” on page 5-5.

To Create a New
Preferences File

To create a new preferences file:

Step Action

1 If open, quit the data collection software program.

Note Data collection software must not running while you perform this 
procedure.

2 Open the System Folder.

3 Open the Preferences folder.

4 Click on and drag the existing preferences file to the trash, and empty the trash.

Depending on the type of ABI PRISM 377 instrument you have, the preferences file 
will be named ABI 377, ABI 377XL, ABI 377-96, or ABI 377-18.

5 Launch the data collection software.

6 Set the folder locations preferences.

See “Folder Location Preferences” on page 5-5 for more detailed instructions.

7 Reset the remaining preferences that you use. 

Detailed instructions are listed by preference in this chapter.
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Folder Location Preferences

Setting Folder
Location Preferences

The folder locations for the following types of files and folders must be designated to 
perform a run, and to handle the data generated during a run:

� Sample sheets

� Module files

� Run folders

� Firmware image file

� Settings

� GeneScan analysis parameters (for GeneScan users only)

� GeneScan size standards (for GeneScan users only)

Software must know where to put and/or locate these files to operate the instrument 
and automate various tasks. For example, the selections displayed in the various 
pop-up menus on sample and run sheets are located in these folders. 

Typically these folders are located on the local hard disk. The folder names and 
locations listed below are the ones specified during system installation. The settings 
can be changed at any time. If changes are made, the new folder location and/or 
name must be specified in the Preferences Folder Locations dialog box (page 5-6).

Folder
Location and 
Folder Name* Description

Sample Sheet Folder Macintosh HD: 
ABI Prism 377: 
Sample Sheets

Contains all the sample sheets. When 
setting up a run sheet, the selections 
displayed on the pop-up menu for sample 
sheets are the files stored in this folder.

Module Folder Macintosh HD: 
ABI Prism 377: 
Modules

Contains the Plate Check, PreRun, and Run 
modules. When setting up a run sheet, the 
selections displayed on the Plate Check, 
PreRun, and Run Module pop-up menus are 
the files stored in this folder.

Chiller Modules 
Folder

Macintosh HD: 
ABI Prism 377: 
Chiller Modules

Contains chiller Plate Check, PreRun, and 
Run modules. When setting up a run sheet, 
the selections displayed on the Plate Check, 
PreRun, and Run Module pop-up menus are 
the files stored in this folder.

Folder Containing 
Run Folders

Macintosh HD: 
ABI Prism 377: 
Runs

Contains the Run folders. A new Run folder 
is created for each run. At the end of data 
analysis, each new Run folder contains a 
gel file, log file, run sheet, and sample files.

Firmware File Folder Macintosh HD: 
ABI Prism 377: 
Firmware Image

Contains the firmware image file.

* IMPORTANT Locations and folder names listed are those at the time of system 
installation. We strongly recommend not changing folder names and locations.

‡ = Displayed in Folder Locations dialog box for GeneScan users only.
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Settings Folder Macintosh HD: 
System folder: 
ABI Folder

Typically set as the ABI Folder. The choices 
in other Preferences dialog boxes and in 
Run windows use the information contained 
in this folder for their pop-up menus (e.g. 
dye/set primer files, instrument/matrix files.)

IMPORTANT To automatically analyze 
data after a run using the sequencing 
analysis software, the Settings folder must 
be designated as the ABI folder.

GeneScan Analysis 
Parameters‡

Macintosh HD: 
GeneScan Analysis 
x.x: 
GS Parameters 
Folder

Contains the parameters used to analyze 
GeneScan run data, and is located in the 
GeneScan Analysis software folder.

GeneScan Size 
Standard Folder‡

Macintosh HD: 
GeneScan Analysis 
x.x: 
GS Standards 
Folder

Contains the size standard definitions used 
to analyze GeneScan run data, and is 
located in the GeneScan Analysis software 
folder.

To set the Folder Location preferences: 

Step Action

1 If the Preferences dialog box … Then …

is not open open the Window menu, select 
Preferences, and then select Folder 
Locations.

is open open the Page pop-up menu and select 
Folder Locations.

2 Click the box that corresponds to the folder location you wish to set.

Folder
Location and 
Folder Name* Description

* IMPORTANT Locations and folder names listed are those at the time of system 
installation. We strongly recommend not changing folder names and locations.

‡ = Displayed in Folder Locations dialog box for GeneScan users only.

Click in these boxes to select 
and change a folder location

Displayed for GeneScan 
users only
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3 Using the pop-up menu in the dialog box that is displayed, locate and select the 
appropriate folder by clicking the folder once only.

IMPORTANT To automatically analyze data with ABI PRISM® DNA Sequencing 
Analysis Software on the same computer used for data collection, the Settings 
Folder must be designated as the ABI Folder (shown below).

4 Click the Select box underneath the list of folders (step 4 in the illustration above.) 
Do not click Open.

5 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.

To set the Folder Location preferences: (continued)

Step Action

2. Use this pop-up 
menu to locate 
the desired folder

3. Click the folder 
once only to 
highlight it

4. Click here to set 
the preference

1. The text above the menu indicates the folder location 
preference currently being set, and corresponds to 
the “select” button at the bottom of the box.
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Default File Name Preferences

Default File Name
Preferences

Data collection software automatically names the new files and folders created for 
each run. These files and folders consist of:

� Sample sheets

� Run folders

� Run files

� Gel files

� Sample files (created after a run from the gel file)

Sample Sheet, Run
Folder, and Run

Sheet Names

The default naming convention for sample sheets, run folders, and run sheets is 
shown in the File Names Preferences window above. For example, a sample sheet 
created at 3:39 PM on June 30, 1998 would have a default name of: 
Sample Sheet–1/30/98 3.39 PM. The date and time are added as a suffix.

Folder and file names can be any text string or nothing at all. You can also choose not 
to display the date and time.

Sample File Names By default, Sample File names have a prefix and a suffix. Choices for the prefix are 
lane number or sample name. Choices for the suffix are:

� Nothing <none>

� The current date and time <date>

� A serial number reset to zero at the start of each run <serial number> 

� A serial number that increments across runs <global serial number>

� The sample name from the file’s sample sheet <sample name>

IMPORTANT Limit the number of characters in sample file names to 27 or less. Do not use 
colons, slashes, or symbols in sample names.
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Changing Folder
and File Name

Preferences

To change folder and file name preferences:

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, 
select Preferences, and then select File 
Names.

is open open the Page pop-up menu and select 
File Names.

2 For sample sheets, run folders, and run sheets:

a. Enter the file or folder name desired in the appropriate field.

b. Open the associated pop-up menu to specify the date and time (<date>), or 
nothing (<none>) as a suffix.

3 For Sample Files:

a. To change the prefix, open the prefix pop-up menu and make a new selection.

b. To change the suffix, open the suffix pop-up menu and make a new selection.

IMPORTANT Limit the number of characters in sample file names to 27 or less. 
Do not use colons, slashes, or symbols in sample names.

Note The global serial number can be reset by changing the value in the General 
Settings Preferences window. Refer to page 5-15 for more information.

4 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.

Type new names
directly in these fields

Sample File prefix 

Sample File suffix
pop-up menu

Type option-8 to 
make a bullet

pop-up menu
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Sequencing Sample Sheet Preferences

Setting Sequencing
Sample Sheet

Preferences

Two parameters can be set as preferences on Sequencing sample sheets:

� DyeSet/Primer

� Instrument File

The factory-default setting for both these parameters is none. As such, the 
DyeSet/Primer and Instrument File must be manually selected each time a new 
sample sheet is created. 

To save time preparing sample sheets, set the defaults for these parameters to reflect 
the type of run most commonly performed.

To change sequencing sample sheet preferences: 

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, 
select Preferences, and then select 
Sequence Sample Sheet Defaults.

is open open the Page pop-up menu and select 
Sequence Sample Sheet Defaults.

2 To change the default settings:

a. Open the DyeSet/Primer or Instrument File pop-up menu.

b. Select the desired file from the pop-up menu. 

3 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.

DyeSet/Primer
pop-up menu
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Sequencing Run Sheet Preferences

Setting Sequencing
Run Sheet

Preferences

The following parameters can be set as preferences for sequencing run files:

� Operator

� Well-to-read (WTR) distance in centimeters

� Lanes

� PreRun module

� Run module

� Autoanalyze

� Auto Print

To change sequencing run file preferences: 

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, 
select Preferences, and then select 
Sequence Run Defaults.

is open open the Page pop-up menu and select 
Sequence Run Defaults.

2 To enter an operator’s name, type the name directly into the Operator field.

3 To change the default setting for the WTR distance, Lanes, PreRun Module, and Run 
Modules, open the pop-up menu for each parameter, and select the desired default.

4 To specify that data be automatically analyzed by the sequencing analysis software:

a. Select the box labeled “Autoanalyze with”.

b. Open the autoanalyze pop-up menu, select Other …

c. Locate and select (double-click or OPEN) the appropriate analysis application 
(ABI PRISM DNA Sequencing Analysis Software).

5 To specify that data be printed automatically at the end of each run, select the check 
box labeled “Auto Print”.
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GeneScan Sample Sheet Preferences

Setting GeneScan
Sample Sheet

Preferences

For GeneScan sample sheets, one parameter can be set as a preference—the size 
standard dye color.

6 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.

To change sequencing run file preferences: (continued)

Step Action

To change GeneScan sample sheet preferences: 

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, 
select Preferences, and then select 
GeneScan Sample Sheet Defaults.

is open open the Page pop-up menu and select 
GeneScan Sample Sheet Defaults.

2 To change the size standard dye color, open the size standard pop-up menu and 
select the appropriate color (B=blue; G=green; Y=yellow; R=red).

3 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.
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GeneScan Run Sheet Preferences

Setting GeneScan
Run Sheet

Preferences

The following parameters can be set as preferences for GeneScan run sheets:

� Operator

� Well-to-read (WTR) distance in centimeters

� Lanes

� PreRun module

� Run module

� Autoanalyze 

� Analysis Parameters

� Gel’s Matrix File

� Size Standard

� Auto Print

To change GeneScan run sheet preferences: 

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, 
select Preferences, and then select 
GeneScan Run Defaults.

is open open the Page pop-up menu and select 
GeneScan Run Defaults.

2 To enter an operator’s name, type the name directly into the Operator field.

3 To change the default setting for the WTR distance, Lanes, PreRun Module, Run 
Module, Gel’s Matrix File, and Size Standard, open the pop-up menu for each 
parameter, and select the desired default.
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4 To specify that data be automatically analyzed by GeneScan analysis software:

a. Select the box labeled “Autoanalyze with”.

b. Open the autoanalyze pop-up menu, select Other …, and then select the 
appropriate analysis application (ABI PRISM GeneScan® Analysis Software).

c. Open the pop-up menu for Gel’s Matrix File, and select the appropriate file.

d. Open the pop-up menu for Size Standard, and select the appropriate file.

e. Open the pop-up menu for Analysis parameters, and select the appropriate file.

Note Refer to the ABI PRISM GeneScan® Analysis Software User’s Manual for 
more information on matrix files, analysis parameters, and size standard files.

5 To specify that data be printed automatically at the end of each run, select the check 
box labeled “Auto Print”.

6 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.

To change GeneScan run sheet preferences: (continued)

Step Action
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General Settings

About General
Setting Preferences

The General Settings window allows you to specify the following:

Setting Description

Instrument Name Used to track which instrument a gel is run on. The name is 
recorded in the Gel and Log files for each run.

Global Serial Number Increments with each run. The number can be automatically 
added as a suffix to all Sample File names. This feature is set via 
the File Names preference window (sample file name).

Suppress Left/Right 
Averaging

Do not use this feature. Current versions of the ABI PRISM 377 
DNA sequencing and GeneScan analysis software cannot 
process unaveraged data. This feature may be added to future 
versions of software.

Plate Check Module Used to designate a default module for plate checks.

Communication Port The Macintosh® computer port (Modem or Printer) to which the 
instrument is attached, or No Port.

The Macintosh computer has two standard connection ports: 
Modem and Printer. Typically, the instrument is attached to the 
Modem port, and a printer or network connection is attached to the 
Printer port. If, however, the instrument must be connected to the 
Printer port, you must specify this change in the General Settings 
preferences window.

The No Port option allows you to use the data collection software 
when no instrument is attached to the computer, or the instrument 
is turned off.

Minimum Number of 
Scans

Determines the amount of hard disk space software sets aside for 
the gel file at the beginning of every run. The default factory setting 
is 12000. If necessary, this number can be increased. We strongly 
recommend you never decrease this number. If decreased, the 
Macintosh may not have enough hard disk space to store the 
additional data. 
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To Change General
Settings Preferences

To change general settings preferences:

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, 
select Preferences, and then select 
General Settings.

is open open the Page pop-up menu and select 
General Settings.

2 Set the preferences as follows:

a. To enter an instrument name, type the name in the Instrument Name field.

b. To change the global serial number, select the current value in the box, and 
type in the new value (use positive integers only).

c. Do not select Suppress Left/Right Averaging. See explanation on previous 
page.

d. To select a plate check module, open the pop-up menu and choose the 
appropriate module.

e. To change the communication port, click the appropriate port icon.

f. To change the minimum number of scans, select the current value in the box, 
and type in a new value.

Note Data collection software collects data for the run time specified on the run 
sheet. We recommend you do not enter a value below the default minimum number 
of scans (12000). If the value is less, data collection software may not allocate 
enough hard disk space to collect all the data.

3 If … Then …

you are finished click OK to save your changes, or 
Cancel to quit without making any 
changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.
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Dye Indicator Preferences

Setting Dye
Indicator

Preferences

Two categories of color definitions are available for the dyes used during a run:

� Dye Color—colors used to display data on the computer screen

� Plot Color—colors used to print data

Dye and plot colors can be changed at any time. This feature is useful if you are color 
blind, and the default factory settings are not appropriate for your needs.

To change Dye Indicator preferences: 

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, select 
Preferences, and then select Dye Indicators.

is open open the Page pop-up menu and select Dye 
Indicators.

2 To change the code used for a particular color, type a different character in the 
appropriate field in the Code column.

3 To change a color, open the appropriate pop-up menu and select a new color, or 
select Other.

Colors used to
display data on 

Colors used to
print data

the computer
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4 If … Then …

Other is not selected proceed to step 6.

Other is selected a. use the Hue Angle and Saturation scroll 
bars/fields, or the color wheel as 
described in the illustration to change 
the hue and saturation.

b. Use the Lightness scroll bar/field, or the 
lightness bar as described in the 
illustration to make the color lighter or 
darker.

As changes are made, the new color is 
displayed in the New box. 

c. When finished, choose one of the 
following:

– Click OK to save the change and 
return to the Dye Indicators preference 
window

– Click Cancel to cancel the change and 
return to the Dye Indicators preference 
window

– Click More Choices, and proceed to 
step 5.

To change Dye Indicator preferences: (continued)

Step Action

Use the wheel or
these boxes to
change hue and
saturation

To use the wheel, move cursor onto wheel. Cursor turns to crosshair. Click 
and drag the 

Use the bar or this
box to change the
lightness

Click and drag this bar
to make changes

Color before 
changes are made

Color as you make
changes
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5 If … Then …

More Choices is not selected proceed to step 6.

More Choices is selected a. Click the Apple RGB icon to display the 
window shown below.

b. Use the bars or the % fields to create a 
new color.

c. When finished, choose one of the 
following:

– Click OK to save the change and 
return to the Dye Indicators preference 
window.

– Click Cancel to cancel the change and 
return to the Dye Indicators preference 
window.

– Click the Apple HSL icon to return to 
the previous window.

6 To revert back to the factory settings, click the Reset to Factory Settings button.

7 If … Then …

you are finished click OK to save your changes, or Cancel to 
quit without making any changes.

you wish to change more 
preferences

open the Page pop-up menu, and select 
another Preference.

To change Dye Indicator preferences: (continued)

Step Action
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Project Information Preferences

About Project Info
Preferences

This preference is for BioLIMS users only (sequencing applications—BioLIMS 
version 1.0 and up; GeneScan applications—BioLIMS version 2.0 and up). The 
project information is used to identify the data transferred to BioLIMS, a nd must be 
defined prior to setting up sample sheets. If this information is not specified, data 
transferred to BioLIMS is identified by the gel file name only.

The Project Info preference allows you to enter a project name, information about the 
project in a comments field, and a person’s name as the project owner. This 
information is transferred to the sample sheet when a project name is selected.

Setting Project Info
Preferences

To set or change Project Info preferences:

Step Action

1 If the Preferences dialog box … Then …

is not open open the Windows pull-down menu, select 
Preferences, and then select Project Info.

is open open the Page pop-up menu and select 
Project Info.

2 Click Add Row to add a row for each project to be defined.

3 To define the first project, select the first cell in the Project Name column, and enter 
a name.

4 Press the tab or right arrow key to move to the Project Comment column, and enter 
comments or leave the field blank.

5 Press the tab or right arrow key to move to the Project Owner column, and enter an 
owner’s name or leave the field blank.

6 Continue adding information in the same manner for the remaining projects.

7 To delete a row, select the row and click Delete Row.

8 If … Then …

you are finished click OK to save your changes, or Cancel to 
quit without making any changes.

you wish to change more preferences open the Page pop-up menu, and select 
another Preference.
5-20 Setting Preferences



6
Making Matrix Files 
for GeneScan 6
Chapter Contents

In this Chapter The following topics are discussed in this chapter:

Terminology

Matrix vs.
Instrument Files

The terms matrix file and instrument file are sometimes used interchangeably. In this 
chapter, the term:

� “Matrix file” refers files that must be created to properly analyze data for 
GeneScan® analysis software applications.

� “Instrument file” refers to the files that must be created to properly analyze data for 
sequencing applications.

Topic See page

Terminology 6-1

Purpose of the Matrix File for GeneScan Applications 6-2

Why Matrices Must Be Remade 6-2

Evaluating Matrix File Quality 6-3

Creating a Matrix File for GeneScan Applications 6-6

Checking the Quality of a New Matrix File 6-8
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Purpose of the Matrix File for GeneScan Applications

Purpose While the most intense fluorescence emitted by an ABI PRISM® dye will fall within a 
small wavelength detection range, some fluorescence emission in the detection 
ranges of the other dyes will always occur. The multicomponent matrix compensates 
for this overlap by subtracting out, in each dye’s detection range, the portion of the 
signal due to fluorescence from other dyes.

Why Matrices Must Be Remade

Factors Affecting
Matrix Quality

When creating a matrix, each relevant dye matrix standard must be run separately to 
determine the proportional amount of fluorescence that is emitted in all four detection 
regions. Because the emission spectra of the dyes vary with the physical environment 
(such as the pH or polymer type and concentration), the matrix must be remade if run 
conditions change. Factors that affect matrix quality are:

� Aging reagents

� Buffer type and concentration

� Gel polymer type

� Denaturing vs. non-denaturing conditions

� Run temperature

� Change in instrument optics (CD camera or lenses)

Virtual Filter Set C The emission maximum of 6-FAM, the recommended blue-displaying dye for this filter 
set, is very close to the laser wavelength of 514.5 nm. Thus, the window for collected 
blue light-intensity data is offset to longer wavelengths and does not contain the 
emission maximum of 6-FAM. It is also very close to the detection region for the 
green-displaying dye TET.

Matrix files made for Virtual Filter Set C are especially susceptible to minor changes in 
run conditions. If you are using Virtual Filter Set C for GeneScan applications, watch 
for evidence of matrix problems and remake the matrix as soon as problems appear.
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Evaluating Matrix File Quality

How to Recognize
Matrix Problems

A poor or incorrect matrix results in too much or too little subtraction of dye spectral 
overlap during data analysis. Each causes a recognizable electropherogram anomaly:

� Bleedthrough peaks, also called “pull-ups” (caused by too little subtraction)

� Elevated interpeak baseline (caused by too much subtraction)

Bleedthrough Peaks
(or Pull-ups)

Bleedthrough peaks are small peaks of one color lying directly under a large peak of 
another color even though there is no PCR product corresponding to the smaller peak. 
As shown Figure 6-1, the large-peak signal is “pulling-up” peaks in other colors.

Figure 6-1 Characteristic appearance of bleedthrough peaks

Bleedthrough can occur for two reasons:

� The matrix was made with the wrong dyes or filter set.

For a list of recommended dye/filter set combinations, refer to the GeneScan 
Reference Guide: ABI™ 373 and ABI PRISM ® 377 DNA Sequencers, 
P/N 4303188.

� The signal from the large peak is off-scale because of sample overloading. In the 
example shown in Figure 6-1, the peak showing bleedthrough is actually off-scale 
(Figure 6-2).

Figure 6-2 Raw data from the bleedthrough example shown in Figure 6-1

Keep peak heights between approximately 150 and 4000 RFU. If sample data is 
off-scale, do one of the following:

� Rerun the samples loading a smaller volume.

� Dilute the samples and rerun them.

pull-up peaks
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Elevated Interpeak
Baseline

Figure 6-3 shows a typical example of an elevated interpeak baseline. In this example, 
the green baseline is elevated in the region between two large black peaks 
(representing the yellow dye signal) because too much green signal is subtracted from 
the yellow signal (see Figure 6-4 on page 6-5). The GeneScan software uses these 
low data points to calculate the baseline for the green signal. Therefore the original 
baseline is elevated.

Note If the baseline is sufficiently elevated, random fluctuations in the baseline can lie above 
the Peak Amplitude Threshold and might be falsely interpreted as product peaks.

If you suspect that an elevated interpeak baseline is caused by matrix problems, 
inspect the data before baselining. This can be done by reanalyzing the data with 
baselining deselected in the Analysis Parameters dialog box. As shown in Figure 6-4, 
low data points are apparent as troughs in one color beneath peaks in another.

Figure 6-3 Characteristic appearance of an elevated baseline caused by a bad or incorrect 
matrix

green baseline
Elevated

Two large black peaks
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Figure 6-4 The data of Figure 6-3 before baselining

What To Do If You
Have Matrix

Problems

If problems related to bleedthrough peaks or to an elevated interpeak baseline appear 
with any regularity, you should remake the matrix. Apply the new matrix to the old 
sample data and reanalyze the data.

Instructions for creating matrix files are listed under “Creating a Matrix File for 
GeneScan Applications” on page 6-6.

Green troughs

Black peaks
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Creating a Matrix File for GeneScan Applications

Overview The matrix file contains the information necessary for software to correct the spectral 
overlap of the dyes in the virtual filter sets. Once a matrix file has been created, it can 
be used for subsequent runs performed:

� With the same kit or chemistry

� On the same instrument

� Using the same:

– run modules

– set of dyes

– gel parameters (gel polymer type, buffer, denaturing or non-denaturing 
conditions, etc.)

After running the matrix standards, use their sample files to generate a matrix file 
using ABI PRISM GeneScan® Analysis Software.

Verify the Raw Data Before creating the matrix file, verify that the raw data from the standards is good.

To view the raw data in GeneScan analysis software:

To verify the raw data:

Step Action

1 Create a new project if you did not select Autoanalyze in the GeneScan Run 
Defaults preferences in the data collection software:

a. Choose New from the File menu.

b. Select the Project icon. An untitled Analysis Control window opens.

c. Choose Add Sample Files from the Project menu.

d. Find and open the Run Folder for the matrix standards run.

e. Select the four Sample files representing the blue, green, yellow, and red 
dye-labeled “runs,” and then click Add.

f. Click Done after the Sample files are transferred.

2 In the Analysis Control window, select the four matrix standard Sample files by 
clicking on the first Sample file, holding down the mouse button, and releasing on 
the last Sample file.

3 Choose Raw Data from the Project menu. Electropherograms displaying raw data 
from the four matrix standard Sample files appear.

Step Action

1 Verify data peaks are present in all four samples. Peak data should be on-scale and 
the dye of interest should have a value of at least 200.

2 Check for any data anomalies, such as an unstable baseline. Rerun samples that 
have an unstable baseline.
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Generating the
Matrix File

3 Select a starting point for the matrix data as shown below. The starting point for 
matrix data should be slightly beyond the point where the primer peak falls back to 
the baseline (approximately 2950 scans in this example).

4 Choose a stop point such that at least three matrix standard peaks will be within the 
range analyzed.

Step Action

start point

To generate the matrix file: 

Step Action

1 Choose New from the File menu.

2 Click the Matrix icon. The Make New Matrix dialog box is displayed.

3 Click the B, G, Y, and R buttons to choose the standard sample files. Choose the 
sample file representing blue dye for B, green dye for G, etc.

4 Enter the starting point for each file. The Start At point should be after the primer 
peak.

Define the Points value. This is the number of points after the start point to be 
analyzed.
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Checking the Quality of a New Matrix File

Procedure Check the quality of the matrix file by reviewing the:

� Values in the Matrix Values window

� Analyzed data of the matrix run

Review the matrix values in the Matrix Values window as follows:

5 Click OK. A successful matrix opens an untitled Matrix Values window with a 4x4 
matrix of numerical values.

6 Use the Save As… command to name and save the matrix file. Choose a name that 
reflects the chemistry, the virtual filter set, and the run conditions.

7 Check the quality of the matrix file by following the procedure below “Checking the 
Quality of a New Matrix File.”

To generate the matrix file: (continued)

Step Action

Step Action

1 View the Matrix Values window.

2 The numbers on the diagonal (Blue against Blue, Green against Green, etc.) must 
all be 1.00. The numbers off the diagonal should be less than 1.00.

Note For virtual filter set C, Green under Blue (the second box from the top in 
the first column on the left) is sometimes slightly above 1.00. This is acceptable.
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Check matrix quality as follows:

Step Action

1 From the Project containing your matrix standard Sample files, open the Analysis 
Control window. 

In the Analysis Control window, select the colors for each sample.

2 Select the four matrix standard Sample files.

3 Choose Assign New Matrix in the Project menu. Select the matrix file.

4 Select numbers 1, 2, 3, and 4 on the left side of the window to highlight the colors 
for each row.

5 Use the Set Analysis Parameters dialog box in the Settings menu to set the 
Analysis Range.

6 Click Analyze.

7 Choose Results from the Windows menu and check each electropherogram by:

a. Clicking 4 in the # of Panels menu

b. Clicking 1 under Dye/Samples

c. Clicking #1 on the Sample Files side of the Results window

8 If… Then…

each peak is one color with the other 
colors flat under it

the matrix is good.

the other colors are not flat under the 
peaks (as shown below)

the matrix is poor.

9 If… Then…

the matrix is good Save the matrix file to the ABI folder.

the matrix is poor Redo the matrix by using different start 
and stop points.

If this does not improve the matrix data, 
run new matrix standards.

Blue

Green
Making Matrix Files for GeneScan 6-9





7
Making Instrument Files 
for Sequencing 7
Chapter Contents

In this Chapter The following topics are discussed in this chapter:

Terminology

Matrix vs.
Instrument Files

The terms matrix file and instrument file are sometimes used interchangeably. In this 
chapter, the term:

� “Matrix file” refers files that must be created to properly analyze data for 
GeneScan® analysis software applications. Refer to Chapter 6, “Making Matrix 
Files for GeneScan,” for more information.

� “Instrument file” refers to the files that must be created to properly analyze data for 
sequencing applications.

Topic See page

Terminology 7-1

Instrument File Overview 7-2

When to Make a New Instrument File 7-3

The Data Utility Program 7-3

Summary of Chemistries 7-4

Color Guide for Data Display Windows 7-4
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Making an Instrument File for Virtual Filter Set E from Matrix Standards 7-10

Checking Instrument Files 7-16

Making an Instrument File from a Sample File 7-18

Storing and Backing Up the Instrument File 7-19

Adding or Replacing a Matrix in an Existing Instrument File 7-20

Correcting Errors in Matrix Creation 7-22
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Instrument File Overview

Purpose Although the dyes in a set fluoresce at different wavelengths, some overlap in the 
spectra still occurs. To correct for this overlap when analyzing data, a mathematical 
matrix is created for each dye set and is stored in a file called the instrument file. 

The instrument file must contain a matrix for each chemistry run on the instrument. 
During data analysis the appropriate matrix is applied to remove any spectral overlap. 
During system installation, an instrument file is created specifically for your 
instrument. However, additional instrument files may be required. See “When to Make 
a New Instrument File” on page 7-3.

What Does the
Instrument File

Contain?

The instrument file normally contains:

� Three matrices

� A comment field

� An instrument name field

These can be seen in the Copy Matrix window in the DataUtility program. A copy of 
this instrument file is attached to every gel file and sample file when these files are first 
created. For this reason, each computer on which you use the Sequencing Analysis 
program must have an instrument file in the ABI folder (which is located in the System 
Folder).

IMPORTANT Due to slight variations in the filters of the ABI™ 373 instruments, and the 
CCD cameras of the ABI PRISM® 377 and ABI PRISM 310 instruments, the instrument file 
created for your ABI PRISM genetic analysis instrument is sub-optimal for other ABI PRISM 
genetic analysis instruments.
If you analyze sample files on a different computer from the one that was used to collect data, 
be sure to copy the correct instrument file(s) to the analysis computer.
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When to Make a New Instrument File

Guidelines During system installation, an instrument file is created specifically for your 
instrument. If a valid instrument file exists in the ABI folder (inside the System Folder) 
on your Macintosh® computer, you need not create one. A new instrument file should 
be created if any of the optics in the instrument change either due to service or age. 
Some specific situations that require a new instrument file are:

� The CCD camera in the instrument is replaced.

� A run shows consistent and proportional pull-up peaks, indicating poor or 
incorrect spectral separation. (Pull-up peaks appear as smaller peaks of one color 
directly under larger peaks of another.)

� Fluorescence and spectral overlap are affected by the gel used for the run. You 
may need to make a new instrument file if the type of acrylamide or other gel 
reagents is changed.

If you need to replace a lost or damaged instrument file, and you do not have a backup 
copy, refer to the Automated DNA Sequencing Chemistry Guide: ABI™ 373 and 
ABI PRISM® 377 DNA Sequencers, P/N 4305080. This manual contains information on 
viewing and copying matrices. You may want to try restoring the instrument file by 
following the procedures in this manual before you recreate the entire instrument file.

The Data Utility Program

What it is Used For The DataUtility program has two main functions for users: to make instrument files, 
and to copy matrices from one instrument file to another. The program is located in the 
Utilities folder within the Sequencing Analysis folder. 

When creating instrument files, the correct data file for each matrix standard must be 
entered in the correct “box” in the Data Utility Make Matrix dialog box.

The Measure Noise function of the program is used by Applied Biosystems Service 
personnel and is not discussed here.
Making Instrument Files for Sequencing 7-3



Summary of Chemistries

The Sequencing
Chemistries

Five cycle sequencing chemistries are currently available to prepare DNA samples for 
the ABI PRISM® 377 DNA Sequencer. Each chemistry requires the use of a specific 
virtual filter set as listed in the table below.

Color Guide for Data Display Windows

The CCD Camera
and Virtual

Filter Sets

Data collection software collects the fluorescent signal from specific locations on a 
CCD camera inside the instrument. These locations correspond to different 
wavelengths of light. The result is the same as using a physical filter to separate the 
light wavelengths. This is referred to as a virtual filter, since no physical filtering 
hardware is used.

Real-Time Display
Colors Vary

On the real-time displays (the Scan and Gel windows), the data collection program 
displays the light intensities, color-coded according to wavelength. Blue, green, yellow, 
and red (in that order) represent the wavelengths of the dye emissions within each dye 
set. Blue represents the shortest wavelength, and red represents the longest. The 
colors on the real-time displays therefore represent the wavelengths of the dyes being 
detected, rather than the bases being detected.

Colors Represent
Relative

Wavelengths

Different virtual filter sets use the same four colors to represent different wavelengths, 
so the colors do not represent actual wavelengths. They represent the relative 
wavelengths of the four dyes in each dye set. For example, Filter Set A uses the four 
colors to represent wavelengths within Dye Set 1 and Dye Set 2. 

Each of the chemistries used for preparing DNA is associated with a dye set. Each 
dye set labels the four bases differently, so the relative wavelength, and therefore the 
color, associated with each base varies with the chemistry used to label it. Due to this, 
the four colors on the real-time displays represent different bases, depending on the 
chemistry used for labeling. The tables below describe the colors that represent each 
of the four bases on the real-time displays.

Chemistry Virtual Filter Set

Fluorescein/Rhodamine Dye Primer
ARhodamine Dye Terminators

dRhodamine Terminators

EBigDye™ Terminators

BigDye™ Primers
7-4 Making Instrument Files for Sequencing



Raw Data
Color Guide

The following tables lists the raw data display colors and dyes for the gel image and 
raw data based on the virtual filter set used.

Raw Data Colors for Virtual Filter Set E

Analyzed Data
Color Guide

The Sequencing Analysis program converts the information collected by the data 
collection program, so that after analysis the colors representing each base are 
consistent regardless of the chemistry used. The colors on all displays of analyzed 
data, including printed electropherograms, are as follows: 

Raw Data Colors for Virtual Filter Set A

Fluorescein/Rhodamine Dye Primers Rhodamine Dye Terminators

Color Base Dye Base Dye

Blue C 5-FAM G R110

Green A JOE A R6G

Yellow G TAMRA T TAMRA

Red T ROX C ROX

dRhodamine Terminators BigDye Primers BigDye Terminators

Color Base Dye Base Dye Base Dye

Blue G dR110 C FAM-dR110 G FAM-dR110

Green A dR6G A FAM-dR6G A FAM-dR6G

Yellow C dTAMRA G FAM-dTAMRA T FAM-dTAMRA

Red T dROX T FAM-dROX C FAM-dROX

Color Guide for All Analyzed Data 

Base Color

C Blue

A Green

G Blacka

a. G is shown as yellow in AutoAssembler™ software.

T Red
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Making an Instrument File for Virtual Filter Set A from Matrix Standards

Summary of
Procedure

The following is a brief outline of the steps involved in making an instrument file.

What Matrix
Standards are

Required?

An instrument file can contain a Dye Primer matrix, a Taq Terminator matrix, and/or a 
T7 Sequences Terminator matrix.

The instrument file for virtual filter set A must contain a dye primer matrix, even if this 
chemistry will not be used. Otherwise, the data collection software will not function 
properly. 

This instrument file can also contain the matrix information for the Rhodamine Dye 
Terminators. (Chemistries used with virtual filter sets A and E are listed on page 7-4.)

Running Matrix
Standards to Obtain

the Raw Data

Perform a run on the instrument using the matrix standard samples required to create 
the instrument file.

IMPORTANT Do not configure the run sheet to automatically analyze the matrix standard 
samples. Select <none> for the Instrument File on the sample sheet. If necessary, deselect the 
Auto Analyze boxes on the run sheet by clicking the box to remove the X.

Proceed to “Verifying the Raw Data” on page 7-7 to verify the raw data is satisfactory, 
and to generate sample files.

Step Action

1 Run the appropriate matrix standards for your instrument, verify that lane tracking is 
correct, and verify that peaks exist in the raw data.

2 Backup the raw sample files for the standards.

3 Make a new instrument file using the DataUtility program. 

Note You can also add matrix data to an existing instrument file. See “Adding or 
Replacing a Matrix in an Existing Instrument File” on page 7-20.

4 Verify the accuracy of the new instrument file by using it to analyze each matrix 
standard file (the raw data). See “Making an Instrument File for Virtual Filter Set E 
from Matrix Standards” on page 7-10.

5 Store the new instrument file. See “Storing and Backing Up the Instrument File” on 
page 7-19.
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Verifying the Raw
Data

After you run the matrix standards, the next step is to verify that the run was 
successful and you have raw data for the matrix.

The following procedure requires you open gel files; track and extract lanes; and 
create and view sample files. Refer to the ABI PRISM® DNA Sequencing Analysis 
Software User’s Manual for instructions on how to perform these operations.

Make Backup
Copies of Raw Data

The sample files used to make an instrument file are altered by the DataUtility 
program when the instrument file is generated. Therefore, it is important to make 
backup copies of the standard sample files (the raw, unanalyzed data) before making 
the instrument file. If the new instrument file is no good, you can create another one 
using the backup copies of the sample files.

To verify lane tracking and peaks in the raw data: 

Step Action

1 Launch the Sequencing Analysis Software program.

2 Open the gel file, and make sure auto-analysis is deselected.

3 Track the matrix standard sample lanes, and extract them into sample files.

IMPORTANT Because the Tracker program only recognizes red data, you have 
to adjust the tracker lines by hand for the green, blue, and yellow standards.

Note The raw matrix data must be contained in sample files. If you extracted the 
matrix data in BioLIMS® mode, export the data to sample files using the 
Sample2DB program. (For more information on exporting BioLIMS database 
records, see the ABI Prism BioLIMS Sample2DB Software User’s Manual, 
(P/N 4304072).)

4 Open each sample file in a Sample window and verify that peaks are present.

5 Open the File menu and select Quit to quit the Sequencing Analysis program.
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Making the
Instrument File

At this point in the procedure, you should have run the necessary matrix standard 
samples (“Running Matrix Standards to Obtain the Raw Data” on page 7-6), 
generated sample files and verified the raw data (“Verifying the Raw Data” on 
page 7-7), and made backup copies of the sample files.

To make an instrument file for virtual filter set A: 

Step Action

1 Open the DataUtility program. 

This program is located in the Utilities folder inside the Sequencing Analysis folder.

2 Open the Utilities menu and select Make Matrix. The Make Matrix dialog box 
appears.

3 Specify the sample file to be used for each standard as follows:

a. Click the C… button. 

b. In the directory dialog box that appears, select the file that contains the data 
from the C standard, then choose Open.

c. Continue this selection process for the A, G, and T standards by clicking the 
A… button to select the A standard and so on.

Note A separate matrix must be generated for each chemistry.

Box
Fluorescein/Rhodamine 

Dye Primer Matrix  Taq Terminator Matrix T7 Terminator Matrix

C… FAM ROX not used

A… JOE R6G not used

G… TAMRA R110 not used

T… ROX TAMRA not used
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4 In each “Start at” text box, leave the default as is, or enter a different value. 

Note The defaults of 2000 for start point and 1500 for data points to be used for 
the matrix are almost always appropriate. Refer to the ABI PRISM DNA Sequencing 
Analysis Software User’s Manual for information on how to determine values for the 
“Start at” and “Points” boxes.

5 In the Points text box, leave the default value as is or enter a different value. (See 
the Note in the preceeding step.)

6 Verify that the correct radio button for the type of chemistry being used is selected 
(Dye Primer, Taq Terminator, or T7 Terminator). If not, select the correct button.

7 Type information in the Instrument and Comment text boxes (e.g. the instrument 
serial number or name, and the date the matrix was created). 

8 Click the New File… button, and enter a descriptive name for the file in the dialog 
box. Since instrument files are specific to instruments and chemistries use these to 
name the file, e.g. “<instrument name>-BigDye-InstFile”.

Note Only alpha-numeric characters, the period (.), the dash (–), and the 
comma (,) are permissible characters for instrument file names.

9 Click Save. The dialog box closes, and the instrument file is saved in the ABI Folder 
in the System Folder. 

10 Click OK to start the matrix calculation. 

The calculation takes about one minute. When the matrix is complete, the message 
“Make matrix successfully completed” is displayed.

If an error message appears and the matrix is not made, see “Correcting Errors in 
Matrix Creation” on page 7-22.

11 Choose OK to close the Make Matrix dialog box, or wait about 20 seconds for the 
dialog box to disappear.

12 If you wish to add a matrix for another chemistry to the instrument file, repeat steps 
2–11 with the following exceptions:

a. For step 8, choose Update File… instead of New File… Select the instrument 
file to be modified. 

b. For step 9, click Open instead of Save.

13 Quit the DataUtility program.

14 Verify the instrument file by following the procedure “Checking Instrument Files” on 
page 7-16.

To make an instrument file for virtual filter set A: (continued)

Step Action
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Making an Instrument File for Virtual Filter Set E from Matrix Standards

Overview When creating an instrument file for virtual filter set E, you must create three matrix 
files: dye primers, Taq terminator, and T7 terminator. All three matrix files must be 
made, even if you are only using one dRhodamine-based chemistry. Data collection 
software will not run with only a Taq or T7 terminator matrix in the file.

The T7 Terminator Matrix file is needed to analyze dRhodamine terminator and 
BigDye terminator sequencing data. It has a baselining algorithm associated with it 
that works well with these chemistries. The dRhodamine terminator and BigDye 
terminator dye set/primer files have tags in them that cause the Sequencing Analysis 
software to select this matrix file. 

The correct placement of standards in the data utility application for making a Filter 
Set E instrument file is shown in the table below.

Perform the following procedures to make an instrument file for Filter Set E 
(dRhodamine-based chemistries):

� “Making the Dye Primer Matrix” on page 7-11

� “Making the Taq Terminator Matrix” on page 7-14

� “Making the T7 Terminator Matrix” on page 7-15

When finished, check the instrument file by following the procedure “Making an 
Instrument File for Virtual Filter Set E from Matrix Standards” on page 7-10.

Table 7-1 Placement of Standards for Virtual Filter Set E

Box
Dye Primer

Matrix Taq Terminator Matrix
T7 Terminator

Matrix

C… dR110 dROX dR6G

A… dR6G dR6G dTAMRA

G… dTAMRA dR110 dROX

T… dROX dTAMRA dR110
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Making the
Dye Primer Matrix

To make the Dye Primer Matrix: 

Step Action

1 Launch the Data Utility software (located in the Utilities folder within the Sequencing 
Analysis folder). The icon looks like this:

2 From the Utilities menu, choose Make Matrix…

The Make Matrix dialog box appears as shown below. Verify that the Dye Primer 
Matrix button at the lower left is selected.

3 Click on the box for each nucleotide base and select the sample file that 
corresponds to the correct matrix standard as shown in the table below.

4 For each matrix standard sample, start with the default value of 2000 for the start 
point. Start with the default value of 1500 for the number of data points to analyze.

Note If the default values do not work, follow the instructions for using other 
values in steps 8 and 9 below.

Box
Dye Primer

Matrix

C… dR110

A… dR6G

G… dTAMRA

T… dROX
Making Instrument Files for Sequencing 7-11



5 Click New File…

A dialog window appears as shown below. Name the file dRhod_BigDye (or another 
appropriate name) and save it in the ABI folder within the System folder.

6 The Make Matrix dialog box should look like that shown below.

a. Type information in the Instrument and Comment text boxes (e.g. the 
instrument serial number or name, and the date the matrix was created). 

b. Click OK.

The computer makes the matrix. When finished, a dialog window appears with 
the message “Make matrix successfully completed.”

c. Click OK.

7 If the computer is unable to make a matrix, examine the raw data again in the 
Sequencing Analysis software. If you used the default values, then select new start 
points as directed in steps 8 and 9. If many peaks are off-scale, dilute the matrix 
standards and rerun them.

To make the Dye Primer Matrix: (continued)

Step Action
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8 If the matrix cannot be made with the default values, proceed with steps a, b, and c 
below.

a. In the Sequencing Analysis software, open a matrix standard sample and 
examine the raw data. An example is shown below.

b. Select a starting point where there are no peaks and the baseline is flat.

c. Select a number of data points to analyze such that no peaks in the range are 
off-scale, i.e., above 4000 relative fluorescence units (RFU), and that the 
baseline at the end of the range is flat. A typical number of data points is 1500.

9 Repeat step 8 for each matrix standard sample. Record the results for later use.

IMPORTANT The number of data points analyzed is the same for each matrix 
standard. Choose starting points for each sample such that all peaks are less than 
4000 RFU and that both the starting and ending points have flat baselines and no 
peaks.

To make the Dye Primer Matrix: (continued)

Step Action
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Making the Taq
Terminator Matrix

To make the Taq Terminator Matrix:

Step Action

1 In the Data Utility application, choose Make Matrix… from the Utilities menu. The 
Make Matrix dialog box appears.

2 In the Make Matrix dialog box, click the Taq Terminator Matrix button at the lower 
left.

3 Click on the box for each nucleotide base and enter the data file that corresponds to 
the correct matrix standard as shown in the table below.

IMPORTANT The order of matrix standard data files is different from that in the 
Dye Primer Matrix (see Table 7-1 on page 7-10).

4 Enter the same numbers for each matrix standard sample in the Start at and Points 
boxes as were used for the Dye Primer Matrix.

5 Click Update File… A dialog window appears.

6 Choose dRhod_BigDye from the ABI folder within the System folder and click 
Open.

The Make Matrix dialog box should look like that shown below.

Note The numbers in the Start at and Points boxes are default values. Your 
numbers may vary.

7 a. Click OK.

The computer makes the matrix. When finished, a dialog window appears with the 
message “Make matrix successfully completed.”

b. Click OK.

Box
Taq Terminator

Matrix

C… dROX

A… dR6G

G… dR110

T… dTAMRA
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Making the T7
Terminator Matrix

To make the T7 Terminator Matrix:

Step Action

1 In the Data Utility application, choose Make Matrix… from the Utilities menu. The 
Make Matrix dialog box appears.

2 In the Make Matrix dialog box, click the T7 Terminator Matrix button at the lower left.

3 Click on the box for each nucleotide base and enter the data file that corresponds to 
the correct matrix standard as shown in the table below (note the order of the matrix 
standard files).

4 Enter the same numbers for each matrix standard sample in the Start at and Points 
boxes as were used in the Dye Primer Matrix and Taq Terminator Matrix.

5 Click Update File… A dialog window appears.

6 Choose dRhod_BigDye from the ABI folder within the System folder and click 
Open.

The Make Matrix dialog box should look like that shown below.

Note The numbers in the Start at and Points boxes are default values. Your 
numbers may vary.

7 a. Click OK.

The computer makes the matrix. When finished, a dialog window appears with the 
message “Make matrix successfully completed.”

b. Click OK.

8 Verify the instrument file by following the procedure “Checking Instrument Files” on 
page 7-16.

Box
T7 Terminator

Matrix

C… dR6G

A… dTAMRA

G… dROX

T… dR110
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Checking Instrument Files

Introduction Instrument files can be verified two ways:

� Using the DataUtility program

� Using analyzed matrix standard samples

Using the
DataUtility Program

This operation allows you to:

� Check the quality of the matrices in the instrument file

� Verify that the matrix is appropriate for the chemistry being used

� Determine if the matrix is responsible for poor data

To view the instrument file: 

Step Action

1 Open the DataUtility program. 

2 From the Utilities menu, choose Copy Matrix…

3 Under Source, select Instrument file, and then select the instrument file name. The 
instrument file is displayed as shown below.

Note The numbers shown here are not representative values, and will differ with 
each chemistry. If the numbers in the matrix appear misaligned, change the System 
Font from Charcoal to Chicago. (From the Finder, choose Options in the 
Appearance control panel.)

4 Make sure the numbers in all the boxes range from 0 to 1. The numbers on the 
diagonals from top left to bottom right should all be 1. 

5 Click Cancel, and quit the DataUtility program.

For virtual filter set E, all three 
matrix boxes will contain 
numeric values as shown 
here. The numeric values will 
be the same in each box.

For virtual filter set A, numeric 
values will typically be 
displayed in the Primer and 
Taq Terminator matrix boxes 
only. The numeric values will 
not be the same in each box.
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Using Matrix
Standards

To verify the instrument file using matrix standards:

Step Action

1 Open the Sequencing Analysis program.

2 Open the matrix standard files that were used to create the instrument file. 

3 Use the electropherogram (analyzed) data view to confirm that the analyzed data 
looks good.

In each file, you should see one color trace with obvious peaks, and all other color 
traces should be flat throughout the run.

A pattern of pronounced peaks or dips in any of the other three colors indicate that 
something is wrong. 

4 If all the data looks good, store and backup the new instrument file. See “Storing 
and Backing Up the Instrument File” on page 7-19.
If the data does not look good, pick a different range of raw data points and remake 
the matrix. Be sure to use the backup copies of raw, unanalyzed data files. An 
analyzed file cannot be used to make an instrument file. Refer to the ABI PRISM 
DNA Sequencing Analysis Software User’s Manual for guidelines and a worksheet 
for selecting new start and data points.
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Making an Instrument File from a Sample File

Introduction An instrument file can be made from matrix standards as explained above, or it can be 
made from a sample file. This procedure requires fewer steps than running matrix 
standards; however, the matrix made from a sample file may not be as good as one 
made from matrix standards. The quality of an instrument file made from a sample file 
depends on the quality of the sample file used.

The best samples to choose for making a matrix have approximately 25% each of A, 
C, G, and T. A good example of this is the pGEM DNA with the –21M13 primer that is 
included as a control in every Ready Reaction Sequencing Kit. 

Making the
Instrument File from

a Sample File To create an instrument file from a sample file: 

Step Action

1 Before making the matrix, verify that lane tracking is accurate. Adjust if necessary.

2 Duplicate the unanalyzed sample file four times. Use the Duplicate command from 
the File menu in the Finder. The four copies will have the following names:

� Sample name

� Sample name Copy 1

� Sample name Copy 2

� Sample name Copy 3

� Sample name Copy 4

These four sample file copies are used in the same way as the four matrix standard 
samples.

3 For Filter Set A instrument files:

Follow the procedure “Making an Instrument File for Virtual Filter Set A from Matrix 
Standards” on page 7-6. Whenever the procedure indicates a specific matrix 
standard to be used, follow the table below:

For Filter Set E instrument files:

Follow the procedure “Making an Instrument File for Virtual Filter Set E from Matrix 
Standards” on page 7-10. Whenever the protocol indicates a specific matrix 
standard to be used, follow the table below:

Matrix Standard Standard File

C… Sample name Copy 1

A… Sample name Copy 2

G… Sample name Copy 3

T… Sample name Copy 4

Matrix Standard Standard File

dR110 Sample name Copy 1

dR6G Sample name Copy 2

dTAMRA Sample name Copy 3

dROX Sample name Copy 4
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Storing and Backing Up the Instrument File

Introduction Valid instrument files must be placed in the ABI Folder in the System Folder. New 
instrument files should also be backed up. Obsolete instrument files should be deleted 
or archived.

Follow the steps in the table below after creating and verifying a new instrument file.

Storing and Backing
Up Instrument Files

To properly store and backup instrument files:

4 Apply the newly made matrix back to the original sample file. There should be 
defined peaks and a flat baseline. If the baseline is not flat, or if there are dips or 
pull-up peaks, then the instrument file is wrong and should not be used.

To create an instrument file from a sample file: (continued)

Step Action

Step Action

1 Use the Finder to make sure the new instrument file is stored in the ABI Folder 
inside the System Folder.

If you saved the file to a different location, drag it to the ABI folder now. To be used 
by the Sequencing Analysis program, the instrument file must be in the ABI folder.

2 Clean up the ABI folder by deleting any invalid instrument files. 

3 Put a backup copy of the instrument file on a server or a disk (and put the disk in a 
safe location). It is a good idea to put the raw sample files for the standards in the 
same place.
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Adding or Replacing a Matrix in an Existing Instrument File

Introduction Use the procedure described below to:

� Add a matrix to an incomplete instrument file.

� Replace an existing matrix.

� Make an additional instrument file for testing purposes.

Note Be sure to make a backup copy of the original instrument file before you modify it.

Adding or Replacing
a Matrix

To add or replace a matrix in an existing instrument file: 

Step Action

1 Open the DataUtility program.The program icon looks like this:

The program is located in the Utilities folder inside the Sequencing Analysis folder.

2 Choose Make Matrix from the Utilities menu. 

The Make Matrix dialog box appears.

Note The files you select for the four nucleotides are the sample files you named 
on the Sample Sheet when you electrophoresed the matrix standards.

3 Specify the sample file to be used for each standard.

a. Click the C… button. In the directory dialog box that appears, select the file that 
contains the data from the C standard, then choose Open to close the dialog 
box.

b. Repeat this selection process with for the A, G, and T standards.
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4 In each “Start at” text box, leave the default as is, or enter a different value. 

Note The defaults of 2000 for start point and 1500 for data points to be used for 
the matrix are almost always appropriate. Refer to the ABI PRISM DNA Sequencing 
Analysis Software User’s Manual for information on how to determine values for the 
“Start at” and “Points” boxes.

5 In the Points text box, leave the default value as is or enter a different value. (See 
the Note in the preceeding step.)

6 Click the Update File… button. 

7 In the directory dialog box that appears:

a. Select the name of the instrument file to which you want to add the new matrix.

b. Click Open.

8 Click the appropriate button for the chemistry (Dye Primer, Taq Terminator, or 
T7 Terminator) at the bottom of the Make Matrix dialog box.

IMPORTANT When you add a new matrix to an instrument file, it overwrites 
any existing matrix of the same type. Other matrices in the file are not affected.

9 Click OK to start the matrix calculation. 

The calculation takes about one minute. 

10 When the message “Make matrix successfully completed” appears, click OK or wait 
approximately 20 seconds for the dialog box to disappear.

If an error message appears and the matrix is not made, see “Correcting Errors in 
Matrix Creation” on page 7-22.

11 Verify the accuracy of the instrument file by following the appropriate procedure 
(“Making an Instrument File for Virtual Filter Set E from Matrix Standards” on 
page 7-10, or “Making an Instrument File from a Sample File” on page 7-18).

12 Store and backup the file as described under “Storing and Backing Up the 
Instrument File” on page 7-19.

To add or replace a matrix in an existing instrument file: (continued)

Step Action
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Correcting Errors in Matrix Creation

Common Problems The two most common problems that can occur during matrix creation are:

� Signal too weak

� Incorrect files or chemistry selected, resulting in an error message stating the 
matrix was not made successfully

Signal Too Weak If the signal size for any of the data is too small, an error message appears and the 
matrix is not made.

To correct for weak signal:

Incorrect Files or
Chemistry

If any of the files selected are obviously incorrect, or if the wrong chemistry button was 
selected, an error message appears and the matrix is not made.

To correct file or chemistry selection: 

Step Action

1 Open the Sequencing Analysis program.

2 Open sample file for the standard in the Sample window.

3 Open the Window menu and select Raw Data.

4 Find a data range with about 1500 points with reasonable signal strength. Write 
down the start and end points for that range.

If the file does not contain enough good data, run a new set of matrix standards.

5 Repeat the Make Matrix process (or the Add/Replace Matrix process on 
page 7-20), using the new start point and data range numbers.

Step Action

1 Repeat the Make Matrix process selecting the correct chemistry button for the 
correct set of matrix sample files.

2 Use the gel file to verify that matrix sample files contain the dye that the file 
indicates.

“Color Guide for Data Display Windows” on page 7-4 explains the correlation 
between the colors in the gel file and the base that each color represents.

IMPORTANT The gel file in the data collection program shows unconverted 
raw data, so the colors displayed represent different bases depending on the 
chemistry.
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In this Chapter This chapter describes how to maintain the instrument and computer. The 
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Instrument Maintenance Recommendations

How to Maintain
the Instrument

ELECTRICAL HAZARD. The ABI Prism 377 contains a high voltage power supply. 
Although the instrument has been designed with safety features in the door to 
disconnect the power supply when the door is open, please follow procedures as 
prescribed. As with any electrophoresis apparatus, be careful during instrument 
operation and when handling electrodes and liquids.

Recommendation For more information see …

After every run:

� Wipe the front and rear heat-transfer plates and 
positioning pins with damp, lint-free towels and 
allow to air dry.

� Remove any liquid present in the electrophoresis 
chamber.

� Wipe the gel cassette clean with a damp, lint-free 
towel and allow to air dry.

� Clean the comb and spacers with deionized 
water. Do not use an organic solvent.

� Rinse the buffer chambers with deionized water 
and allow to air dry.

� “Cleaning Instrument 
Accessories” on page 8-3

� Chapter 2, “Pouring Gels”

� Chapter 3, “Instrument 
Operation”

Weekly:

� Check the water reservoir level, and refill as 
necessary.

“Refilling the Water Reservoir” on 
page 8-5
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Cleaning Instrument Accessories

How To Thoroughly clean instrument accessories after each run as described below: 

Cleaning
Glass Plates

Clean plates, spacers, and combs are critical for successful gel preparation and a 
successful run. Plates that are cleaned thoroughly and consistently will also help 
avoid the temporary loss of signal that can occur sporadically on this instrument. 

Our research indicates this loss of signal is due to contaminant molecules 
(surfactants, fatty acids, long chain polymers) attached to the surface of the plates. It 
manifests itself as a band of little or no signal across the entire width of the gel image. 
It usually occurs between 140 to 200 base pairs, and typically lasts the equivalent of 
20 to 40 base pairs. Following this band, signal strength usually returns to normal.

Glass plates can be cleaned manually or in a dishwasher. The use of a laboratory 
dishwasher with a hot (195°F/90°C) deionized water rinse cycle has been found to 
effectively remove suspect contaminants, thereby eliminating any temporary loss of 
signal.

Using a Dishwasher We strongly recommend cleaning glass plates in a laboratory dishwasher with a hot 
(195°F/90°C) deionized water rinse cycle. Using a dishwasher helps ensure plates are 
cleaned effectively and consistently every time, and will also eliminate the sporadic, 
temporary loss of signal that can occur on this instrument (described above.) 
Deionized water is required for the rinse cycle only. Dishwasher recommendations are 
listed on page 8-4.

Accessory Method of Cleaning

Glass plates We strongly recommend cleaning glass plates in a laboratory 
dishwasher with a hot, deionized water rinse cycle. See “Cleaning 
Glass Plates” below for more information.

Heat transfer plates Wipe with damp, lint-free towels and allow to air dry on a 
non-scratch surface.

Positioning pins in 
electrophoresis 
chamber

Wipe with damp, lint-free towels and allow to air dry. Gel or TBE 
crystals collect on them (white, cakey substance) and can cause 
arcing.

CAUTION Arcing is a luminous, low voltage, high current 
electrical discharge. Arcing can severely damage the 
instrument.

Spacers and comb Clean with deionized water and allow to air dry. Refer to 
Chapter 2, “Pouring Gels,” for more information.

Note Do not clean spacers and combs with organic solvents. 
These tend to adhere and do not evaporate well. Residual solvent 
can prevent the gel from polymerizing right up against the spacer. 
Do not mark spacers or combs with liquid markers such as 
Sharpie® markers.

Gel cassette Wipe with damp, lint-free towel and allow to air dry. Must be 
completely dry before the next run or arcing can occur. See the 
Caution statement above.
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When using a dishwasher, we recommend you:

� Connect the dishwasher to a high-grade, deionized water source.

� Clean the plates as soon as possible once the gel is removed.

� Rinse residual gel from the plates before loading in a dishwasher.

� Initially use the longest deionized water rinse option on the dishwasher, followed 
by a drying cycle. After some experimentation, you may be able to reduce the 
rinse time.

� Do not use a detergent.

� Avoid excessive handling of dry plates with ungloved hands.

Recommended dishwashers are listed below.

If a dishwasher is not available, follow the procedure listed in Chapter 2, “Pouring 
Gels.” 

Recommended
Dishwashers

The following dishwashers have been found to work well. A customized plate rack may 
be required.

Item Part Number Supplier

Lancer 1600 dishwasher 
with facility for drying

Lancer 1600 UP Lancer USA Inc.
705 West Highway 434
Longwood, Florida 32750
Telephone: 407-332-1855

Lancer UK Ltd.
1 Pembroke Avenue
Waterbeach, Cambridge
CB5 9QR
Telephone: 44-01223-861665
Fax: 44-01223-861990

Sequencing plate rack (50 
plate capacity) for Lancer 
dishwasher

SPR 16 Lancer USA Inc. as listed above

Labconco Undercounter 
SteamScrubber 
Washer/Dryer

15-352-801 Fisher Scientific 
U.S. Headquarters
585 Alpha Drive
Pittsburgh, Pennsylvania 15238

Customer Service: 1-800-766-7000
Fax: 1-800-926-1166
Internet: http://www.fishersci.com
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Refilling the Water Reservoir

Procedure Check the water level in the reservoir once a week. Refill the reservoir when it is 
between one-third and one-half full. 

To refill the water reservoir:

Step Action

1 Turn the pump off if it is running.

IMPORTANT Do not remove the water reservoir while a run is in progress.

2 Open the water reservoir compartment on the right side of the instrument by pulling 
gently on the door.

3 Unscrew the water reservoir and remove it by pulling downward.

4 Place a paper towel under the tubes connecting the reservoir to the pump to catch 
any drips.

5 Fill the reservoir approximately 3/4 full (750–850 mL) with a solution of deionized 
water and 5.0% antifreeze (any brand). 

6 Replace the reservoir, and insert the tubes that connect it to the pump before 
screwing the reservoir into place.

7 Screw the reservoir into place, and close the compartment door.
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Replacing the Upper Buffer Chamber Gasket

Two Styles of Upper
Buffer Chambers

Your instrument will have one of two styles of upper buffer chambers. The earlier 
version (illustrated on page 8-7; P/N 604078) is white with a convex window, and is 
referred to in this section as the white upper buffer chamber. The version released in 
mid-1998 (illustrated on page 8-10; P/N 4304406) is transparent with a flat window, 
and is referred to in this section as the transparent upper buffer chamber. Separate 
instructions are provided for each chamber.

Parts and Tools
Required

For the Transparent Upper Buffer Chamber

For the White Upper Buffer Chamber

Parts and Tools Kit Part Number Supplier

ABI PRISM 377 Buffer Chamber Gasket 
Kit (contains 2 gaskets (P/N 430440), 
sealant (P/N 201480), and instructions)

7307172 Applied Biosystems

Latex gloves N/A Major laboratory supplier

Kimwipes® or similar lint-free wipes N/A Major laboratory supplier

Spatula
(must fit into groove of buffer chamber to 
remove old sealant)

N/A Major laboratory supplier

Parts and Tools Kit Part Number Supplier

ABI PRISM 377 Buffer Chamber Gasket 
Kit (contains 5 gaskets, sealant, and 
instructions)

604524 Applied Biosystems

Latex gloves N/A Major laboratory supplier

Kimwipes or similar lint-free wipes N/A Major laboratory supplier

Scrap glass plate or flat rigid plastic plate 
at least 10” x 4”

N/A Major laboratory supplier

Spatula
(must fit into groove of buffer chamber to 
remove old sealant)

N/A Major laboratory supplier
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Procedure for White
Upper Buffer

Chamber

The following is an illustration of the white upper buffer chamber.

Removing the Old Gasket

ELECTRICAL SHOCK HAZARD. The ABI Prism 377 contains a high voltage power supply. 
Although the instrument has been designed with safety features in the door to 
disconnect the power supply when the door is open, please follow procedures as 
prescribed. As with any electrophoresis apparatus, be careful during instrument 
operation and when handling electrodes and liquids.

Step Action

1 Disconnect the electrophoresis cable from the instrument and remove the buffer 
chamber.

2 Place the buffer chamber on a piece of clean lab paper so the lens is not scratched 
and does not touch the work surface.

3 Using the spatula, remove the old gasket and sealant from the groove of the buffer 
chamber. Be sure to remove all residual glue from the bottom of the groove.

IMPORTANT Do not use solvents to remove residual glue. Solvents can 
damage the chamber.
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Installing the New Gasket

To install the new gasket: 

Step Action

1 Fit the new gasket into the groove to ensure a proper fit. The rounded surface faces 
out. The surface with the channel must contact the bottom of the groove in the 
chamber. When properly fitted, remove the gasket.

� Trim the gasket if too long. 

� The gasket can be short within 1 mm of each end.

2 Wearing latex gloves, apply a 1/16” (1.5 mm) diameter bead of sealant into the 
center of the groove. Apply a consistent amount throughout the groove.

3  Place the gasket in the groove. 

4 Starting from one side of the chamber, use your index finger to gently press the 
gasket into the groove with a rolling motion.

IMPORTANT Do not use excessive force to push the gasket into the groove. 
Excessive force or stretching the center portion of the gasket can distort the 
material and adversely affect sealing.

5 Remove excess sealant with a Kimwipe. Be especially careful that no sealant is left 
on the surface of the gasket that will contact the glass plate.

6 Stretch the ends of the gasket to the ends of the groove if necessary, and hold the 
ends in place for 10 seconds.

CAUTION Never stretch the center portion of the gasket. 
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7 Place the scrap glass or plastic plate on top of the gasket, making sure the plate 
sits flat.

IMPORTANT Use scrap glass only. Do not use glass plates that are also used 
for gels. Residual sealant will ruin gel plates.

8 Press gently and evenly on the plate with your fingertips, and hold for 15 seconds.

9 Visually verify that there are no gaps between the plate and the gasket. If a gap 
exists, remove the plate and use your fingertips to flatten the gasket. Then return to 
step 7. If a gap still exists, remove the gasket, clean off the sealant, and return to 
step 1. Once there are no gaps, remove the glass plate and proceed to the next 
step.

10 Carefully remove all excess sealant with a Kimwipe.

11 Allow the sealant to cure for a minimum of 2 hours to overnight before use.

To install the new gasket: (continued)

Step Action

Glass plate
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Procedure for
Transparent Upper

Buffer Chamber

The following is an illustration of the transparent upper buffer chamber.

Removing the Old Gasket

ELECTRICAL SHOCK HAZARD. The ABI Prism 377 contains a high voltage power supply. 
Although the instrument has been designed with safety features in the door to 
disconnect the power supply when the door is open, please follow procedures as 
prescribed. As with any electrophoresis apparatus, be careful during instrument 
operation and when handling electrodes and liquids.

To remove the old gasket and sealant:

Step Action

1 Disconnect the electrophoresis cable from the instrument and remove the buffer 
chamber.

2 Place the buffer chamber on a piece of clean lab paper so the lens is not scratched 
and does not touch the work surface.

3 Using the spatula, remove the old gasket and sealant from the groove of the buffer 
chamber. Be sure to remove all residual glue from the bottom of the groove.

IMPORTANT Do not use solvents to remove residual glue. Solvents can 
damage the chamber.
8-10 System Maintenance



Installing the New Gasket

To install the new gasket: 

Step Action

1 Place the buffer chamber on clean lab paper to avoid scratching it.

2 Wearing latex gloves, apply a 1/16” (1.5 mm) diameter bead of sealant into the 
center of the groove. Apply a consistent amount throughout the groove.

3 Place the gasket in the groove as follows:

a. Hold the curves of the gasket as shown below, and place the gasket into the 
groove. 

b. Gently press the gasket in place starting with both positions 1 (the two curves 
of the gasket), then position 2, and then each position 3.

The gasket is longer than the groove. Do not cut off the ends of the gasket, 
otherwise the gasket will leak. It is a sealed gasket that must remain sealed to work 
effectively.

4 Remove excess sealant with a Kimwipe. Be especially careful that no sealant is left 
on the surface of the gasket that will contact the glass plate.

5 Install the buffer chamber onto a cassette with glass plates for at least two hours 
before filling it with buffer. This will ensure good adhesion and allow the sealant to 
cure.

1 1

2

33
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Replacing Electrophoresis Cables and Electrodes

Overview Electrophoresis cables and electrodes are built as assemblies to simplify their 
installation. Therefore, change the entire assembly when replacing a cable or 
electrode. Part numbers for the assemblies are as follows.

Procedure ELECTRICAL SHOCK HAZARD. The ABI Prism 377 contains a high voltage power supply. 
Although the instrument has been designed with safety features in the door to 
disconnect the power supply when the door is open, please follow procedures as 
prescribed. As with any electrophoresis apparatus, be careful during instrument 
operation and when handling electrodes and liquids.

To replace an electrophoresis cable and electrode assembly:

Buffer Chamber Electrode Assembly Part Number

Upper 254304

Lower 254303

Step Action

1 Disconnect the electrophoresis cable from the instrument and remove the buffer 
chamber.

2 To remove the cable/electrode 
assembly from the …

Follow these steps …

upper buffer chamber a. Remove the two plastic screws on the 
back left end of the upper buffer 
chamber (Figure 8-1 or Figure 8-2 on 
page 8-13).

b. Remove the assembly from the buffer 
chamber.

lower buffer chamber The assembly in the lower buffer chamber is 
held under a hook at the right end of the 
chamber.

a. Remove the flathead plastic screw.

b. Lift the electrode assembly from the left 
side.

c. Pull it from beneath the hook at the 
right end of the buffer chamber.

3 Insert the new assembly into the buffer chamber.

If replacing the assembly in the lower buffer chamber, be sure the assembly is 
properly situated under the hook at the right end of the chamber.

4 Reinstall the screw(s).
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Figure 8-1 Cable and electrode assembly in the white upper buffer chamber (P/N 604078)

Figure 8-2 Cable and electrode assembly in the transparent upper buffer chamber 
(P/N 4304406)

Front of buffer 
chamber

Remove these screws 
and lift the “L”-shaped 
fixture out of the chamber

The lower buffer chamber 
has a hook at the right end

Electrode fixture

Instrument 
connection

Electrophoresis 
cable

Front of buffer 
chamber

Electrode fixture

Electrophoresis 
cable

Instrument 
connection

Remove these screws 
and lift the “L”-shaped 
fixture out of the chamber
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CCD Pixel Position Value

Overview The charge coupled device (CCD) pixel position value is a reference point for 
alignment of the CCD camera with the laser beam. The instrument is shipped with the 
correct CCD pixel position value in memory. When you start a run, data collection 
software checks for a value greater than zero. If not found, the following error message 
is displayed.

Perform the following procedures to locate and reenter the correct CCD pixel position 
value before using the instrument.

Locating and
Entering the CCD

Pixel Position Value

The correct CCD pixel position value is printed on a white label affixed to the CCD 
camera. The label is visible from the front of the instrument through the opening below 
the rear heat-transfer plate. 

To locate the CCD pixel position value:

Rear heat-transfer 
plate

CCD camera with 
pixel position label 
visible here

Step Action

1 Have a flashlight available.

2 Open the front door of the instrument.

3 Shine the flashlight through the opening below the rear heat-transfer plate, and 
locate the white label on the CCD camera.

4 Record the value on the white label.

5 If you cannot find the label, call technical support (telephone numbers in Chapter 1.)
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Using Calibration
File Make

Use the Calibration File Make function from the Manual Control window to create the 
ABI 377 Calibrations file and store the CCD pixel position value in it. You can add the 
instrument serial number to the file as described below. The ABI 377 Calibrations file 
is placed in the Preferences folder inside the System folder. 

IMPORTANT You must have the correct CCD pixel position value in instrument memory 
before using Calibration File Make.

Creating an ABI 377 Calibrations File

Adding the Serial Number to the ABI 377 Calibrations File

You can add the instrument serial number to the ABI 377 Calibrations file using Simple 
Text, which is provided with the Macintosh® operating system.  

To enter the correct CCD pixel position value: 

Step Action

1 Turn power on to the instrument.

2 Select Manual Control from the Window menu in data collection software. 

3 Open the Fxn Name pop-up menu, and select the CCD Pixel Position function.

The current pixel position value is displayed. If it is the same as the value on the 
white label, do not complete the remaining steps. If the value is different, continue.

4 Select the text box, and type the correct CCD pixel position value.

5 Click Execute.

6 If the CCD Pixel Position error occurs again, call technical support (see Chapter 1.)

To create an ABI 377 Calibrations file: 

Step Action

1 Turn power on to the instrument.

2 Select Manual Control from the Window menu in data collection software.

3 Open the Fxn Name pop-up menu, and select Calibration File Make.

4 Click Execute, and select Save from the File menu.

To enter the instrument serial number: 

Step Action

1 Open the System Folder, the Preferences Folder inside it, and the ABI 377 
Calibrations file.

2 Select the series of question marks displayed, and type the instrument serial 
number in their place. (The serial number is located on the back of the instrument.)

3 Select Save from the File menu.

4 Close the ABI 377 Calibrations file.

5 Quit the SimpleText program.
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Using Calibration
File Send

Use Calibration File Send from the Manual Control window to send the CCD pixel 
position value and instrument serial number to the instrument. The serial number is 
included in all Sample files created by the instrument and can be viewed in the 
annotative view of the sample file. This is useful for instrument identification, 
particularly if you operate more than one instrument.

To send a Calibration file to the instrument:

Step Action

1 Turn power on to the instrument.

2 Select Manual Control from the Window menu. 

3 Open the Fxn Name pop-up.

4 Select Calibration File Send.

5 Click Execute.
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Computer Maintenance Recommendations

How To Maintain
Maximum

Operating Efficiency

Computers require regular maintenance to operate efficiently and consistently. 
Because the ABI PRISM 377 software works with large files and accesses the hard 
disk often, it is important to follow the procedures described in this section. Adherence 
to these recommendations will minimize the occurrence of errors during operation, 
and will help maintain maximum operating efficiency.

Recommendation For more information see …

Restart the Macintosh before each run. “Restarting the Computer” on 
page 8-18

Rebuild the desktop:

� Once a month

� After installing new software

� After running Norton Utilities™

“Rebuilding the Desktop” on 
page 8-18

Delete (or store on another medium and then delete) 
data files and other non-essential files from the hard 
disk at least once a week. 

Data files are gel files*, sample sheets, run sheets, 
and sample files. This practice will ensure that enough 
disk space is always available to run the instrument.

*Because gel files are so large (20–70 MB), we 
recommend deleting them as soon as satisfactory 
sample files are generated.

� “Deleting Data Files” on 
page 8-18

� “Archiving Data from Runs” on 
page 8-23

Includes a short description of 
each type of data file.

Optimize the hard disk when fragmentation is severe. 
Check the level of fragmentation once a month using 
Norton Speed Disk.

IMPORTANT Always backup important files 
before optimizing the hard disk.

� “Optimizing the Hard Disk” on 
page 8-19 

� “Norton Utilities” on page 8-22

Backup all programs and important files regularly. 
Examples include:

� Analysis and data collection software

� Matrix/instrument files

� Customized files such as custom modules and 
analysis parameters

� Size standard files

� “Backing Up Important Files” 
on page 8-20

Do not add other software programs to the Macintosh 
that runs the instrument.

“Adding Non-Applied Biosystems 
Software” on page 8-28

Install only one System file per hard disk. “System File” on page 8-29

Configure SAM™ to scan the desktop only. See “SAM” on page 8-21

Disable Norton’s automatic optimization features. See “Norton Utilities” on page 8-22
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Restarting the Computer

Overview Restart the Macintosh once each day or before every run. Restarting the computer 
clears the random access memory (RAM). This helps ensure enough memory is 
available to begin data collection.

Rebuilding the Desktop

Overview Rebuilding the desktop cleans up the Desktop system file. This file:

� Is invisible to users

� Keeps track of where everything is located on the hard disk

� Grows larger over time if it is not rebuilt

If the Desktop system file grows too large, the computer’s response time will slow to 
unacceptable levels. Therefore, we recommend rebuilding the desktop:

� Once a month

� After installing new software

� If you get a system error message with a bomb after inserting a disk

Procedure To rebuild the desktop:

Deleting Data Files

Overview We recommend removing unnecessary files from the hard disk before starting the 
data collection program. For example, the ABI PRISM 377 data collection and analysis 
software programs create large data files (gel files, sample files, sample sheets, and 
run sheets) that accumulate on the hard disk. Data files include gel files, sample files, 
sample sheets, and run sheets. These files can quickly fill all the available memory on 
the computer. 

Backup data files and other files that are not used regularly, and then delete the 
original files from the hard disk to reclaim memory for future work. This practice will 
ensure that enough disk space is available for new data files.

Step Action

1 Hold down the Command and Option keys, and choose Restart from the Special 
menu.

2 Continue to hold down the two keys until the message “Are you sure you want to 
rebuild the desktop file …?” appears on the screen.

3 Click OK.
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Procedure To delete a file from the hard disk:

Optimizing the Hard Disk

Why Optimize the
Hard Disk

Over time, files stored on the hard disk become fragmented—stored in pieces in 
various locations on the disk. As the amount of fragmentation increases, computer 
performance slows because it takes the computer longer to find all the pieces.

Optimizing the hard disk:

� Reduces fragmentation

� Frees up disk space

� Helps maintain optimum computer performance

Recommendations We recommend:

� Checking the fragmentation level of the hard disk once a month using Norton 
Speed Disk™. 

� Optimizing the hard disk when the fragmentation level is severe.

� Turning off automatic optimization features. Enabling these features can result in 
loss of data if the utility decides to optimize the hard disk while a run is in progress 
and data is being collected.

Refer to the Norton Utilities user’s manual for instructions on using Norton Speed 
Disk.

Before Optimizing
the Hard Disk

Before optimizing the hard disk, back up all important files onto floppy disks or another 
storage medium. Make sure you know where all the original software program disks 
(or copies of the programs) are located, should it become necessary to reload all the 
system software. See “Backing Up Important Files” on page 8-20, and “System 
Software” on page 8-25.

Step Action

1 If you wish to save the file, store it on a floppy disk or other storage medium.

2 Drag the file into the trash can.

3 Open the Special menu and choose Empty Trash.

4 Click OK.
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Backing Up Important Files

Overview Backing up means making a copy of the programs and files present on the hard disk, 
and storing the copies in a location other than the hard disk of the computer that runs 
the instrument. Various methods can be used to backup files, such as:

� Copying the files onto a portable disk, such as a Zip™ disk

� Copying the files to a server on a network

� Copying the files onto a hard drive other than the one used to run the instrument

� Using Disk Copy to make image files of software programs from the original floppy 
disks directly onto a hard drive or other storage media

Recommendations To avoid losing data files and software programs in the event of a hard disk failure, we 
strongly recommend:

� Backing up all important data files (gel files, sample files, run sheets, and sample 
sheets) once each day

� Making a copy of each important software program using an application such as 
Disk Copy

� Backing up other important files the same day they are created (e.g. custom 
modules, matrix/instrument files, size standard files, analysis parameter files)

� Before optimizing the hard disk:

– Backing up all important files

– Making sure the original or a copy of all the system software is available 
should it become necessary to reinstall the software
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SAM

Product Overview Symantec AntiVirus for Macintosh (SAM™) is comprehensive virus prevention, 
detection, and elimination software. Computer viruses are programs that replicate 
themselves in the computer system. They can spread throughout the programs on 
your hard disk, or spread over a network, eventually causing severe damage.

SAM performs the following functions:

� Checks applications for viruses when they are run

� Checks Microsoft Word documents and Excel worksheets for macro viruses

� Checks floppy disks for viruses when inserted into the hard drive

� Checks files downloaded from the Internet, a BBS, or email

� Monitors the Macintosh for activity that might indicate the presence of a virus

All of the software supplied with the ABI PRISM 377 DNA Sequencer is free of 
computer viruses. However, any additional software installed on the computer could 
have a virus.

Recommendations We recommend:

� Keeping SAM activated on the Macintosh at all times. 

� Setting up SAM so that it scans the desktop only. Otherwise, it may scan the hard 
drive while data is being collected, resulting in lost data.

Refer to the SAM user’s manual for more detailed information.
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Norton Utilities

Product Overview Norton Utilities™ is a collection of software utilities designed for data protection and 
recovery.

Use the following utilities to repair or recover disks, folders, or files:

� Norton Disk Doctor—repairs hard disks

� Volume Recover—restores accidentally initialized (but not formatted) hard disks or 
badly damaged disks using FileSaver information

� UnErase—Recovers files that have been thrown away or are not visible due to 
disk damage

� Norton Disk Editor—Edits data directly on the hard disk

Use the following utilities to prevent disk problems from becoming serious, and to 
minimize the effects of unavoidable damage:

� FileSaver

– Checks disks for problems while the Macintosh is idle, and alerts the user to 
problems as they develop

– Tells users when to perform backups or optimization

– Saves valuable information about your disks and files that other Norton 
Utilities use

� Startup Disk Builder—creates three types of custom startup disks used to start up 
the Macintosh and run Norton Disk Doctor, Norton Disk Editor, and Speed Disk

� Norton Fastback—Makes and restores backup copies of your files

� Wipe Info—Overwrites file contents so that they can never be recovered

� DiskLight—Alerts you to when the disk is being accessed

Use the following utilities to improve the performance of your Macintosh:

� Speed Disk—Optimizes (defragments) files on the hard disk to improve computer 
performance

� System Info—Rates the performance of your Macintosh

� Fast Find—Searches disks to find files by name or category

� Floppier—Makes exact copies of your disks that can be copied to new disks, or 
stored to disk as image files

Refer to the Norton Utilities user’s manual for more detailed information on this 
product.
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Archiving Data from Runs

Recommendations For optimal computer performance, we recommend the following:

� Keep as few files as possible on the hard disk. 

� Do not store gel files and run folders on the hard disk.

� Copy all files you want to save onto a backup medium before each run to ensure 
adequate disk space is always available.

Files Created During
a Run

When you set up a run, the data collection software creates a Run folder and a run 
file. During the run, the program automatically creates and saves two files: the Gel file 
and the Log file. After the run, the analysis program creates Sample and sequence 
(.Seq) files.

Run Files Each run file contains information that associates specific samples with specific lane 
positions. It also stores information about the sample sheet and module associated 
with the run. Run files are small enough to store on floppy disk. 

Gel Files Gel files contain the raw data acquired by the data collection program. They are 
typically very large (20–70 MB.) Because Gel files are so large, we recommend 
deleting them from the hard disk after you have obtained satisfactory Sample files. You 
do not usually need to keep gel files once lane tracking is adjusted and sample files 
are created.

Use magnetic tapes, removable cartridge drives, or optical drives to archive gel files. 
Gel files are too large to fit on floppy disks.

IMPORTANT Do not discard a gel file until lane tracking is adjusted (if necessary), and 
verified.

Log Files Log files provide a good record of your runs. Individually, Log files are small enough to 
archive on floppy disks. 

Sample files Use floppy disks, a magnetic tape drive, a removable cartridge drive, or an optical 
drive to archive sample files. A Sample file is 150-200 KB in size, depending on the 
length of the run. A 1.4 MB, high-density disk holds about six files. Archive Sample 
files once the channel selections (tracking) are correct.

.Seq files For sequencing applications only, .Seq files show the base letter sequence only (or a 
header, depending on the format you choose).You can open them from word 
processing programs and print them. You can also save the files in several formats 
that can be read by other software programs. The Preferences dialog box in the 
specific analysis program allows you to choose the file format.

Other Files Other files provide information for a run that you might have customized and should 
therefore save. These include the sample sheets, analysis settings, or the 
matrix/instrument files you create.
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Sample Sheet Files Sample sheets can be a good reference after data collection. Individually, sample 
sheet files are small enough to archive on floppy disks.

Custom Analysis
Settings and
Matrix Files

A backup copy of all custom analysis settings and matrix/instrument files should be 
kept on a separate storage medium. Each of these types of files alone is small enough 
to store on a floppy disk.
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Reinstalling ABI PRISM 377 Software

System Software The following software is supplied with the ABI PRISM 377 and is installed onto the 
computer by the Applied Biosystems Field Service Specialist during system 
installation.

� ABI PRISM® Data Collection Software, version 2.1 or higher

� Data analysis software—one or both of the following:

– ABI PRISM® GeneScan® Analysis Software, version 2.1 or higher

– ABI PRISM® DNA Sequencing Analysis Software, version 3.0 or higher

� Symantec AntiVirus for Macintosh (SAM™), version 4.0 or greater

� Norton Utilities™

Separate disks for each software program are included. Store these disks in a safe 
place.

Installation
Procedure

The following general procedure can be used to reinstall ABI PRISM 377 instrument 
software, such as sequencing or GeneScan analysis software. More specific 
instructions for downloading and installing data collection software from our website 
are listed under “Downloading Data Collection Software from Our Website” on 
page 8-26.

To install ABI PRISM 377 software:

Step Action

1 Quit any currently running applications.

2 Hold down the Shift key and choose Restart from the Special menu to restart the 
computer with extensions turned off. Continue holding down the shift key until you 
know the extensions are disabled. Some Macintosh’s will display a message that 
extensions are turned off. All Macintosh’s display extension icons that are X’d over.

IMPORTANT If extensions are not turned off, you may not be able to complete 
the installation.

3 Insert the Install disk into the appropriate drive.

4 If the Installer window does not open automatically, double-click the disk icon. 

5 Open the Readme file and read it.

6 Double-click the Installer icon.

7 Respond to the prompts as appropriate.

8 Click Quit when installation is complete.

9 Restart the computer to turn the extensions back on, and rebuild the desktop. (See 
“Rebuilding the Desktop” on page 8-18.)
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Downloading Data Collection Software from Our Website

Overview The most current version of ABI PRISM Data Collection Software for this instrument 
can be downloaded from our website. The procedure we recommend is as follows.

Renaming the
Existing Software

and Preferences

During installation, the new data collection software automatically overwrites the older 
version currently installed on the hard drive. We recommend saving the older version 
under a different name before the new version is installed. The old version can be 
deleted once you have verified the new version is successfully installed. We also 
recommend deleting the existing Preferences file prior to installing the new software.

To rename the old software and existing Preferences file:

Downloading from
the Website

To download the software from our website:

1. Save the existing software under a new name. This is recommended as a safeguard 
just in case something goes wrong when installing the new software.

2. Delete the existing Preferences file by saving it under a new name.

3. Download the new software from our website onto a floppy disk.

4. Load the new software from the floppy disk onto the hard drive.

5. Launch the new software.

6 Reset the Folder Locations preferences and any other preferences you use.

Step Action

1 Rename the ABI PRISM 377 folder. We suggest renaming the folder “ABI PRISM 377 
<version number>”. For example, ABI PRISM 377 v2.1.

2 Open the Preferences folder located inside the System folder.

3 Select the file named ABI 377, ABI 377XL, ABI 377-96, or ABI 377-18 as 
appropriate, and rename it. We suggest adding the suffix “v <version number>”. For 
example, Preferences v2.1.

4 Proceed to “Downloading Data Collection Software from Our Website”.

Step Action

1 Access the ABI PRISM 377 DNA Sequencer website at:
www.appliedbiosystems.com/techsupport

2 Click Download Software.

3 Click the 377 folder icon.

4 If not already on the hard drive, click on the DiskCopy.<version number>.hqx file. 
This utility program is required to create a floppy disk.

5 Click the appropriate data collection software .hqx file.

For example: ABI PRISM 377 v2.1.image.hqx
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Loading from
Floppy Disk to

Hard Drive

To load the software from the floppy disk onto the hard drive:

6 To copy the software onto a floppy disk:

a. Double-click the DiskCopy icon.

b. Open the Utilities menu and select Make A Floppy.

c. Select the data collection software image from the menu, and click Open.

d. When prompted, insert a blank floppy disk into the hard drive.

e. When finished, open the File menu and select Quit.

7 Quit the internet connection, and continue the installation by following the 
instructions listed under “Loading from Floppy Disk to Hard Drive” below.

Step Action

Step Action

1 Quit any currently running applications.

2 Hold down the Shift key and choose Restart from the Special menu to restart the 
computer with extensions turned off. Continue holding down the shift key until you 
see the extensions are all disabled.

IMPORTANT If extensions are not turned off, you may not be able to complete 
the installation.

3 Insert the disk with the software into the floppy drive of the Macintosh connected to 
the instrument.

4 If the Installer window does not open automatically, double-click the disk icon. 

5 Open the Readme file and read it.

6 Double-click the Installer icon.

7 Respond to the prompts by clicking Continue or Install.

8 Click Quit when installation is complete.

9 Close the installer window, and drag the disk icon to the trash to eject the disk.

10 Store the disk for future use.

11 Restart the Macintosh to turn the extensions back on, and rebuild the desktop. (See 
“Rebuilding the Desktop” on page 8-18.)

12 Launch the new software. If the old Preferences file was renamed as recommended 
under “Renaming the Existing Software and Preferences” on page 8-26, you will 
now be asked to specify various folder locations. See “Folder Location Preferences” 
in Chapter 5, “Setting Preferences.”
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Adding Non-Applied Biosystems Software

Recommendations IMPORTANT We strongly recommend that you do not install other programs on the 
Macintosh computer that runs the instrument. Some programs can interfere with instrument 
operation.

If additional software is installed, keep SAM activated to check for viruses (described 
on page 8-21).

Additional recommendations:

� Do not install games or screen savers onto the hard disk.

� Do not install programs that require additional control panels (CDEVs) or 
extensions (INITs). This includes games with custom sound or graphics. 
Unnecessary INITs can be turned off using the Extensions Manager.

INITs, Extensions, and CDEVs reside in the extensions and control panel folders in 
the System folder, and alter the programming code of the system. Compatibility is 
guaranteed only for the INITs shipped with the ABI PRISM 377 DNA Sequencer. Even 
seemingly innocuous INITs like SuperClock! and After Dark can interfere with system 
operation. If you suspect there is a problem with a specific INIT, follow the 
troubleshooting procedure listed below.

INIT
Troubleshooting

Procedure

If you suspect there is a problem with a specific INIT, follow this procedure.

To turn off specific INITs:

Step Action

1 Open the Extensions Manager window as follows:

a. Open the Apple menu.

b. Select Control Panels and open the control panels menu.

c. Select Extensions Manager.

2 Click the suspect INIT to remove the checkmark and turn it off.

3 Open the Special menu and select Restart to restart the Macintosh.

4 Try running the system without the INIT to see if this solves the problem.

To turn off all INITs:

Step Action

1 Restart the Macintosh while holding down the Shift key to turn off all INITs.

To turn all INITs back on:

Step Action

1 Restart the computer.
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System File

Overview Only one file named “System” is required to operate the Macintosh computer. The 
System file is located in the System Folder on the hard disk, and is essential for all 
operations on the Macintosh. The System folder and file are set up on the computer 
during system installation.

Other software programs sold by Applied Biosystems that can be used on the 
ABI PRISM 377 DNA Sequencer do not include a System file. However, applications 
sold by other manufacturers might include a System file. We strongly recommend that 
you do not install other System files if additional software is installed. See “Adding 
Non-Applied Biosystems Software” on page 8-28 for more information.

Note Store the System floppy disks or CDs in a safe place. We also recommend making a 
copy of each disk. A utility such as Disk Copy can be used.

For more information on the System file and folder, refer to the Macintosh system 
reference manual.
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System Software Overview

Overview The ABI PRISM® 377 DNA Sequencer is shipped with two types of software:

� ABI PRISM® Data Collection Software

� One of the following data analysis software programs:

– ABI PRISM® DNA Sequencing Analysis Software

– ABI PRISM GeneScan® Analysis Software

This chapter describes the ABI PRISM Data Collection Software. This software:

� Controls the instrument by sending it commands that are contained in files called 
modules

� Collects data from the instrument and stores it in a gel file

� Transfers data to either sequencing or GeneScan software for analysis

The data collection software is installed on the Macintosh® computer hard drive 
during system installation.

For more information on the data analysis software programs and the chemistries 
available for use with this system, refer to the following manuals:

� ABI PRISM GeneScan® Analysis Software User’s Manual

� GeneScan Reference Guide: ABI™ 373 and ABI PRISM 377 DNA Sequencers, 
P/N 4303188

� ABI PRISM® DNA Sequencing Software User’s Manual

� Automated DNA Sequencing Chemistry Guide: ABI 373 and ABI PRISM 377 DNA 
Sequencers, P/N 4305080

Also refer to the chemistry kit protocols, and to our website at: 
www.appliedbiosystems.com/techsupport.
9-2 Data Collection Software



Data Collection Software Files and Folders

Organizational
Structure

The data collection software program, and the various ancillary files and folders 
required to perform runs, generate sample files for data analysis, and store data are 
organized inside two folders on the Macintosh hard drive: 

� ABI PRISM 377 Folder — located directly on the hard drive

� ABI Folder — located inside the System folder (also referred to as the 
Settings Folder)

The folder and file structure is shown below.

Folders and Files Inside the ABI PRISM 377 Folder

Files Inside the ABI (Settings) Folder

Matrix files Instrument files DyeSet/Primer files Comb files

The names of the ABI Folder files shown here are examples only, and do not represent the 
entire contents of the ABI Folder. Refer to the following tables for a description of the folders 
and files in the ABI PRISM 377 and ABI folders.
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Folders Inside the
ABI PRISM 377

Folder

Description of folder in the ABI PRISM 377 folder:

The ABI folder (also referred to as the Settings folder) is located in the System Folder 
on the Macintosh hard drive. The ABI folder contains the following files:

Data collection software uses files from both the ABI PRISM 377 and ABI folders:

� For the preparation of sample and run sheets

� To control the instrument and collect data

As such, data collection software must always know where the folders containing 
these files are located on the hard drive. During system installation, the Applied 
Biosystems Field Service Specialist specifies the location of these folders by setting 
the Folder Locations Preference to the recommended defaults. Periodically you may 
have to reset these preferences. Refer to Chapter 5, “Setting Preferences,” on 
page 5-5 for more detailed information and instructions.

Folder Name Description of Contents

Runs Contains an individual run folder for each run sheet created. At the 
end of a run, the individual run folder will typically contain a run, 
gel, and log file (generated by data collection software), and 
sample files (generated by the analysis software).

Sample Sheets Contains each sample sheet created.

Modules Contains the standard module files. These files contain the 
commands used to operate the instrument for plate checks, 
preruns, and runs.

Chiller Modules Contains the module files used for plate checks, preruns, and runs 
for subambient temperature operation of the instrument.

Firmware Image Contains the firmware that resides on the instrument.

ABI PRISM 377 
Collection

The data collection software program file.

File Type Description

DyeSet/Primer Also referred to as mobility files. Contain the information used to 
compensate for differences (shifts) in sample mobility. See 
“DyeSet/Primer Files” on page 9-49 for more information.

Comb No longer used.

Instrument For sequencing applications only. A set of mathematical matrices 
used to compensate for the spectral overlap that occurs between 
the dyes used together as a set. Sometimes referred to as a matrix 
file.

Matrix For GeneScan applications only. A mathematical matrix used to 
compensate for the spectral overlap that occurs between the dyes 
used together as a set.
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Setting Folder Location Preferences

Overview To complete sequencing sample sheets and run sheets, you must select files from 
various pop-up menus. If one of these pop-up menus lists <none> only, software 
cannot find the folder that contains the pertinent files. To correct this, you must reset 
the appropriate Folder Locations Preference.

Guidelines are provided in the tables below. The information listed reflects the default 
folder names and locations as assigned automatically when ABI PRISM Data 
Collection Software is installed. 

IMPORTANT To avoid problems setting up sample and run sheets, we strongly recommend 
not changing the names or locations of these folders.

Instructions for setting Folder Location Preferences are listed on page 9-6. For more 
information, see “Data Collection Software Files and Folders” on page 9-3, and 
Chapter 5, “Setting Preferences.”

Sequencing Sample Sheet 
Pop-Up Menus

Folder Location Preference 
Dialog Box Field Folder Name and Location

DyeSet/Primer Settings Folder ABI folder inside the System folder

Instrument File Settings Folder ABI folder inside the System folder

Run Sheet Pop-Up Menus
Folder Location Preference 

Dialog Box Field Folder Name and Location

Plate Check, PreRun and Run 
Modules

Module Folder Modules folder (or Chiller Modules 
folder if appropriate) inside the 
ABI PRISM 377 folder

Sample Sheet Sample Sheet Folder Sample Sheets folder inside the 
ABI PRISM 377 folder

Instrument File (sequencing only) Settings Folder ABI folder inside the System folder

Gel’s Matrix File and Matrix File 
(GeneScan only)

Settings Folder ABI folder inside the System folder

Analysis Parameters (GeneScan 
only)

GeneScan Analysis Parameters GS Parameters folder inside the 
GeneScan Analysis software folder

Size Standard (GeneScan only) GeneScan Size Standard Folder GS Standards folder inside the 
GeneScan Analysis software folder
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Procedure To set folder location preferences:

Step Action

1 Open the Windows menu, select Preferences, and then select Folder Locations.

2 Click the field that corresponds to the folder location you wish to set.

3 Using the menus in the dialog box, locate and select the appropriate folder.

4 Click the “Select” field at the bottom of the dialog box to set the folder location. Do 
not click Open.

5 Return to step 2 to set additional folder location preferences, or click OK if finished.

For example, click this field 
to set the Module folder
location preference

Folder located
and selected

Click this field to set the location
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Data Flow Between the Computer and Instrument

Overview of
Data Flow

Data flows between the Macintosh computer and the ABI PRISM 377 instrument as 
shown below.

Input Files Information from the following files is used by data collection software to operate the 
instrument, and identify and store the data collected. These files are located in the 
ABI PRISM 377 Folder.

Macintosh ComputerABI Prism 377 Instrument

Data collection software sends the operating instructions specified in modules selected on the 
run sheet to the instrument. As the run is performed, the instrument sends raw sample data 
back to the computer. This data is stored in a Gel file. Data is then automatically or manually 
extracted from the gel file, and analyzed by sequencing or GeneScan analysis software.

Gel File

Sequencing 
Analysis

GeneScan 
Analysis

Run Sheet

Sample
Sheet

Module
files

DATA 
COLLECTION 

PROGRAM

ANALYSIS 
PROGRAMS

Raw sample data

Operating 
instructions

Electrophoresis

File Type Location* Description

Sample Sheet Sample Sheets 
folder inside the 
ABI PRISM 377 
folder

Contain information used for:

� sample identification and tracking

� data analysis

Module or Chiller 
Module

Modules or Chiller 
Modules folder 
inside the 
ABI PRISM 377 
folder

Contain instrument settings for the various plate checks, 
pre-runs, and runs that can be performed. The modules 
to be used for a run are specified on a run sheet. 

Run Sheet Individual run 
folders inside the 
Runs folder inside 
the ABI PRISM 377 
folder

Contain:

� Sample information imported from the sample 
sheet

� Module designations and other pertinent 
information used to direct instrument operation and 
data collection

* Locations valid only if folder location preferences are not changed. See “Setting Folder Location 
Preferences” on page 9-5 and Chapter 5, “Setting Preferences,” for more information.
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Sample and run sheets both require the selection of additional information for their 
completion. Refer to the following for more information:

� “About Sample Sheets for Sequencing Applications” on page 9-14, or “About 
Sample Sheets for GeneScan Applications” on page 9-20

� “About Run Sheets” on page 9-28

� “Modules” on page 9-42

Output Files The following files are created automatically by data collection software for each run.

Temporary Files
Created in the
System Folder

Software creates a number of temporary files in the System folder. Do not delete 
these files. They are deleted automatically when no longer needed.

Launching the Data Collection Software Program

How to Launch To launch the data collection program.

File Type Location* Description

Gel

All three files are 
located in an 
Individual Run 
folder inside the 
Runs folder inside 
the ABI PRISM 377 
folder

Contains the data collected during a run.Gel files are typically 
very large (20–70 MB.) The default naming convention used for 
gel files is: •Gel File•<date>•<time>

Log Contains a date and time-stamped comprehensive history of 
actions taken, instrument and computer conditions, and any 
errors received during a run. The default naming convention 
used for log files is: Log

Run This file is a copy of the run sheet prepared for the run. The run 
sheet is also an input file. The default naming convention used 
for run files is: •Run File•<date> <time>

* Locations valid only if folder location preferences are not changed. See “Setting Folder Location 
Preferences” on page 9-5 and Chapter 5, “Setting Preferences,” for more information.

Step Action

1 From the Finder, open the Special menu and select Restart.

We recommend restarting the computer once a day or before each run to reduce 
memory fragmentation, and to quit any applications running in the background.

2 Double-click the data collection software program icon or the alias.

3 If … Then …

the software launches properly proceed with preparing the instrument 
and software for a run.

a dialog box asking for folder locations 
appears

you must set the Folder Locations 
Preference. Instructions are located on 
page 9-5, and in Chapter 5, “Setting 
Preferences.”.
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Menu Commands

Overview Data collection software has its own menu bar (shown below) located at the top of the 
computer screen after the software is launched. Pull-down menus and the 
point-and-click technique are used to execute commands. As you become familiar 
with this software, you can also use shortcut keyboard commands when available. 
Shortcut keyboard commands are listed opposite the corresponding command on the 
pull-down menu (see the File Menu illustration on page 9-10).

Active versus
Inactive Menu

Commands

Commands in the pull-down menus can be active or inactive. Active commands are 
shown in bold print and can be selected by the user. Inactive commands are shown in 
grey and cannot be selected at that particular time. You will see inactive commands 
become active at various times throughout the procedures you perform.

Apple Menu

The Apple menu is a standard Macintosh feature. It displays and provides access to 
the desktop accessories installed on the system.

The first item in the Apple menu, About ABI Prism 377 Collection, opens the data 
collection software splash screen, which shows general information about the 
software including the version. Click anywhere on the splash screen to close it.

This command is active, and can be selected by the user

This command is inactive, and cannot be selected at this
time by the user
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File Menu

File menu commands

Command Description
For more 
detail see

Close, Save, 
Save As …, 
Page Setup …,
Print …, Quit

Standard Macintosh commands. Macintosh 
manual

New …
Open …

Opens run and sample sheets. Use New to create a 
new file. Use Open to open an existing file.

—

Save a Copy In … Use to make an extra copy of an existing file for backup 
or modification. The copy can be renamed and stored in 
a different location from the original. —

Import … Imports text from files such as those generated by a 
database into a sample sheet.

page 9-27

Export … Exports data from a sample sheet in tab-delimited text 
format for database applications.

page 9-27

Print One Prints one copy of the active window. Bypasses the 
standard print dialog box.

—

The File menu contains commands for:

� Creating, opening, closing, and saving files

� Importing and exporting data to other file types

� Printing

� Quitting the application

Keyboard shortcut commands
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Edit Menu

Edit menu commands 

Command Description

Undo (Undo Typing, 
Undo Paste, Can’t 
Undo), Cut, Copy, 
Paste, Clear, 
Show Clipboard

Standard Macintosh commands. Refer to the Macintosh manual 
for more information.

Select All Selects all the cells of a sample sheet.

Fill Down Inserts text into all the cells selected in a column on a sample 
sheet.

Set Scale... Sets the scale of the panels in the Electrophoresis History 
window.

Show Clipboard The information selected when using the Copy command is 
saved to the clipboard. Use this command to see what you have 
copied to the clipboard prior to using the Paste command.

The Edit menu contains:

� Standard editing and selecting commands

� Spreadsheet editing commands

� Command for changing the scale in the Electrophoresis History 
window
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Instrument Menu

Instrument menu commands

Command Description
For more 
detail see

Start Plate Check Starts a plate check using the settings of the plate check 
module specified on the run sheet. The gel and plates 
are scanned without electrophoresis before loading 
samples to ensure the plates are clean and the gel is not 
contaminated.

Chapters
1 and 3

Start PreRun Starts a prerun using the settings of the prerun module 
specified on the run sheet.

Start Run Starts a run using the settings of the run module 
specified on the run sheet.

Pause Temporarily halts the scanner. No functions are 
performed. The data in instrument memory continues to 
be stored, and the gel temperature increases or is 
maintained as appropriate.

Resume Resumes instrument operation. This command 
becomes active after instrument operation has been 
paused using the Pause command.

Cancel Run Active only when a module is running. Allows you to 
immediately stop the run in progress. The run is ended, 
and the run sheet is closed. A run cannot be resumed 
once it is cancelled.

The Instrument menu contains commands for starting, pausing, and 
stopping instrument operation.
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Window Menu

Choosing any window from this menu brings that window to the front and makes it the 
active window.

Window menu commands

Command Description
For more 
detail see

Status Displays the Status window. page 9-53

Log Displays the Log file. Command is active only when a 
module is running.

page 9-54

Sample Sheet Command active only if a sample sheet is open in the 
background while a module is running. Sample 
information can be changed. However, the changes will 
not affect the run in progress. 

page 9-14 
and 9-20

Run Command active only if a run sheet is open in the 
background while a module is running. Information 
cannot be changed once the Run button is clicked.

page 9-28

Scan Displays the Scan window. Command is active only 
when a module is running.

page 9-55

Gel Image Displays the Gel File. Command is active only when a 
module is running.

page 9-55

Electrophoresis 
History

Displays the Electrophoresis History window. Command 
is active only when a module is running.

page 9-56

Manual Control Displays a window that allows you to manually control 
certain instrument functions.

page 9-57

Preferences Opens the Preferences menu. Chapter 5, 
“Setting 
Preferences”

The Window menu opens:

� The standard windows associated with a run (Status, Log, 
Sample Sheet, Run Sheet, Scan, Gel Image, and 
Electrophoresis History)

� Manual Control window

� Preferences menu

� Any other windows listed at the bottom of the menu
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About Sample Sheets for Sequencing Applications

What is a
Sequencing

Sample Sheet

A sequencing sample sheet (shown below) is a file that contains information used for:

� Sample identification and tracking

� Data analysis

There are two types of sample sheets: one for sequencing, and one for GeneScan 
analysis applications. The information entered on the sample sheet is imported to the 
sequencing run sheet (described on page 9-28).

IMPORTANT Do not mix sequence and GeneScan analysis samples on the same sample 
sheet or in the same run.

Description of Fields
on the Sample Sheet

The information specified on sequencing sample sheets is described below:

Name of Field Description

Sample Name Name assigned to a sample.

IMPORTANT Each sample must have a unique name. Limit 
sample names to 27 characters including the default characters. Do not 
use colons, slashes, or symbols in sample names. 

DyeSet/Primer Also referred to as a mobility file. Contains the information used to:

� Compensate for differences (shifts) in sample mobility

� Interpret what each dye color in a set represents

A dye set/primer file must be selected for data to be analyzed 
automatically at the end of a run. For more information see:

� “About Automatic Data Analysis” on page 9-38

� “DyeSet/Primer Files” on page 9-49

Project Name

(for BioLIMS® 
software users 
only)

Used to identify data transferred to BioLIMS software. If a project name 
is not specified, the data transferred to BioLIMS is identified by the gel 
file name only.

Project names must be entered in the Project Info Preference prior to 
preparing a sample sheet. Refer to “Project Information Preferences” in 
Chapter 5 for instructions and more information.
9-14 Data Collection Software



General Sample
Sheet Information

The following general information will help you prepare sample sheets.

� Sample sheet information is used by the software to identify each individual 
sample when Sample Files (described on page 9-60) are generated after a run. 
Therefore, it is critical that each sample name be entered in the field whose 
number corresponds to the gel lane in which the sample is loaded.

� If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up sequencing sample sheets by setting sequencing 
sample sheet default preferences. See “Save Time by Setting Sample Sheet 
Preferences” on page 9-16, and Chapter 5, “Setting Preferences,” for more 
information.

� An instrument file is specified on both the sample and run sheets. The same file 
should be specified on both sheets. However, if different files are selected, the 
instrument file specified on the sample sheet is the one used for automatic data 
analysis. If <none> is selected on the sample sheet, the instrument file selected 
on the run sheet is used.

� Information can be imported from tab-delimited text files (for instance, files 
generated by a database). The sample sheet can be exported as a tab-delimited 
text file to database, spreadsheet, or word processing programs. Refer to 
“Importing and Exporting Sample Sheet Information” on page 9-27 for more 
information.

� The same sample sheet can be used for more than one run if the information 
required is the same. An existing sample sheet can also be used as a template to 
create new sample sheets by opening the file, saving it under a different name 
(“Save As” command under the File menu), and then modifying the new file.

� If the wrong dye set/primer or instrument file is specified, the data can be 
reanalyzed using the correct file. Refer to the ABI Prism DNA Sequencing 
Analysis Software User’s Manual for more information.

� Sample sheets can be printed.

Instrument File Also referred to as a matrix file, an instrument file is a set of up to three 
mathematical matrices used to compensate for the spectral overlap 
that occurs between the dyes used together as a set. During system 
installation, the engineer installing the system creates a default 
instrument file that is given the instrument serial number as a file name. 
Depending on the chemistries used, you may have to create additional 
instrument files. 

An instrument file must be selected for data to be analyzed 
automatically at the end of a run.

For more information, see:

� “About Automatic Data Analysis” on page 9-38

� Chapter 6, “Making Matrix Files for GeneScan”

� The chemistry kit protocol

� Automated DNA Sequencing Chemistry Guide, P/N 4305080

Comments Any additional information.

Name of Field Description
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Preparing a Sequencing Sample Sheet

IMPORTANT Do not mix sequence and GeneScan analysis samples on the same sample 
sheet or in the same run.

Save Time by
Setting Sample

Sheet Preferences

If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up sample sheets by setting sequencing sample sheet 
default preferences. Setting sample sheet preferences means setting the default value 
of certain fields to the values used most often. The following fields on sequencing 
sample sheets can be set as preferences:

� DyeSet/Primer

� Instrument File

Once these preferences have been set, the preferred values appear automatically on 
each new sequence sample sheet. Preferences can be changed as often as 
necessary either by setting new preference values, or by opening the pop-up menus 
and manually selecting new values. Instructions for setting sequencing sample sheet 
default preferences are located in Chapter 5, “Setting Preferences.”

Entering
Information

See “How to Enter Information on Sample Sheets” on page 9-26. Procedures include:

� Applying the same parameter to all fields in a column

� Copying information from one field or row to another

� Moving information from one lane to another

Opening a New
Sample Sheet

To open a new sequencing sample sheet:

Step Action

1 If necessary, launch the data collection software. (Instructions are listed under 
“Launching the Data Collection Software Program” on page 9-8.)

2 Open the File menu and select New.

3 Click the icon named Sequence Sample.
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Entering
Sample Names

To import sample names from tab-delimited text files, follow the instructions listed 
under “Importing and Exporting Sample Sheet Information” on page 9-27. Otherwise, 
follow this procedure.

To enter sample names: 

Step Action

1 Enter sample names in the Sample Name column by clicking in the Sample Name 
field, and typing the sample name. Enter names in the exact order the samples will 
be loaded onto the gel. The numbers to the left of the Sample Name column 
represent the gel lane numbers. Leave fields blank that correspond to empty lanes.

IMPORTANT Each sample must have a unique name. Limit sample names to 
27 characters including the default characters. Do not use colons, slashes, or 
symbols in sample names. 

Note More text can be entered than is visible. Text automatically shifts as the 
information is entered. Use the keyboard arrow keys to scroll through long entries. 

2 If matrix standard samples are being run, enter a name for each matrix sample. To 
help ensure a robust matrix is produced, we strongly recommend you follow these 
guidelines:

� Leave at least one empty lane between non-matrix standard samples and 
matrix standard samples.

� Leave one empty lane between each matrix standard sample.

Lane number on the gel

Empty lanes 
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Selecting the
DyeSet/Primer File

Different dye set/primer files can be used for the same run as long as the virtual filter 
set is the same for all samples. Dye set/primer file names for dRhodamine Terminators 
are similar to those for BigDye™ Terminators, and can easily be mistaken for one 
another. If the wrong file is selected, base spacing in the data will not be noticeably 
affected. C and T bases will be miscalled. If you are not sure which file to select, refer 
to the chemistry kit protocol and to “DyeSet/Primer Files” on page 9-49.

Selecting the
Instrument File

The instrument file must be the same for all the samples.

To select a dye set/primer file:

Step Action

1 Open the DyeSet/Primer pop-up menu and select the appropriate file for the first 
sample. You must select a file if you want the data to be analyzed automatically at 
the end of the run.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the 
folder that contains the dye set/primer files. To correct this, you must set the 
Settings Folder Preference to the ABI Folder. See “Setting Folder Location 
Preferences” on page 9-5.

2 If the file is the same for all remaining samples, click in the column heading to select 
the entire column, open the Edit menu, and select Fill Down. Otherwise, select the 
appropriate DyeSet/Primer file for each sample individually.

Click these boxes to 
open pop-up menus

Click in this field to select
the entire column

To select the instrument file:

Step Action

1 Open the Instrument File pop-up menu for the first sample, and select the 
appropriate file. You must select a file if you want the data to be analyzed 
automatically at the end of the run.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the 
folder that contains the instrument files. To correct this, you must set the Settings 
Folder Preference to the ABI Folder. See “Setting Folder Location Preferences” on 
page 9-5.

2 Click in the column heading to select the entire column, open the Edit menu, and 
select Fill Down to enter the same instrument file for the remaining samples.
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Selecting Project
Names and

Entering Comments

The Project Name field is for BioLIMS software users only. Otherwise, the field can be 
left blank. If a project name is not identified, the data transferred to BioLIMS is 
identified by the gel file name only. 

Project names must be defined prior to setting up the sample sheet as Project Info 
Preferences. Refer to “Project Information Preferences” in Chapter 5 for instructions 
and more information.

Saving and
Closing the

Sample Sheet

To save and close the sample sheet:

To select project names and enter comments:

Step Action

1 Open the Project Name pop-up menu for each sample, and select the appropriate 
project name.

2 If the Project Name is the same for all remaining samples, click in the column 
heading to select the entire column, open the Edit menu, and select Fill Down. 
Otherwise, select the appropriate Project Name for each sample individually.

3 To enter a comment, click in the Comments field, and type the information.

Click here to open the
Project Name pop-up menu

Step Action

1  Do one of the following:

� Open the File menu and select Close.

� Click the box in the upper left-hand corner of the window, and then click Save.

2 Click Save.

3 A dialog box showing the default sample sheet file name, and the location where 
the sample sheet will be stored is displayed. 

a. Change the file name now if desired.

b. Click Save.

IMPORTANT Although it is an option, we do not recommend changing the 
storage location of the sample sheet. If the location is changed, software will not be 
able to locate the sample sheet when you set up the run sheet.

Note You can also save the sample sheet by opening the File menu and 
selecting Save, Save As, or Save A Copy In.

Folder where sample sheets
are stored

Sample sheet file name
Data Collection Software 9-19



About Sample Sheets for GeneScan Applications

What is a GeneScan
Sample Sheet

A GeneScan sample sheet (shown below) is a file that contains information used for:

� Sample identification and tracking

� Data analysis

There are two types of sample sheets: one for GeneScan and one for sequencing 
analysis applications. The information entered on the sample sheet is imported to the 
GeneScan run sheet (described on page 9-28).

IMPORTANT Do not mix GeneScan and sequence analysis samples on the same sample 
sheet or in the same run.

Description of Fields
on the Sample Sheet

The information specified on GeneScan sample sheets is described below:

Name of Field Description

Sample Name Name assigned to a sample.

IMPORTANT Each sample must have a unique name. Limit 
sample names to 27 characters including the default characters. Do 
not use colons, slashes, or symbols in sample names.

Project Name

(for BioLIMS 
software version 2.0 
and up only)

Used to identify data transferred to BioLIMS software. If a project 
name is not specified, the data transferred to BioLIMS is identified 
by the gel file name only.

Project names must be entered in the Project Info Preference prior 
to preparing a sample sheet. Refer to “Project Information 
Preferences” in Chapter 5 for instructions and more information.

Color and Pres Used to indicate the dye colors run in each lane on the gel. Required 
for data to be analyzed automatically. See “About Automatic Data 
Analysis” on page 9-38 for more information.

Std Used to indicate the color of the size standard. Required for data to 
be analyzed automatically. See “About Automatic Data Analysis” on 
page 9-38 for more information.

Sample Info Additional sample identification information used by ABI PRISM 
Genotyper® DNA Fragment Analysis Software.

Comments Any additional information.
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General Sample
Sheet Information

The following general information will help you prepare sample sheets.

� Sample information is used by the software to identify each individual sample 
when Sample Files (described on page 9-60) are generated after a run. 
Therefore, it is critical that each sample name be entered in the field whose 
number corresponds to the gel lane in which the sample is loaded.

� If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up GeneScan sample sheets by setting GeneScan 
sample sheet default preferences. See “Save Time by Setting Sample Sheet 
Preferences” on page 9-22, and Chapter 5 for more information.

� Information can be imported from tab-delimited text files (for instance, files 
generated by a database). The sample sheet can be exported as a tab-delimited 
text file to database, spreadsheet, or word processing programs. Refer to 
“Importing and Exporting Sample Sheet Information” on page 9-27 for more 
information.

� The same sample sheet can be used for more than one run if the information 
required is the same. An existing sample sheet can also be used as a template to 
create new sample sheets by opening the file, saving it under a different name 
(“Save As” command under the File menu), and then modifying the new file.

� Sample sheets can be printed.
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Preparing a GeneScan Sample Sheet

IMPORTANT Do not mix GeneScan and sequence analysis samples on the same sample 
sheet or in the same run.

Save Time by
Setting Sample

Sheet Preferences

If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up sample sheets by setting GeneScan sample sheet 
default preferences. Setting sample sheet preferences means setting the default value 
of certain fields to the values used most often. The following field can be set as a 
preference:

� Std (size standard dye color)

Once you have set this preference, the preferred value appears automatically on each 
new GeneScan sample sheet. This preference can be changed as often as necessary 
either by setting a new preference value, or by manually selecting a different value on 
the sample sheet. Instructions for setting GeneScan sample sheet default preferences 
are located in Chapter 5, “Setting Preferences.”

Entering
Information

See “How to Enter Information on Sample Sheets” on page 9-26. Procedures include:

� Applying the same parameter to all fields in a column

� Copying information from one field or row to another

� Moving information from one lane to another

Opening a New
Sample Sheet

To open a new GeneScan sample sheet:

Entering
Sample Names

To import sample names from tab-delimited text files, follow the instructions listed 
under “Importing and Exporting Sample Sheet Information” on page 9-27. Otherwise, 
follow this procedure.

Step Action

1 If necessary, launch the data collection software. (Instructions are listed under 
“Launching the Data Collection Software Program” on page 9-8.)

2 Open the File menu and select New.

3 Click the icon named GeneScan Sample.

To enter sample names: 

Step Action

1 Enter sample names in the Sample Name column by clicking in the appropriate 
Sample Name field, and typing the sample name. Enter names in the exact order 
the samples will be loaded onto the gel. The numbers to the left of the Sample 
Name column represent the gel lane numbers. Leave fields blank that correspond 
to empty lanes.

IMPORTANT Each sample must have a unique name. Limit sample names to 
27 characters including the default characters. Do not use colons, slashes, or 
symbols in sample names. 

Note More text can be entered than is visible. Text automatically shifts as the 
information is entered. Use the keyboard arrow keys to scroll through long entries.
9-22 Data Collection Software



Selecting
Project Names

The Project Name field is for BioLIMS software version 2.0 and up users only. 
Otherwise, the field can be left blank. If a project name is not identified, the data 
transferred to BioLIMS is identified by the gel file name only. 

Project names must be defined prior to setting up the sample sheet as Project Info 
Preferences. Refer to “Project Information Preferences” in Chapter 5, “Setting 
Preferences,” for instructions and more information.

2 If matrix standard samples are being run, enter a name for each matrix sample. To 
help ensure a robust matrix is produced, we strongly recommend you follow these 
guidelines:

� Leave at least one empty lane between non-matrix standard samples and 
matrix standard samples.

� Leave one empty lane between each matrix standard sample.

IMPORTANT Matrices are dye set, instrument, and run condition dependent. 
As such, matrices must be remade when any of these conditions change. For more 
information, refer to Chapter 6, “Making Matrix Files for GeneScan.”.

To enter sample names: (continued)

Step Action

Lane number on the gel

Sample A loaded in lane 1

Lane 2 left empty

First matrix standard sample

Lane 4 left empty

Second matrix standard sample

loaded in lane 3

loaded in lane 5

To select project names:

Step Action

1 Open the Project Name pop-up menu for each sample, and select the project 
name.

2 If the Project Name is the same for all remaining samples, click in the column 
heading to select the entire column, open the Edit menu, and select Fill Down. 
Otherwise, select the appropriate Project Name for each sample individually.

Click here to open the
Project Name pop-up menu
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Specifying the Size
Standard Dye Color

To specify the size standard dye color:

Specifying the Dyes
Run in Each Lane

The dye colors run together in a lane must be specified for each sample.

Entering Sample
Info and Comments

The information in the Sample Info and Comments fields is imported into ABI PRISM 
Genotyper® DNA Fragment Analysis Software, and is used for sample identification 
and sorting. If these fields are left blank, only the words “sample file” will appear when 
sample information is displayed in Genotyper.

To enter Sample Info and Comments:

Step Action

1 For all non-matrix standard samples, designate the color of the size standard by 
clicking in the box to the right of the appropriate letter in the Color column (B = blue; 
G = green; Y = yellow; R = red). When selected, a diamond is displayed in the Std 
column. This must be specified for data to be analyzed automatically.

2 Leave the Std column blank for matrix standard samples. If necessary, remove 
diamonds for matrix standard samples by clicking on the diamond.

Size standard
dye color is red

To specify the dye colors run together in each lane:

Step Action

1 Click in the appropriate boxes in the Pres (present) column to select the dye colors 
that will be run in each lane for each sample. Codes for the colors are displayed in 
the Color column (B = blue; G = green; Y = yellow; R = red). Dyes be specified for 
data to be analyzed automatically.

2 To deselect a color, click in the appropriate box to remove the X.

Click in these boxes to 
indicate the dyes being 
run in each lane

Step Action

1 To enter Sample Info, click in the Sample Info field and type the information.

2 To enter a comment, click the Comments field, and type the information.
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Saving and
Closing the

Sample Sheet

To save and close the sample sheet:

Step Action

1 Do one of the following:

a. Open the File menu and select Close.

b. Click the box in the upper left-hand corner of the window, and then click Save.

2 Click Save.

3 A dialog box showing the default sample sheet file name, and the location where 
the sample sheet will be stored is displayed. 

a. Change the file name now if desired.

b. Click Save.

IMPORTANT Although it is an option, we do not recommend changing the 
storage location of the sample sheet. If the location is changed, software will not be 
able to locate the sample sheet when you set up the run sheet.

Note You can also save the sample sheet by opening the File menu and 
selecting Save, Save As, or Save A Copy In.

Folder where sample sheets
are stored

Sample sheet file name
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How to Enter Information on Sample Sheets

Entering Sample
Names, Sample Info,

and Comments

Click in the Sample Name, Sample Info (GeneScan sample sheets only), or 
Comments field. Type the desired information. More text can be entered in a field than 
is visible. Text automatically shifts as it is entered. Use the keyboard arrow keys to 
scroll through long entries.

Moving From One
Field to Another

Several methods can be used to move from one field to another:

� Click in the field

� Press the directional arrow keys

� Press Tab to move to the next field to the right

� Press Return to move to the next field down

Applying Same
Parameter to all

Fields in a Column

To apply the same parameter to all fields in a column:

Copying
Information

To copy information from one field to another:

To copy an entire row of information to another row:

Moving Information To move information to a different lane:

Step Action

1 Select the parameter in the top field of the column.

2 Click the column title to select the entire column.

3 Open Edit menu and choose Fill Down.

Step Action

1 Click the field to be copied.

2 Open the Edit menu and choose Copy.

3 Click the new field.

4 Open the Edit menu and choose Paste.

Step Action

1 Click the lane number in the left-most column to select the entire row.

2 Open the Edit menu and choose Copy.

3 Click the lane number of the row you wish to copy into.

4 Open the Edit menu and choose Paste.

Step Action

1 Hold down the Option key, and click the lane number of the row containing the 
information you want to move.

2 Holding down Option key and the mouse button, drag the lane number to another 
lane number. When you release the mouse button, the sample information appears 
in the new location.
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Importing and Exporting Sample Sheet Information

Importing
Information

To import information into a sample sheet:

Exporting
Information

Exporting information from a completed sample sheet creates a tab-delimited text file. 
The format of this file is the same as the format discussed in step 1 of the import 
procedure listed above.

To export information from the sample sheet to a text file:

Step Action

1 Export the information to be imported to the sample sheet into a tab-delimited text 
file. Format the file based on the following guidelines:

� The file should contain only the information you wish to import. It should not 
have a header.

� The information imported to the first field in the sample sheet is everything up 
to the first tab in the text file.

� Each row in the text file should contain the information for one row in the 
sample sheet. Rows should ordered as you wish them to appear on the sample 
sheet.

1 Open the Edit menu and choose Select All to select all fields in the sample sheet.

2 Open the Edit menu and choose Import.

3 In the dialog box, choose the file you wish to import.

4 Click OK.

Step Action

1 Activate the sample sheet window by clicking in it.

2 Open the Edit menu and choose Export.

3 In the dialog box, enter a name for the text file.

4 Click OK. The icon used for exported files is shown below.
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About Run Sheets

What is a Run Sheet A run sheet is a file that contains:

� The software modules and other pertinent information used to direct instrument 
operation during a run. A typical run consists of the:

– Plate check

– Prerun

– Run

(See Chapters 1 and 3 for more information on the plate check, prerun and run.)

� Sample identification information

� Gel comb configuration

� Information required for automatic data analysis (see “About Automatic Data 
Analysis” on page 9-38 for more information)

The run sheet is also used to control the instrument. In this context it is referred to as 
the run window. The instrument is controlled by clicking the buttons at the top of the 
run window (Plate Check, PreRun, Run, Pause/Resume, and Cancel.)

There are two types of run sheets: one for sequencing, and one for GeneScan 
analysis applications.

Sequencing
Run Sheets

The following is a new sequencing run sheet for standard ABI PRISM 377 instruments. 
The run sheet for instruments with the XL or 96-lane upgrade differs slightly as noted 
in the following table.

Run sheets for sequencing analysis applications contain the following information:

Parameter Description

Plate Check Module* File containing the instrument settings for the plate check.

PreRun Module* File containing the instrument settings for the prerun.

Run Module* File containing the instrument settings for the run.

Collect time* The length of time in hours that data will be collected.

Sample Sheet The sample sheet prepared for the run. When selected, the 
information from the sample sheet is imported to the sample 
information fields on the run sheet.

* Can be set as Preferences. See “Setting Run Sheet Preferences” on page 9-31.
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GeneScan
Run Sheets

The following is a new GeneScan run sheet for standard ABI PRISM 377 instruments. 
The run sheet for instruments with the XL or 96-lane upgrade differs slightly as noted 
in the following table.

Well-to-Read Distance* The well-to-read distance of the glass plates in cm.

Instrument File* Also referred to as a matrix file, an instrument file is a set of 
mathematical matrices used to compensate for the spectral 
overlap that occurs between the dyes used together as a set. The 
instrument file created by the service engineer during system 
installation is given the instrument serial number as its name. 
Depending on the chemistries used, you may have to create 
additional instrument files. 

An instrument file must be selected for data to be analyzed 
automatically at the end of a run.

For more information, refer to:

� “About Automatic Data Analysis” on page 9-38

� Chapter 7, “Making Instrument Files for Sequencing”

� Automated DNA Sequencing Chemistry Guide, 
P/N 4305080

� Chemistry kit protocol

Lanes* Number of lanes in the gel.

Run Mode*
(XL or 96-lane upgrade 
instruments only)

This field is displayed for ABI PRISM 377 XL or 96-lane upgrade 
instruments only. It is used to designate the scan mode: 96 Lane 
Scan, XL Scan, or Full Scan.

Operator* Operator’s name.

Sample Number, 
Sample Name, 
Sample File Name

These fields are filled in automatically when the Sample Sheet is 
selected.

Auto Analyze When selected, data is automatically transferred to sequencing 
analysis software and analyzed at the end of a run. See “About 
Automatic Data Analysis” on page 9-38 for more information.

Auto Print When selected, analyzed data is printed automatically.

Parameter Description

* Can be set as Preferences. See “Setting Run Sheet Preferences” on page 9-31.
Data Collection Software 9-29



Run sheets for GeneScan analysis applications contain the following information:

Parameter Description

Plate Check Module* File containing the instrument settings for the plate check.

PreRun Module* File containing the instrument settings for the prerun.

Run Module* File containing the instrument settings for the run.

Collect time* The length of time in hours data will be collected.

Sample Sheet The sample sheet prepared for the run. When selected, the 
information from the sample sheet is imported to the sample 
information fields on the run sheet.

Well-to-Read Distance* The well-to-read distance of the glass plates in cm.

Gel’s Matrix File* A mathematical matrix used to compensate for the spectral 
overlap that occurs between the dyes used together as a set. 
Matrices are dye set, instrument, and run condition dependent. 
As such, matrices must be remade when any of these conditions 
change. A matrix file must be selected for data to be analyzed 
automatically.

For more information, refer to:

� “About Automatic Data Analysis” on page 9-38

� Chapter 6, “Making Matrix Files for GeneScan”

� ABI PRISM GeneScan Reference Guide: ABI 373 and 
ABI PRISM 377 DNA Sequencers, P/N 4303188

Lanes* Number of lanes in the gel.

Run Mode*
(XL or 96-lane upgrade 
instruments only)

This field is displayed for ABI PRISM 377 XL or 96-lane upgrade 
instruments only. It is used to designate the scan mode: 96 Lane 
Scan, XL Scan, or Full Scan.

Operator* Operator’s name.

Sample Number, 
Sample Name, 
Sample File Name

These fields are filled in automatically when the Sample Sheet is 
selected.

Matrix File The same as the Gel’s Matrix File listed above. Required only if 
data is to be analyzed automatically at the end of the run.

Auto Analyze When selected, data is automatically transferred to GeneScan 
analysis software and analyzed at the end of a run. See also 
“About Automatic Data Analysis” on page 9-38.

Analysis Parameters A set of analysis parameters predefined in GeneScan analysis 
software. Selecting analysis parameters is required only if the 
Auto Analyze feature is selected. Otherwise, this field can be left 
blank. See also “About Automatic Data Analysis” on page 9-38.

Size Standard A file that contains information on the size standard run with the 
samples. Selecting a size standard is required only if the Auto 
Analyze feature is selected. Otherwise, this field can be left 
blank. See also “About Automatic Data Analysis” on page 9-38.

Auto Print When selected, analyzed data is printed automatically. See also 
“About Automatic Data Analysis” on page 9-38.

* Can be set as Preferences. See “Setting Run Sheet Preferences” on page 9-31.
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Preparing a Run Sheet

Setting Run
Sheet Preferences

If the same type of run is performed repeatedly on the same instrument, you can 
reduce the time spent setting up run sheets by setting sequencing or GeneScan run 
sheet default preferences. Setting run sheet preferences means setting the default 
value of certain fields on the run sheet template to the values used most often. The 
following fields can be set as preferences:

� Operator

� Lanes

� Well-to-read distance

� Prerun and run modules

� Software program to be used for automatic data analysis

� Auto print

� Analysis parameters (GeneScan run sheets only)

� Gel’s matrix file (GeneScan run sheets only)

� Size standard (GeneScan run sheets only)

Once these preferences are set, the preferred values appear automatically on each 
new run sheet. Preferences can be changed as often as necessary either by setting 
new preference values, or by manually selecting new files/values on the run sheet. 
Instructions for setting run sheet preferences are located in Chapter 5, “Setting 
Preferences.”.

Opening a New
Run Sheet

To open a new run sheet:

Selecting the Plate
Check, PreRun, and

Run Modules

To select the plate check, prerun, and run modules:

Step Action

1 If necessary, launch the data collection software. (Instructions are listed under 
“Launching the Data Collection Software Program” on page 9-8.)

2 Open the File menu and select New.

3 Click either the Sequence Run or GeneScan Run icon as appropriate. A new Run 
folder is created automatically in the Runs folder inside the ABI PRISM 377 folder.

Step Action

1 Open the Plate Check Module pop-up menu, and select the a plate check module.

IMPORTANT If the pop-up menus list <none> only, software cannot find the 
folder that contains the modules. See “Setting Folder Location Preferences” on 
page 9-5.

2 Open the PreRun Module pop-up menu, and select a prerun module.

3 Open the Run Module pop-up menu, and select a run module.
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Selecting the
Number of Lanes

To select the number of lanes:

Selecting the
Sample Sheet

IMPORTANT Select the number of lanes before selecting the sample sheet. If the default 
number of lanes is less than the number of samples, the sample information on the run sheet 
will be truncated. For example, if you entered 36 samples on the sample sheet, but the default 
number of lanes on the run sheet is 24, only the information for the first 24 samples will be 
imported to the run sheet if the sample sheet is selected before the number of lanes is changed 
to 36.

To select a sample sheet:

Step Action

1 Open the lanes pop-up menu and select the appropriate value.

Note If this is an XL or 96-lane upgrade instrument, the appropriate value for the 
Run Mode field is selected automatically when this parameter is set. The run sheet 
for the standard ABI PRISM 377 instrument does not have a Run Mode field.

For GeneScan applications:

Full Scan–24, 34, 36 lanes
XL Scan–48, 50, 64, 66 lanes
96 Lane Scan–96 lanes

For Sequencing applications:

Full Scan–24, 32, 36 lanes
XL Scan–48, 64 lanes
96 Lane Scan–96 lanes

Step Action

1 Open the sample sheet pop-up menu, and select the sample sheet prepared for this 
run. Once selected, the information on the sample sheet is imported into the run 
sheet.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the 
folder that contains the sample sheets. To correct this, see “Setting Folder Location 
Preferences” on page 9-5.

2 The information imported from the sample sheet cannot be changed on the run 
sheet. If changes are made to the sample sheet after it has been selected on the 
run sheet, you must reimport the sample sheet data.

To make changes to the sample sheet after selecting it on the run sheet:

a. Open the sample sheet by clicking the icon next to the sample sheet pop-up 
menu on the run sheet.

b. Make changes to the sample sheet.

c. Close and save the sample sheet.

d. Open the sample sheet pop-up menu on the run sheet, and select <none>.

e. Open the sample sheet pop-up menu on the run sheet, and reselect the 
sample sheet.

You cannot make changes to the sample sheet while a module is running.

Click this icon
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Selecting the
Instrument or Gel’s

Matrix File

For GeneScan runs in particular, matrices are dye set, instrument, and run condition 
dependent. As such, matrices must be remade when any of these conditions change. 
For more information, refer to Chapter 6, “Making Matrix Files for GeneScan,” and the 
ABI PRISM GeneScan Reference Guide, P/N 4303188.

To select an instrument or gel matrix file:

Selecting the Run
Mode, Well-to-Read

Distance, and
Operator

To select the run mode, well-to-read distance, and operator:

If this is a … Then …

sequencing run open the Instrument File pop-up menu, and select the appropriate file. If 
one does not yet exist, leave the field set to <none>. A file must be 
selected for automatic data analysis.

GeneScan run open the Gel’s Matrix File pop-up menu, and select the appropriate file. 
If one does not yet exist, leave the field set to <none>. Required for 
automatic data analysis.

IMPORTANT If the pop-up menu lists <none> only, software cannot find the folder that 
contains the instrument/matrix files. To correct this, see “Setting Folder Location 
Preferences” on page 9-5.

Step Action

1 Open the Well-to-Read distance pop-up menu and select the appropriate value.

2 If this is … Then …

a standard instrument proceed to the next step.

an XL or 96-lane upgrade instrument verify that the correct mode is displayed 
in the Run Mode field.

3 Click in the Operator field and type your name.
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Setting the
Collection Time

To set the collection time:

Step Action

1 Enter the duration of the run in the Collect time field. Use the run time 
recommended in your protocol. The following are suggested run times only.

Well-to-Read 
Length in cm

Type of Run
Scans per 

Hour/Application

Suggested Collection Time in Hours

19:1 Acrylamide 
Gels

Long Ranger (LR), 
PAGE-PLUS (PP), 
29:1 Acrylamide 

Gels

12 1200/GS 1.0 1.0

12 2400/GS 1.0 1.0

36 1200/GS & Seq 7.0 9.0

36 2400/GS
2400/Seq

2.0
3.5

4.0
4.0

48 1200/Seq 10.0 11.0 (29:1 & LR)
12.0 (PP)

GS = GeneScan application; Seq = Sequencing Application

Note The number of scans that can be collected is limited by the software.

2 If … Then …

you do not want the data to be 
analyzed automatically

a. deselect the boxes in the Auto 
Analyze column by clicking in each 
box to remove the X.

b. Proceed to “Starting the Run or 
Closing the Run Sheet” on page 9-37.

this is a sequencing run and you want 
the data to be analyzed automatically

proceed to “Auto Analysis for Sequencing 
Runs” on page 9-35.

this is a GeneScan run and you want 
the data to be analyzed automatically

proceed to “Auto Analysis for GeneScan 
Runs” on page 9-36.
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Auto Analysis for
Sequencing Runs

See “About Automatic Data Analysis” on page 9-38 for more information.

IMPORTANT Do not analyze matrix standard samples.

To set up the run sheet for automatic data analysis:

Step Action

1 Verify that the data analysis software is selected in Preferences. To do this:

a. Open the Window menu, and select Preferences.

b. Select Sequence Run Defaults …

c. Look at the “Autoanalyze with …” field. 

2 If the analysis software 
is … Then …

selected click OK to return to the run sheet.

not selected a. Open the “Autoanalyze with” pop-up menu, and 
select Other.

b. In the dialog box, locate the ABI PRISM DNA 
Sequencing Analysis Software and click Open.

c. Close the current run sheet, and create a new run 
sheet. 

Note Changing the preference has no affect on run 
sheets created prior to the change.

3 On the run sheet, verify that the Auto Analyze boxes are selected for each 
non-matrix standard sample. If the boxes are not selected:

a. Reopen the sample sheet by clicking the icon next to the sample sheet pop-up 
menu.

b. Select a dye set/primer file for each sample that you want analyzed 
automatically. 

c. Close and save the sample sheet.

d. Open the sample sheet pop-up menu, and select <none>.

e. Open the sample sheet pop-up menu, and reselect the sample sheet to update 
the information.

4 If matrix standard samples are being run, deselect Auto Analyze for all matrix 
standard samples.

5 Select Auto Print for analyzed data to be printed automatically.

6 Proceed to “Starting the Run or Closing the Run Sheet” on page 9-37.

Analysis software
not selected

Click this icon
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Auto Analysis for
GeneScan Runs

See “About Automatic Data Analysis” on page 9-38 for more information.

IMPORTANT Do not analyze matrix standard samples.

To set up the run sheet for automatic data analysis:

Step Action

1 Verify that the data analysis software is selected in Preferences. To do this:

a. Open the Window menu, and select Preferences.

b. Select GeneScan Run Defaults …

c. Look at the “Autoanalyze with …” field. 

2 If the analysis software 
is … Then …

selected click OK to return to the run sheet.

not selected a. Open the “Autoanalyze with” pop-up menu, and 
select Other.

b. In the dialog box, locate the ABI PRISM DNA 
Sequencing Analysis Software and click Open.

c. Close the current run sheet, and create a new run 
sheet. 

Note Changing the preference has no affect on run 
sheets created prior to the change.

3 Verify that the Auto Analyze boxes are selected for each non-matrix standard 
sample (Figure 9-1 on page 9-37). Selecting Auto Analyze allows you to select 
analysis parameters, a size standard, and the auto print option.

4 If matrix standard samples are being, run, deselect Auto Analyze for all matrix 
standard samples.

5 If not already selected, or if you wish to change the preference settings, set the 
remaining fields as follows:

a. Open the Analysis Parameters pop-up menu, and select an analysis 
parameters file. Analysis parameters must be set up in the analysis software 
program prior to completing the run sheet. Refer to ABI PRISM GeneScan 
Analysis Software User’s Manual for instructions.

b. Open the Size Standard pop-up menu, and select the appropriate size 
standard file.

c. Select the Auto Print boxes for analyzed data to be printed automatically.

Note If the pop-up menus list <none> only, software cannot find the folders that 
contain the analysis parameters and size standard files. To correct this, see 
“Commands Used to Perform a Plate Check, PreRun, and Run” on page 9-39.

Analysis software
not selected
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C

Figure 9-1 Auto analyze selected and deselected on a GeneScan run sheet

Starting the Run
or Closing the

Run Sheet

To start the run or close the run sheet:

Auto analyze selected. A set of 
analysis parameters and a size 
standard must be selected.

Auto analyze deselected. This 
automatically deactivates the 
analysis parameters, size 
standard, and auto print fields.

If … Then …

you are ready to proceed 
with instrument operation

a. Open the File menu and choose Save. A dialog box 
showing the default run sheet name, and the location 
where the file will be saved is displayed. Change the file 
name and storage location now if desired.

b. Click Save.

c. Click the appropriate button on the run sheet to start a 
plate check, prerun, or run.

For more information on the run sheet buttons and other 
commands used for instrument operation, see “Commands 
Used to Perform a Plate Check, PreRun, and Run” on 
page 9-39.

you wish to close the run 
sheet

a. Open the File menu and choose Close.

b. Click Save. A dialog box showing the default run sheet 
name, and the location where the file will be saved is 
displayed (shown in previous step). Change the file 
name and storage location now if desired.

c. Click Save.

Folder where run
sheets are stored

Run sheet file name
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About Automatic Data Analysis

Overview Data can be analyzed and printed automatically or manually after a run. When the 
software is set up for automatic data analysis, the data collected during the run and all 
other information required for analysis, is transferred to the analysis software program 
automatically at the end of the run. The analysis software then automatically analyzes 
the data and prints the results.

The information that must be specified for automatic data analysis is application 
specific. Requirements are listed below.

Auto analyze must be selected to use the Stop & Analyze feature during the run. 
(Described on page 9-39.)

For Sequencing
Applications

To perform automatic data analysis after a sequencing run, the following information 
must be selected on sequencing sample and run sheets:

� On the sequencing sample sheet:

– A dye set/primer file

Selecting a dye set/primer file on the sample sheet automatically places an X 
in the corresponding Auto Analyze box on the run sheet.

– An instrument file

� On the sequencing run sheet:

– Auto print (optional)

In addition, the analysis program—ABI PRISM DNA Sequencing Analysis 
Software—must be selected on the Sequence Run Defaults Preference. This tells the 
data collection software where to send the data when the run is finished. Instructions 
are listed under “Auto Analysis for Sequencing Runs” on page 9-35.

For GeneScan
Applications

To perform automatic data analysis after a GeneScan run, the following information 
must be selected on GeneScan sample and run sheets:

� On the GeneScan sample sheet:

– Size standard designation (Std column)

– Dye colors run in each lane (Pres column)

� On the GeneScan run sheet:

– Gel’s matrix file

– Matrix file

– Analysis parameters

– Size standard

– Auto analyze

– Auto print (optional)

In addition, the analysis program—ABI PRISM GeneScan Analysis Software—must be 
selected on the GeneScan Run Defaults Preference. This tells the data collection 
software where to send the data when the run is finished. Instructions are listed under 
“Auto Analysis for GeneScan Runs” on page 9-36.
9-38 Data Collection Software



Commands Used to Perform a Plate Check, PreRun, and Run

Overview A plate check, prerun, and run can be started by using the buttons on the run sheet, or 
by using commands from the Instrument menu.

Using the Buttons
on the Run Sheet

A button must be “active” to be selected.

The following is a description of each button and its function.

Button Function

Plate Check Click the Plate Check button to start a plate check. The Plate Check button 
becomes active when the plate check module is selected on the run sheet. 
The duration of the plate check is specified in the module. However, the 
plate check can be paused or cancelled by clicking the Pause or Cancel 
button. 

PreRun Click the PreRun button to start a prerun. The PreRun button becomes 
active when the prerun module is selected on the run sheet. The duration of 
the prerun is specified in the module. A prerun can be paused or cancelled 
by clicking the Pause or Cancel button. 

Run Click the Run button to start the run. The Run button becomes active when 
the run module and sample sheet are selected on the run sheet.

Pause/
Resume

The Pause button becomes active when a plate check, prerun, or run is 
started. Click Pause to temporarily halt instrument operation. Pausing a 
prerun or run halts electrophoresis, while maintaining gel temperature. 
When the Pause button is selected, it changes to Resume. Click Resume to 
resume instrument operation. 

Cancel The Cancel button becomes active when a plate check, prerun, or run is 
started. Click Cancel to cancel a plate check, prerun, or run. If cancel is 
selected during a run, the following dialog box is displayed.

� Clicking Terminate terminates the run without automatic data analysis.

� Clicking Stop & Analyze terminates the run, and starts automatic data 
analysis of the data collected to that point in the run. The run cannot be 
resumed. To use this feature, the run sheet must be configured for 
automatic data analysis prior to starting the run.

� Clicking Continue resumes the run and data collection.

Buttons looks like 
this when inactive 

Buttons looks like 
this when active 

Toggles between 
Pause and Resume
Data Collection Software 9-39



The following table is an example of a typical series of commands that would be used 
for a sequencing run. This example is written as if a shark’s-tooth comb is being used, 
and samples are being loaded using a staggered load method. Refer to Chapter 3, 
“Instrument Operation,” for more information on sample load methods and 
recommendations.

Button Clicked Module Affected Action

Plate Check module

Starts the plate check. Plates are scanned 
without electrophoresis to check for 
fluorescent contaminants.

N/A

Terminates the plate check. Buffer chambers 
are then filled and checked for leaks. Front 
heat-transfer plate mounted if applicable.

PreRun module

Starts the prerun. Gel is electrophoresed 
without data collection to equilibrate gel 
temperature.

PreRun module

Pauses the prerun. Wells flushed and 
samples loaded into the odd numbered 
lanes (this is the staggered load method). 
Gel temperature is maintained.

PreRun module

Prerun is resumed. Samples are 
electrophoresed into the gel without data 
collection for approximately two minutes.

PreRun module

Pauses the prerun. Wells flushed again, and 
remainder of samples loaded into the even 
numbered lanes. Gel temperature is 
maintained.

N/A Terminates the prerun.

Run module Starts the run (electrophoresis and data 
collection).
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Using Commands
from the Instrument

Menu

The Instrument menu contains commands that perform the same functions as the run 
sheet buttons.

The functions of the commands on the Instrument menu are summarized below.

To … Select this command from the Instrument menu …

Start a plate check Start Plate Check

Start a prerun Start PreRun

Start a run Start Run

Temporarily halt a prerun or run so 
it can be resumed later

Pause

Resume a prerun or run after it has 
been paused

Resume

Terminate a plate check, prerun, or 
run

Cancel Run
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Modules

Overview Modules are software files that contain the various settings (electrophoresis voltage, 
gel temperature, etc.) required for instrument operation (the plate check, prerun, and 
run). ABI PRISM Data Collection Software version 2.1 modules can be grouped into 
two general categories:

� Standard modules

Provide gel temperature control from 10°C above ambient to a maximum of 60°C. 
Located in the Modules folder. 

� Chiller modules

Modules used when an external cold water bath is attached to the instrument, and 
temperatures below 10°C above ambient are required. Located in the Chiller 
Modules folder. See “Chiller Modules” on page 9-44 for more information.

Within each of these categories are prerun and run modules specific for sequencing 
or GeneScan analysis applications. The application is designated by the module name 
(see “Module Naming Conventions” below).

Choosing a module automatically selects a virtual filter set. (Virtual filter sets, dye 
sets, and the various chemistries available are described under “Virtual Filter Sets” on 
page 9-51 and “DyeSet/Primer Files” on page 9-49.) If the wrong run module (and 
therefore virtual filter set) is chosen for a particular chemistry, the data will be poor or 
useless. For sequencing applications, bases will be miscalled, or the data will be 
meaningless. We recommend running the samples again using the correct run 
module.

See page 9-47 for a list of ABI PRISM Data Collection Software version 2.1 modules.

Module Naming
Conventions

The naming conventions used for module files are described in the table below.

Name Definition

Seq Module is for ABI PRISM DNA Sequencing Analysis Software 
applications

GS Module is for ABI PRISM GeneScan Analysis Software applications

Plate Check Plate check module

PR Prerun module

Run Run module

12, 36, or 48 The well-to-read distance of the gel plates in centimeters

A, B, C, D, E, or F The virtual filter set used by the module

1200 1200 scans/hour (approximately 100 bph for sequencing)

2400 2400 scans/hour—high speed (approximately 200 bph for 
sequencing)

CHILLER Modules designed for use with an external cold water bath
9-42 Data Collection Software



The following examples show how to interpret a module name.

To View the Settings
in a Module

To determine the instrument settings specified by a particular module, open the 
module settings dialog box from a run sheet (instructions listed below). The module 
settings window shows the following information.

Module Definition

GS Run 36D-2400 CHILLER GS = GeneScan

Run = Run

36 = 36 cm well-to-read glass plates

D = virtual filter set D

2400 = 2400 scans/hour

CHILLER = chiller module

Seq PR 48A-1200 Seq = Sequencing

PR = prerun

48 = 48 cm well-to-read glass plates

A = virtual filter set A

1200 = 1200 scans/hour

Plate Check A Plate Check = plate check

A = virtual filter set A

Electrophoresis Voltage Collection Time

Electrophoresis Current Gel Temperature (also referred to as the run 
temperature)

Electrophoresis Power Laser Power

CCD Offset CCD Gain

To open a Module Settings dialog box: 

Step Action

1 Open the File menu and choose New.

2 Click Sequence Run or GeneScan Run to open a new run sheet.

3 Open the Run Module pop-up menu and choose the module file you wish to view.

4 Click the small document icon next to the Run module pop-up menu to open the 
Module Settings dialog box.

Click this icon to view the settings 
of the module selected 
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Chiller Modules Chiller modules and an external cold water bath operating at 22°C and below allow 
you to perform PCR Single-stranded Conformation Polymorphism (SSCP) analysis. 

For more information on using chiller modules and an external cold water bath, refer to 
Appendix B, “Subambient Temperature Operation.” 

For more information on the PCR SSCP technique, refer to PCR SSCP Analysis: A 
Guide to Fluorescent PCR Single-stranded Conformation Polymorphism Analysis on 
the ABI PRISM 377 DNA Sequencer (P/N 904413).

Installing Chiller
Modules

Chiller modules are installed by moving them into the Modules folder with the standard 
modules, or by setting the Folder Locations Preference to allow the software to access 
them directly in the Chiller Modules folder.

Moving Chiller Modules to the Modules Folder

5 The Module Settings dialog box also allows you to change module settings. Module 
settings can be modified temporarily for one run without changing the original 
module. You can also use existing modules as templates for creating new modules, 
or you can change the default settings of an existing module. For more information 
and instructions, see “Modifying and Creating Modules” on page 9-45.

Shown above is the Module Settings dialog box for the module named 
GS PR 36F-2400.

6 Close the run sheet when finished.

To open a Module Settings dialog box: (continued)

Step Action

To move chiller modules to the Modules folder:

Step Action

1 Double-click the hard drive icon on the Macintosh to access the Finder and open 
the hard drive directory.

2 Open the ABI PRISM 377 folder. 

3 Open both the Modules folder and the Chiller Modules folder.

4 Click in the Chiller Modules window so it becomes the active window.

5 Open the Edit menu, and choose Select All to select all the files in the Chiller 
Modules folder.

6 Click and drag all the chiller module files into the Modules folder.

7 Close both folders.
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Setting Preferences to Access Chiller Modules Directly in the Chiller Modules Folder

IMPORTANT To run the instrument using standard conditions, change the Module folder 
preferences setting from the Chiller Modules folder back to the standard Modules folder.

Modifying and
Creating Modules

ABI PRISM 377 Data Collection Software version 2.1 module files can be:

� Permanently modified

� Temporarily modified for one run

� Used as templates to create custom module files without changing the original 
module

Module files are created and modified by opening an existing module file that has 
been selected on a run sheet. How the file is saved determines whether a new module 
is created, or an existing module is temporarily or permanently modified.

Note Rather than permanently modifying existing modules, we strongly recommend using 
the modules supplied with the software as templates to create new modules. This ensures you 
will always have all the modules designed for use with your instrument.

To set preferences to access chiller modules in the Chiller Modules folder:

Step Action

1 Open the ABI PRISM Data Collection Software version 2.1.

2 Open the Window menu, select Preferences, and then select Folder Locations.

3 Click the Module Folder to open the Select Module Folder dialog box.

4 Click once on Chiller Modules to highlight the folder.

5 Click the Select “Chiller Modules” button. 

6 Click OK to save this setting.

To modify an existing module or create a new one: 

Step Action

1 Open the File menu and choose New.

2 Click Sequence Run or GeneScan Run to open a new run sheet.

3 Open the Run Module pop-up menu and choose the module file you wish to work 
with.

4 Click the small document icon next to the Run module pop-up menu to display the 
Module Settings dialog box.

Click this icon to view the settings of 
the module selected
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Unused Modules We recommend moving modules that are not used to a folder named Unused 
Modules. This will limit the number of modules displayed in the module pop-up menus 
on the run sheet.

5 Enter new values in the respective fields as desired.

6 Save the changes by clicking … To …

Save use the changes as a one-time override for 
the current run.

Save As Default save the changes as the new defaults in the 
existing module.

Note Rather than permanently modifying 
existing modules, we recommend using the 
Save Copy In command to create a new 
module. This ensures you will always have all 
the modules designed for use with your 
instrument.

Save Copy In … create a new module. Enter a name for the 
new module in the dialog box displayed, and 
then click Save.

7 Close the run sheet.

To modify an existing module or create a new one: (continued)

Step Action
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List of Modules The table below lists all the modules supplied with ABI PRISM 377 Data Collection 
Software version 2.1. To keep the number of modules displayed in the pop-up menus 
on the run sheet to a minimum, we recommend moving all unused module files to a 
folder named Unused Modules on the Macintosh hard drive.

ABI PRISM 377 Data Collection Software version 2.1 module files: 

Standard Modules Chiller Modules

N/A N/A

Plate Check A Plate Check A CHILLER

Plate Check B Plate Check B CHILLER

Plate Check C Plate Check C CHILLER

Plate Check D Plate Check D CHILLER

Plate Check F Plate Check F CHILLER

Seq PR 36A-1200 Seq PR 36A-1200 CHILLER

Seq PR 36B-1200 Seq PR 36B-1200 CHILLER

Seq PR 36A-2400 Seq PR 36A-2400 CHILLER

Seq PR 36B-2400 Seq PR 36B-2400 CHILLER

Seq Run 36A-1200 Seq Run 36A-1200 CHILLER

Seq Run 36B-1200 Seq Run 36B-1200 CHILLER

Seq Run 36A-2400 Seq Run 36A-2400 CHILLER

Seq Run 36B-2400 Seq Run 36B-2400 CHILLER

Seq Run 36E-1200 Seq Run 36E-1200 CHILLER1

Seq Run 36E-2400 Seq Run 36E-2400 CHILLER

Seq Run 48A-1200 Seq Run 48A-1200 CHILLER

Seq Run 48B-1200 Seq Run 48B-1200 CHILLER

Seq Run 48E-1200 Seq Run 48E-1200 CHILLER

GS PR 12A-1200 GS PR 12A-1200 CHILLER

GS PR 12C-1200 GS PR 12C-1200 CHILLER

GS PR 12D-1200 GS PR 12D-1200 CHILLER1

GS PR 12F-1200 GS PR 12F-1200 CHILLER1

GS PR 12A-2400 GS PR 12A-2400 CHILLER

GS PR 12C-2400 GS PR 12C-2400 CHILLER

GS PR 12D-2400 GS PR 12D-2400 CHILLER

GS PR 12F-2400 GS PR 12F-2400 CHILLER

GS PR 36A-1200 GS PR 36A-1200 CHILLER

GS PR 36C-1200 GS PR 36C-1200 CHILLER

GS PR 36D-1200 GS PR 36D-1200 CHILLER

GS PR 36F-1200 GS PR 36F-1200 CHILLER

1. Use virtual filter set E modules with ABI PRISM dRhodamine Terminator Cycle Sequencing Kits or the 
dRhodamine Matrix Standards Kit only. Use virtual filter set D and F modules with GeneScan and NED 
dyes.

2. These chiller modules are recommended for PCR Single-stranded Conformation Polymorphism 
Analysis (SSCP).
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GS PR 36A-2400 GS PR 36A-2400 CHILLER

GS PR 36D-2400 GS PR 36D-2400 CHILLER

GS PR 36C-2400 GS PR 36C-2400 CHILLER

GS PR 36F-2400 GS PR 36F-2400 CHILLER

GS Run 12A-1200 GS Run 12A-1200 CHILLER

GS Run 12C-1200 GS Run 12C-1200 CHILLER

GS Run 12D-1200 GS Run 12D-1200 CHILLER

GS Run 12F-1200 GS Run 12F-1200 CHILLER

GS Run 12A-2400 GS Run 12A-2400 CHILLER

GS Run 12C-2400 GS Run 12C-2400 CHILLER

GS Run 12D-2400 GS Run 12D-2400 CHILLER

GS Run 12F-2400 GS Run 12F-2400 CHILLER

GS Run 36A-1200 GS Run 36A-1200 CHILLER

GS Run 36C-1200 GS Run 36C-1200 CHILLER

GS Run 36D-1200 GS Run 36D-1200 CHILLER

GS Run 36F-1200 GS Run 36F-1200 CHILLER

GS Run 36A-2400 GS Run 36A-2400 CHILLER

GS Run 36C-2400 GS Run 36C-2400 CHILLER

GS Run 36D-2400 GS Run 36D-2400 CHILLER

GS Run 36F-2400 GS Run 36F-2400 CHILLER

GS Run 60W A CHILLER2

GS Run 60W C CHILLER2

GS Run 60W D CHILLER2

GS Run 2140V A CHILLER2

GS Run 2140V D CHILLER2

GS Run 2140V C CHILLER2

ABI PRISM 377 Data Collection Software version 2.1 module files: (continued)

1. Use virtual filter set E modules with ABI PRISM dRhodamine Terminator Cycle Sequencing Kits or the 
dRhodamine Matrix Standards Kit only. Use virtual filter set D and F modules with GeneScan and NED 
dyes.

2. These chiller modules are recommended for PCR Single-stranded Conformation Polymorphism 
Analysis (SSCP).
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DyeSet/Primer Files

What are
DyeSet/Primer Files

For sequencing applications only, dye set/primer files:

� Must be specified on sample sheets for data to be analyzed automatically

� Contain the information used to:

– Compensate for differences (shifts) in sample mobility

– Interpret what each dye color in a set represents

Each of the dyes used in a set affects the electrophoretic mobility of cycle sequencing 
extension products differently. The relative mobility of the dye-labeled fragments is 
specific to each sequencing chemistry. Under the same set of run conditions, the 
mobilities are very reproducible.

ABI PRISM DNA Sequencing Analysis Software compensates for these mobility 
differences by applying the mobility shift information contained in dye set/primer files. 
As a result, evenly spaced peaks are presented in the analyzed data.

Dye set/primer files also tell the software which matrix in the instrument file to use for 
data analysis.

DyeSet/Primer File
Naming Conventions

Dye set/primer file names indicate the primer, chemistry, type and concentration of 
gel, and sometimes the filter set used. The abbreviations used for these file names are 
as follows:

Note The percentages (4%, 5%, and 6%) are approximates. For example, if the gel is 4.25% 
acrylamide, use the corresponding 4% acrylamide dye set/primer file. Also, 5% Long Ranger 
equals 4% acrylamide when selecting these files.

The following examples show how to interpret a dye set/primer file name.

Abbreviation Definition

DP Dye primer

DT Dye terminator

x% The approximate percent concentration of the gel used

Ac Acrylamide gel

LR Long Ranger gel

BD BigDye

dR dRhodamine

{x x x} Any combination of virtual filter set, primer, and chemistry

DyeSet/Primer File Name Definition

DP4%Ac{-21M13} DP = dye primer

4%Ac = 4% acrylamide gel

{-21M13} = the primer

DP5%LR{BD M13 FWD & REV} DP = dye primer

5%LR = 5% Long Ranger gel

BD = Big Dye

M13 FWD & REV = m13 forward and reverse primers
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Choosing a DyeSet/
Primer File

The dye set/primer files listed below are recommended for the following sequencing 
chemistries.

If the wrong dye set/primer file is specified on the sequencing sample sheet and is 
used for automatic data analysis, the data can be reanalyzed using the correct file. 
Refer to the Automated DNA Sequencing Chemistry Guide for more information.

DT {dR Set Any-Primer} DT = dye terminator

dR = dRhodamine

dR Set = virtual filter set E

Any Primer = works with any primer

DT4%Ac{B Set–AnyPrimer} DT = dye terminator

4%Ac = 4% acrylamide gel

B Set = virtual filter set B

Any Primer = works with any primer

DyeSet/Primer File Name Definition

Dye Set/Primer Files and DNA Sequencing Chemistries

Dye Primer BigDye Primer Dye Terminator
dRhodamine 
Terminator BigDye Terminator

DP4%Acv2{M1
3Rev}

DP5%LR{BD M13 
FWD & REV}

DT4%Ac{A 
Set-AnyPrimer}

DT {dR Set 
Any-Primer}

DT {BD Set 
Any-Primer}

DP4%Ac{-21M
13}

DP4%Ac{KS}

DP4%Ac{SK}

DP4%Ac{SP6}

DP4%Ac{T3}

DP4%Ac{T7}
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Virtual Filter Sets

What Are They Virtual filter sets are used to detect light intensity in four non-overlapping, 
light-collecting regions on a CCD camera located inside the instrument. Each region 
corresponds to a wavelength range that contains or is close to the emission maximum 
of an ABI PRISM dye. Data collection software color-codes the intensity displays from 
the four regions. These appear as the blue, green, black (yellow on gel images), and 
red peaks in the raw data.

This process is similar to using a physical filter to separate light of different 
wavelengths. However, the filter sets are “virtual” because the instrument uses no 
physical filtering hardware to perform the separation. Each virtual filter set has been 
optimized to provide the maximum possible separation among the centers of detection 
for the different dyes used together as a set, while maintaining an excellent 
signal-to-noise ratio. The virtual filter used during data collection is designated by the 
run module selected on the run sheet. 

The exact positions of the CCD regions and the dye combinations appropriate to 
these positions depend upon the virtual filter set used. For example, with Virtual Filter 
Set E the instrument records the light intensity in four regions, or “windows,” centered 
at 540 nm, 570 nm, 595 nm, and 625 nm. The window positions in each virtual filter 
set have been optimized to provide the maximum possible separation among the 
centers of detection for the different dyes while maintaining good signal strength.

The data collection software color-codes the intensity displays from the four 
light-collection regions. These appear as the blue, green, black (yellow on gel images), 
and red peaks in the raw data.

The Sequencing Analysis Software uses the same four colors to color-code analyzed 
data from all dye/virtual filter set combinations. The display colors represent the 
relative, not the actual, detection wavelengths. For consistency, the software always 
displays analyzed data with A as green, C as blue, G as black, and T as red in the 
electropherogram view.

The wavelengths of the “windows” in the virtual filter sets used in cycle sequencing 
applications are listed in the following table.

Virtual Filter Set Color
Wavelength Range of Virtual Filter 

(nm)

A blue 530–541

green 554–564

yellow/black 581–591

red 610–620

E blue 535–545

green 565–575

yellow/black 590–600

red 620–630
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Filter Sets Available All the ABI PRISM 377 instruments use six virtual filter sets designated A through F.

For GeneScan applications

Virtual filter sets A,C, D, and F are used.

For Sequencing Applications

Virtual filter sets A and E are used.

For More
Information

For more information, see:

� “About Run Sheets” on page 9-28

� “Modules” on page 9-42

� GeneScan Reference Guide

� Automated DNA Sequencing Chemistry Guide
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Viewing Data and Instrument Status
\

Windows Available Four different windows are available for viewing real-time data and instrument status.

� Data windows are:

– Scan

– Gel

� Instrument windows are:

– Status

– Electrophoresis History

In addition to these windows, a chronological, comprehensive record of all significant 
system events including error and status messages is kept in a Log file. All of these 
windows can be open at the same time, however, only one window can be active at 
any given time.

The Status Window During a run, the current status of the instrument is viewed in the Status window. The 
information in this window is updated approximately every three seconds. Open the 
Status window by choosing Status from the Window menu.

IMPORTANT The electrophoresis voltage, gel temperature and laser power are setpoints. 
Electrophoresis current and power are limits.

Click arrows to 
expand or collapse 
the window

Gray box indicates the value set 
for the parameter by the module

Time remaining for the 
module being executed 

Total duration of the 
module being executed 

Green arrow is 
actual reading 
from instrument
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The Log File A Log file is created automatically for each run when the run is started. Log files 
contain a comprehensive, chronological record of all error and status messages 
generated by the data collection program during a run. This information includes:

� Start and stop times of the run

� Instrument and Macintosh errors

Each Log file is stored in its respective Run folder inside the Runs folder. These files 
can be very large, and only the last 32K of information can be viewed using the data 
collection program. To view the Log file using the data collection software program, 
open the Window menu and choose Log. Use Microsoft® Word or Simple Text to view 
the entire Log file stored in a Run folder.

The following is an example of the kinds of information stored in a Log file.

The information in the file is formatted as follows:

xxx mm/dd/yy hh:mm:ssdescription

The entry in the first column, xxx, is variable. Possible entries are:

... information (system start or stop, file created)
 - -> message sent to instrument
<- - message received from instrument
*** warning
### error

The second column shows the month/day/year and hours:minutes:seconds. The third 
column is a brief description of the event.
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The Scan Window The Scan window (below) shows real-time raw data as sweeps of the laser across the 
gel. The different colored lines represent each dye color in the dye set. Data is 
updated every few seconds.

To display the Scan window, open the Window menu and choose Scan.To set the 
scale of the Scan window, open the Edit menu and choose Set Scale. Enter minimum 
and maximum values for the scale in the dialog box that is displayed.

The Gel Window The Gel window is a reconstruction of actual data. The first fragments passing the 
laser appear at the top of the window and move toward the bottom as new data is 
collected. You can scroll up or down the Gel window to see parts that are not visible. 
Remember, however, that this window is a re-creation of the data through time, and 
does not indicate the physical position of the fragments. 

To display the Gel window, choose Gel Image from the Window menu.

Scan 0

End of run
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The Electrophoresis
History Window

The Electrophoresis History window displays the set and actual values for the 
electrophoresis power supply and gel temperature throughout the course of a run. The 
scale for each panel is adjustable.

The information in the Electrophoresis History window is also stored in the Gel file. To 
display the electrophoresis history window, open the Window menu and choose 
Electrophoresis History.

To adjust the scale: 

Step Action

1 Double-click one of the panels in the window, or click a panel once and choose Set 
Scale from the Edit menu. The Set Scale dialog box is displayed.

2 Type in the minimum and maximum values you wish to display.

3 Click OK.

Double-click here
to adjust the scale

Scan numbers
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Viewing Other
Run-Related
Information

The Sample Sheet

To display the sample sheet associated with the current run, choose Sample Sheet 
from the Window menu. This option is available only if a sample sheet is selected in a 
Run window that is open. For more information, see:

� “About Sample Sheets for Sequencing Applications” on page 9-14

� “About Sample Sheets for GeneScan Applications” on page 9-20

� Sequencing or GeneScan Analysis Software user’s manual as appropriate

The Run Sheet

To display the Run sheet for the current run, choose Run from the Window menu. For 
more information see:

� “About Run Sheets” on page 9-28

Opening and Saving Files

Opening Files Most files are opened using the Open command in the File menu. Other files, such as 
Log and Gel files, are opened by clicking the file icon from the data collection software 
program.

Saving Files Files are saved by choosing one of the Save commands from the File menu. Sample 
and run sheets are automatically named and saved based on the default settings 
entered for the Default File Names and Folder Locations Preferences. Refer to 
Chapter 5, “Setting Preferences,” for more information.

When modifying existing sample sheets, run sheets, or Module Settings dialog boxes, 
we recommend saving the changes under a new file name to preserve the original 
information.

To save a modified file under a new name:

Step Action

1 Open the File menu and choose Save As.

2 Enter a name for the modified file, and select a storage location for it.

3 Click Save. 

To save a backup copy of the file you are working with:

Step Action

1 Open the File menu and choose Save a Copy In.

2 Enter a name for the file, and select a storage location for it.

3 Click Save.

A backup copy of the file is saved with the new file name, and the original file 
remains on the computer screen.
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Archiving Files

Gel Files A gel file is automatically created for each run, and contains the raw data collected by 
the data collection software. Gel files typically require 10–70 MB of disk space. 
Because gel files are so large, they can be deleted from the hard disk once 
satisfactory sample files have been generated. It is typically not necessary to save gel 
files once the tracking has been verified or adjusted, and sample files are created. 
(See page 9-60.)

To archive Gel files, use magnetic tapes, removable cartridge drives, CD ROMs, or 
optical drives. Gel files are too large to fit on floppy disks.

Note If a gel file is deleted, the data can be reanalyzed, but cannot be retracked.

Sample Files Use floppy disks, a magnetic tape drive, a removable cartridge drive, or an optical 
drive to archive sample files (described on page 9-60). A 1.4 MB, high-density disk 
holds about six files. A sample file is 150-200 KB in size, depending on the length of 
the run. Save a sample file when you feel confident that the channel selections 
(tracking) are correct for the sample.

Printing Files

Setting Up the
Page for Printing

The contents of any of the editable window can be printed (for example, sample 
sheets, run sheets, module settings dialog boxes).

Before printing, certain parameters can be specified, such as the paper size, the 
orientation of the page, and whether or not the print should be reduced from actual 
size. To set up a page for printing, choose Page Setup from the File menu and make 
the appropriate selections.

The appearance of the Page Setup dialog box depends on the printer you are using. 
Refer to the manual for your particular printer for information on page set up.

Printing Procedure To print the contents of a window:

Note If you choose Auto Analyze and Auto Print on the run sheet, electropherograms are 
automatically printed after the collected data is analyzed.

Step Action

1 Make sure the printer is on and loaded with paper.

2 Click the window you wish to print to make it active.

3 Choose Print, or Print One from the File menu.

Print One prints the window immediately, bypassing the standard print dialog box.

If you choose Print, you can set the number of copies and the pages that you want 
to print. The appearance of the print dialog box depends on the printer you are 
using.

4 Click Print.
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Quitting the Data Collection Program

Closing Open
Windows

To close open windows:

Quitting the
Program

To quit the data collection program:

Note If a run is in progress, a dialog box asks you to verify that you want to quit. Quitting the 
data collection software program while a run is in progress cancels the run. Whatever data has 
been collected to that point is saved. You can then use either analysis program to open the Gel 
file containing the collected data.

Step Action

1 Click a window to make it active.

2 Close the window using one of the following methods:

� Click the close box in the upper left corner of the window.

� Open the File menu and choose Close.

The current settings in the window are saved.

Step Action

1 Open the File menu and choose Quit.
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Data Analysis Overview

Overview When the run is finished, data is analyzed automatically or manually using one of two 
data analysis software programs:

� ABI PRISM GeneScan Analysis Software

� ABI PRISM DNA Sequencing Analysis Software

The following information is a brief overview of the data analysis process up through 
the generation of sample files. For more information on these software programs and 
how to use them to analyze your data, refer to the following publications:

� ABI PRISM DNA Sequencing Analysis Software User’s Manual

� ABI PRISM GeneScan Analysis Software User’s Manual

Sample Files When a run is finished, the gel file is processed by sequencing or GeneScan analysis 
software either automatically or manually. The Auto Analyze feature and associated 
parameters on the run sheet must be properly configured for data analysis to occur 
automatically at the end of a run. (See “About Run Sheets” on page 9-28 for more 
information.) Gel file processing includes:

� Examining and adjusting the gel image

� Adjusting the tracking, and marking lanes for extraction

� Extracting sample data for each lane marked, and generating sample files

One sample file is created for each lane of data extracted from the gel file. Each 
sample file contains:

� Information entered on the sample and run sheets

� Raw and analyzed data

� Run start and stop times

� Voltage, temperature, and power values during the run

� A record of analysis settings

� Peak locations and size calling values

� Base calls (for sequencing applications only)

Sample files are stored in the corresponding run folder along with the Gel, Log, and 
run sheet files.

<File Name>.seq
Files

Created by ABI PRISM DNA Sequencing Analysis Software only, these files show the 
base letter sequence of the data. The files can also contain a header, and are stored 
in the corresponding run folder along with the Gel, Log, run sheet, and sample files.

.seq files can be opened from word processing programs and printed. They can also 
be saved in several formats that can be read by other software programs. The 
Preferences dialog box in the sequencing analysis software program allows you to 
choose a file format.
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Gel Recipes A
Appendix Contents

In this Appendix The following information is provided in this appendix:

Topic See page

List of Gel Recipes and Recommendations A-2

Sequencing Chemistries Released in 1997 A-3

Factors that Affect Gel Quality and Read Lengths A-4

Chemical Abbreviations Used A-9

Preparing TBE Buffer A-9

Deionizing Formamide A-10

29:1 Polyacrylamide Gels—Protocol and Run Conditions A-11

PAGE-PLUS Gels—Protocol and Run Conditions A-13

Long Ranger Gel Solution Protocols A-15

MDE Gel Protocol for SSCP A-18

Polyacrylamide Gel Solution Protocols A-19

Supplier Information A-22

Storing Reagents and Stock Solutions A-23
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List of Gel Recipes and Recommendations

List of Recipes The following gel recipes for sequencing applications are provided in this appendix.

Recommendations
for Longest

Read Length

Gel formulations that provide longer read lengths when compared to read lengths 
from 19:1 polyacrylamide gels of the same plate size and run speed are listed in the 
following table.

Note The products required to make the gels presented in this appendix are not 
manufactured by Applied Biosystems. The quality assurance of these products is regulated by 
the respective suppliers.

Gel Formulation See page

Polyacrylamide Generic 19:1 A-19

29:1—4.5%

A-1129:1—4.25%

for SSCP

Long Ranger™ 5.0%

A-154.75% (Long Ranger Singel)

for SSCP

PAGE-PLUS 4.8%
A-135.25%

Mutation Detection gel (MDE) for SSCP — A-18

SSCP = Single-strand Conformation Polymorphism

Plate Size and 
Run Speed Recommended Gel Formulations

Expected Read 
Length Ranges

� 36-cm well-to-read 
(WTR) plates

� 1200 scans/hr

� 4.5% 29:1 polyacrylamide

650–800� 4.8% PAGE-PLUS

� 5.0% Long Ranger 
(concentrate or Singel™ gel forms)

� 36-cm WTR plates

� 2400 scans/hr
� 4.5% 29:1 polyacrylamide 550–700

� 48-cm WTR plates

� 1200 scans/hr

� 4.25% 29:1 polyacrylamide

750–900� 4.75% Long Ranger Singel

� 5.25% PAGE-PLUS
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Sequencing Chemistries Released in 1997

New Chemistries During 1997, three new sequencing chemistries were released:

When these new chemistries are used with the gel formulations listed under 
"Recommendations for Longest Read Length" on page A-2, read lengths commonly 
fall at the upper end of the ranges listed in the table. The new chemistries produce 
longer read lengths because they have:

� Greater signal-to-noise ratios

� More even peak heights in both dye terminator chemistries

� More intense signal with the BigDye™ primers and terminators

Chemistry Part Numbers

ABI PRISM® dRhodamine Terminator Cycle Sequencing Ready 
Reaction Kit with AmpliTaq® DNA Polymerase, FS

403044 for the
100 reaction kit

403045 for the
1000 reaction kit

ABI PRISM® BigDye™ Primer Cycle Sequencing Ready Reaction Kit 
with AmpliTaq® DNA Polymerase, FS

403051 for the
100 reaction kit

403049 for the
1000 reaction kit

ABI PRISM® BigDye™ Terminator Cycle Sequencing Ready Reaction 
Kit with AmpliTaq® DNA Polymerase, FS

4303149 for the
100 reaction kit

4303150 for the
1000 reaction kit
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Factors that Affect Gel Quality and Read Lengths

Factors One of the most critical variables that determines the success or failure of both 
sequencing and GeneScan® analysis software runs is the gel. The use of consistently 
prepared, high quality gels will help ensure the best experimental results and minimize 
time spent troubleshooting gel problems. Poor quality gels often cause problems that 
are mistaken for instrument problems.

For sequencing runs, the quality of the gel directly effects the number of bases that 
can be called. For GeneScan runs, the quality of the gel effects the mobility of DNA 
fragments from run-to-run, reproducibility of sizing, signal strength, and resolution.

Factors that affect gel quality include:

� Purity and freshness of reagents

� Rate of polymerization

� Presence of air bubbles

� Age of the gel

Other important variables that can significantly impact read lengths include:

� Template

– quality

– base composition

– quantity

� Primer design

� Amount of sequencing reaction loaded on the gel

� Quality of formamide used in loading buffer

� Type of chemistry used
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Reagent Purity Always use ultra-pure reagents obtained from a reliable source and high-grade, 
distilled, deionized water to prepare solutions, and wear clean laboratory gloves. 
Filtration of all solutions is essential to remove any particulate matter that may 
fluoresce or scatter light.

Reagent purity and associated problems: 

Reagent Problems That Can Occur When Fresh Reagents are Not Used

Acrylamide and 
bisacrylamide

Impurities in these reagents can cause:

� Irreproducible gel porosity

� Deviant mobility

� Inhibition of polymerization

� Poor resolution

These problems lead to compromised reproducibility. Possible 
contaminants include:

� Acrylic acid

– The hydrolysis product of acrylamide

– Copolymerizes with acrylamide and bisacrylamide

– Causes DNA to migrate slowly, resulting in broad, diffuse bands 
(poor resolution)

� Linear polyacrylamide

– Caused by catalytic contaminants in the dry acrylamide monomer.

– Decreases the effective concentration of the acrylamide, causing 
the DNA to migrate faster

� Ionic contaminants

– Mostly metals, such as iron or copper

– Can inhibit or accelerate polymerization

IMPORTANT Storage guidelines for these reagent are listed under 
“Storing Reagents and Stock Solutions” on page A-23. Proper storage is 
critical for the production of high quality gels.

! WARNING ! CHEMICAL HAZARD. Acrylamide and 
bisacrylamide are neurotoxins. Avoid inhalation and skin contact. 
Wear gloves at all times and work in a fume hood when handling 
acrylamide solutions, and use appropriate precautions to avoid 
inhalation of crystalline acrylamide.

Ammonium 
Persulfate (APS)

APS begins to decompose immediately when dissolved in water. The 
result is loss of activity. Therefore, it is vital that this chemical be 
prepared fresh daily, since it affects the rate of polymerization and thus 
the gel properties. 

Store solid APS at room temperature in an airtight container with 
desiccant to keep it dry. 
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TEMED N, N, N', N'-tetramethylethylenediamine (TEMED) is by nature very 
reactive and prone to oxidation. The oxidized form is yellow and less 
active. Using oxidized TEMED slows gel polymerization time, thereby 
significantly altering the gel characteristics. Because it is hygroscopic, 
this initiator gradually accumulates water, which increases the rate of 
oxidation.

! WARNING ! CHEMICAL AND FIRE HAZARD. TEMED is 
extremely flammable and can be very destructive to the skin, eyes, 
nose, and respiratory system. Keep it in a tightly closed container. 
Avoid inhalation and contact with skin, eyes and clothing. Always 
work under a hood and wear chemical resistant gloves when 
handling TEMED solutions. 

Urea Old urea has breakdown products that affect sample migration. 
Guidelines for using urea are as follows:

� Use urea in the crystalline form

� Weigh urea fresh each time it is used

� Prepare solutions containing urea fresh each time

� Do not prepare stock solutions containing urea

! WARNING ! CHEMICAL HAZARD. Urea is a potential 
mutagen. Avoid inhalation and contact with skin, eyes and 
clothing. 

Buffers and 
Other Gel 
Components

Metals, non-buffer ions, and decomposition products are contaminants 
commonly found in reagents such as Tris, borate and urea. Transition 
metal ions tend to affect gel polymerization in various ways, causing 
run-to-run irreproducibility. 

Non-buffer ions tend to inhibit DNA mobility, also causing run-to-run 
irreproducibility. 

To help avoid these problems:

� Use only high quality Tris, borate and urea

� Use only distilled, deionized water to dilute reagents

� Do not use 10X TBE buffer which has precipitated. The change in 
ion concentrate affects sample migration.

Reagent purity and associated problems: (continued)

Reagent Problems That Can Occur When Fresh Reagents are Not Used
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Rate of
Polymerization

The properties of the gel depend on the rate of polymerization. The rate of 
polymerization is affected by:

� Temperature

� Oxygen

� Initiator concentration

Each parameter is discussed in detail below for academic purposes only. The 
protocols contained in this appendix have already been optimized. Therefore, 
experimentation with these variables is not necessary.

Factors that affect the rate of polymerization: 

Factor Affect on Rate of Polymerization

Temperature Temperature directly affects the rate of polymerization. The rate of 
polymerization determines the properties of the gel. Therefore, 
temperature control is crucial for the production of high-quality gels. 

Optimal room temperature for gel production and polymerization is 20 to 
23°C. The gel solution and glass plates should be the same 
temperature. Gels produced within this temperature range are 
transparent. They are not too porous, and more elastic than gels 
produced in colder or warmer temperatures. These gels are also the 
most reproducible. 

Gels produced in cold environments such as 4°C are turbid, porous, and 
inelastic. Run-to-run reproducibility is greatly compromised. 

Gels produced in environments that are too warm are inelastic because 
the polymer chains are too short. The result is non-reproducibility from 
run to run.

Oxygen Oxygen acts as a free radical trap, thereby inhibiting polymerization. The 
result is a porous gel. Therefore, polymerization must be fast enough to 
prevent too much oxygen from dissolving into the gel solution during 
polymerization. Follow these guidelines to minimize the amount of 
oxygen that dissolves in the gel solution during polymerization.

� Gently stir gel solutions to avoid the introduction of air bubbles

� Handle the gel solution gently when casting the gel to avoid the 
introduction of air bubbles

� Keep the vacuum strength and time constant during the vacuum 
filtration step in the protocols provided in this Appendix for 
run-to-run reproducibility. 

� Perform vacuum filtering and gel casting with the solution at room 
temperature, since cold solutions have a greater capacity for 
dissolving oxygen

� Use fresh, high-quality reagents

� Carefully follow the gel preparation protocols in this manual
Gel Recipes A-7



Air bubbles Air bubbles can distort the sample path, which affects lane tracking. Pour gels 
carefully and gently so air bubbles never form. 

If air bubbles are trapped between the comb and the gel solution, carefully remove 
and reinsert the comb until the bubbles are gone.

Age of the Gel Follow these guidelines for consistent results:

� To ensure complete polymerization, wait a full two hours after casting the gel 
before use

� Use gels within two to six hours after casting

After six hours, resolution begins to noticeably deteriorate. Gels that stand overnight 
can show significantly slower DNA migration due to the slow hydrolysis of urea to 
ammonium carbonate. Since the amide groups of the polymer slowly hydrolyze into 
acid groups, gels that stand 48 hours can also show significant loss in resolution 
beyond 350 bases.

Also, the exposed areas (top and bottom) of the thin gels commonly used with the 
ABI Prism® 377 DNA Sequencer dry out quickly.

Initiator 
Concentration

TEMED and APS initiate gel polymerization.

Too much TEMED or APS decreases the average polymer chain length, 
and increases gel turbidity.

Too little TEMED or APS can slow polymerization to the point where 
oxygen enters the monomer solution and inhibits further polymerization.

The concentration of initiators in degraded TEMED and APS may be too 
low for the protocols presented in this manual.

Factors that affect the rate of polymerization: (continued)

Factor Affect on Rate of Polymerization
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Chemical Abbreviations Used

Chemical
Abbreviations Used

Chemical abbreviations used in the following gel recipes:

Preparing TBE Buffer

10X TBE To make 50 mL of 10X TBE:

Note 10X TBE stored at room temperature should be used within 1 month. Do not use if a 
precipitate is present.

IMPORTANT Discard if the pH is not 8.3 (± 0.2), and make a fresh solution. Do not attempt 
to adjust the pH.

IMPORTANT Do not use 10X TBE buffer which has precipitated. The change in ion 
concentrate affects sample migration.

1X TBE Working solution (1X) is 89 mM Tris-base, 89 mM Boric acid, 2 mM Na2EDTA; pH is 
approximately 8.3 at ambient temperatures. 

To prepare a 1X TBE working solution:

Abbreviation Chemical Substance

APS ammonium persulfate

EDTA ethylenediaminetetraacetic acid

TEMED N,N,N’,N’-tetramethylelthylenediamine

TBE tris-borate-ethylenediaminetetaacetic acid buffer

Step Action

1 To a 50-mL screw cap tube, add the following:

� 5.4 g Tris

� 2.8 g Boric acid

� 0.4 g Na2EDTA

� Distilled, deionized water to 50 mL

IMPORTANT Be sure to use disodium EDTA to make 10X TBE stock. Some 
major laboratory suppliers provide monosodium EDTA or tetrasodium EDTA.

2 Mix ingredients thoroughly by vortexing.

3 Verify that the pH is between 8.2 and 8.3.

Step Action

1 Add 120 mL 10X TBE stock solution to a large graduated cylinder

2 Dilute with deionized water to a total volume of 1200 mL.
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Deionizing Formamide

Procedure IMPORTANT Always use deionized formamide. Over time, formamide hydrolyzes to formic 
acid and formate. Deionized formamide stock lasts for 3 months at –15 to –25°C.

Step Action

1 Mix 50 mL of formamide and 5 g of AG501 X8 ion-exchange resin.

! WARNING ! CHEMICAL HAZARD. Formamide is a teratogen and is 
harmful by inhalation, skin contact, and ingestion. Use in a well-ventilated 
area. Use chemical-resistant gloves and safety glasses when handling.

2 Stir for 30 minutes at room temperature.

3 Check that the pH is greater than 7.0 using pH paper.

If the pH is not greater than 7.0, decant the formamide into a beaker containing 
another 5 g of ion-exchange resin and repeat 30-minute stirring at room 
temperature.

4 When the pH is greater than 7.0, allow the beads to settle to the bottom of the 
beaker. Remove the supernatant (formamide), taking care not to disturb the beads.

5 Dispense the deionized formamide into aliquots of 500 µL and store for up to 
3 months at –15 to –25°C.

6 Use one aliquot per set of samples. Discard any unused deionized formamide.
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29:1 Polyacrylamide Gels—Protocol and Run Conditions

Ingredients and Run
Conditions

For 36-cm well-to-read runs—4.5% 29:1 Polyacrylamide Gel, 6 M Urea

For 48-cm well-to-read runs—4.25% 29:1 Polyacrylamide Gel, 6 M Urea

Protocol for 29:1
Polyacrylamide Gels

! WARNING ! CHEMICAL HAZARD. Urea causes eye, skin, and respiratory irritation. 
Lab experiments have shown mutagenic effects. Avoid contact. Wear chemical resistant 
gloves, safety goggles, and other protective clothing.

! WARNING ! CHEMICAL HAZARD. Acrylamide and bisacrylamide are neurotoxins. 
Avoid inhalation and skin contact. Wear gloves at all times, and work in a fume hood 
when handling acrylamide solutions. Use appropriate precautions to avoid inhalation of 
crystalline acrylamide.

! WARNING ! CHEMICAL AND FIRE HAZARD. TEMED is extremely flammable and 
can be very destructive to the skin, eyes, nose, and respiratory system. Keep it in a 
tightly closed container. Avoid inhalation and contact with skin, eyes and clothing. 
Always work under a hood and wear chemical resistant gloves when handling TEMED 
solutions. Read the MSDS in the Safety Summary included with your instrument user’s 
manual.

Ingredient For 50 mL Run Conditions

urea 18.0 g For runs at 1200 scans/hr:

� Use standard 36-cm, 1200 scans/hr run 
modules

� Increase run time to 9 hr

For runs at 2400 scans/hr:

� Use standard 36-cm, 2400 scans/hr run 
modules

� Increase run time to 4 hr

40% acrylamide stock 5.625 mL

deionized water 25.0 mL

Mixed-bed ion exchange 
resin

0.5 g

Filter and degas the above ingredients 
before adding TBE.

10X TBE 5.0 mL

10% APS 250 µL

TEMED 30.0 µL

Ingredient For 50 mL Run Conditions

urea 18.0 g � Use standard 48-cm run modules

� Increase run time to 11 hr40% acrylamide stock 5.31 mL

deionized water 25.0 mL

Mixed-bed ion exchange 
resin

0.5 g

Filter and degas the above ingredients 
before adding TBE.

10X TBE 5.0 mL

10% APS 250 µL

TEMED 30.0 µL
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To prepare the acrylamide-urea solution:

Adding the polymerizing reagents:

Step Action

1 Instructions for preparing glass plates and two gel pouring methods are located in 
Chapter 2, “Pouring Gels.” Glass plates and all other gel pouring equipment must be 
ready for use prior to adding the polymerizing reagents to the gel solution.

2 Prepare all stock solutions per the appropriate list of ingredients on page A-11.

3 Combine urea, 40% acrylamide stock, 25.0 mL deionized water, and mixed-bed ion 
exchange resin in a 150 mL beaker.

4 Stir the solution until all the urea crystals have dissolved.

5 Filter the solution through a 0.2-µm cellulose nitrate filter.

6 Degas for 2–5 minutes.

Note Degas time for all gels should be constant to ensure a reproducible 
polymerization rate for all gels.

7 Transfer the solution to a 100-mL graduated cylinder.

8 Add filtered 10X TBE buffer.

IMPORTANT Always remove the mixed-bed ion exchange resin by filtration 
(step 5 above) before adding the TBE buffer. Resin will destroy the effectiveness of 
the buffer.

9 Adjust the volume to 50.0 mL with deionized water.

IMPORTANT If the plates are not clean and mounted in the gel cassette or other 
device, clean and mount them now before adding the polymerizing agents to the gel 
solution. Instructions are listed in Chapter 2, “Pouring Gels.”

Step Action

1 Add freshly made 10% APS, and swirl carefully to mix without introducing air 
bubbles.

Note Be as accurate and reproducible as possible when making the 10% APS 
solution. Significant variation in this reagent can produce changes in data quality.

2 Add TEMED, and swirl carefully to mix without introducing air bubbles.

3 Immediately pour the gel. 

4 Allow the gel to polyermize a minimum of 2 hours before use.

Note 29:1 polyacrylamide gels take a minimum of 2 hours to polymerize, 
sometimes longer.
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PAGE-PLUS Gels—Protocol and Run Conditions

Overview To obtain the longest read length, 5.0% Long Ranger (from concentrate or Singel) and 
4.8% PAGE-PLUS gels are recommended for 36-cm runs at 1200 scans/hr only. 
These gel formulations have not been shown to consistently increase read lengths on 
36-cm runs at 2400 scans/hr, or 48-cm gel runs.

For 48-cm gel runs, 5.25% PAGE-PLUS and 4.75% Long Ranger Singel gels give 
longer read lengths than 19:1 polyacrylamide gels.

For 36-cm gel runs at 2400 scans/hr, use a 4.5% 29:1 polyacrylamide gel.

Ingredients and Run
Conditions

For 36-cm well-to-read runs—4.8% PAGE-PLUS Gel, 6 M Urea

For 48-cm well-to-read runs—5.25% PAGE-PLUS Gel, 6 M Urea

Ingredient For 50 mL Run Conditions

urea 18.0 g � Use standard 36-cm, 1200 scans/hr run 
modules

� Increase run time to 9 hr
40% gel stock solution 6.0 mL

10X TBE 5.0 mL

deionized water to 50.0 mL

10% APS 300 µL

TEMED 30.0 µL

Ingredient For 50 mL Run Conditions

urea 18.0 g � Use 48-cm run module

� Increase run time to 12 hr40% gel stock solution 6.6 mL

10X TBE 5.0 mL

deionized water to 50.0 mL

10% APS 250 µL

TEMED 25.0 µL
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Protocol for
PAGE-PLUS Gels

To prepare 4.8 and 5.25% PAGE-PLUS gels:

Step Action

1 Instructions for preparing glass plates and two gel pouring methods are located in 
Chapter 2, “Pouring Gels.” Glass plates and all other gel pouring equipment must be 
ready for use prior to adding the polymerizing reagents to the gel solution.

2 Prepare all stock solutions per the appropriate list of ingredients on page A-13.

3 Weigh out the urea and carefully transfer it to a stoppered, graduated cylinder. 

4 Using a pipette, add the appropriate amount of gel stock solution and 10X TBE buffer 
to the cylinder.

5 Adjust the volume to 49.5 mL by slowly adding deionized water, and tapping the 
cylinder to release air bubbles trapped by the urea.

6 Stopper the cylinder and invert to dissolve the urea.

7 Allow the solution to warm to room temperature.

8 Add deionized water to bring the solution to a final volume of 50 mL.

9 Stopper the cylinder and mix the contents thoroughly.

10 Filter the solution through a 0.2-µm cellulose nitrate filter. 

11 Degas for 2–5 minutes, and transfer the solution to a wide-mouthed container.

Note Degas time for all gels should be constant to ensure a reproducible 
polymerization rate for all gels.

IMPORTANT If the plates are not clean and mounted in the gel cassette or other 
device, clean and mount them now before adding the polymerizing agents to your 
solution. Instructions are listed in Chapter 2, “Pouring Gels.”

Adding the polymerizing reagents: 

Step Action

1 Add freshly made 10% APS, and swirl carefully to mix without introducing air 
bubbles.

Note Be as accurate and reproducible as possible when making the 10% APS 
solution. Significant variation in this reagent can produce changes in data quality.

2 Add TEMED, and swirl carefully to mix without introducing air bubbles.

3 Immediately pour the gel. 

4 Allow the gel to polymerize for 2 hours before using.
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Long Ranger Gel Solution Protocols

Overview To obtain the longest read length, 5.0% Long Ranger™ (from concentrate or Singel) 
and 4.8% PAGE-PLUS gels are recommended for 36-cm runs at 1200 scans/hr only. 
These gel formulations have not been shown to consistently increase read lengths on 
36-cm runs at 2400 scans/hr, or 48-cm gel runs.

For 48-cm gel runs, 5.25% PAGE-PLUS and 4.75% Long Ranger Singel gels give 
longer read lengths than 19:1 polyacrylamide gels.

For 36-cm gel runs at 2400 scans/hr, use a 4.5% 29:1 polyacrylamide gel.

Ingredients and Run
Conditions

For 48-cm well-to-read runs—4.75% Long Ranger Singel

For 36-cm well-to-read runs—5.0% Long Ranger Singel

For 36-cm well-to-read runs—5.0% Long Ranger/6 M Urea Gel

10% Ammonium
Persulfate

IMPORTANT Use fresh ammonium persulfate. Prepare the 10% ammonium persulfate 
solution no more than two hours before pouring the gel. Crystals should crackle as dissolved.

Ingredients Run Conditions

As supplied by the manufacturer. � Use 48-cm run module

� Increase run time to 11 hr

Ingredients Run Conditions

As supplied by the manufacturer. � Use standard 36-cm run modules with a run 
speed of 1200 scans/hr

� Increase run time to 9 hr

Ingredient For 50 mL Run Conditions

urea 18.0 g � Use standard 36-cm run modules with a run 
speed of 1200 scans/hr 

� Increase run time to 9 hr
50% gel stock solution 5.0 mL

10X TBE 5.0 mL

deionized water to 50.0 mL

10% APS 250 µL

TEMED 25.0 µL

Step Action

1 Weigh out 0.50 ± 0.005 g of ammonium persulfate into a 15-mL polypropylene tube.

! WARNING ! CHEMICAL HAZARD. Always wear appropriate safety 
attire (full-length laboratory coat, protective glasses, gloves, etc.) when 
handling and mixing hazardous chemicals. Always work under a chemical 
fume hood when handling and mixing hazardous chemicals. The room in 
which you work must have proper ventilation and a waste-collection system.

2 Using a P-5000 Pipetman or equivalent, add 5 mL of deionized water to the tube.

3 Vortex until all crystals dissolve.

4 The 10% APS solution can be stored in tightly capped tubes for up to 1 month.
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4.75% Long Ranger
Singel

Follow the manufacturer’s instructions to prepare the 4.75% Long Ranger Singel gel 
solution.

5.0% Long Ranger
Gel (not for SSCP)

For SSCP applications, follow the instructions listed under “5.0% Long Ranger Gel for 
SSCP” on page A-17.

IMPORTANT The 5.0% Long Ranger (FMC Corporation, P/N 50610) gel solution is 
hazardous waste. Dispose of the unused working solution in accordance with all applicable 
federal, state, and local health and safety regulations. After you finish pouring the gel, 
thoroughly clean all work surfaces with water.

To prepare a 36-cm, 5.0% Long Ranger/6 M urea gel: 

Step Action

1 Instructions for preparing glass plates and two gel pouring methods are located in 
Chapter 2, “Pouring Gels.” Glass plates and all other gel pouring equipment must be 
ready for use prior to adding the polymerizing reagents to the gel solution.

2 Weigh out 18.0 g of urea and transfer it carefully to a graduated cylinder.

CHEMICAL HAZARD. Urea is a mutagen. Do not breathe the dust. Refer to the 
Material Safety Data Sheet for the proper protective equipment that should be 
worn when working with this reagent.

3 Using a pipette, add the following:

� 5.0 mL 50% Long Ranger gel solution concentrate

� 5.0 mL 10X TBE

! WARNING ! CHEMICAL HAZARD. Long Ranger gel solution contains 
acrylamide. Acrylamide is a potent neurotoxin and is absorbed through the 
skin. Effects are cumulative. Always wear appropriate safety attire (a 
full-length laboratory coat, protective glasses, chemical-resistant gloves, etc.) 
and work under a chemical fume hood when handling powders, solutions, 
and gels. Unpolymerized acrylamide sublimes. Use in a well-ventilated area 
and clean up spills immediately.

4 Slowly add distilled, deionized water to bring the liquid level to approximately 45 mL.

Note Gently tap the cylinder while adding the water to release any air bubbles 
trapped by the urea.

5 Stopper and then invert the cylinder to dissolve the urea.

Note Although the cylinder and its contents become very cold, the urea 
dissolves rapidly.

6 Allow the solution to warm to room temperature.

7 Add distilled, deionized water to a final volume of 50 mL.

8 Stopper the cylinder and then mix the contents thoroughly.

9 Use a 0.2-µm cellulose nitrate filter to filter the solution.

10 Degas the filtrate by one of the following methods:

� Purging with argon or helium

� Applying a vacuum for at least five minutes

IMPORTANT If the plates are not clean and mounted in the gel cassette or 
other device, clean and mount them now before adding the polymerizing agents to 
the gel solution. Instructions are listed in Chapter 2, “Pouring Gels.”
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5.0% Long Ranger
Gel for SSCP

The protocol for making a non-denaturing, 8.1% Long Ranger gel solution for SSCP 
differs from the preceding protocol in two places:

� Step 2 on page A-16—Do not add urea. 

� Step 3 on page A-16:

Add the following:

– 8.1 mL 50% Long Ranger gel solution concentrate

– 1.25 g glycerol

– 5.0 mL 10X TBE

Adding the polymerizing reagents:

Step Action

1 Add fresh 10% APS to the gel solution. Swirl gently to mix. Be careful to avoid 
introducing air bubbles.

2 Add 25 µL of TEMED (tetramethylethylenediamine) to the solution. Swirl gently to 
mix. Be careful to avoid introducing air bubbles.

! WARNING ! TEMED (Tetramethylethylenediamine) is a flammable 
liquid and is extremely corrosive. Vapors may travel considerable distance to 
sources of ignition and flash back. TEMED is harmful by inhalation, contact 
with the skin, and if swallowed. Use only in a chemical fume hood. When 
handling, wear lab coat, safety glasses, and chemical-resistant gloves.

3 Immediately pour the gel.

4 Allow the gel to polymerize for at least 2 hours before use.
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MDE Gel Protocol for SSCP

Preparation
Procedure

Step Action

1 Instructions for preparing glass plates and two gel pouring methods are located in 
Chapter 2, “Pouring Gels.” Glass plates and all other gel pouring equipment must 
be ready for use prior to adding the polymerizing reagents to the gel solution.

2 Combine the following:

� 10.0 mL 2X Mutation Detection Gel Solution (MDE)

� 4.0 mL 10X TBE

� 2.0 g glycerol

! WARNING ! MDE (Mutation Detection Gel Solution) contains 
Acrylamide. Acrylamide is a poison, neurotoxin, irritant, carcinogen, and 
possible teratogen. Acrylamide sublimes (the solid releases toxic vapor) and 
is harmful if swallowed, inhaled, or absorbed through the skin. Effects are 
cumulative. When handling, always wear protective equipment (lab coat, 
safety glasses, and chemical-resistant gloves) and use in a well-ventilated 
area. On a routine basis, thoroughly clean surfaces subject to contamination.

3 Add sufficient distilled, deionized water to bring the total volume to 40.0 mL. Mix 
well to obtain a homogenous solution.

Note This step is critical because glycerol is viscous, and it is difficult to obtain a 
homogeneous solution.

4 Use a 0.2-µm filter unit to vacuum filter the MDE solution containing glycerol and 
1X TBE for 5 minutes.

IMPORTANT If the plates are not clean and mounted in the gel cassette or 
other device, clean and mount them now before adding the polymerizing agents to 
the gel solution. Instructions are listed in Chapter 2, “Pouring Gels.”

Adding the polymerizing reagents:

Step Action

1 With the filtered MDE solution at room temperature, add 200 µL of 10% APS. Swirl 
gently to mix. Be careful to avoid air bubbles.

2 Add 25 µL of TEMED to the solution. Swirl gently to mix. Be careful to avoid air 
bubbles.

3 Immediately pour the gel. 

4 Allow the gel to polymerize for at least 2 hours before use.
A-18 Gel Recipes



Polyacrylamide Gel Solution Protocols

Preparing the
40% Polyacrylamide

Stock Solution

To make 150 mL of 40% polyacrylamide stock solution, use:

Note For SSCP, always use a low cross-linker concentration (≥37.5:1, acrylamide: 
bisacrylamide) in the polyacrylamide stock solution. For other applications, typically use a 
19:1 stock solution.

Note 40% polyacrylamide stock lasts for 1 month at 2–6°C.

Application Acrylamide (g) Bisacrylamide (g)

SSCP 58.5 1.56

All other applications 57 3

To prepare the 40% polyacrylamide stock solution: 

Step Action

1 Working in a fume hood, combine the appropriate amounts acrylamide and 
bisacrylamide in a glass beaker.

! WARNING ! CHEMICAL HAZARD. Acrylamide and bisacrylamide are 
poisons, neurotoxins, irritants, carcinogens, and possible teratogens. 
Acrylamide and bisacrylamide sublime (the solids release toxic vapor) and 
are harmful if swallowed, inhaled, or absorbed through the skin. Effects are 
cumulative. When handling, always wear protective equipment (lab coat, 
safety glasses, and chemical-resistant gloves) and use in a well-ventilated 
area. On a routine basis, thoroughly clean surfaces subject to contamination.

2 Dissolve the crystalline acrylamide and bisacrylamide in enough distilled, deionized 
water to bring the total volume to 135 mL.

3 Add 15 g of mixed-bed, ion-exchange resin.

4 Stir at room temperature until all crystals dissolve. Continue stirring for 
5–10 minutes.

5 Filter the mixture through 0.2-µm cellulose nitrate filter.

6 Transfer the filtrate to a graduated cylinder and bring the total volume to 150 mL 
with distilled, deionized water.

7 Store at 2–6°C.
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For All Applications
Except SSCP

To prepare 40 mL of an N% polyacrylamide/6 M urea gel:

Step Action

1 Instructions for preparing glass plates and two gel pouring methods are located in 
Chapter 2, “Pouring Gels.” Glass plates and all other gel pouring equipment must 
be ready for use prior to adding the polymerizing reagents to the gel solution.

2 Combine the following:

� N mL 40% polyacrylamide stock (19:1)

Note N is the desired gel percentage.

� 14.4 g urea

� 1.0 g mixed-bed, ion-exchange resin

� 25 mL distilled, deionized water

3 Stir well until all the urea crystals have dissolved.

4 Use a 0.2-µm cellulose nitrate filter to filter the polyacrylamide solution for 
5 minutes.

Note During this step you both filter and degas the solution.

5 Add 4.0 mL of filtered 10X TBE and sufficient distilled, deionized water to bring the 
total volume to 40 mL.

IMPORTANT If the plates are not clean and mounted in the gel cassette or 
other device, clean and mount them now before adding the polymerizing agents to 
the gel solution. Instructions are listed in Chapter 2, “Pouring Gels.”

Adding the polymerizing reagents:

Step Action

1 With the filtered polyacrylamide solution at room temperature, add 200 µL of 10% 
APS (ammonium persulfate). Swirl gently to mix. Be careful to avoid air bubbles.

2 Add 25 µL of TEMED to the solution. Swirl gently to mix. Be careful to avoid air 
bubbles.

! WARNING ! TEMED (tetramethylethylenediamine) is a flammable liquid 
and is extremely corrosive. Vapors may travel considerable distance to 
sources of ignition and flash back. TEMED is harmful by inhalation, contact 
with the skin, and if swallowed. Use only in a chemical fume hood. When 
handling, wear lab coat, safety glasses, and chemical-resistant gloves.

3 Immediately pour the gel.

4 Allow the gel to polymerize for at least 2 hours before use.
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For SSCP
Applications Only

To prepare a standard 6.5% nondenaturing, polyacrylamide gel for SSCP:

Step Action

1 Instructions for preparing glass plates and two gel pouring methods are located in 
Chapter 2, “Pouring Gels.” Glass plates and all other gel pouring equipment must 
be ready for use prior to adding the polymerizing reagents to the gel solution.

2 Combine the following:

� 6.5 mL 40% polyacrylamide stock (37.5:1)

� 1.0 g mixed-bed, ion-exchange resin 

� 1.25 g glycerol

� 25 mL distilled, deionized water

3 Mix well to obtain a homogenous solution.

Note This step is critical because glycerol is viscous, and it is difficult to obtain a 
homogeneous solution.

4 Use a 0.2-µm cellulose nitrate filter to filter the solution for 5 minutes.

Note During this step you both filter and degas the solution.

5 Add 4.0 mL of filtered 10X TBE and sufficient distilled, deionized water to bring the 
total volume to 40.0 mL.

IMPORTANT If the plates are not clean and mounted in the gel cassette or 
other device, clean and mount them now before adding the polymerizing agents to 
the gel solution. Instructions are listed in Chapter 2, “Pouring Gels.”

Adding the polymerizing reagents:

Step Action

1 With the filtered polyacrylamide solution at room temperature, add 200 µL of 10% 
APS (ammonium persulfate). Swirl gently to mix. Be careful to avoid air bubbles.

2 Add 25 µl of TEMED to the solution. Swirl gently to mix. Be careful to avoid air 
bubbles.

! WARNING ! TEMED (Tetramethylethylenediamine) is a flammable 
liquid and is extremely corrosive. Vapors may travel considerable distance to 
sources of ignition and flash back. TEMED is harmful by inhalation, contact 
with the skin, and if swallowed. Use only in a chemical fume hood. When 
handling, wear lab coat, safety glasses, and chemical-resistant gloves.

3 Immediately pour the gel.

4 Allow the gel to polymerize for at least 2 hours before use.
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Supplier Information

Item Supplier

� 29:1 acrylamide stock solutions

� PAGE-PLUS stock solutions

Amresco, Inc.
30175 Solon Industrial Parkway
Solon, OH 44139-4300
800-829-2805
216-349-2805

� Long Ranger Singel

� Long Ranger Concentrate
(5% solution, P/N 50610)

� Mutation Detection (MDE) Gel Solution 
(P/N 50621)

FMC BioProducts
191 Thomaston St
Rockland, ME 04841
800-341-1574
207-594-3495
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Storing Reagents and Stock Solutions

Acrylamide � Good quality acrylamide can be stored dry at room temperature for up to one 
year. 

� 40% stock solution of acrylamide and bisacrylamide (19:1 or 29:1) can be stored 
at 4°C for up to one month. Use distilled, deionized water only.

� Using the premixed powders saves time, and minimizes your exposure to the solid 
form of the neurotoxins acrylamide and bisacrylamide.

Bisacrylamide � Store bisacrylamide dry at room temperature for up to one year. 

� 40% stock solution of acrylamide and bisacrylamide (19:1 or 29:1) at 4°C for up to 
one month.

! WARNING ! CHEMICAL HAZARD. Acrylamide and bisacrylamide are neurotoxins. 
Avoid inhalation and skin contact. Wear gloves at all times and work in a fume hood 
when handling acrylamide solutions, and use appropriate precautions to avoid 
inhalation of crystalline acrylamide.

TEMED Because it is hygroscopic, this initiator gradually accumulates water, which increases 
the rate of oxidation. Water-free TEMED (>99% pure), stored in a tightly sealed 
container at room temperature, should be good for up to six months.

! WARNING ! CHEMICAL AND FIRE HAZARD. TEMED is extremely flammable and 
can be very destructive to the skin, eyes, nose, and respiratory system. Keep it in a 
tightly closed container. Avoid inhalation and contact with skin, eyes and clothing. 
Always work under a hood and wear chemical resistant gloves when handling TEMED 
solutions.

Urea Store at room temperature.

Ammonium
Persulfate (APS)

APS is hygroscopic. Store solid APS at room temperature in an airtight container. 
Store with desiccant if the environment is humid. If tightly sealed, it can be stored at 
4°C for up to 1 year. 
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Subambient Temperature 
Operation B
Appendix Contents

In this Appendix The information in this appendix describes how to modify your ABI PRISM® 377 DNA 
Sequencer to run with an external gel cooling system (water bath) for run 
temperatures below the standard temperature. The standard run temperature is 
ambient plus 10°C up to 60°C. 

The following topics are discussed in this appendix:

For More
Information

Refer to the GeneScan® Reference Guide : ABI™ 373 and ABI PRISM® 377 DNA 
Sequencers (P/N 4303188) for more information on Single-stranded Conformation 
Polymorphism (SSCP) and operating the instrument at subambient temperatures.

Purpose of an External Cooling System

Performing SSCP The ABI PRISM 377 DNA Sequencer controls gel temperature from 10°C above 
ambient temperature to a maximum of 60°C. To perform PCR Single-stranded 
Conformation Polymorphism (SSCP) protocols at lower temperatures (below 10°C 
above ambient), a water bath must be attached to the instrument.

For more information on performing SSCP, refer to PCR SSCP Analysis: A Guide to 
Fluorescent PCR Single-stranded Conformation Polymorphism Analysis on the 
ABI PRISM 377 DNA Sequencer (P/N 904413).

Topic See page

Purpose of an External Cooling System B-1

Hardware and Software Requirements B-2

How the External Water Bath Functions B-3

Installing the External Water Bath B-5

Operating at Subambient Temperatures B-6

Avoiding Condensation Inside the Instrument B-7
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Hardware and Software Requirements

Overview The following hardware and software is required to operate the instrument at 
subambient temperatures:

� An external water bath connected to the instrument

� 30 k-ohm thermistors installed on the instrument

� ABI PRISM® 377 Data Collection Software version 2.1 or higher

Hardware
Requirements

Water Bath

The water bath, polyurethane tubing, and tubing connectors required for instrument 
modification must meet the following minimum requirements.

Any external water bath that meets these requirements should work properly. The 
NESLAB Model RTE111 meets these requirements and has been tested with the 
instrument. 

Refer to the user manual for the water bath you select, follow proper procedures, and 
ensure that all product safety and regulatory requirements applicable to your location 
are met.

Thermistors

To perform SSCP at temperatures less than 22°C, the instrument must have 30 k ohm 
thermistors installed. Some instrument may have 100 k ohm thermistors which must 
be replaced to use an external water bath.

To determine which thermistors are installed on the instrument, check a Log file from a 
recent run using ABI PRISM Data Collection Software version 2.1 or higher. The 
configuration information in the Log lists the type of thermistors installed. 

If necessary, schedule a service call with your Applied Biosystems service engineer to 
replace the 100 k thermistors with 30 k thermistors.

Software
Requirements

ABI PRISM Data Collection Software version 2.1 and above contain the features 
required to accommodate the external water bath, including chiller modules. 
Performing runs at subambient temperatures with an external water bath requires the 
specification of chiller modules on the run sheet.

Standard modules are located in a folder called Modules. At system installation, the 
software is typically set up so that the standard modules are the ones displayed in the 

Hardware Minimum Requirements

Water Bath Cooling capacity: 250 watts at 20°C

Heating capacity: 500 watts up to 60°C

Pump flow rate: 1 gal/min or 4 L/min at pressure head of 3 m

Automatic Shutdown: At high temperature and low 
liquid-level 

Polyurethane Tubing 6 ft. (1/4-in. i.d., 3/8-inch o.d.)

Tubing Connectors 1/4-in. female NPT, 1/4-in. male barbed fittings (NESLAB 
P/N 126000000007)
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pop-up menus on run sheets. Chiller modules are stored in a folder called Chiller 
Modules. You must either move the chiller modules to the Modules folder, or change 
the Folder Locations Preference for Modules to the Chiller Modules folder for the 
software to access the chiller modules. Refer to “Installing Chiller Modules” on 
page 9-44 in Chapter 9, “Data Collection Software,” and Folder Location Preferences 
in Chapter 5, “Setting Preferences,” for instructions on how to access the chiller 
modules.

Requirements for
Specific Run

Conditions

The following table lists the requirements for standard and SSCP operation of the 
instrument.

How the External Water Bath Functions

Disengages Internal
Pump System

The instrument configuration with the external water bath attached is similar to 
Figure 1 when viewed from the back. Instructions in the chiller modules disengage the 
instrument’s internal pump system and switch to the external water bath. When the 
external valve is turned so the arrow points down, access to the internal gel 
temperature control unit is closed off. 

Figure 1. Rear view of the instrument with external water bath attached

Run Conditions
Data Collection 

Software Version
Thermistor

(ohms) External Bath

>10°C above ambient to 60°C 1.1 or 2.1 100 k not required

SSCP from 22°C to ambient +10°C 2.1 100 k required

SSCP at <22°C 2.1 30 k required

External valve with
arrow pointing down
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Water Bypasses the
Gel Temperature

Control Unit

With the external water bath attached, water passes directly into the front and rear 
heat-transfer plates in the instrument, bypassing the gel temperature control unit.

Figure 2. Instrument interior view with arrows showing water flow. Dotted line shows 
instrument components used with the external water bath.

External Water Bath
Attached for

Standard Operating
Conditions

If the external water bath used has a heating capacity to 60°C, the instrument can be 
run under standard operating conditions (ambient temperature plus 10°C—60°C) with 
the external water bath attached.

Frequent monitoring of the water level is required when the external bath is used 
during standard runs. For long periods of use, disconnect the external water bath, 
reinstall the water bottle and tubes, and use the standard run modules rather than the 
chiller modules.

At system installation, the software is typically set up so that the standard modules are 
the ones displayed in the pop-up menus on run sheets.Chiller modules are stored in a 
folder called Chiller Modules. You must either move the chiller modules to the Modules 
folder, or change the Folder Locations Preference for Modules to the Chiller Modules 
folder for the software to access the chiller modules. Refer to “Installing Chiller 
Modules” on page 9-44 in Chapter 9, “Data Collection Software,” and Folder Location 
Preferences in Chapter 5, “Setting Preferences,” for instructions on how to access 
standard and chiller modules.
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Installing the External Water Bath

Positioning the
Machines

To position the instrument and external water bath:

Determining Intake
and Outlet

To identify the intake and outlet flow tubes on the instrument:

Disconnecting the
Internal Pump

To disconnect the internal pump:

Attaching the
External Water Bath

To attach the external water bath to the instrument:

Step Action

1 Position the ABI PRISM 377 so the rear of the instrument can be accessed easily.

2 Facing the ABI PRISM 377, position the water bath on the right side of the 
instrument and at the same height.

3 Connect the instrument and water bath to an external power supply.

Step Action

1 Turn on the instrument.

2 Open the right panel of the instrument where the water bottle is mounted.

3 Unscrew the water bottle, and slowly pull it down to expose the ends of the tubes, 
but do not remove the bottle.

4 Observe the direction of water flow from the tubes into and out of the bottle to 
identify the intake and outlet tubes.

Note Water coming into the bottle is from the instrument outlet, and water 
drawn out of the bottle goes into the instrument intake. Some instruments have a 
small cutout at the bottom of the water intake tube.

5 Turn off the instrument.

Step Action

1 Remove the water bottle, and pull down the intake and outlet tubes to remove them.

2 Store the tubes and water bottle for later use.

3 Step to the rear of the instrument, and turn the external valve so that the arrow 
points down Figure 1 on page B-3).

4 Cut two pieces of polyurethane tubing approximately three feet (one meter) long.

5 Insert one end of a piece of tubing into the intake port on the instrument. 

6 Repeat step 5 with the second piece of tubing in the outlet port.

Step Action

1 Wrap the threads of the intake and outlet ports on the external water bath with 
Teflon tape.

2 Attach a metal tubing connector to each port.

3 Connect the free end of the intake tube to the outlet fitting on the back of the 
external water bath.

4 Connect the free end of the outlet tube to the intake fitting on the back of the 
external water bath.
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Operating at Subambient Temperatures

Performing a Run at
Subambient

Temperatures

Follow these steps to perform runs at subambient temperatures:

Step Action

1 Follow all instructions in the external water bath user manual.

2 Fill the external water bath with cold, deionized distilled water, and add antifreeze as 
recommended by the manufacturer.

! WARNING ! CHEMICAL HAZARD. Antifreeze may cause respiratory 
tract, skin, and eye irritation. Wear chemical-resistant gloves and safety 
glasses when handling, and always use in a well-ventilated area.

3 Check that all tubing is tightly connected.

4 Turn on power to the external water bath, start the circulating pump, and add water 
as needed to maintain the proper level.

IMPORTANT If the water level drops below the level recommended by the 
manufacturer, the circulation pump shuts off, and the temperature is not maintained. 

5 Set the external water bath temperature at 3–4°C below the desired gel 
temperature. Open the Status window and monitor the temperature.

6 Place a lid on the bath to minimize evaporation.

7 Add water and antifreeze during operation as needed to maintain the 
manufacturer’s recommended water level.

8 Monitor the temperature and humidity in the lab (see “Avoiding Condensation Inside 
the Instrument” on page B-7).

CAUTION Condensation can cause decreased performance and severe 
damage to the instrument. Monitor the room temperature and humidity, 
consult the following condensation tables, and maintain the water bath 
temperature setting above the corresponding dew point.
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Avoiding Condensation Inside the Instrument

How To Avoid Severe
Instrument Damage

Operating the ABI PRISM 377 DNA Sequencer at subambient temperatures may 
cause condensation to form inside the instrument. This can cause decreased 
performance and severely damage the instrument. To avoid condensation, keep the 
water temperature above the dew point (temperature at which water vapor condenses 
into liquid), or lower the humidity in the room. 

Refer to the following table to determine the dew point of water at various relative 
humidities and ambient temperatures in your lab.

CAUTION Condensation can cause decreased performance and severe damage to the 
instrument. Monitor the room temperature and humidity, consult the following 
condensation tables, and maintain the water bath temperature setting above the 
corresponding dew point.

Dew Point Table

Ambient Temp. 15°C Ambient Temp. 20°C Ambient Temp. 25°C Ambient Temp. 30 °C Ambient Temp. 35°C

Relative 
Humidity 

(%)

Approx. 
Dew Point

(°C)

Relative 
Humidity 

(%)

Approx. 
Dew Point

(°C)

Relative 
Humidity 

(%)

Approx. 
Dew Point

(°C)

Relative 
Humidity 

(%)

Approx. 
Dew Point

(°C)

Relative 
Humidity 

(%)

Approx. 
Dew Point

(°C)

100 15 100 20 100 25 100 30 100 35

90 14 90 18 90 23 90 29 90 33

80 12 80 16 80 21 80 26 80 31

70 10 70 14 70 19 70 24 70 29

60 12 60 17 60 21 60 26

50 10 50 14 50 19 50 23

40 10 40 15 40 19

30 10 30 15

20 9
Subambient Temperature Operation B-7





C
 Parts and Accessories C
Appendix Contents

In this Appendix Part numbers for the following are provided in this appendix:

Part Number Updates

Part numbers are subject to change. Consult the Applied Biosystems World Wide Web 
Site (www.appliedbiosystems.com/techsupport) for updated information.

Accessory/Reagent See page

Part Number Updates C-1

Glass Plates, Spacers, and Clamps C-2

Combs and Overlays C-3

Gel Cassette and Pouring Fixtures C-3

Buffer Chambers and Gasket Kits C-3

Electrophoresis Cable and Electrode Assemblies C-4

Front Heat-Transfer Plate C-4

Two Pitch, Eight-Channel Loader Suppliers C-5

User’s Manuals C-7

ABI PRISM DNA Fragment Analysis Kits and Reagents

GeneScan Size Standards C-8

Fluorescent dNTPs C-8

Fluorescent dNTP PCR Kits C-9

Fluorescent Phosphoramidites C-9

Fluorescent NHS-Esters C-9

Matrix Standard Sets C-9

Fluorescent Genotyping Demonstration Kits A and B C-10

ABI PRISM Linkage Mapping Set Version 2 C-11
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Glass Plates, Spacers, and Clamps

cm Description Part Number

48 Stepped Glass Plate and Spacer Kit, 48-cm

Includes two sets of 0.4 mm 48-cm well-to-read stepped glass 
plates and 48 cm spacers.

4305810

(for 96-lane 
upgrade only)

Front Stepped Glass Plate, 48-cm 4305387
(for 96-lane 

upgrade only)

Glass Plate and Spacer Kit

Includes two sets of 48-cm well-to-read glass plates and 
48-cm spacers.

401878

Rear Glass Plate, 48-cm 401835

Front Glass Plate, 48-cm 401838

Spacers, two 48-cm, 0.2 mm thick 401837

36 Stepped Glass Plate and Spacer Kit, 36-cm 

Includes two sets of 0.4 mm 36-cm well-to-read stepped glass 
plates and 48 cm spacers that must be cut to size before use.

4305693

(for 96-lane 
upgrade only)

Stepped glass plates only, 36-cm, one set 4305384
(for 96-lane 

upgrade only)

Clamps, three, 2 inch 

(use with 36-cm stepped glass plates, P/N 4305693)

4305386

Glass Plate and Spacer Kit

Includes two sets of 36-cm well-to-read glass plates and 
36-cm spacers.

401876

Rear Glass Plate, 36-cm 401839

Front Glass Plate, 36-cm 401840

Spacers, two 36-cm, 0.2 mm thick 401836

12 Glass Plate and Spacer Kit

Includes: two sets of 12-cm well-to-read glass plates and 
spacers

401877

Front Glass Plate, 12-cm 401834

Rear Glass Plate, 12-cm 401833
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Combs and Overlays

Gel Cassette and Pouring Fixtures

Buffer Chambers and Gasket Kits

Wells Description Part Number

100 Sharktooth Comb, 0.4 mm thick, 1.8 mm center 4305385
(96 lane)

66 Squaretooth Comb, 0.2 mm thick, 66-well 402183

Plastic Overlay, 66-well 402187

64 Sharktooth Comb, 0.2 mm thick, 64-well 402180

50 Squaretooth Comb, 0.2 mm thick, 50-well 402053

Plastic Overlay, 50-well 402186

48 Sharktooth Comb, 0.2 mm thick, 48-well 402177

36 Sharktooth Comb, 0.2 mm thick, 36-well 401828

Squaretooth Comb, 0.2 mm thick, 36-well 401910

32 Sharktooth Comb, 0.2 mm thick, 32-well 401922

Squaretooth Comb, 0.2 mm thick, 32-well 401907

24 Squaretooth Comb, 0.2 mm thick, 24-well 401904

Sharktooth Comb, 0.2 mm thick, 24-well 401827

18 Sharktooth Comb, 0.2 mm thick, 18-well 402168

604297 Gel Cassette

401991 Gel Pouring Fixture Kit (contains top and bottom fixtures, clamps, and syringe)

401969 Top Pouring Fixture

604014 Bottom Pouring Fixture

4304406 Upper Buffer Chamber

604078 Upper Buffer Chamber (obsolete; gasket kit available as P/N 604524))

603875 Lower Buffer Chamber

4304409 Gasket Replacement Kit (for upper buffer chamber P/N 4304406)

604524 Gasket Replacement Kit for upper buffer chamber P/N 604078
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Electrophoresis Cable and Electrode Assemblies

Front Heat-Transfer Plate

603822 Upper Buffer Chamber Electrode Assembly

603823 Lower Buffer Chamber Electrode Assembly

603833 Front 36-cm Well-to-Read Heat-Transfer Plate
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Two Pitch, Eight-Channel Loader Suppliers

Introduction For your convenience, the following tables provide information on suppliers of 
two-pitch, eight-channel loaders.

IMPORTANT Contact the companies listed for availability, pricing, and technical information 
regarding these products.

Suppliers Inside
the United States

Note Hamilton Co. (702-858-3000) also supplies loaders that may work with this upgrade.

Suppliers Outside
the U.S.

Supplier Supplier Headquarters Product  Part No.

Kloehn 
Company

10000 Banburry Cross Dr.
Las Vegas, NV 89134 USA

Voice: (702) 243-7727
Fax: (702) 243-6036
World Wide Web: http://www.kloehn.com

Outside U.S. offices are listed on the 
following page.

Loader, 
0.25-mm

18597

Loader, 
0.3-mm

18663

Needle, 
0.25-mm (8)

18597

Needle, 
0.3-mm (8)

18628

World Precision 
Instruments, 
Inc.

Sarasota International Trade Center
175 Sarasota Center Blvd.
Sarasota, FL 34240-9258 USA

Voice: (941) 371-1003
Fax: (941) 377-5428
World Wide Web: http://www.wpiinc.com

Outside U.S. offices are listed on the 
following page.

Loader Gel Mate 96

Needle, 
0.25-mm (10)

67124

Supplier Supplier Contact Geographic Areas Served

Kloehn Europe Bahnhofstrasse 12
Postfach 55
CH-7402
Bonaduz, Switzerland

Voice: 41 81 630 2303
Fax: 41 81 641 3488
E-mail: kloehneurope@bluewin.ch

� Europe

World Precision 
Instruments, Inc.
Australia

P.O. Box 1191
Glen Waverly, Victoria 3150
Australia

Voice: 61 (0) 3 9887-6262
Fax: 61 (0) 3 9887-9585
E-mail: wpiau@c031.aone.net.au

� Australia

� Indonesia

� Malaysia

� New Guinea

� New Zealand
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World Precision 
Instruments, Inc.
Germany

Liegnitzer Str. 15
D-10999 Berlin, Germany

Voice: 49 (0) 30-6188845
Fax: 49 (0) 30-6188670
E-mail: wpi@wpi.sireco.de

� Austria

� Bulgaria

� Czechoslovakia

� Germany

� Greece

� Holland (Netherlands)

� Hungary

� Italy

� Poland

� Rumania

� Russia

� Switzerland

� Yugoslavia

World Precision 
Instruments, Inc.
Japan

1-4-2-702 Naka-Meguro, Meguro
Tokyo 153-0061, Japan

Voice: 81 (0) 3-3760-5050
Fax: 81 (0) 3-3760-5055
E-mail: wpi@tkb.att.ne.jp

� Japan

World Precision 
Instruments, Inc.
United Kingdom

Astonbury Farm Business Centre
Aston, Stevenage
Hertfordshire SG2 7EG England

Voice: 44 (0) 1438-880025
Fax: 44 (0) 1438-880026
E-mail: wpi@piuk.demon. co.uk

� Belgium

� Denmark

� England

� Finland

� France

� Ireland

� Norway

� Portugal

� Scotland

� Spain

� Sweden

World Precision 
Instruments, Inc.
Other world-wide 
areas

Sarasota International Trade Center
175 Sarasota Center Blvd.
Sarasota, FL 34240-9258
USA

Voice: (941) 371-1003
Fax: (941) 377-5428
E-mail wpi@wpiinc.com

� Areas not listed above

Supplier Supplier Contact Geographic Areas Served
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User’s Manuals

Instrument

Software

4303613 ABI PRISM® 377 DNA Sequencer User’s Manual

904412 ABI PRISM® 377 DNA Sequencer XL Upgrade User’s Manual

4305423 ABI PRISM® 377 DNA Sequencer 96-lane Upgrade User’s Manual

4303242 ABI PRISM GeneScan® Analysis Software User’s Manual (version 3.0)

902842 GeneScan 672 Software User’s Manual

4303188 GeneScan Reference Guide: ABI™ 373 and ABI PRISM® 377 DNA 
Sequencers

4305080 Automated DNA Sequencing Chemistry Guide: ABI 373 and ABI PRISM 377 
DNA Sequencers

904532 ABI PRISM® DNA Sequencing Software User’s Manual (version 3.0)

4304075 ABI PRISM® DNA Sequencing Software User’s Manual (version 3.2)
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ABI PRISM DNA Fragment Analysis Kits and Reagents

GeneScan Size
Standards

GeneScan-350, 500, and 400HD contain enough material for 800 lanes. 
GeneScan-1000 and 2500 contain enough material for 400 lanes.
GeneScan-500XL contains enough material for 1600 lanes. Loading buffer is 
included.

Fluorescent dNTPs For fluorescent labeling of DNA during PCR amplification:

Note [TAMRA]dNTP is supplied at a concentration four times higher than [R110]dNTP and 
[R6G]dNTP because it produces approximately four times less signal.

401735 GeneScan-350 [ROX]

401736 GeneScan-350 [TAMRA]

402985 GeneScan-400HD [ROX]

401734 GeneScan-500 [ROX]

401733 GeneScan-500 [TAMRA]

403040 GeneScan-500XL [TAMRA]

403039 GeneScan-500XL [ROX]

401098 GeneScan-1000 [ROX]

401100 GeneScan-2500 [ROX]

401545 GeneScan-2500 [TAMRA]

401144 Loading Buffer

401894 [F]dUTP Set: [R110], [R6G], and [TAMRA] 3, 3, and 12 nmol (3 x 30 µL)

401896 [R110]dUTP 6 nmol (2 x 30 µL)

401897 [R6G]dUTP 6 nmol (2 x 30 µL)

401895 [TAMRA]dUTP 24 nmol* (2 x 30 µL)

402793 [F]dCTP Set: [R110], [R6G], and [TAMRA] 3, 3, and 12 nmol (3 x 30 µL)

402795 [R110]dCTP 6 nmol (2 x 30 µL)

402796 [R6G]dCTP 6 nmol (2 x 30 µL)

402794 [TAMRA]dUTP 24 nmol* (2 x 30 µL)
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Fluorescent dNTP
PCR Kits

Each kit listed below includes a GeneAmp® kit as specified (100 reactions) along with 
an [F]dNTP set that contains 30 µL each of [R110]dNTP (3 nmol), [R6G]dNTP 
(3 nmol), and [TAMRA]dNTP (12 nmol).

Fluorescent
Phosphoramidites

For direct 5' end labeling on an automated DNA synthesizer:

Fluorescent
NHS-Esters

For post-synthesis labeling of primers containing a 5' Aminolink 2:

Matrix Standard
Sets

N808-0220 GeneAmp PCR Reagent Kit with AmpliTaq® DNA Polymerase with [F]dUTP 
Set

N808-0221 GeneAmp PCR Core Reagents with [F]dUTP Set

N808-0222 GeneAmp Thermostable rTth Reverse Transcriptase RNA PCR Kit with 
[F]dUTP Set

N808-0223 GeneAmp PCR Reagent Kit with AmpliTaq DNA Polymerase with [F]dCTP 
Set

N808-0224 GeneAmp PCR Core Reagents with [F]dCTP Set

N808-0225 GeneAmp Thermostable rTth Reverse Transcriptase RNA PCR Kit with 
[F]dCTP Set

401527 [6-FAM] Phosphoramidite 85 mg

401533 [TET] Phosphoramidite 100 mg

401526 [HEX] Phosphoramidite 105 mg

400981 [TAMRA] NHS-Ester 5 mg/60 µL in DMSO

400980 [ROX] NHS-Ester 5 mg/60 µL in DMSO

400808 Aminolink 2 0.25 g

401114 Dye Primer Matrix Standards Kit (Filter Set A) for NHS-ester labeling

Contains one tube each of 5-FAM-, JOE-, TAMRA-, and ROX-labeled DNA

402792 [F]dNTP Matrix Standards

Contains one tube each of R110-, R6G-, TAMRA-, and ROX-labeled DNA

401546 Fluorescent Amidite Matrix Standards Kit (Filter Set C) for fluorescent 
phosphoramidite labeling

Contains one tube each of 6-FAM-, TET-, HEX-, TAMRA- and ROX-labeled 
DNA

402996 NED Matrix Standard

Used in combination with the 5-FAM, JOE and ROX dyes in the Dye Primer 
Matrix Standards Kit or the 6-FAM, HEX, and ROX dyes in the Fluorescent 
Amidite Matrix Standards Kit
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Fluorescent
Genotyping

Demonstration Kits
A and B

402246 Kit A-PCR Reagents

Contains six fluorescent labeled PCR primer pairs labeled with [HEX], [TET] & 
[FAM], two control DNAs (CEPH 1347-02 and 1347-10), and a ready made mix 
of PCR reagents containing AmpliTaq Gold™ DNA Polymerase, GeneAmp 
PCR Buffer II, dNTPs, and magnesium chloride

Also includes GeneScan-350 Internal Lane Size Standard and loading buffer

402247 Kit B-Amplified PCR Products

Contains four tubes of pooled (combined) PCR products. To generate the 
products each DNA sample (CEPH 1347-01, 1347-02, 1347-10, 1347-15) has 
been amplified with the same six fluorescent-labeled PCR primer pairs in kit A. 
All of the PCR products from one tube can be detected in one gel lane.
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ABI PRISM Linkage
Mapping Set

Version 2 50-Rxn Kits 300-Rxn Kits Panel Chromosome

403089 403118 Complete Set 1–22, X

403090 403119 1 1

403091 403120 2 1

403092 403121 3 2

403093 403122 4 2

403094 403123 5 3,4

403095 403124 6 3,4

403096 403125 7 3,4

403097 403126 8 5,6

403998 403127 9 5,6

403099 403128 10 5,6

403100 403129 11 7,8

403101 403130 12 7,8

403102 403131 13 9,10,11

403103 403132 14 9,10,11

403104 403133 15 9,10,11

403105 403134 16 9,10,11

403106 403135 17 12,13

403107 403136 18 12,13

403108 403137 19 12,13

403109 403138 20 14

403110 403139 21 15,16

403111 403140 22 15,16

403112 403141 23 17,18

403113 403142 24 17,18

403114 403143 25 19,20,21,22

403115 403144 26 19,20,21,22

403116 403145 27 19,20,21,22

403117 403146 28 X

450096 Individual Primer Pairs from the ABI PRISM® Linkage Mapping 
Set Version 2

Must be ordered through Applied Biosystems Custom 
Oligonucleotide Synthesis Service (specify locus name)

3000 pmol

403061 True Allele™ PCR Premix 18 mL, enough 
for 2000 rxns

403062 Control DNA CEPH 1347-02 180 µL, 
enough for 
150 rxns
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D
Applied Biosystems 
Limited Warranty D
Applied Biosystems warrants to the Customer that, for a period ending on the earlier 
of one year from completion of installation or fifteen (15) months from the date of 
shipment to the Customer (the “Warranty Period”), the ABI PRISM® 377 DNA 
Sequencer purchased by the Customer (the “Instrument”) will be free from defects in 
material and workmanship, and will perform in accordance with the specifications for 
performance set forth at the time of sale in the Instrument Specification Sheet 
published and maintained by Applied Biosystems (the “Specifications”).

During the Warranty Period, if the Instrument’s hardware fails to perform in 
accordance with the Specifications, Applied Biosystems will repair or replace the 
Instrument so that it meets the Specifications, at Applied Biosystems expense.

This Warranty does not extend to any Instrument or part which has been (a) the 
subject of an accident, misuse, or neglect, (b) modified or repaired by a party other 
than Applied Biosystems, or (c) used in manner not in accordance with the 
instructions contained in the Instrument User’s Manual. This Warranty does not cover 
the customer-installable accessories or customer-installable consumable parts for the 
Instrument that are listed in the Instrument User’s Manual. Those items are covered by 
their own warranties.

Applied Biosystems obligation under this Warranty is limited to repairs or 
replacements that Applied Biosystems deems necessary to correct covered defects or 
failures of which Applied Biosystems is notified prior to expiration of the Warranty 
Period. All repairs and replacements under this Warranty shall be performed by 
Applied Biosystems on-site at the Customer's location at Applied Biosystems 
expense.

No agent, employee, or representative of Applied Biosystems has any authority to 
bind Applied Biosystems to any affirmation, representation, or warranty concerning 
the Instrument that is not contained in this Warranty Statement. Any such affirmation, 
representation or warranty made by any agent, employee, or representative of Applied 
Biosystems shall not be binding on Applied Biosystems.

Applied Biosystems shall not be liable for any incidental, special, or consequential 
loss, damage or expense directly or indirectly arising from the purchase or use of the 
Instrument. Applied Biosystems makes no warranty whatsoever with regard to 
products or parts furnished by third parties.

THIS WARRANTY IS THE SOLE AND EXCLUSIVE WARRANTY AS TO THE 
INSTRUMENT AND IS IN LIEU OF ANY OTHER EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE AND IS IN LIEU 
OF ANY OTHER OBLIGATION ON THE PART OF APPLIED BIOSYSTEMS.
Applied Biosystems Limited Warranty D-1
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A
ABI (settings) folder, location and 

description of 3-52
ABI Prism 377

changing settings in real 
time 3-48

cold boot procedure 4-23
data analysis

overview 1-18 to 1-19
data flow to computer 9-7 to 9-8
description of instrument 1-11
firmware image, downloading 

file 4-24
how the instrument works 1-13
instrument operation

an overview 1-14 to 1-17
cleaning the glass plates 3-4 

to 3-5
cleaning up after run 3-45
filling buffer chambers 3-16 

to 3-17
installing front heat 

transfer-plate 3-18
installing lower buffer 

chamber 3-9
installing upper buffer 

chamber 3-15
loading gel into cassette 3-6 

to 3-7
loading samples 3-37
manually controlling the 

instrument 3-48 to 
3-50

materials required but not 
supplied 3-2

performing a prerun 3-35 to 
3-39

performing plate check 3-11 
to 3-13

preparing 1X TBE buffer 
solution 3-3

preparing a run sheet 3-28 
to 3-34

preparing GeneScan sample 
sheet 3-24 to 3-27

preparing loading 
solution 3-3

preparing sequencing sample 
sheet 3-19 to 3-23

read region, description 
of 3-47

removing gel cassette 3-45
setting folder location 

preferences 3-51 to 
3-53

setting up the software 3-19
skipping lanes, determining 

which to skip 3-14
starting and monitoring the 

run 3-40 to 3-43
theory of operation 1-13
viewing the Log file 3-44

maintenance
CCD pixel position 

value 8-14 to 8-16
cleaning accessories 8-3 to 

8-4
recommendations 8-2
refilling water reservoir 8-5
replacing electrophoresis 

cables and 
electrodes 8-12 to 
8-13

replacing upper buffer 
chamber gasket 8-6 
to 8-11

part number updates C-1
reinstalling software 8-25
safety warnings 1-4
software 9-2
subambient temperature operation

avoiding condensation B-7
hardware and software 

required B-2 to B-3
how external water bath 

works B-3 to B-4
installing external water 

bath B-5
performing a run B-6
purpose of external cooling 

system B-1
See Also SSCP

summary of operation 
procedures 3-2

system components 1-11 to 1-12
hardware 1-11
models available 1-11 to 

1-12
software 1-11, 9-2

troubleshooting guide 4-6 to 4-9
viewing status 9-53 to 9-57
warranty D-1

ABI Prism 377 DNA Sequencer with 
96-Lane Upgrade, description of 
instrument 1-12

ABI Prism 377 DNA Sequencer with XL 
Upgrade, description of 
instrument 1-11 to 1-12

ABI Prism 377 Site Preparation and 
Safety Guide, description of 
guide 1-4

ABI Prism 377-18 DNA Sequencer, 
description of instrument 1-11

ABI Prism DNA Sequencing Software
automatic data analysis 9-38
description of software 1-19
instrument files

adding/replacing matrix 7-20 
to 7-21

color guide for data 
display 7-4 to 7-5

for Virtual Filter Set A 7-6 to 
7-9

for Virtual Filter Set E 7-10 to 
7-15

from a sample file 7-18 to 
7-19

overview 7-2
storing and backing up 7-19
summary of chemistries 7-4
terminology 7-1
verifying instrument 

files 7-16 to 7-17
when to make new file 7-3

run sheets
about 9-28 to 9-29
preparing 9-31 to 9-37
setting preferences 3-28, 

5-11, 9-31
Index-1



sample sheets
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ABI Prism GeneScan Analysis 

Software
about automatic data 

analysis 9-38
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guide 4-16
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3-51, 3-52, 5-14, 9-31, 9-36
automatic data analysis 9-38
folder location 5-2, 5-5, 5-6, 9-5

analyzing data 1-18, 3-46
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Apple menu, about 9-9
Applied Biosystems

warranty D-1

APS
effect of changing 

concentration A-8
storing A-23

archiving
data from runs 8-23 to 8-24
gel and sample files 9-58
instrument files 7-19
recommendations for 8-20
See Also saving

arcing
instrument damage warning 3-9
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Auto Print checkbox 9-58
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as part of GeneAssist 
system 1-21

description of software 1-21 to 
1-22

automatic data analysis
analysis parameters 3-28, 3-33, 

3-34, 3-51, 3-52
automatically printing 

results 3-32, 3-33
deselecting 3-31
for GeneScan runs 3-33
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B
backing up

data from runs 8-23 to 8-24
instrument files 7-19
recommendations for 8-20
See Also archiving and saving

BigDye primers
associated filter set 7-4
kit A-3

BigDye terminators
associated filter set 7-4
kit A-3

BioLIMS
description of 1-22
project info preferences 3-19, 

3-25, 5-20
project names 3-19, 3-25

bis-acrylamide, safety warning A-5, 
A-23

bleedthrough peaks 6-3
buffer chamber

cleaning after a run 3-45
emptying 3-45
filling procedure 3-16 to 3-17
fixing leaks in upper 

chamber 3-17
installing lower buffer 

chamber 3-8 to 3-10
installing upper buffer 

chamber 3-15
replacing upper buffer chamber 

gasket 8-6 to 8-11

solution levels that must be 
maintained 3-17

buffer chamber, upper
gasket kit part numbers C-3

buffer solution
how impurities affect 

reproducibility A-6
levels that must be maintained in 

buffer chambers 3-17
preparing 10X TBE A-9
preparing 1X TBE 3-3, A-9

C
cables, See  electrode cables
calcium buildup, removing 4-32 to 

4-33
Calibration file

Calibration File Make 4-27 to 
4-28

Calibration File Send 4-27 to 
4-28

See Also CCD camera and CCD 
pixel position value

sending CCD pixel position value 
to instrument 8-16

calibration file make function, 
description of 3-49

calibration file send function, 
description of 3-49

cassette, See  gel cassette
CAUTION, user attention word 

defined 1-5
CCD camera

aligning 4-25 to 4-26
color and virtual filter sets 7-4
pixel position value 8-14 to 8-16
using Calibration File Make 4-27 

to 4-28
using Calibration File Send 4-27 

to 4-28
CCD Gain function, description 

of 3-49
CCD offset function, description 

of 3-50
CCD pixel position value 3-49, 4-25

location of 4-26
reentering 4-26
using Calibration File Make 4-25
using Calibration File Send 4-25

channels, number of in each 
lane 1-15

chemistries
chemical abbreviations used in gel 

recipes A-9
gels used for GeneScan runs 2-2
gels used for sequencing 

runs 2-2, 7-4
sequencing gel recipes A-3
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chiller modules
description of 9-44
installing 9-44 to 9-45

chiller modules folder, location and 
description of 3-51

clamps, part numbers C-2
cleaning, instrument accessories 8-3 

to 8-4
cleanup after a run 3-45
cold boot instrument function 3-50
cold boot procedure 4-23
collection time

modifying 9-45
suggested times 3-31

combs
cleaning 2-8
inserting 96-lane comb 3-6
inserting shark’s tooth 3-6
inserting square tooth 3-6
part numbers C-3

computer. See Macintosh computer
contaminants of

acrylamide A-5
buffers A-6
Tris A-6
urea A-6

coolant system clogs, removing 4-32 
to 4-33

customer support 1-6 to 1-10
e-mail address 1-6
internet address 1-9
telephone/fax 1-6 to 1-9

D
data

deleting data files 8-18 to 8-19
viewing 9-53 to 9-57

Gel window 3-41, 9-55
Scan window 3-41, 9-55

data analysis
about automatic analysis 9-38
designating Settings folder for auto 

analysis 3-52
overview 1-18 to 1-19, 9-60
See also automatic data analysis
using the stop and analyze 

feature 3-40
Data Collection software

description of 1-14
files and folders 9-3 to 9-4
menu commands 9-9 to 9-13
quitting 9-59
starting 9-8
troubleshooting guide 4-10

DataUtility program
description of program 7-3
using to verify instrument 

files 7-16 to 7-17
deionizing formamide A-10
deleting data files 8-18 to 8-19

desktop, how to rebuild 8-18
dew point table B-7
Documents on Demand 1-9 to 1-10
diffuse bands, reagent purity and 

associated problems A-5
dishwasher

recommendations 2-8
using to clean plates 2-6

dRhodamine terminator
kit A-3
virtual filter used 7-4

dye indicator preferences 5-17 to 
5-19

dye set/primer files
description of 9-49
how to select 9-50
naming conventions 9-49 to 9-50

dyes, about fluorescent dyes 1-13

E
Edit menu 9-11
electrical shock hazard

installing gel cassette 3-9
performing a plate check 3-11
warnings in manual 1-4, 4-32, 

8-2, 8-7, 8-10, 8-12
electrode cables

connecting lower buffer 
chamber 3-9

connecting upper buffer 
chamber 3-15

disconnecting 3-45
electrophoresis

description of gel 
electrophoresis 1-13

optimizing for GeneScan 
runs 4-34 to 4-35

electrophoresis chamber, 
illustrated 3-8

electrophoresis current function 3-49
Electrophoresis History window 9-56
electrophoresis off function 3-49
electrophoresis on function 3-49
electrophoresis power function 3-49
electrophoresis volts function 3-49
elevated interpeak baseline 6-4
e-mail, address for technical 

support 1-6
ergonomic hazard

sample loading hazards and 
recommendations 3-37

error messages, Macintosh operating 
errors 4-20

Execute button, manual control 
mode 3-48

explosion warning, nitric acid 
hazardous waste 4-32

exporting, sample sheet 
information 9-27

external cooler off function 3-50

external cooler on function 3-50
external cooling system

avoiding condensation B-7
hardware and software 

required B-2 to B-3
how an external water bath 

works B-3 to B-4
installing external water bath B-5
MDE gel protocol A-18
performing a run B-6
purpose of B-1
See also SSCP

F
Factura software, description of 1-21
File menu 9-10
files

archiving 8-23, 9-58
deleting to ensure adequate disk 

space for new data 
files 3-40

gel files 9-56, 9-58
Log file 9-54
opening and saving 9-57
temporary files created in System 

folder 9-8
firmware

about the firmware 4-21
downloading new image 3-50, 

4-24
file location 3-51
symptoms of corrupt 

firmware 4-21
firmware file folder, location and 

description of 3-51
fluorescent dyes 1-13
folder locations

folder names and locations 3-51 
to 3-52

how to set 3-52 to 3-53
setting preferences 5-5 to 5-7
table of locations 9-5 to 9-6

formamide
chemical warning 3-3
deionizing A-10

formamide/blue dextran, using in empty 
wells 3-38

fragment analysis
kit and reagent part numbers C-8 

to C-11
front heat-transfer plate

installing 3-18
part number C-4
removing and cleaning 3-45
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G
gasket mark

description of 2-5
how to remove 4-31

gel cassette
cleaning after a run 3-45
electrical shock hazard 

warning 3-9
how to carry with glass 

plates 3-4
how to carry with plates 2-10
installation procedure 3-8 to 3-10
loading gel plates into 

cassette 3-6 to 3-7
part numbers C-3
removing from instrument 3-45

gel extrusion
description 4-29
preventing 3-35
solutions for 4-29

gel files
archiving 9-58
description of 1-17, 9-58
saving 8-23
using the GelDoc utility 1-19

gel injection device (fixture) 2-14
gel pouring methods

overview of methods 2-4
plates mounted in cassette 2-10
using unmounted plates 2-20

gel quality
factors that affect 2-1
importance of 2-3

gel recipes
chemical abbreviations used A-9
factors that affect read 

lengths A-4
list of recipes and 

recommendations A-2
Long Ranger gels

10% ammonium 
persulfate A-15

4.75% Long Ranger 
Singel A-16

5% Long Ranger gel
for SSCP A-17
not for SSCP A-16 to 

A-17
ingredients and run 

conditions A-15
MDE gel for SSCP A-18
PAGE-PLUS gels

ingredients and run 
conditions A-13

protocol A-14

Polyacrylamide gels
gel solution protocols A-19 

to A-21
ingredients and run 

conditions A-11
protocol A-11 to A-12

See Appendix A 2-1
sequencing chemistries A-3
supplier information A-22

gel recommendations 2-2
gel sapcers, See spacers
gel temperature

determining 3-36, 9-43
modifying 9-45
viewing in Status window 3-36

Gel window, description of 3-42, 9-55
GelDoc II utility 1-19
gels

factors that affect gel quality A-4 
to A-8

age of the gel A-8
air bubbles A-8
rate of polymerization A-7
reagent purity A-5 to A-6

preparing A-2
removing from glass plates 3-45
selecting a gel formulation 2-2
troubleshooting gel and gel image 

problems 4-3 to 4-4
using high quality gels, importance 

of 2-3
using new glass plates 2-5
See Also gel recipes

GenBase software 1-20
GeneAssist Sequence Analysis 

System 1-21
general settings, description of and 

how to change 5-15 to 5-16
GeneScan analysis parameters folder, 

location and description 3-52
GeneScan Analysis Software

automatic data analysis 9-38
description of software 1-18
fragment kit and reagent part 

numbers C-8 to C-11
matrix files, See matrix files 6-1
optimizing electrophoresis 

conditions 4-34 to 4-35
run sheets

about 9-29 to 9-30
preparing 9-31 to 9-37
setting preferences 5-13 to 

5-14
sample sheets

about 9-20 to 9-21
entering information 9-26
importing/exporting 

information 9-27
preparing 9-22 to 9-25
setting preferences 5-12

GeneScan size standard folder, 
location and description 3-52

GenoPedigree software 1-20
Genotyper software 1-20
getting started

if unfamiliar with instrument 1-2
new user information 1-3
safety information 1-4

glass plates
avoid organic solvent 2-7
before using new plates 2-5
cleaning after a run 3-45
cleaning before loading gel 3-4 

to 3-5
cleaning by hand 2-6 to 2-7
cleaning in a dishwasher 2-6
decontaminating 4-30 to 4-31
gasket mark 2-5
identifying front and back 2-5
part numbers C-2
read region, description of 3-47
recommended dishwashers 2-8

H
hard disk

ensuring space for automatically 
created files 3-40

optimizing 8-19
hardware, description of system 

components 1-11
HCl wash, performing 4-31
heat transfer plate

rear, cleaning after a run 3-45
See also front heat transfer plate

help 1-6 to 1-10
e-mail address 1-6
internet address 1-9
telephone hours 1-6
telephone/fax 1-6 to 1-9

I
IMPORTANT, user attention word 

defined 1-5
importing sample sheet 

information 9-27
INHERIT software 1-21
injection device (fixture) for gel 

preparation 2-14
instrument components

hardware 1-11
models available 1-11 to 1-12
software 1-11

instrument files
adding/replacing matrices 7-20 

to 7-21
backing up 7-19
color guide for data display 7-4 to 

7-5
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DataUtility program, description of 
program 7-3

for Virtual Filter Set A 7-6 to 7-9
for Virtual Filter Set E 7-10 to 

7-15
from a sample file 7-18 to 7-19
overview 7-2
storing and backing up 7-19
summary of chemistries 7-4
terminology 7-1
verifying instrument files 7-16 to 

7-17
when to make new file 7-3

instrument manuals, part 
numbers C-7

Instrument menu, about 9-12
instrument operation

cleaning glass plates 3-4 to 3-5
cleaning up after run 3-45
filling buffer chambers 3-16 to 

3-17
installing front heat 

transfer-plate 3-18
installing gel cassette 3-8 to 3-10
installing lower buffer 

chamber 3-8 to 3-10
installing upper buffer 

chamber 3-15
loading gel into cassette 3-6 to 

3-7
loading samples 3-35 to 3-39
manually controlling the 

instrument 3-48 to 3-50
materials required but not 

supplied 3-2
new user recommendations 1-3
performing plate check 3-11 to 

3-13
performing prerun and loading 

samples 3-35 to 3-39
preparing 1X TBE buffer 

solution 3-3
preparing GeneScan sample 

sheet 3-24 to 3-27
preparing loading solution 3-3
preparing run sheet 3-28 to 3-34
preparing sequencing sample 

sheet 3-19 to 3-23
read region, description of 3-47
setting folder location 

preferences 3-51 to 3-53
setting up the software, an 

overview 3-19
skipping lanes, determining which 

to skip 3-14
starting and monitoring the 

run 3-40 to 3-43
summary of procedures 3-2
theory of operation 1-13

troubleshooting guide 4-6 to 4-9
viewing the Log file 3-44

instrument status
Electrophoresis History 

window 9-56
Status window 9-53

internet address
Documents on Demand 1-9 to 

1-10
part number updates C-1

K
keyboard commands, shortcuts 9-9
KOH wash, performing 4-30

L
lane tracking, affects of air 

bubbles A-8
laser

safety bar 3-18
safety warning 3-13

laser power function, description 
of 3-49

laser run function, description of 3-49
laser standby function, description 

of 3-49
load volumes, suggested 3-39
loading samples

how to 3-35
skipping lanes 3-38

loading solution
preparing loading solution 3-3
using formamide in empty 

wells 3-38
Log file

description of 9-54
description of and viewing 3-44
error messages 4-20

Log window. See Log file.
Long Ranger gels

10% ammonium persulfate A-15
4.75% Long Ranger Singel A-16
5% Long Ranger gel

for SSCP A-17
not for SSCP A-16 to A-17

gel solution ingredients A-15
recommendations A-2
run conditions for 48 and 36 cm 

gels A-15
lower buffer chamber

filling 3-16
installing 3-8 to 3-10

M
Macintosh computer

data flow to instrument 9-7 to 9-8
maintenance

adding non-Applied 
Biosystems 
software 8-28

archiving data from 
runs 8-23 to 8-24

backing up files 8-20
deleting data files 8-18 to 

8-19
downloading software from 

the web 8-26 to 8-27
optimizing hard disk 8-19
rebuilding desktop 8-18
recommendations 8-17
reinstalling software 8-25
restarting computer 8-18
system file, about 8-29
virus prevention 

program 8-21
Norton Utilities 8-22
operating error messages 4-20
Symantec Antivirus program 

(SAM) 8-21
maintenance, computer See Macintosh 

computer
maintenance, instrument

CCD pixel position value 8-14 to 
8-16

cleaning accessories 8-3 to 8-4
recommendations 8-2
refilling water reservoir 8-5
replacing electrophoresis cables 

and electrodes 8-12 to 
8-13

replacing upper buffer chamber 
gasket 8-6 to 8-11

See Also Macintosh computer, 
maintenance

manually controlling the 
instrument 3-48 to 3-50

materials required but not 
supplied 3-2

matrix
adding/replacing in an instrument 

file 7-20 to 7-21
See alsomatrix files
verifying an instrument file 7-16

matrix files
creating a matrix 6-6 to 6-8
evaluating the quality of 6-3 to 

6-5
purpose of 6-2
terminology 6-1
verifying new matrices 6-8 to 6-9
when to remake 6-2
Index-5



matrix standard samples
automatic analysis 3-32, 3-33
entering on GeneScan sample 

sheets 3-24
entering on sequencing sample 

sheets 3-20
loading recommendations for 

GeneScan 3-24
loading recommendations for 

sequencing 3-20
requirements 3-2

MDE gel
list of gel recipes and 

recommendations
protocol A-18

menu commands 9-9 to 9-13
Apple menu 9-9
Edit menu 9-11
File menu 9-10
Instrument menu 9-12
Window menu 9-13

mobility, sample
inconsistent, reagent purity and 

associated problems A-5
inhibited by buffer impurity A-6
troubleshooting guide 4-19

module folder, location and description 
of 3-51

modules 9-42 to 9-48
chiller modules

description of 9-44
installing 9-44 to 9-45

list of modules 9-47
modifying and creating 

modules 9-45 to 9-46
naming conventions 9-42 to 9-43
standard modules 9-42
unused modules 9-46
viewing module settings 9-43 to 

9-44
Mutation Detection gel, See MDE gel

N
new user recommendations 1-3
nitric acid wash 4-32
nitric acid waste, explosion 

warning 4-32
Norton Utilities

about 8-22
using Disk Doctor 4-20

Note, user attention word defined 1-5

O
opening files 9-57
operating the instrument.

 See instrument operation
organic solvents and glass plates 2-7

overlay strips
part numbers C-3
using 3-5

P
PAGE-PLUS gels

gel recipes and 
recommendations A-2

ingredients and run 
conditions A-13

protocol A-14
part numbers

buffer chambers C-3
combs and overlay strips C-3
electrode assemblies C-4
electrophoresis cables C-4
fragment kits and reagents C-8 

to C-11
front heat-transfer plate C-4
gasket kits for upper buffer 

chambers C-3
gel cassette and pouring 

fixture C-3
glass plates, spacer, and 

clamps C-2
two-pitch, eight-channel loader 

suppliers C-5 to C-6
updates via the web C-1
user’s manuals C-7

PCR Single-stranded Conformation 
Polymorphism. See SSCP

pipetting
ergonomic warning and 

suggestions 1-4, 3-37
plate check

commands to perform 9-39 to 
9-41

electrical shock hazard 
warning 3-11

how to perform 3-11
purpose of 1-15 to 1-16

plates
cleaning

cleaning by hand 2-6 to 2-7
recommended 

dishwashers 2-8
using a dishwasher 2-6

cleaning before loading gel 3-4 
to 3-5

gasket mark 2-5
identifying front and back 2-5
part numbers C-2
read region, description of 3-47
using new glass plates 2-5

Polyacrylamide gels
gel formulation A-2
gel solution protocols A-19 to 

A-21
ingredients and run 

conditions A-11

protocol A-11 to A-12
polymerization

APS, reagent purity and 
associated problems A-5

how affects gel quality A-7
initiator concentration A-8
TEMED A-6

poor resolution, caused by acrylamide 
impurity A-5

porous gel, factor that affects rate of 
polymerization A-7

positioning pins
checking cassette 

installation 3-10
cleaning after a run 3-45

pouring fixtures for gels, part 
numbers C-3

pouring gels.
See  gel pouring methods

power switch 3-8
preferences

default file name preferences, 
setting 5-8 to 5-9

defined 5-1 to 5-2
dye indicator 5-17 to 5-19
folder locations preferences, 

setting 5-5 to 5-7
for GeneScan sample 

sheets 3-24
for run sheets 3-28
for sequencing sample 

sheets 3-19
general settings, setting 5-15 to 

5-16
GeneScan run sheet preferences, 

setting 5-13 to 5-14
GeneScan sample sheet 

preferences, setting 5-12
if the preferences file becomes 

corrupt 5-4
Project Info (BioLIMS), 

setting 5-20
Project Info preference 3-19, 

3-25
sequencing run sheet preferences, 

setting 5-11 to 5-12
sequencing sample sheet 

preferences, setting 5-10
setting folder locations 3-51 to 

3-53, 9-5 to 9-6
viewing and modifying 5-3
where they are stored 5-2

prerun
commands to perform 9-39 to 

9-41
performing prerun and loading 

samples 3-35 to 3-39
purpose of 1-16 to 1-17

Primer Express software, description of 
software 1-20
Index-6



primers, dye
BigDye 7-4
fluorescein/rhodamine 7-4

printing
automatic printing after 

analysis 9-58
files, setting up for printing 9-58
sequence files 9-60

printing data from runs 3-46
project names

how to define 3-25
purpose of 3-25

protein sequences, analyzing with 
INHERIT software 1-21

protocols
chemical abbreviates used A-9
factors that affect read 

lengths A-4
list of recipes and 

recommendations A-2
Long Ranger gels

10% ammonium 
persulfate A-15

4.75% Long Ranger 
Singel A-16

5% Long Ranger gel
for SSCP A-17
not for SSCP A-16 to 

A-17
ingredients and run 

conditions A-15
MDE gel protocol A-18
PAGE-PLUS gels

ingredients and run 
conditions A-13

protocol A-14
Polyacrylamide gels

gel solution protocols A-19 
to A-21

ingredients and run 
conditions A-11

protocol A-11 to A-12
sequencing chemistries A-3

pull-up peaks 6-3
pump off function, description of 3-49
pump on function, description of 3-49
purity, effect of urea impurity A-6

Q
quality, temperature and gel 

quality A-8
QuantiBlot kit, when to use 4-15
quitting Data Collection software 9-59

R
read lengths, factors that affect A-4
read region

description of 1-15
read region, description of 3-47
reagents

purity, how it affects gel 
quality A-5 to A-6

storing A-23
rebuilding the desktop 8-18
reproducibility, affects of

acrylamide impurity A-5
buffer impurity A-6
vacuum strength and time during 

degassing A-7
reset

single reset, performing 4-22
total reset, performing 4-22

resolution
affects of acrylamide 

impurity A-5
definition of 4-34
deterioration due to aging 

gel A-8
modifying run voltage, effect 

of 4-34 to 4-35
troubleshooting guide 4-17 to 

4-18
restarting the computer 8-18
run

cleaning up after run 3-45
commands to perform 9-39 to 

9-41
description of 1-17
modifying run time 4-34, 9-45
starting and monitoring 3-40 to 

3-43
run file, saving 8-23
run sheets

for GeneScan runs 9-29 to 9-30
for sequencing runs 9-28 to 9-29
how to prepare 3-28 to 3-34, 

9-31 to 9-37
preferences, setting

GeneScan 5-13 to 5-14
sequencing 5-11 to 5-12

viewing 9-57
run temperature

determining 3-36, 9-43
modifying 9-45
viewing in Status window 3-36

run time, modifying 4-34, 9-45
run window. Same as run sheet.
runs folder, location and description 

of 3-51

S
safety information

ergonomic hazards and 
recommendations 1-4

Site Preparation and Safety 
Guide 1-4

safety information, location 1-3
safety warnings

electrical shock hazard 1-4, 
4-32, 8-2, 8-7, 8-10, 8-12

general warnings for ABI Prism 
377 1-4

TEMED A-6, A-23
urea A-6

SAM (Symantec AntiVirus program), 
about 8-21

sample files
archiving 8-23, 9-58
description of 9-60
location of 3-51, 9-4
making instrument file 7-18 to 

7-19
sample loaders

two-pitch, eight-channel loader 
suppliers C-5 to C-6

sample loading
suggested load volumes 3-39

sample mobility troubleshooting 
guide 4-19

sample names
restrictions 3-20, 3-24, 9-14, 

9-17
sample sheet folder, location and 

description of 3-51
sample sheets

changing after selecting on run 
sheet 3-30

entering information 9-26
GeneScan applications

about 9-20 to 9-21
preferences, setting 5-12
preparing 9-22 to 9-25

importing/exporting 
information 9-27

preparing for GeneScan run 3-24
preparing for sequencing 

run 3-19 to 3-23
sequencing applications

about 9-14 to 9-15
preparing 9-16 to 9-19
setting preferences 5-10

viewing 9-57
samples

loading, ergonomic warning and 
suggestions 3-37

performing prerun and loading 
samples 3-35 to 3-39
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saving
automatically created files, 

ensuring disk space 3-40
data from runs 8-23 to 8-24
files 9-57
sequence files 9-60
 See Also archiving

Scan window
description of 3-41, 9-55
use during Plate Check 3-11

Sequence Navigator software, 
description of software 1-22

sequencing chemistries A-3
sequencing software

automatic data analysis 3-32, 
9-38

description of software 1-19
instrument files

adding/replacing 
matrices 7-20 to 7-21

color guide for data 
display 7-4 to 7-5

DataUtility program, 
description of 
program 7-3

for Virtual Filter Set A 7-6 to 
7-9

for Virtual Filter Set E 7-10 to 
7-15

making from a sample 
file 7-18 to 7-19

overview 7-2
storing an backing up 7-19
summary of chemistries 7-4
terminology 7-1
verifying instrument 

files 7-16 to 7-17
when to make new file 7-3

run sheets
about 9-28 to 9-29
preparing 9-31 to 9-37
setting preferences 5-11 to 

5-12
sample sheets

about 9-14 to 9-15
entering information 9-26
importing/exporting 

information 9-27
preparing 9-16 to 9-19
setting preferences 5-10

serial number, entering in Calibration 
file 4-27, 8-15

settings (ABI) folder, location and 
description of 3-52

settings, changing manually 3-48
shark’s tooth comb, inserting 3-6
signal

description of temporary 
loss 4-29

preventing temporary loss 
of 4-29

troubleshooting guide 4-11 to 
4-15

single reset 4-22
Single-stranded Conformation 

Polymorphism, See SSCP
Site Preparation and Safety Guide, 

description of guide 1-4
skipping lanes

determining which to skip 3-14
software

adding non-Applied Biosystems 
software 8-28

additional ABI Prism software
AutoAssembler 1-21 to 1-22
BioLIMS 1-22
GenBase 1-20
GeneAssist Sequence 

Analysis System 1-21
GenoPedigree 1-20
Genotyper 1-20
Primer Express 1-20
Sequence Navigator 1-22

chiller modules
description of 9-44

data analysis software, 
described 1-18 to 1-19

Data Collection software
files and folders 9-3 to 9-4
menu commands 9-9 to 9-13
starting 9-8

DataUtility program
about 1-19
description of program 7-3
using to verify instrument 

files 7-16 to 7-17
downloading from the web 8-26 

to 8-27
GelDoc II utility 1-19
modules 9-42 to 9-48

chiller modules
installing 9-44 to 9-45

list of modules 9-47
modifying and creating 

modules 9-45 to 9-46
naming conventions 9-42 to 

9-43
standard modules 9-42
unused modules 9-46
viewing module 

settings 9-43 to 9-44
quitting Data Collection 

program 9-59
reinstalling ABI Prism 377 

software 8-25
setting up for a run 3-19
shipped with instrument 1-11
system file, about 8-29
system software 9-2

software manuals, part numbers C-7
solvents, organic, and glass 

plates 2-7
spacers

cleaning 2-8
part numbers C-2
placement of 2-11

special text usage 1-5
SSCP

avoiding condensation B-7
Chiller modules, description 

of 9-44
dew point table B-7
hardware and software 

required B-2 to B-3
how external bath water 

works B-3 to B-4
installing external bath water B-5
MDE gel protocol A-18
performing a run B-6
purpose of external cooling 

system B-1
staining wells 3-35
status lights on instrument 3-8
Status window

description of 3-42
viewing gel and run 

temperatures 3-36
Status window, description of 9-53
stock solutions, storing A-23
stop and analyze feature, using 3-40
storing instrument files 7-19
subambient temperature operation

avoiding condensation B-7
Chiller modules, description 

of 9-44
hardware and software 

required B-2 to B-3
how external water bath 

works B-3 to B-4
installing external water bath B-5
MDE gel protocol A-18
performing a run B-6
purpose of external cooling 

system B-1
suppliers

for gel solutions A-22
for two-pitch, eight channel 

loaders C-5 to C-6
Symantec AntiVirus program, 

about 8-21
system file, about 8-29
system software 9-2

reinstalling 8-25
Index-8



T
tab-delimited text, importing or 

exporting 9-27
technical support 1-6 to 1-10

e-mail address 1-6
internet address 1-9
telephone/fax 1-6 to 1-9

technical updates to user’s 
manual 1-5

TEMED
effect of changing 

concentration A-8
oxidized form A-6
safety warning A-6, A-23
storing A-23

temperature
how affects gel quality A-8

temperature, run 3-35
ensuring appropriate denaturation 

conditions 1-16
temporary files created in System 

folder 9-8
terminators, dye

BigDye 7-4
dRhodamine 7-4
Rhodamine 7-4

theory of operation 1-13
total reset 4-22
tracking

affects of air bubbles A-8
Tracker program, red data 

requirement 7-7
using the GelDoc utility 1-19

Tris contaminants, reagent purity and 
associated problems A-6

Tris-borate-EDTA, chemical 
warning 3-3

troubleshooting
amplification 4-16
CCD camera

aligning 4-25 to 4-26
CCD pixel position

Calibration File Make and 
Send 4-27 to 4-28

CCD pixel position value 4-25
cold boot procedure 4-23
coolant system clogs 4-32
Data Collection software 4-10
firmware 4-21
gasket marks on glass 

plates 4-31
gel and gel image 4-3 to 4-4
gel extrusion 4-29
if preferences file becomes 

corrupt 5-4
instrument 4-6 to 4-9
log file error messages 4-20
quick reference tables 4-3 to 

4-19

removing coolant system 
clogs 4-32 to 4-33

resolution troubleshooting 
guide 4-17 to 4-18

sample mobility 4-19
signal troubleshooting 4-11 to 

4-15
single reset, performing 4-22
temporary loss of signal 4-29
total reset, performing 4-22

U
unmounted plates, gel pouring 

method 2-4
upper buffer chamber

 See also buffer chamber
filling 3-16
installing 3-15
replacing gasket 8-6 to 8-11

urea
contaminants A-6
effect of impurity A-6
safety warning A-6

user attention words 1-5
User Bulletins, description of 1-5
user’s manuals

part numbers C-7
updates 1-5

V
Virtual Filter Set A

making instrument file 7-6 to 7-9
virtual filter sets, about 9-51

Virtual Filter Set C
making matrix files for 6-2
virtual filter sets, about 9-51

Virtual Filter Set E
making instrument file 7-10 to 

7-15
virtual filter sets, about 9-51

virus protection program, description of 
program 8-21

W
warnings

acrylamide A-5, A-23
bis-acrylamide A-5, A-23
safety information 1-3
TEMED A-6, A-23
urea A-6
WARNING, user attention word 

defined 1-5
warranty D-1
waste, nitric acid explosion 

warning 4-32
water reservoir, refilling 8-5

wells
flushing before loading 

samples 3-35
using formamide in empty 

wells 3-38
Window menu, about 9-13
www address
   Applied Biosystems 1-9

Documents on Demand 1-9 to 
1-10

part number updates C-1

X
XL-Upgrade, description of 

instrument 1-11 to 1-12
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